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Basic Safety Instructions

Always read through and comply with the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety
standards of our products up to date and to offer our customers the highest possible degree of safety. Our
products and the auxiliary equipment they require are designed, built and tested in accordance with the
safety standards that apply in each case. Compliance with these standards is continuously monitored by
our quality assurance system. The product described here has been designed, built and tested in
accordance with the EC Certificate of Conformity and has left the manufacturer’s plant in a condition fully
complying with safety standards. To maintain this condition and to ensure safe operation, you must
observe all instructions and warnings provided in this manual. If you have any questions regarding these
safety instructions, the Rohde & Schwarz group of companies will be happy to answer them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must
not be used in any way that may cause personal injury or property damage. You are responsible if the
product is used for any purpose other than its designated purpose or in disregard of the manufacturer's
instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation
and within its performance limits (see data sheet, documentation, the following safety instructions). Using
the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore
essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be
allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this
will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions
and the product documentation in a safe place and pass them on to the subsequent users.

Observing the safety instructions will help prevent personal injury or damage of any kind caused by
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions
before and when using the product. It is also absolutely essential to observe the additional safety
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In
these safety instructions, the word "product"” refers to all merchandise sold and distributed by the Rohde &
Schwarz group of companies, including instruments, systems and all accessories. For product-specific
information, see the data sheet and the product documentation.

Safety labels on products

The following safety labels are used on products to warn against risks and dangers.

Symbol Meaning Symbol Meaning

Notice, general danger location | O ON/OFF Power

Observe product documentation

Caution when handling heavy equipment d) Standby indication

Danger of electric shock f— Direct current (DC)

> B>
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Basic Safety Instructions

Meaning Symbol Meaning
Caution ! Hot surface ~_ Alternating current (AC)
Protective conductor terminal = Direct/alternating current (DC/AC)
To identify any terminal which is intended for
connection to an external conductor for
protection against electric shock in case of a
fault, or the terminal of a protective earth
Earth (Ground) D Class Il Equipment
to identify equipment meeting the safety

requirements specified for Class Il equipment
(device protected by double or reinforced
insulation)

Frame or chassis Ground terminal

EU labeling for batteries and accumulators

For additional information, see section "Waste
disposal/Environmental protection”, item 1.

devices

Be careful when handling electrostatic sensitive

EU labeling for separate collection of electrical
and electronic devices

For additional information, see section "Waste
disposal/Environmental protection”, item 2.

Warning! Laser radiation

For additional information, see section
"Operation", item 7.

Signal words and their meaning

The following signal words are used in the product documentation in order to warn the reader about risks

and dangers.

& WARNING

A CAUTION

Indicates a hazardous situation which, if not avoided, will result in death or
serious injury.

Indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

Indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

Indicates information considered important, but not hazard-related, e.g.
messages relating to property damage.
In the product documentation, the word ATTENTION is used synonymously.

These signal words are in accordance with the standard definition for civil applications in the European
Economic Area. Definitions that deviate from the standard definition may also exist in other economic
areas or military applications. It is therefore essential to make sure that the signal words described here
are always used only in connection with the related product documentation and the related product. The
use of signal words in connection with unrelated products or documentation can result in misinterpretation
and in personal injury or material damage.
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Basic Safety Instructions

Operating states and operating positions

The product may be operated only under the operating conditions and in the positions specified by the
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local
or national safety regulations and rules for the prevention of accidents must be observed in all work
performed.

1.

Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:
predefined operating position is always with the housing floor facing down, IP protection 2X, use only
indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea
level. A tolerance of +10 % shall apply to the nominal voltage and +5 % to the nominal frequency,
overvoltage category 2, pollution degree 2.

Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation
that is not carried out as described in the product documentation could result in personal injury or
even death.

Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient
temperature must not exceed the maximum temperature specified in the product documentation or in
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or
even death.

Electrical safety

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock,
fire and/or serious personal injury or death may occur.

1.

Prior to switching on the product, always ensure that the nominal voltage setting on the product
matches the nominal voltage of the mains-supply network. If a different voltage is to be set, the power
fuse of the product may have to be changed accordingly.

In the case of products of safety class | with movable power cord and connector, operation is
permitted only on sockets with a protective conductor contact and protective conductor.

Intentionally breaking the protective conductor either in the feed line or in the product itself is not
permitted. Doing so can result in the danger of an electric shock from the product. If extension cords
or connector strips are implemented, they must be checked on a regular basis to ensure that they are
safe to use.

If there is no power switch for disconnecting the product from the mains, or if the power switch is not
suitable for this purpose, use the plug of the connecting cable to disconnect the product from the
mains. In such cases, always ensure that the power plug is easily reachable and accessible at all
times. For example, if the power plug is the disconnecting device, the length of the connecting cable
must not exceed 3 m. Functional or electronic switches are not suitable for providing disconnection
from the AC supply network. If products without power switches are integrated into racks or systems,
the disconnecting device must be provided at the system level.

Never use the product if the power cable is damaged. Check the power cables on a regular basis to
ensure that they are in proper operating condition. By taking appropriate safety measures and
carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be
hurt by, for example, tripping over the cable or suffering an electric shock.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

Basic Safety Instructions

The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher
fuse only after consulting with the Rohde & Schwarz group of companies).

Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the
socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.

Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric
shocks.

For measurements in circuits with voltages Vs > 30 V, suitable measures (e.g. appropriate
measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be
taken to avoid any hazards.

Ensure that the connections with information technology equipment, e.g. PCs or other industrial
computers, comply with the IEC 60950-1 / EN 60950-1 or IEC 61010-1 / EN 61010-1 standards that
apply in each case.

Unless expressly permitted, never remove the cover or any part of the housing while the product is in
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the
product.

If a product is to be permanently installed, the connection between the protective conductor terminal
on site and the product's protective conductor must be made first before any other connection is
made. The product may be installed and connected only by a licensed electrician.

For permanently installed equipment without built-in fuses, circuit breakers or similar protective
devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the
product, as well as the product itself, is adequately protected from injury or damage.

Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the
danger of an electric shock.

Any object that is not designed to be placed in the openings of the housing must not be used for this
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries.

Unless specified otherwise, products are not liquid-proof (see also section "Operating states and
operating positions", item 1). Therefore, the equipment must be protected against penetration by
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product
itself may be damaged, which can also lead to personal injury.

Never use the product under conditions in which condensation has formed or can form in or on the
product, e.qg. if the product has been moved from a cold to a warm environment. Penetration by water
increases the risk of electric shock.

Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such
as alcohol, acetone or diluents for cellulose lacquers.

Operation

1.

Operating the products requires special training and intense concentration. Make sure that persons
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries
or material damage may occur. It is the responsibility of the employer/operator to select suitable
personnel for operating the products.
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2. Before you move or transport the product, read and observe the section titled "Transport".

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz
product, consult a physician immediately to determine the cause and to prevent health problems or
stress.

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be
sure to read and pay special attention to the section titled "Waste disposal/Environmental protection”,
item 1.

5. Depending on the function, certain products such as RF radio equipment can produce an elevated
level of electromagnetic radiation. Considering that unborn babies require increased protection,
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the
potential danger.

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and
protective clothing must be worn.

7. Laser products are given warning labels that are standardized according to their laser class. Lasers
can cause biological harm due to the properties of their radiation and due to their extremely
concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a
Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the
product documentation. The objective is to prevent personal injury (e.g. due to laser beams).

8. EMC classes (in line with EN 55011/CISPR 11, and analogously with EN 55022/CISPR 22,

EN 55032/CISPR 32)

— Class A equipment:
Equipment suitable for use in all environments except residential environments and environments
that are directly connected to a low-voltage supply network that supplies residential buildings
Note: Class A equipment is intended for use in an industrial environment. This equipment may
cause radio disturbances in residential environments, due to possible conducted as well as
radiated disturbances. In this case, the operator may be required to take appropriate measures to
eliminate these disturbances.

— Class B equipment:
Equipment suitable for use in residential environments and environments that are directly
connected to a low-voltage supply network that supplies residential buildings

Repair and service

1. The product may be opened only by authorized, specially trained personnel. Before any work is
performed on the product or before the product is opened, it must be disconnected from the AC supply
network. Otherwise, personnel will be exposed to the risk of an electric shock.
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Basic Safety Instructions

Adjustments, replacement of parts, maintenance and repair may be performed only by electrical
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed
after parts relevant to safety have been replaced (visual inspection, protective conductor test,
insulation resistance measurement, leakage current measurement, functional test). This helps ensure
the continued safety of the product.

Batteries and rechargeable batteries/cells

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g.
lithium cells) must be handled in accordance with the EN 62133 standard.

1.
2.

Cells must not be taken apart or crushed.

Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided.
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth.

Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a
drawer where they can short-circuit each other, or where they can be short-circuited by other
conductive materials. Cells and batteries must not be removed from their original packaging until they
are ready to be used.

Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted.

If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If
contact occurs, wash the affected area with plenty of water and seek medical aid.

Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells)
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see
parts list) in order to ensure the safety of the product.

Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the
national regulations regarding waste disposal and recycling.

Transport

1.

The product may be very heavy. Therefore, the product must be handled with care. In some cases,
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid
back or other physical injuries.

Handles on the products are designed exclusively to enable personnel to transport the product. It is
therefore not permissible to use handles to fasten the product to or on transport equipment such as
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of
transport or lifting. Noncompliance can result in personal injury or material damage.

If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the
product in the vehicle to prevent injuries or other damage in the event of an accident.
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Instrucciones de seguridad elementales

Waste disposal/Environmental protection

1. Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted
municipal waste, but must be collected separately. It may only be disposed of at a suitable collection
point or via a Rohde & Schwarz customer service center.

2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but
must be collected separately.
Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for
take-back obligations and disposal obligations for manufacturers within the EU. Contact your
Rohde & Schwarz customer service center for environmentally responsible disposal of the product.

3. If products or their components are mechanically and/or thermally processed in a manner that goes
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel)
may be released. For this reason, the product may only be disassembled by specially trained
personnel. Improper disassembly may be hazardous to your health. National waste disposal
regulations must be observed.

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal
regulations must be observed. Also observe the relevant safety instructions in the product
documentation. The improper disposal of hazardous substances or fuels can cause health problems
and lead to environmental damage.

For additional information about environmental protection, visit the Rohde & Schwarz website.

Instrucciones de seguridad elementales

iEs imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al dia
con los estandares de seguridad y de ofrecer a nuestros clientes el maximo grado de seguridad. Nuestros
productos y todos los equipos adicionales son siempre fabricados y examinados segun las normas de
seguridad vigentes. Nuestro sistema de garantia de calidad controla constantemente que sean cumplidas
estas normas. El presente producto ha sido fabricado y examinado segun el certificado de conformidad
de la UE y ha salido de nuestra planta en estado impecable segun los estandares técnicos de seguridad.
Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario debera
atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de empresas
Rohde & Schwarz esta siempre a su disposicién en caso de que tengan preguntas referentes a estas
informaciones de seguridad.

Ademés queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto
esta destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente
autorizado, para aplicaciones de campo y de ninguna manera debera ser utilizado de modo que alguna
persona/cosa pueda sufrir dafio. El uso del producto fuera de sus fines definidos o sin tener en cuenta las
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna
forma responsable de consecuencias a causa del mal uso del producto.
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Instrucciones de seguridad elementales

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las
indicaciones de la correspondiente documentacion del producto y dentro del margen de rendimiento
definido (ver hoja de datos, documentacién, informaciones de seguridad que siguen). El uso del producto
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el
uso de productos de Rohde & Schwarz, encontraria la informacion debida en la documentacion del
producto en el capitulo correspondiente. Guarde bien las informaciones de seguridad elementales, asi
como la documentacién del producto, y entréguelas a usuarios posteriores.

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o dafios por
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del
producto. Deberan tenerse en cuenta todas las demas informaciones de seguridad, como p. €j. las
referentes a la proteccion de personas, que encontrardn en el capitulo correspondiente de la
documentacién del producto y que también son de obligado cumplimiento. En las presentes
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas

Rohde & Schwarz bajo la denominacién de "producto”, entre ellos también aparatos, instalaciones asi
como toda clase de accesorios. Los datos especificos del producto figuran en la hoja de datos y en la
documentacién del producto.

Sefializacién de seguridad de los productos

Las siguientes sefiales de seguridad se utilizan en los productos para advertir sobre riesgos y peligros.

Simbolo Significado Simbolo Significado

Aviso: punto de peligro general | O Tension de alimentacion de PUESTA EN

o, MARCHA / PARADA
Observar la documentacion del producto

Atencién en el manejo de dispositivos de peso d) Indicacion de estado de espera (standby)
A elevado
| 18 kg |
2 Peligro de choque eléctrico e Corriente continua (DC)
f Advertencia: superficie caliente A~ Corriente alterna (AC)
. Conexion a conductor de proteccion —_ Corriente continua / Corriente alterna (DC/AC)
Conexion a tierra D El aparato esta protegido en su totalidad por un
aislamiento doble (reforzado)
Conexi6n a masa Distintivo de la UE para baterias y
acumuladores

Mas informacién en la seccion
"Eliminacion/proteccion del medio ambiente",
punto 1.
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Instrucciones de seguridad elementales

Simbolo Significado Significado

Aviso: Cuidado en el manejo de dispositivos
sensibles a la electrostatica (ESD)

Distintivo de la UE para la eliminacion por
separado de dispositivos eléctricos y
electronicos

Mas informacién en la seccion
"Eliminacion/proteccion del medio ambiente”,
punto 2.

Advertencia: rayo laser

Mas informacion en la seccién
"Funcionamiento", punto 7.

Palabras de sefial y su significado

En la documentacidon del producto se utilizan las siguientes palabras de sefial con el fin de advertir contra
riesgos y peligros.

A PELIGRO Indica una situacion de peligro que, si no se evita, causa lesiones
graves o incluso la muerte.

Indica una situacién de peligro que, si no se evita, puede causar

A ADVERTENCIA lesiones graves o incluso la muerte.

Indica una situacién de peligro que, si no se evita, puede causar
lesiones leves o moderadas.

A ATENCION

m Indica informacién que se considera importante, pero no en relacion
con situaciones de peligro; p. €j., avisos sobre posibles dafios
materiales.

En la documentacion del producto se emplea de forma sindénima el
término CUIDADO.

Las palabras de sefial corresponden a la definicion habitual para aplicaciones civiles en el area
econdémica europea. Pueden existir definiciones diferentes a esta definicién en otras areas econémicas o
en aplicaciones militares. Por eso se deberd tener en cuenta que las palabras de sefial aqui descritas
sean utilizadas siempre solamente en combinacion con la correspondiente documentacién del producto y
solamente en combinacion con el producto correspondiente. La utilizacion de las palabras de sefial en
combinacion con productos o documentaciones que no les correspondan puede llevar a interpretaciones
equivocadas y tener por consecuencia dafios en personas u objetos.

Estados operativos y posiciones de funcionamiento

El producto solamente debe ser utilizado segun lo indicado por el fabricante respecto a los estados
operativos y posiciones de funcionamiento sin que se obstruya la ventilacion. Si no se siguen las
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con
posible consecuencia de muerte. En todos los trabajos deberan ser tenidas en cuenta las normas
nacionales y locales de seguridad del trabajo y de prevencion de accidentes.
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Instrucciones de seguridad elementales

Si no se convino de otra manera, es para los productos Rohde & Schwarz valido lo que sigue:
como posicién de funcionamiento se define por principio la posicién con el suelo de la caja para
abajo, modo de proteccién IP 2X, uso solamente en estancias interiores, utilizacién hasta 2000 m
sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicara una tolerancia de
+10 % sobre el voltaje nominal y de +5 % sobre la frecuencia nominal. Categoria de sobrecarga
eléctrica 2, indice de suciedad 2.

No sitle el producto encima de superficies, vehiculos, estantes o mesas, que por sus caracteristicas
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalacion del
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si
se realiza la instalacion de modo distinto al indicado en la documentacion del producto, se pueden
causar lesiones o, en determinadas circunstancias, incluso la muerte.

No ponga el producto sobre aparatos que generen calor (p. €j. radiadores o calefactores). La
temperatura ambiente no debe superar la temperatura maxima especificada en la documentacion del
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.

Seguridad eléctrica

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia
de muerte.

1.

Antes de la puesta en marcha del producto se deberd comprobar siempre que la tensién
preseleccionada en el producto coincida con la de la red de alimentacion eléctrica. Si es necesario
modificar el ajuste de tension, también se deberan cambiar en caso dado los fusibles
correspondientes del producto.

Los productos de la clase de proteccién | con alimentacion mévil y enchufe individual solamente
podran enchufarse a tomas de corriente con contacto de seguridad y con conductor de proteccion
conectado.

Queda prohibida la interrupcién intencionada del conductor de proteccién, tanto en la toma de
corriente como en el mismo producto. La interrupcion puede tener como consecuencia el riesgo de
gue el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de
enchufe, debera garantizarse la realizacién de un examen regular de los mismos en cuanto a su
estado técnico de seguridad.

Si el producto no est& equipado con un interruptor para desconectarlo de la red, o bien si el
interruptor existente no resulta apropiado para la desconexion de la red, el enchufe del cable de
conexion se debera considerar como un dispositivo de desconexion.

El dispositivo de desconexién se debe poder alcanzar facilmente y debe estar siempre bien accesible.
Si, p. €]., el enchufe de conexion a la red es el dispositivo de desconexién, la longitud del cable de
conexion no debe superar 3 m).

Los interruptores selectores o electrénicos no son aptos para el corte de la red eléctrica. Si se
integran productos sin interruptor en bastidores o instalaciones, se debera colocar el interruptor en el
nivel de la instalacion.

No utilice nunca el producto si esta dafiado el cable de conexién a red. Compruebe regularmente el
correcto estado de los cables de conexion a red. Asegurese, mediante las medidas de proteccién y
de instalacion adecuadas, de que el cable de conexién a red no pueda ser dafiado o de que nadie
pueda ser dafiado por él, p. €j. al tropezar o por un choque eléctrico.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

Instrucciones de seguridad elementales

Solamente esta permitido el funcionamiento en redes de alimentacion TN/TT aseguradas con fusibles
de 16 A como maximo (utilizacién de fusibles de mayor amperaje solo previa consulta con el grupo de
empresas Rohde & Schwarz).

Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por
completo y fuertemente en la toma de corriente. La no observacion de estas medidas puede provocar
chispas, fuego y/o lesiones.

No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto
podria causar fuego o choques eléctricos.

En las mediciones en circuitos de corriente con una tension Ug; > 30 V se deberan tomar las medidas
apropiadas para impedir cualquier peligro (p. ej. medios de medicién adecuados, seguros, limitacion
de tensidn, corte protector, aislamiento etc.).

Para la conexiéon con dispositivos informaticos como un PC o un ordenador industrial, debe
comprobarse que éstos cumplan los estandares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1
validos en cada caso.

A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y
puede causar lesiones, fuego o dafos en el producto.

Si un producto se instala en un lugar fijo, se debera primero conectar el conductor de proteccion fijo
con el conductor de proteccion del producto antes de hacer cualquier otra conexién. La instalacion y
la conexidon deberan ser efectuadas por un electricista especializado.

En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automatico ni otros
mecanismos de seguridad similares, el circuito de alimentacién debe estar protegido de modo que
todas las personas que puedan acceder al producto, asi como el producto mismo, estén a salvo de
posibles dafios.

Todo producto debe estar protegido contra sobretension (debida p. ej. a una caida del rayo) mediante
los correspondientes sistemas de proteccion. Si no, el personal que lo utilice quedara expuesto al
peligro de choque eléctrico.

No debe introducirse en los orificios de la caja del aparato ningin objeto que no esté destinado a ello.
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o
lesiones.

Salvo indicacién contraria, los productos no estan impermeabilizados (ver también el capitulo
"Estados operativos y posiciones de funcionamiento”, punto 1). Por eso es necesario tomar las
medidas necesarias para evitar la entrada de liquidos. En caso contrario, existe peligro de choque
eléctrico para el usuario o de dafios en el producto, que también pueden redundar en peligro para las
personas.

No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido
condensaciones sobre el producto o en el interior de éste, como p. €j. al desplazarlo de un lugar frio a
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico.

Antes de la limpieza, desconecte por completo el producto de la alimentacion de tension (p. €j. red de
alimentacion o bateria). Realice la limpieza de los aparatos con un pafio suave, que no se deshilache.
No utilice bajo ninglin concepto productos de limpieza quimicos como alcohol, acetona o diluyentes
para lacas nitrocelulésicas.
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Instrucciones de seguridad elementales

Funcionamiento

1.

El uso del producto requiere instrucciones especiales y una alta concentracion durante el manejo.
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos
necesarios en cuanto a aptitudes fisicas, psiquicas y emocionales, ya que de otra manera no se
pueden excluir lesiones o dafios de objetos. El empresario u operador es responsable de seleccionar
el personal usuario apto para el manejo del producto.

Antes de desplazar o transportar el producto, lea y tenga en cuenta el capitulo "Transporte".

Como con todo producto de fabricacion industrial no puede quedar excluida en general la posibilidad
de que se produzcan alergias provocadas por algunos materiales empleados —los llamados
alérgenos (p. €j. el niquel)—. Si durante el manejo de productos Rohde & Schwarz se producen
reacciones alérgicas, como p. €j. irritaciones cutaneas, estornudos continuos, enrojecimiento de la
conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las
causas y evitar cualquier molestia o dafio a la salud.

Antes de la manipulacién mecénica y/o térmica o el desmontaje del producto, debe tenerse en cuenta
imprescindiblemente el capitulo "Eliminacién/proteccion del medio ambiente”, punto 1.

Ciertos productos, como p. €]. las instalaciones de radiocomunicacion RF, pueden a causa de su
funcion natural, emitir una radiacion electromagnética aumentada. Deben tomarse todas las medidas
necesarias para la proteccion de las mujeres embarazadas. También las personas con marcapasos
pueden correr peligro a causa de la radiacién electromagnética. El empresario/operador tiene la
obligacion de evaluar y sefalizar las areas de trabajo en las que exista un riesgo elevado de
exposicion a radiaciones.

Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias téxicas
(gases, liquidos etc.) que pueden generar dafios a la salud. Por eso, en caso de incendio deben
usarse medidas adecuadas, como p. ej. mascaras antigas e indumentaria de proteccion.

Los productos con laser estan provistos de indicaciones de advertencia normalizadas en funcién de la
clase de laser del que se trate. Los rayos laser pueden provocar dafios de tipo biolégico a causa de
las propiedades de su radiacion y debido a su concentracién extrema de potencia electromagnética.
En caso de que un producto Rohde & Schwarz contenga un producto laser (p. €j. un lector de
CD/DVD), no debe usarse ninguna otra configuracion o funcion aparte de las descritas en la
documentacién del producto, a fin de evitar lesiones (p. ej. debidas a irradiacion laser).

Clases de compatibilidad electromagnética (conforme a EN 55011 / CISPR 11; y en analogia con EN

55022 / CISPR 22, EN 55032 / CISPR 32)

— Aparato de clase A:
Aparato adecuado para su uso en todos los entornos excepto en los residenciales y en aquellos
conectados directamente a una red de distribucion de baja tensiéon que suministra corriente a
edificios residenciales.
Nota: Los aparatos de clase A estan destinados al uso en entornos industriales. Estos aparatos
pueden causar perturbaciones radioeléctricas en entornos residenciales debido a posibles
perturbaciones guiadas o radiadas. En este caso, se le podra solicitar al operador que tome las
medidas adecuadas para eliminar estas perturbaciones.

— Aparato de clase B:
Aparato adecuado para su uso en entornos residenciales, asi como en aquellos conectados
directamente a una red de distribucién de baja tension que suministra corriente a edificios
residenciales.
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Instrucciones de seguridad elementales

Reparacion y mantenimiento

1.

El producto solamente debe ser abierto por personal especializado con autorizacion para ello. Antes
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tension de alimentacion, para
evitar toda posibilidad de choque eléctrico.

El ajuste, el cambio de partes, el mantenimiento y la reparacion deberan ser efectuadas solamente
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los
aspectos de seguridad (p. €j. el enchufe, los transformadores o los fusibles), solamente podran ser
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad
debera realizarse un control de seguridad (control a primera vista, control del conductor de
proteccién, medicién de resistencia de aislamiento, medicion de la corriente de fuga, control de
funcionamiento). Con esto queda garantizada la seguridad del producto.

Baterias y acumuladores o celdas

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterias y
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible
consecuencia de muerte. El manejo de baterias y acumuladores con electrolitos alcalinos (p. €j. celdas de
litio) debe seqguir el estandar EN 62133.

1.
2.

No deben desmontarse, abrirse ni triturarse las celdas.

Las celdas o baterias no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz
directa del sol. Las celdas y baterias deben mantenerse limpias y secas. Limpiar las conexiones
sucias con un pafio seco y limpio.

Las celdas o baterias no deben cortocircuitarse. Es peligroso almacenar las celdas o baterias en
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto reciproco o por contacto con
otros materiales conductores. No deben extraerse las celdas o baterias de sus embalajes originales
hasta el momento en que vayan a utilizarse.

Las celdas o baterias no deben someterse a impactos mecanicos fuertes indebidos.

En caso de falta de estanqueidad de una celda, el liquido vertido no debe entrar en contacto con la
piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un
médico.

En caso de cambio o recarga inadecuados, las celdas o baterias que contienen electrolitos alcalinos
(p. €j. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o
baterias solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de
recambios).

Las baterias y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterias o
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales.
Respete en esta relacién las normas nacionales de eliminacion y reciclaje.

Transporte

1.

El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con
precaucion y, si es necesario, usando un sistema de elevacion adecuado (p. ej. una carretilla
elevadora), a fin de evitar lesiones en la espalda u otros dafios personales.
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Instrucciones de seguridad elementales

Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por
personas. Por eso no esta permitido utilizar las asas para la sujecion en o sobre medios de transporte
como p. €j. gruas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los
productos de manera segura a los medios de transporte o elevacion. Para evitar dafios personales o
dafos en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o
elevacién utilizado.

Si se utiliza el producto dentro de un vehiculo, recae de manera exclusiva en el conductor la
responsabilidad de conducir el vehiculo de manera segura y adecuada. El fabricante no asumira
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un
vehiculo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehiculo
debidamente para evitar, en caso de un accidente, lesiones u otra clase de dafios.

Eliminacién/protecciéon del medio ambiente

1.

Los dispositivos marcados contienen una bateria o un acumulador que no se debe desechar con los
residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminacién se debe
efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atencién al
cliente de Rohde & Schwarz.

Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar,
sino que deben ser recogidos por separado.

Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminacién de residuos y asume
plenamente los deberes de recogida y eliminacién para los fabricantes dentro de la UE. Para
desechar el producto de manera respetuosa con el medio ambiente, dirijase a su servicio de atencion
al cliente de Rohde & Schwarz.

Si se trabaja de manera mecéanica y/o térmica cualquier producto o componente mas alla del
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales
pesados como p. ej. plomo, berilio o niquel). Por eso el producto solo debe ser desmontado por
personal especializado con formacién adecuada. Un desmontaje inadecuado puede ocasionar dafios
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminacién de
residuos.

En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que
deban tratarse como residuos especiales (p. €j. refrigerantes o aceites de motor con intervalos de
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas
sustancias y las normas regionales de eliminacion de residuos. Tenga en cuenta también en caso
necesario las indicaciones de seguridad especiales contenidas en la documentacién del producto. La
eliminacién incorrecta de sustancias peligrosas o combustibles puede causar dafios a la salud o
dafios al medio ambiente.

Se puede encontrar mas informacion sobre la proteccién del medio ambiente en la pagina web de
Rohde & Schwarz.
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Customer Support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz
equipment.

Up-to-date information and upgrades

To keep your instrument up-to-date and to be informed about new application notes related to your
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish.
We will take care that you will get the right information.

Europe, Africa, Middle East Phone +49 89 4129 12345
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772)
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +6565 1304 88
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /
+86-400-650-5896
customersupport.china@rohde-schwarz.com

ROHDE&SCHWARZ

1171.0200.22-06.00


mailto:customersupport.asia@rohde-schwarz.com
mailto:customersupport.la@rohde-schwarz.com
mailto:customer.support@rsa.rohde-schwarz.com
mailto:customersupport@rohde-schwarz.com

1.1
1.2
1.3

21
211
2.1.2
213
214

2141
2142
215
2.1.6
2.1.7

2.2
2.21

23
2.31
23.2
233
234
235

2351
2352
2353
2354
2.3.6
2.3.7

24

241

Contents

Preface...... e ————_— 13
Documentation OVervieW..........cccuciirinniminnnii s 13
Typographical CONVENtiONS.........ccciiiiiiiccccceerrrre s sss s sssssrrs e e s s s a s ssnmnnne e e neees 14
Notes on Screenshots..........ccciviriii i ———————— 14
Preparing for USe......u i s s e s e s 15
Front Panel TOUN ... s 15
LT NS T PSR 15
Standby LEDs and Standby Key ... 16
1T o] =TSR 17
SEIUP KBYS. .o 17
Keys for Setting Parameters....... ..o 17
DISPIAY KEYS. ...t 18
Keypad for dat@ @Ntry.........oooio e 18
Rotary Knob and Navigation Keys. ... 19
Front Panel CONNECIONS. ......ooiuiiiiie e 20
Rear Panel TOUN ...t s 21
Description of the CONNECIOrS. .......oooiiiiii e 22
Putting into Operation...........ccccoiiiiein e —— 24
YIRS TU o] o] (=TT (o] o P PP PRPP 25
Unpacking and Checking the Instrument.............cccoooiiii e 26
Placing or Mounting the InStrument.............oooiiii e 26
Connecting the Instrument to the AC SUPPIY.......eeiiiiiiiii e 28
Starting the INStrUMENt.........oo e 28
Standby and Ready State..........oocuuiiiiiiii 29
Start Display and BOOING..........uuiiiiiiiiiie e 29
FUNCHON CRECK. ... . 29
Default SEttiNgS.......eeeiiee e 30
Shutting Down the INStrUMENt..........ooiii e 31
POWET FUSES.....iieiei ettt ettt e e st e e e nnneeees 31
Connecting External ACCESSOrIeS.......ccuuiiriiimiriiinnsre s 32
ConNECHiNg USB DEVICES. .....ciiiiiiiiiie ittt 32



25

2.6
2.6.1
2.6.2
2.6.3
2.7
271
2.7.2
2.8
2.8.1
2.8.2
2821
2822
2823
2824
2825

3.1
3.2
3.3
3.4

4.1

4.2
4.21
422
4221
4222
4223
4224
423
424
4241

Linux Operating System.......cccccviiiimiiiiirr s 33
Setting Up a Network (LAN) Connection..........cccovvmmmminnnssmnnnnsns e 34
Connecting the Instrument to the Network...........coociiiii e, 35
ASSIGNING the 1P AQAIESS. ....eiiiiiiiiiee e 36
USING COMPUEET NGIMES.......ciiiiiiiiiiei e 37
Remote Access via an External Controller...........coccoeiiiiiiinicinneee e 37
Using a Web Browser for Remote ACCESS.........ouiiiiiiiiiiiiiiieeceie e 39
Remote Access via a VNC Client Software. ..., 40
LXI Configuration...........ccciiiiiiiiiiiiiir s 45
LXI BrOWSEr SEENGS. ....eeeiiiiiiiiie ettt e e e e 46
LAN CONfIGUIALION. .....ciiiiiiiiie et 47
[P CoNfIQUIALION. ... e 48
Advanced LAN Configuration...........c.ueeiiiiiiiiioiiiee et 48
PiING ClHIENT. ...t 49
WWED CONTIOL. ..t e e e e rb e e st ee e 50
SCPIREMOLE TrACE. .. . eieiiiiiiiieii ettt e e 51
Getting Started...........coooiiiiirii e ———— 54
Brief Introduction to the Instrument’'s Concept.......cccccvermiiiiccccccicscer s 54
Application Field of the Instrument............cimiiii e 56
Description of Individual Diagram BIOCKS..........cccccerireesrerirscsereeesssee e e e essmee e e 56
Example of SEtUP.......cccccriiiiiiiiii e ssss e mnn e e e e e e e nnn 59
Manual Operation..........cccccriiiiniiiir e ——— 64
GV L= 10 RS 64
[ 1153 o] - V7O 67
Settings Displayed in the Header Section.............coccviiiiiiiiiiei e 67
Status Information and MESSAQES........ocoveiiiiiiiiie e 68
Status INfOrMAtION..........oiii e 68
LT T= T = SRRSO 68
VOlatilE MESSAGES. .. . viiiiiiiiiie ettt e e e e e e e e e e e e r e e e e e e e e e e e nannrnne 68
Permanent MESSAGES. .......cooi ittt ettt e e e e e e e e e e e e e e e 69
INFO WINAOW. ... 69
=] oTod [l 1T To =10 KRS 70
Function Blocks in the BIOCK Diagram..............eeeiiieieeiiiiiiiiiieeieeee e 70



4242
425
4.3
4.4
441
442
443
444
445
4.4.6
447
448
4.5
451
4.6
4.7
471
4.7.2
4.7.21
4.8
4.8.1

5.1

5.2
5.2.1
5.2.2
5.2.3
5.2.3.1
5232
5.2.3.3
5234
5.2.3.5
5.2.3.6

Signal Flow and Input/Output Symbols in the Block Diagram.............ccccccceeiiiiiiiiinnins 71
Structure of the DiIAlOgsS. .......coiuiiiiii i 71
Accessing Dialogs. ... ————_— 72
Setting Parameters........cccoiiiiiiir 73
WOrking With the CUISON........cueiiiii e 74
Selecting @ Control EIEMENt..........oooiiiiiii e 74
Switching Parameters On/Off.........ooiiiiii e 75
ENtering @ VaAlUC......ccoiiiie e 75
WOrKing With URNIES ....cooiiiiiiiii e 77
Selecting a Value from @ List........cueeiiiiii e 77
Terminating Entries with Confirmation............cccccooiii e 78
Restoring the Previous ValUe..............oooiiiiiii e 78
EditOrs. . .o ———— 79
Working With LisSt EQItOr.........ccoiiiiiiiiiiiiiie et 80
How to Use the Help System........ccccvciiiiiiniiiiee e 81
File Management.........ccoccuieiiiimmni s s 82
File SElECt DIAlOG. .. . cei ittt 84
11V =T g = To =T PSPPI 85
EXteNSIioNS fOr USEr FIleS.....oouiiiiiiiii e 85
Legend of Front-Panel Controls........ccccccmiiniiimiiniisrs e 86
Front Panel Key EmMUIatioN............oooiiiiiiii e 87
Instrument Function............oooiiiiiiiinr 89
Overview of Instrument FUNCtions.........cccoiiiiiiii e 89
General Instrument Settings........cccccvererrierirrrre e 920
Overview of General Instrument Settings........cccvvviiiiiiiii e 90
Default Instrument Settings - Preset KeY.......oiuviviiiiiiiii e 91
General Configuration of Instrument - Setup Key.......ccccoooiiiiiiiiiiie e 91
Internal AdJUSTMENTS.......ooi e 92
Hardware CONTig.......oii it e st e e e et e e e s e e e e e s nneeeens 94
SOftWArE / OPLIONS....eeiiiiieee et e e e e e e e e e e aeees 95
Manage LICENSE KBYS....ccoii it e e 96
NRP-Z INfO/UPAALE.......ccciiiiiieeeee et e e e e e e 97
SMZ INFO UPAALE.....coiiiiiiie e e as 99



5.2.3.7
5.2.3.8
5.2.3.9
5.2.3.10
5.2.3.11
5.2.3.12
5.2.3.13
5.2.3.14
5.2.3.15
5.2.3.16
5.2.3.17
5.2.3.18
5.2.3.19
5.2.3.20
5.2.3.21
5.2.4
5.2.5
5.2.5.1
5252
5.2.6
5.2.7
5.2.8
5.2.8.1
5.2.8.2
5.2.8.3
5284
5.2.8.5

5.3
5.3.1
5.3.1.1
5.3.1.2
5.3.2
5.3.21

DiISplay Update..........ooiiiiiiiiiei s 100
T ST PP PPR 100
Check Front Pane@l..........ooo it 101
Shutting Down and Rebooting the Instrument.............cccccoiiien 102
Date and TIME ..ot 103
NEWOIK SEHINGS .o 104
Display/Keyboard Settings. ........coocuuiiiiiiiiiiiiee e 107
Remote Channel SettiNgsS.........ueiiiiiiii e 108
Instrument EmUIationS. ..o 110
LXE SEATUS . ..ttt 112
PrOtECHION. ...ttt 113
S T=Te U 2P PTPRPR 114
SAVEIRECAIL. ... s 120
FaCLOrY PreSet. ... 120
[ (= T TP PPRR 121
Switching to Manual Control - Local Key..........cueeiiiiiiiiiiiiii e 121
Generating a Hard Copy of the Display...........cccueeiiiiiiiiiiiiic e 122
Hard CopY SetlNGS. ... .eeiiiiiiiiiii et 122
HardCOPY OPtiONS. .. ..ttt e e e e e e e 123
MeSSAQES - INTO KEY....ooiiiiiiiie e 125
Help System - Help KEY.......uiiiiiii e 125
Storing and Loading Instrument Data - File Key.........ccoociiiiiiiiiie 126
SAVE/RECAII IMENU. ... 127
Storing INStrument SEHiNGS. ......oovveiiii i 127
Loading Instrument Settings..........eviiiiiiiii 128
11V =T g = To =T PP PRSP 130
Accessing the File System of the Instrument and Transferring Files from and to the

INSTTUMIENT. ...ttt eeees 132
= oo 135
OVErvieW Of RF SIgNaAl......uuuiiiiiiiiiei ettt e e e e e reeeae e e e an 135
L O 0 { o U USSR 135
RF Signal Modes and CharacteristiCs............ooviiiiiiiiiiiiiie e 136
RE FrEQUENCY ... ..ottt ettt e e e e ettt e e e e e e e e e e ss st seneeeaeaeeeeesannnnnes 137
RF Frequency vs. RF Output FreqUENCY..........uuviiiiiiiieee e 137



5322
5.3.23
5324
5.3.2.5
5.3.3
5.3.3.1
5.3.4
5.34.1
5.3.5
5.3.5.1
5352
5353
5354
5.3.5.5
5.3.5.6
5.3.5.7
5.3.6
5.3.6.1
5.3.7
5.3.7.1
5.3.7.2
5.3.7.3
53.7.4
5.4
5.4.1
5.4.1.1
5412
5.4.2
5421
5.4.3
5.4.3.1
5.4.4
5441

Setting the RF FrEQUENCY......coouiiiiiiii e 138
RF FrequencCy Dialog.........oii e 138
FrequenCy SetliNGS. . ... i 138
User Variation Settings.........cooiiiiiiiiiii e 140
PRIESE. .. 140
PhaSE SEHINGS. ....ceiiiiiiiiii e 140
Reference OSCIlIAtOr...........ooiiiiii e 141
Reference Oscillator SEtiNgS. ........cuvvviiiiiiiii e 143
R LEVEL. ..t 145
OVErVIEW OFf RF LEVEL....coiiiiiiiiiie e 145
RF LEVEI DiIAIOJ. ... eteiiteeee ettt e e 146
Power-ONn/EMFEF SettiNgsS.......cooi it 151
Automatic Level Control - ALC........cuuiiiiiiiiiie e 151
NRP-Z LeVEI CONLIOL.....ceiiiitiiiie ittt 154
USEI COMTECHION. ...ttt ettt et et e e e aanaeeeenan 158
Reverse POWer ProteCtioN..........c..eeii it 165
RF MEASUIEMENT. ...ttt et e e e e e 166
NRP-Z POWET VIBWET ...ttt e e e e 166
RF Sweep and List MOGE........ouuiiiiiiiiiie et 174
OVEIVIBW. ...ttt e e e e et e e e e s bttt e e e e ab e e e e e e bt e e e e e e nnees 174
RF FreqQUENCY SWEED....... ittt e e 175
RF LEVEI SWEEP.....eeeieieitee et 182
[ 1Yo Lo L= PR RR PRI 187
Modulation.........coiiii i ———————————— 196
Overview Of MOAUIBLION. .......coiiiii e 196
Enabling/Disabling Analog Modulations using the MOD On/Off Key.......ccccccceeeinnee. 197
MOAUILION SOUICES.....cciiiiiiiiiei it e e e 197
Amplitude Modulation (AM).........coo i 198
Amplitude Modulation Settings.........ccooiiiiiiiii e 199
Frequency Modulation (FIM).........c.ueeeiiic e 202
Frequency Modulation Settings..........cuiiiiiiiiiiiii e 202
Phase Modulation (PhilM).........c.ueiiii e 206
Phase Modulation Dialog.............cuiiiiiiiiiiiee e 206



545
5.45.1
5.4.6
5.4.6.1
5.5
5.5.1
5.5.2
5.5.2.1
5.5.3
5.5.4
5.54.1
5542

6.1
6.1.1
6.1.2
6.1.3

6.1.3.1
6.1.3.2
6.1.3.3
6.1.3.4
6.1.4
6.1.5
6.1.6
6.1.6.1
6.1.6.2
6.1.7

6.2
6.2.1
6.2.2
6.2.3

6.2.3.1
6.2.3.2

Pulse Modulation (PM).........coi e 209
Pulse Modulation Settings.........cooiiiiiiiiiii e 210
StEre0 MOAUIBTION. ... 211
Stereo Modulation DiIalog.......ccoiiiiiiiiiiiii e 212
Modulation Generator and LF OQutput...........cooiiiiiee e 218
Overview Of LF GeNErator..........cuuiiiiiiiiiie e 218
LI OUEPUL. .t e e 218
LF OULPUL DIGIOG. ...ttt 219
LF FreqUENCY SWEEP.....cii ittt e e 220
PUISE GENEIATON. ...ttt 226
Pulse Generator SEttNGS........ooii i 226
Pulse Train GeNeration..........ocuuiiii i 230
Remote Control BasicCs.......cccccuviiiiiiiiiiniiiiiinnnssssssssssssns e 235
Remote Control Interfaces and Protocols...........ccccciiniimininnninnse s 235
VISA LIDIAIIES. .ttt ettt neeas 236
LT T= o = TP PPRRPPPR 236
LAN INTEITACE. ...ei ettt 237
HISLIP PrOtOCOL......etiiittii ettt ettt e e e s nabee e 239
VXI=TT PrOTOCOL. ..ot e e e e anee 239
Socket COMMUNICALION. .......uiiiiiii et 239
LAN INterface MESSAGES. ....cceiiuiiiie ettt ettt e et e e e e enbee e e e e 240
USB INTEITACE. ...ttt ettt et e b e e sbe e e 240
Serial INtEIACE. ......eii i 241
GPIB Interface (IEC/IEEE Bus INterface)..........cceoviviiieiiiiiiiie e 241
GPIB INterface MESSAGES. ....ccciuiiiiie ittt e e e e nbee e e e 242
GPIB INStruMeNnt AArESS. ......eeiiiiiieiiie ettt 243
LXI BrowSer INTEITACE. .......ueiiiiii et 243
Starting a Remote Control SesSion.........ccocccciiiiricceerressserr e 244
Switching to Remote CoNtrol...........oocuviiiiiiiiiiic e 244
Returning to Manual Operation.............ocueiiiiiiiiiiie e 245
EXAMIPIES. ..o ———————————————————— 245
Remote Control 0Ver GPIB..........c.cooiiiiiiiii e 246
Remote Control over LAN using VXI-11 ProtoCol..........cccccveeiiiiiiiiiiiiiee e 246



R&S®SMB100A

Contents

6.2.3.3
6.3
6.3.1
6.3.2
6.3.3
6.3.4
6.3.5
6.3.6
6.4
6.4.1
6.5
6.5.1
6.5.2
6.5.3
6.5.4
6.5.5
6.5.6
6.5.7
6.5.7.1
6.5.7.2
6.5.7.3
6.5.7.4
6.5.8
6.6

7.1
7.2
7.3
7.4
7.5
7.6
7.7
7.8

Remote Control over LAN using Socket Communication..............ccccovvveeiiiiiieeeennns 251
SCPI Command StruCture..........cccvivrieiiiinninie s 258
Syntax for Common COMMEANGS.........coiiiiiiiiieiiiiie e 258
Syntax for Device-Specific COMMAaNAS............ueiiiiiiiiiiiii e 259
SCPI Parameters. ......cooo i 261
Overview of Syntax Elements..........oooiiiiii e 264
Structure of @ commaNd lINE.........oooiiiiiiii e 264
ReESPONSES 10 QUETIES. ... ettt e e e e e e e e e e eeeaaaaeeeas 265
Command Sequence and Synchronization..........cccccceceriiiiiini e, 266
Preventing Overlapping EXECULION...........cooiiiiiiiiii e 267
Status Reporting System.........cccocviiiiiiii e ————— 269
Hierarchy of the Status RegiSters............oooi e 269
Structure of a SCPI Status Register........cooiiiiiiiii e 271
Status Byte (STB) and Service Request Enable Register (SRE).............oocociiee. 273
Event Status Register (ESR) and Event Status Enable Register (ESE)..................... 274
Questionable Status Register (STATus:QUEStionable)...........cccceeviiiiiiiiiiienceee, 274
Operation Status Register (STATus:OPER&tION).........ooviiiiiiiiiiiii e 275
Application of the Status Reporting System........ ..o 275
SErVICE REQUEST. ... . ettt e e e e e e e e e e e 275
SEIAI POl 276
Query of an INStruMENt StatUS. ........c.eeiiiii 276
EFrOr QUEUE. ...ttt e e e e e 276
Reset Values of the Status Reporting System.........ccuoeiiiiiiieees 277
General Programming Recommendations...........cccccvmiriininnesnns s snnnnnes 277
Remote Control Commands...........ccccoiiininiiniinnnnnsssssseenenn e 279
Conventions used in SCPI Command Descriptions........cccccceiiiiiccccicnceeeeeennnnnnn. 279
CoMmMMON COMMEANGS.......ceeiiiiriiiirirsrr s r s sn e s a e s nn s nn s 279
Preset ComMmands.........cccriieiminmninis s 284
CALibration SUDBSYStem..........ccccciiiiiicie e 286
DIAGNOSHIC SUDSYSEEM......coieie e 288
DISPlay SUDSYSEeM.......ccoiiceieeircrrerrrrere e e smr e e e mn e e 290
FORMat SUDSYSEEM........coo e 293
HCOPY SUDSYStEM.......ooiiiceiiiieeeere e e e e s e s e e mn e e e mmn e e e mnn e e s 294

Operating Manual 1407.0806.32 — 21 9



7.9
7.10
7.10.1
7.10.2
7.10.3
7.10.4
711
7.12
713
7.13.1
7.13.2
7.13.3
7.13.4
7.13.5
7.13.6
7.13.7
7.13.8
7.13.9
7.13.10
7.13.11
7.13.12
7.13.13
7.13.14
7.13.15
7.13.16
714
715
7.16
717
7.18
7.19
7.19.1
7.19.2

KBOAard SUDSYSteM.......ccccuiiiiiirrs s 301
MMEMoOry SUDSYSteM.....ccccuiiiiiinrie i 302
File Naming CONVENTIONS. .......ooiiiiiiiiei i 303
EXtensions fOr USEr FIleS. .. ..o 303
EXAMIPIES. .t 304
Remote Control COMMEANGS. .......coiiiiiiiiiiiiie e 305
OUTPUt SUDSYStEM.....cceeiiii it e 311
SENSe, READ and INITiate Subsystems..........cccccoiiiiiiniiin s 315
SOURCE SUDSYStEM......cueiiiiiiirrr i s 325
SOURCEIAM SUDSYSIEM......eiiiiiiiiii e 325
SOURCce:CORRECHION SUDSYSIEM......coiiiiiiiiiiiiiiiiii e 328
SOURCEIFM SUDSYSEM....iiiiiiieiiiie e 337
SOURCE:FREQUENCY SUDSYSIEM......uiiiiiiiiiiiiie et 340
SOURCE:INPUL SUDSYSEM......iiiiiiii i 347
SOURCce:LFOUtput SUDSYSIEM.....ccoiiiiiiiiii e 348
SOURCELIST SUDSYSEM....ciiiiiiiiiiiieit e 358
SOURce:MODuUIation SUDSYSEM.........uiiiiiiiiiiie e 371
SOURCEIPGEN SUDSYSIEM......ciiiiiiiiiiiiiiee s 371
SOURCEIPHASE SUDSYSIEM.....coiiiiiiiiiiiieiee e 372
SOURCEIPM SUDSYSIEM......eiiiiiiiiiii e 373
SOURCE:IPOWET SUDSYSIEM.....coiiiiiiiiiiiiiiei e e 376
SOURCEIPULM SUDSYSIEM......eeiiiiiiiiiiiie e 387
SOURCe:ROSCIllator SUDSYSEM........uiiiiiiiiiiiee e 405
SOURCE:STEREO SUDSYSIEM.....coiiiiiiiiiiiiii e 408
SOURCE:SWEED SUDSYSIEM....coiiiiiiiiiii e 417
STATUS SUDSYStEM.....cocii i ——— 429
SYSTem Subsystem..........ccooiiiiii i ———————— 433
TEST SUDSYStEM...cceeiiiiiiiir i 448
TRIGger SUbSYSteM........cccciiiir e ———— 449
UNIT SUDSYStEM....cccciiiiiiiire i 455
Direct Commands for the Stereo/RDS Coder Option R&S SMB-B-5..................... 456
Remote-Control COMMANGS..........coiiiiiiiiiieiiie et 456
EXAMIPIES. e 477



7.19.2.1
7.19.2.2
7.19.2.3
7.19.24

8.1

9.1
9.1.1
9.1.2
9.13

9.2
9.2.1
9.2.2

9.3

9.4

9.5

9.6

Alternative FrequenCy LiStS..........ooiiiiiiiii e 477
Enhanced Other Networks. ... ... 478
Free Format Groups (FFGS).. ... 479
TransSPareNt-IMOTE. ........ooiiiii e 479
MaintenNaNCe.......... oo 480
Storing and PacKing.......c.cccooeeiiirermerirccsmre e sssmre e s 480
Status Information, Error Messages and Troubleshooting............ 481
Status Information..........ccn e ————————— 481
Status information displayed between the frequency and level fields......................... 481
Status information displayed to the left of the Info line............cccoeiiii i, 483
Status information displayed in the INfo liN€...........ccovviiiiiiiiiiii e, 483
Error MESSageS. . cuuiiiiiiiiiiiiiiciinnnrrinnensssssssssssssnsnesee s e s e s ssssasssssssnnnnssesessssassnssssnsnnnnnnnns 484
VOlatile MESSAGES. .. . eeeiiiiiiieeee et e e e e e e e e e e e e e e e e e e e e e 484
Permanent MESSAGES. .....c.coii ittt e e e e e e e e e e e e e e e e e 485
SCPI-Error MESSAQeS....cucciiiiiiiiiiiiinnnmrrrererrsssssssssssssssnessesssssssssssssssssnsnsssssssssssssasssssnnn 485
Device-Specific Error MeSSages.......ccccuvmmrrrriririiiiiisssssssmssresssesssssssssssssssssssssssssssssas 485
Resolving Network Connection Failures.........cccccovviiiiccccciecmrnneene s seeeeeeees 487
Obtaining Technical SUPPOI.........cceiiiiiiiiciceicecrrrrr e ssssnr e mmnmneees 488
N T 1= SO 490
Hardware Interfaces.........ccoomeecii e 490
GPIB BUS INtEIrface.......cceeiiiereericcccree e s e e mn e smn e smn e e e mn e e mnn s 490
List of Commands..........cooiiiiieeeeeccccrre e e 492
g o 1= PR 502






1.1

Documentation Overview

Preface

Documentation Overview

This section provides an overview of the R&S SMB user documentation. You find it on
the product page at:

http://www.rohde-schwarz.com/product/SMB100A.html > "Downloads"

Quick start guide

Introduces the R&S SMB and describes how to set up and start working with the prod-
uct. Includes basic operations, typical measurement examples, and general informa-
tion, e.g. safety instructions, etc. A printed version is delivered with the instrument.
Online help

Offers quick, context-sensitive access to the complete information directly on the
instrument.

Operating manual

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control commands
with programming examples, and information on maintenance, instrument interfaces
and error messages. Includes the contents of the quick start guide manual.

The online version of the operating manual provides the complete contents for imme-
diate display on the Internet.
Service manual

Describes the performance test for checking the rated specifications, module replace-
ment and repair, firmware update, troubleshooting and fault elimination, and contains
mechanical drawings and spare part lists.

Instrument security procedures manual

Deals with security issues when working with the R&S SMB in secure areas.

Basic safety instructions

Contains safety instructions, operating conditions and further important information.
The printed document is delivered with the instrument.

Data sheet and brochure

The data sheet contains the technical specifications of the R&S SMB. It also lists the
options and their order numbers as well as optional accessories.


http://www.rohde-schwarz.com/product/SMB100A.html

1.2

1.3

Notes on Screenshots

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.
Release notes and open source acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.

The open source acknowledgment document provides verbatim license texts of the
used open source software.

See http://www.rohde-schwarz.com/product/SMB100A.html > "Downloads" > "Firm-
ware"

Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics, see http://www.rohde-schwarz.com/appnotes.

Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description
"Graphical user interface ele- All names of graphical user interface elements on the screen, such as
ments" dialog boxes, menus, options, buttons, and softkeys are enclosed by

quotation marks.

KEYS Key names are written in capital letters.

File names, commands, File names, commands, coding samples and screen output are distin-

program code guished by their font.

Input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quota-
tion marks.

Notes on Screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as much as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic test situations.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.


http://www.rohde-schwarz.com/product/SMB100A.html
http://www.rohde-schwarz.com/appnotes

Front Panel Tour

2 Preparing for Use

The following topics help you to get familiar with the instrument and perform the first
steps:

® Front Panel Tour
® Rear Panel Tour
® Putting into Operation

This section explains the control elements and connectors of the Signal Generator
R&S SMB with the aid of the front and rear views and describes how to put the instru-
ment into operation. It also describes the connection of peripherals such as printer,
keyboard or mouse. Specifications of interfaces can be found in the data sheet.

The Chapter 3, "Getting Started", on page 54 of this manual provides an overview of
the generator functions and introduces the operating concept. Detailed operating
instructions and an overview of menus follow in Chapter 4, "Manual Operation”,

on page 64.

For all reference information concerning manual and remote control of the instrument,
refer to the online help system or its printed/printable version. A more detailed descrip-
tion of the hardware connectors and interfaces is also part of the help system.

2.1 Front Panel Tour

The front panel of the R&S SMB consists of the VGA display, some utility keys (left
side) and the hardkey area with connectors and control interfaces (right side). The sub-
sequent sections provide brief explanations on the controls and connectors, the hard-
key area and the front panel.

> ROHDE & SCHWARZ SMB 100A - SIGNAL GENERATOR - 9kHz.6 GHz
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Figure 2-1: Front panel view

2.1.1 Utility Keys
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Front Panel Tour

The keys to the left of the display cause the R&S SMB to return to a definite instrument
state and provide information on the instrument and assistance.

For more information refer to chapter "Instrument Settings".

PRESET
Sets the instrument to a defined state (see Chapter 2.3.5.4, "Default Settings",
on page 30).

LOCAL
Switches from remote control to local (manual) control.

SETUP
Opens the "Setup" dialog for configuring presettings.

For more information, see Chapter 5.2.3, "General Configuration of Instrument - Setup
Key", on page 91.

FILE
Activates the menu for storing or loading files (see Chapter 4.7, "File Management",
on page 82).

INFO
Displays status messages, error messages and warnings.

WINBAR
Toggles between the diagram and active menus.

HELP
Displays context-sensitive help text.

Standby LEDs and Standby Key
The standby LEDs and the ON/STANDBY key are located in the bottom left corner of
the front panel.

The ON/STANDBY key toggles the instrument between standby and ready state (indi-
cated by the standby LEDs).

The standby LEDs indicate the instrument states as follow:
e the green LED (left) is on when the instrument is ready for operation,
® the yellow LED (right) is on in the standby mode.

See also Chapter 2.3.5.1, "Standby and Ready state", on page 29.
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Front Panel Tour

Display

The display clearly shows all main settings and signal generator states.

The display is divided into the following sections:

® Frequency and level display with info line
— Frequency and level settings containing offset.
— Status messages

— Brief error messages.
To access an window with detailed information for a message, use the INFO
key.
® Block diagram
The block diagram shows the current configuration and the signal flow in the gen-
erator with the aid of function blocks containing an on/off switch. Selecting a func-
tion block opens a list of associated setting menus. Active menus, info windows
and graphs are displayed on top of the block diagram. The block diagram can be
displayed in the foreground anytime with the DIAGRAM key.

For detailed information, see Chapter 4.2, "Display”, on page 67.

Setup Keys

The keys to the right of the display set parameters, select views and control the win-
dows.

Keys for Setting Parameters

These keys provide direct access to the settings in the header of the instrument for fast
setting the RF signal.

For more information refer to chapter "Instrument Functions".

FREQ
Activates frequency entry.

LEVEL
Activates level entry.

ON/OFF TOGGLE

® Switches highlighted elements or a function block on and off.

® Switches between two or more settings, e.g. items of selection lists. At the end of a
list, the cursor is set on the first entry again.
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Front Panel Tour

BACKSPACE
Deletes the character to the left of the cursor.

Display Keys

The keys assigned right to rotary knob arrange different windows on the display, and
turn the RF signal and the modulation on and off.

DIAGRAM
Brings the block diagram to the foreground. Active menus are minimized.

ESC

The function of this key depends on the current cursor position.

® (Calls the next higher selection level.

® Closes the open window without accepting new entries; the old value or parameter
is retained.

In dialog boxes that contain a "Cancel" button it activates that button.

Closes all kinds of dialog boxes, if the edit mode is not active.

Quits the edit mode, if the edit mode is active.

Switches between different entry fields of a menu.

Shifts the entry cursor from the header display to the previously active menu, or to
the previously highlighted block in the block diagram if no menu is active.

MOD ON/OFF
Switches the modulations on and off.

"MOD OFF" is displayed in the info line of the header next to the "Level" field.

RF ON/OFF
Switches the RF signal on and off.

"RF OFF" is displayed in the header next to the "Frequency" field.

Keypad for data entry

The keys in the data entry keypad are used to enter alphanumeric data and units.

Data entry keys are only enabled while the cursor is placed on a data input field in a
dialog. Their function depends on the data type of the input field.
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Keys Description
0...9/abc Enters the corresponding numbers (in numeric input fields) or characters (character input
fields).

Inserts a decimal point (numeric input fields) or dot (character input fields) at the cursor
position. Multiple decimal points are not allowed.

Unit keys Selects a unit and thus determine the absolute value, or changes the unit, i.e. trigger a
recalculation without changing the absolute value. The function depends on the time at
which the UNIT key is used during parameter entry (see Chapter 4.4.5, "Working with Units
", on page 77).

For unit-free values, the X1 key is equivalent to ENTER. It confirms the previous entry and
deactivates the input field.

Adds a blank in a character input field.

o Enters special characters. Toggles through the available characters if the key is pressed
several times in a row.

A<->a Toggles between uppercase and lowercase characters.

A, B,C,D, Enters hexadecimal values. The letters assigned to the keys are automatically active when
E,F an entry field with a hexadecimal value is active.

ENTER

Pressing the rotary knob has the same effect.

® Concludes the entry of dimensionless entries. For other entries, this key can be
used instead of the default unit key. The new value is accepted.

Confirms ("OK") and closes open input windows.

In a dialog box, selects the default or focused button.

In a dialog box, activates the edit mode for the focused area, if available.

In a dialog box, activates or deactivates the selected option of the focused area, if
the edit mode is active.

® (Calls the next menu level.

2.1.6 Rotary Knob and Navigation Keys

The rotary knob and the arrow keys are alternative control elements for data variation
and navigation in the graphical user interface.
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ROTARY KNOB

The rotary knob has several functions:

® Increases (clockwise direction) or decreases (counter-clockwise direction) numeric
values at a defined step width in editing mode

Moves the cursor, e.g. to a function block in the block diagram

Scrolls within lists, tables or tree views

Acts like the ENTER key, when it is pressed.

Shifts the selection bar within focused areas (e.qg. lists), if the edit mode is activa-
ted.

Note: Turning or pressing the rotary knob is equivalent to pressing the UP and DOWN
keys or the ENTER key in the keypad.

NAVIGATION KEYS

The navigation keys consist of 4 arrow keys which are used for navigation, alternatively
to the rotary knob.

UP/ DOWN The up and down arrow keys do the following:

KEYS ® |n a numeric edit dialog box, increase or decrease the instrument

parameter.
® |n a list, table, window or dialog box, scroll vertically.

LEFT/RIGHT  The left and right arrow keys do the following:

KEYS ® |n an alphanumeric edit dialog box, move the cursor forward and

back.
® |n a list, table, window or dialog box, scroll horizontally.

2.1.7 Front Panel Connectors

The RF and LF output connectors and a connector for external modulation signals are
located on the front panel.

MOD EXT

© nirr

Input for external modulation signals.

<€) LF

Output for internal LF modulation generator signal.

See also data sheet and Chapter 5.5.1, "Overview of LF Generator", on page 218,
Chapter 5.5.2, "LF Output", on page 218.
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RF 50 Ohm
Output for RF signal.

NOTICE! Maximum Input Levels. Do not overload the RF output.

The instrument is equipped with a reverse power protection that prevents the RF out-
put against back feed, see Chapter 5.3.5.7, "Reverse Power Protection”, on page 165.
Nevertheless, the maximum permisssible reverse power is specified in the data sheet.

Depending on the equipped frequency option, the RF output connectors vary.

RF Option Microwave Option

RF 5062

Frequency options Connector Frequency options Connector
type type
test port
R&S SMB- B101 N female R&S SMB-B112/-112L adapter, PC 3.5
mm female
R&S SMB-B102 R&S SMB-B120/-B120L
R&S SMB-B103 R&S SMB-B131 test port
R&S SMB-B140/-140L/-B140N | 2dapter, PC
2.92 mm female
R&S SMB-B106

NOTICE! Risk of RF connector and cable damage. Excessive tightening of the connec-
tors can damage the cables and connectors. Too weak tightening leads to inaccurate
results.

Always use an appropriate torque wrench suitable for this type of connector and apply
the torque specified in the application note 1MA99.

The application notes are available on the Internet and provide additional information
on care and handling of RF connectors.

Rohde & Schwarz offers appropriate torque wrenches for various connectors. For
ordering information see the R&S SMB data sheet or product brochure.

Rear Panel Tour

This section gives an overview of connectors on the rear panel of the instrument. Each
connector is briefly described and a reference is given to the chapters containing
detailed information. For technical data of the connectors refer to the data sheet.


http://www.rohde-schwarz.com/appnote/1MA99
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Figure 2-2: Rear panel view

2.2.1 Description of the Connectors

FUSES
The R&S SMB is fully fused by two fuses IEC60127-T3.15H/250 V.

The fuses are accommodated in the fuse holders next to the power connector. Use
only fuses of the mentioned type.

AC SUPPLY AND POWER SWITCH

When the R&S SMB is connected to the AC supply, it automatically sets itself to the
correct range for the applied voltage (range: see type label). There is no need to set
the voltage manually or change fuses.

The power switch can be set to two positions:

e 0
The instrument is disconnected from the mains.

° |
The instrument is power-supplied. It is either ready for operation (STANDBY) or in
operating mode, depending on the position of the ON/STANDBY switch on the
instrument front.

See also data sheet and Chapter 2.3.4, "Connecting the Instrument to the AC Supply",
on page 28.

USE IN USB IN
USB (universal serial bus) interface of type B (device USB).

This interface can be used for remote control of the instrument.

USB CONNECTORS TYPE A
USB (universal serial bus) interfaces of type A (host USB).

® Connection of peripherals such as mouse, keyboard, etc.
® Connection of memory stick for file transmission
® Firmware update

See also Chapter 2.4.1, "Connecting USB Devices", on page 32.

Operating Manual 1407.0806.32 — 21 22



R&S®SMB100A Preparing for Use

LAN CONNECTOR

Ethernet interface

® Forintegrating signal generators in a network
® Remote control of signal generator

® Remote access to the signal generator

® Firmware update

See also:
® Chapter 2.6, "Setting Up a Network (LAN) Connection", on page 34
® Chapter 6.1.3, "LAN Interface", on page 237

IEC 625/IEEE 488
IEC-bus (IEEE 488) interface for remote control of the instrument.

See also Chapter A.1, "GPIB Bus Interface", on page 490 and Chapter 6.1.6, "GPIB
Interface (IEC/IEEE Bus Interface)", on page 241.

Note: In order to avoid electromagnetic interference (EMI) caused by open lines,
always terminate any connected IEC-bus cable with an instrument or a controller.

STEREO R/L

Inputs for analog stereo modulation signals. External modulation sources or the inter-
nal LF generator can be used (stereo modulation is available with option R&S SMB-
B5).

See also Chapter 5.4.6, "Stereo Modulation", on page 211.

S/P DIF
Input for digital stereo signals (stereo modulation is available with option R&S SMB-
B5).

See also Chapter 5.4.6, "Stereo Modulation", on page 211.

SIP DIF -
(==

SIGNAL VALID
Output of valid signal. This signal marks the valid signal times (valid level and fre-
quency indication). The signal is generated automatically.

INSTR TRIG
Input for external trigger for sweeps and list mode.

See also Chapter 5.3.7.4, "List Mode", on page 187 and Chapter 5.3.7.1, "Overview",
on page 174.

PULSE VIDEO
Output of internal pulse generator signal or external pulse signal fed in via the PULSE
EXT connector (video signal).

See alsoChapter 5.4.5, "Pulse Modulation (PM)", on page 209 .
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PULSE EXT
Input of external pulse signal or input of external trigger/gate signal for internal pulse
generator.

See alsoChapter 5.4.5, "Pulse Modulation (PM)", on page 209 .
REF 0UT (3 REF OUT

_ Output of internal reference signal.

: See also Chapter 5.3.4, "Reference Oscillator", on page 141.
REF IN—3) REF IN
Input for external reference signal.

See also Chapter 5.3.4, "Reference Oscillator", on page 141.

OoCcXo
® Oven-controlled reference oscillator (option R&S SMB-B1)
or

® high performance oven-controlled reference oscillator (option R&S SMB-B1H)

The OCXO generates a very precise 10 MHz reference signal. It needs some minutes
of warm-up time to reach its nominal frequency.

Refer also to the data sheet for detailed information.

2.3 Putting into Operation

This section describes the basic steps to be taken when setting up the R&S SMB for
the first time.

A WARNING

Risk of injury and instrument damage

The instrument must be used in an appropriate manner to prevent electric shock, fire,

personal injury, or damage.

® Do not open the instrument casing.

® Read and observe the "Basic Safety Instructions" delivered as a printed brochure
with the instrument.

In addition, read and observe the safety instructions in the following sections.
Notice that the data sheet may specify additional operating conditions.

Operating Manual 1407.0806.32 — 21 24



Putting into Operation

Risk of instrument damage

Note that the general safety instructions also contain information on operating condi-
tions that prevent damage to the instrument. The instrument's data sheet can contain
additional operating conditions.

Risk of electrostatic discharge (ESD)

Electrostatic discharge (ESD) can damage the electronic components of the instrument
and the device under test (DUT). ESD is most likely to occur when you connect or dis-
connect a DUT or test fixture to the instrument's test ports. To prevent ESD, use a wrist
strap and cord and connect yourself to the ground, or use a conductive floor mat and
heel strap combination.

For details, refer to the basic safety instructions delivered as a printed brochure with
the instrument.

Risk of instrument damage during operation

An unsuitable operating site or test setup can damage the instrument and connected
devices. Ensure the following operating conditions before you switch on the instrument:

® All fan openings are unobstructed and the airflow perforations are unimpeded. The
minimum distance from the wall is 10 cm.

® The instrument is dry and shows no sign of condensation.

® The instrument is positioned as described in the following sections.

® The ambient temperature does not exceed the range specified in the data sheet.
® Signal levels at the input connectors are all within the specified ranges.

® Signal outputs are correctly connected and are not overloaded.

2.3.1 EMI Suppression

Electromagnetic interference (EMI) may affect the measurement results.

To suppress generated Electromagnetic Interference (EMI),

® Use suitable shielded cables of high quality. For example use double-shielded RF
and LAN cables.
Note: USB cables are of varying and often poor quality. Therefore, check the qual-
ity of each individual USB cable as described in the service manual.

® Always terminate open cable ends.
® Note the EMC classification in the data sheet
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2.3.2 Unpacking and Checking the Instrument

To remove the instrument from its packaging and check the equipment for complete-
ness, proceed as follows:

1. Pull off the polyethylene protection pads from the instrument's rear feet.

2. Carefully remove the pads from the instrument handles at the front.

3. Pull off the corrugated cardboard cover that protects the rear of the instrument.
4

Carefully unthread the corrugated cardboard cover at the front that protects the
instrument handles and remove it.

5. Check the equipment for completeness using the delivery note and the accessory
lists for the various items.

6. Check the instrument for any damage. If there is damage, immediately contact the
carrier who delivered the instrument. Make sure not to discard the box and packing
material.

Packing material

Retain the original packing material. If the instrument needs to be transported or ship-
ped at a later date, you can use the material to protect the control elements and con-
nectors.

2.3.3 Placing or Mounting the Instrument

The R&S SMB is designed for use under laboratory conditions, either on a bench top
or in a rack using a rack adapter kit (order number see data sheet).

Bench Top Operation

If the R&S SMB is operated on a bench top, the surface should be flat. The instrument
can be used in horizontal position, standing on its feet, or with the support feet on the
bottom extended.
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A CAUTION

Risk of injury if feet are folded out

The feet may fold in if they are not folded out completely or if the instrument is shifted.
This may cause damage or injury.

Fold the feet completely in or completely out to ensure stability of the instrument.
Never shift the instrument when the feet are folded out.

When the feet are folded out, do not work under the instrument or place anything
underneath.

The feet can break if they are overloaded. The overall load on the folded-out feet
must not exceed 500 N.

A CAUTION

Risk of injury and instrument damage if stacking instruments

A stack of instruments may tilt over and cause injury. Furthermore, the instruments at
the bottom of the stack may be damaged due to the load imposed by the instruments
on top.

Observe the following instructions when stacking instruments:

R

Never stack more than three instruments with the same dimensions (width and
length). If you need to stack more than three instruments, install them in a rack.

The overall load imposed on the lowest instrument must not exceed 500 N.

All instruments should have the same dimensions (width and length).
If you need to stack smaller instruments on the top, the overall load imposed on the
lowest instrument must not exceed 250 N.

If the instruments have foldable feet, fold them in completely.

E l imax. 500 N

4 1\ maxt$50 Ng [ﬂ ::

r 1 \( ,

T -y -

() 1 () 1 () )
|

0 (0 ;

Correct

L™ L™ L™ e
Too many instruments Different dimensions Feet folded out
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Rackmounting

The R&S SMB can be installed in a rack using a rack adapter kit (Order No. see data
sheet). The installation instructions are part of the adapter kit.

Risk of instrument damage in a rack

An insufficient airflow can cause the instrument to overheat, which may disturb the
operation and even cause damage.

Make sure that all fan openings are unobstructed, that the airflow perforations are
unimpeded, and that the minimum distance from the wall is 10 cm.

2.3.4

2.3.5

Connecting the Instrument to the AC Supply

The R&S SMB is automatically adapted to the AC voltage supplied. There is no need
to set the voltage manually or change fuses. The AC SUPPLY AND POWER SWITCH
is at the rear of the unit.

» Connect the instrument to the AC power source using the AC power cable deliv-
ered with the instrument.

Note: The instrument is in compliance with safety class EN61010-1.
Connect the instrument only to a socket with earthing contact.

Starting the Instrument

Switching off the AC power

You can leave the AC power on permanently to preserve your last instrument settings.
Switching off is required only if the instrument must be completely disconnected from
all power supplies.

Starting up instruments with power switch
1. Connect the instrument to the AC supply.

2. To turn the power on, press the main power switch to position | (On).

After power-up, the instrument is in standby or ready state, depending on the state
of the ON/STANDBY key at the front panel of the instrument when the instrument
was switched off for the last time.

3. In case the instrument is in standby mode, i.e. the yellow LED is on, press the ON/
STANDBY key to switch the instrument to ready state.
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2.3.5.2

Putting into Operation

Standby and Ready state
The ON/STANDBY key is located in the bottom left corner of the front panel.

Switching between standby and ready state

» Press the ON/STANDBY key briefly to switch the instrument from the standby to
ready state or vice versa.

In ready state, the left, green LED is on. The instrument is ready for operation. All
modules are power-supplied and the R&S SMB initiates its startup procedure.

In standby state, the right, yellow LED is on. The standby power only supplies the
power switch circuits and the oven-controlled crystal oscillator to keep it at its oper-
ating temperature. In this state it is safe to switch off the AC power and disconnect
the instrument from the power supply.

Start Display and Booting

The instrument boots the operating system, starts the instrument firmware and auto-
matically performs a selftest. If the previous session was terminated regularly, the
instrument uses the last setup with the relevant instrument settings.

Once the startup procedure has been terminated, the block diagram opened in the pre-
vious session is displayed and the instrument is ready for operation.

Use the PRESET key to return the instrument to its definite reset/preset state, if the
current setup is not anymore relevant.

To customize the start settings, use the "File" dialog.

Rebooting the instrument

Press the STANDBY key for approx. 5 s. to reboot the instrument, if the software stops
unexpectedly.

2353

Function Check

The signal generator automatically monitors the main functions when the instrument is
switched on and continuously during operation.

A detected fault is indicated by a "ERROR" message displayed in the info line together
with a brief error description. For in-depth identification of the error, press the INFO
key. In response, a description of the error(s) is displayed.

For more information, refer to Chapter 9, "Status Information, Error Messages and
Troubleshooting”, on page 481.

Additionaly to the automatic monitoring, the R&S SMB offers the following capabilities
to ensure correct functioning:

® |Internal Adjustments
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Press the SETUP key and select "System > Internal Adjustments" to access the
dialog for preforming and configuring of the adjustments settings. A maximum level
accuracy can be obtained, for instance.

® Selftest
A selftest is provided for service purposes.

Default Settings

When the instrument is switched on, it is not the preset state that is active, but rather
the instrument state that was set before the instrument was switched off. It is also reco-
mended that you use the PRESET key to return the instrument to its defined preset
state every time a new configuration is required or the current setup is not anymore rel-
evant.

The R&S SMB offers a two-stage preset concept:

® Preset the instrument to a predefined state
The PRESET key calls up a defined instrument setup. All parameters and switch-
ing states are preset (also those of inactive operating modes). The default instru-
ment settings provide a reproducible initial basis for all other settings. However,
functions that concern the integration of the instrument into a measurement setup
are not changed, e.g. GPIB bus address or reference oscillator source settings.

® Preset the instrument to its factory settings
The instrument can also be forced to load its default factory settings. To access the
corresponding dialog box, press the SETUP key and select the "Factory Preset".
For more information and an overview of the settings affected by the factory preset
function, see Chapter 5.2.3.20, "Factory Preset", on page 120.

Overview of the Most Important Preset States

The following list gives an overview of the presets for the most important generator set-
tings. The other presets can be found in the preset tables of the individual menus and
the information accompanying the remote commands.

® "RF frequency" =1 GHz
® "RF level" RF output switched off

e "Level" =30 dBm for instruments including an attenuator
"Level" = -5 dBm for instruments with no attenuator

e "Offsets" =0
® "Modulations State" = Off

® Uninterrupted level settings are switched off
"Level Attenuator Mode" = AUTO

® |Internal level control "Level ALC" = AUTO
® User correction "Level Ucor" = OFF

® "LF output State" = Off

® "Sweep State" = Off

Settings that are not affected by the PRESET key

® Reference frequency settings ("Ref Oscillator" menu)

| —
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® Power on settings ("Level/EMF" menu)

® Network settings ("Setup" menu)

® GPIB address ("Setup" menu)

® *|IDN? Identification and emulation ("Setup" menu)

® Password and settings protected by passwords ("Setup" menu)
e Start/Stop Display Update ("Setup" menu)

® Display and keyboard settings ("Setup” menu)

@ User-defined instrument states can be stored and called up in the "File" dialog.

2.3.6 Shutting Down the Instrument

To shut down the R&S SMB, proceed as described below.

Risk of losing data

If you switch off the running instrument using the rear panel switch or by disconnecting
the power cord, the instrument loses its current settings. Furthermore, program data
may be lost.

Press the ON/STANDBY key first to shut down the application properly.

1. Press the ON/STANDBY key to save the current setup, shut down the operating
system and set the instrument to standby state.

The yellow LED must be on.
2. To switch off the power, press the main power switch to position 0 (Off).

None of the front-panel LEDs should be on.

2.3.7 Power Fuses

The R&S SMB is fully fused by two fuses IEC60127-T3.15H/250 V.

The fuses are accommodated in the fuse holders next to the power connector. Use
only fuses of the mentioned type.
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Shock hazard

Before replacing a fuse, make sure that the instrument is switched off and disconnec-
ted from all power supplies.

Always use fuses supplied by Rohde & Schwarz as spare parts, or fuses of the same
type and rating.

24

2.41

Connecting External Accessories

The equivalent USB ports on the front and/or rear panel of the R&S SMB can be used
to connect a variety of accessories.

In addition the instrument provides interfaces for network integration (see Chapter 2.6,
"Setting Up a Network (LAN) Connection", on page 34).

Connecting USB Devices

Via the USB ports, you can connect external devices directly to the R&S SMB. If you

need more interfaces, you just use an USB hub.

The following list shows various USB devices that can be useful:

® Memory stick for easy transfer of data to/from a computer (for example firmware
updates).

® CD-ROM drives for easy installation of firmware applications.

® Keyboard or mouse to simplify the entry of data, comments, file names, etc.

® Power sensors, for example of the NRPxS(N) Power Sensors family.

Installing USB devices is easy under Linux, because all USB devices are plug&play.
After a device is connected to the USB interface, the operating system automatically
searches for a suitable device driver.

If Linux does not find a suitable driver, it will prompt you to specify a directory that con-
tains the driver software. If the driver software is on a CD, connect a USB CD-ROM
drive to the instrument before proceeding.

When a USB device is subsequently disconnected from the R&S SMB, the operating
system immediately detects the change in hardware configuration and deactivates the
corresponding driver.

All USB devices can be connected to or disconnected from the instrument during oper-
ation.
Connecting a memory stick or CD-ROM drive

If installation of a memory stick or CD-ROM drive is successful, the operating system
informs you that the device is ready to use. The device is made available as a new
drive (/usb). The name of the drive is manufacturer-dependent.
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Connecting a keyboard

The keyboard is detected automatically when it is connected. The default keyboard lay-
out is English — US.

Use the "Setup > Keyboard Settings" dialog to configure the keyboard properties.

Connecting a mouse

The mouse is detected automatically when it is connected.

2.5 Linux Operating System

The instrument uses an embedded Linux operating system. To make sure that the
instrument software works properly, certain rules must be adhered to concerning the
operating system.

Risk of causing instrument unusability

The instrument is equipped with the Linux operating system. Additional software can
therefore be installed on the instrument. The use and installation of additional software
may impair instrument function. Thus, run only programs that Rohde & Schwarz has
tested for compatibility with the instrument software.

The drivers and programs used on the instrument under Linux have been adapted to
the instrument. Existing instrument software must always be modified using only
update software released by Rohde & Schwarz.

The configuration of the operating system is optimally adapted to signal generator
functions in the factory. Changes in the system setup are only required when peripher-
als like keyboard are installed or if the network configuration does not comply with the
default settings (see Chapter 2.6.1, "Connecting the Instrument to the Network”",

on page 35). After the R&S SMB is started, the operating system boots and the
instrument firmware is started automatically.

Accessing Operating System
No access to the operating system is required for normal operation.

All necessary system settings can be made in the "Setup" dialog.

The R&S SMB provides an internal flash memory, it does not contain a disk drive. The
flash memory holds the operating system, the firmware and the stored data. Data
transfer is possible via a memory stick connected to a USB interface. The memory
stick and the flash memory are accessed via the "File Manager".
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Accessing the File System

The instrument also supports two standard methods to access the file system form a
remote client:
® FTP (file transfer protocol)

® File sharing according to the SAMBA/SMB (server message block) protocol.

Both methods allow the access to the folder /var/user/share.

Default password
The FTP and SAMBA/SMB file access use the user "instrument" with the default pass-
word "instrument".

It is highly recommenced that you change this password in the Chapter 5.2.3.18,
"Security", on page 114 dialog before connecting the instrument to the network!

Refer also to Application Note 1GP72 "Connectivity of Signal Generators", provided on
the Rohde & Schwarz website, at http://www.rohde-schwarz.com/appnotes.

Screen saver

A screen saver can be activated in the R&S SMB. When active, the display is shut off
when no entries via front panel, external mouse or external keyboard are made for a
period of time. The screen saver prolongs the life time of the display.

Use the "Setup > Display Settings" dialog to switch on or off the screen saver and to
adjust the screen saver settings.

2.6 Setting Up a Network (LAN) Connection

The R&S SMB is equipped with a network interface and can be connected to an Ether-
net LAN (local area network). Provided the appropriate rights have been assigned by
the network administrator and the Linux firewall configuration is adapted accordingly,
the interface can be used, for example:

® To transfer data between a controller and the instrument, e.g. in order to run a
remote control program.
See Chapter 6, "Remote Control Basics", on page 235.

® To access or control the measurement from a remote computer using the R&S
VISA or Ultr@VNC programs (or similar tools, like another VNC client or any Web
browser supporting Java)

® To transfer data from a remote computer and back, e.g. using network folders

This section describes how to configure the LAN interface. It includes the following top-
ics:

® Chapter 2.6.1, "Connecting the Instrument to the Network", on page 35

® Chapter 2.6.2, "Assigning the IP Address", on page 36
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Accessing Operating System
No access to the operating system is required for normal operation.

All necessary system settings can be made in the "Setup" dialog.

2.6.1 Connecting the Instrument to the Network

There are two methods to establish a LAN connection to the instrument:

® A non-dedicated network (Ethernet) connection from the instrument to an existing
network

® A dedicated network connection (Point-to-point connection) between the instru-
ment and a single computer

In both cases, an IP address has to be assigned to the instrument and the computer,
which is usually accomplished automatically. See also Chapter 2.6.2, "Assigning the IP
Address", on page 36.

To set up a network (LAN) connection

Risk of network failure

Before connecting the instrument to the network or configuring the network, consult
your network administrator. Errors may affect the entire network.

» Connect the instrument to the network or to a single PC.

If the instrument is connected to the LAN, the operating system automatically
detects the network connection and activates the required drivers.

By default, the instrument is configured to use dynamic TCP/IP configuration and
obtain all address information automatically.

The network card can be operated with a 10/100 Mbps Ethernet IEEE 802.3u interface.

Risk of network connection failure

Network cables and cable connectors of poor quality may cause network connection
failures.

If the network connection to the instrument fails, check the network infrastructure and
contact your network administrator.

For details, see section "Status Information, Error Messages and Troubleshooting".
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2.6.2 Assigning the IP Address

Depending on the network capacities, the TCP/IP address information for the instru-

ment can be obtained in different ways.

® |f the network supports dynamic TCP/IP configuration using the Dynamic Host
Configuration Protocol (DHCP), all address information can be assigned automati-
cally.

® |f the network does not support DHCP, the instrument tries to obtain the IP address
via Zeroconf (APIPA) protocol. If this attempt does not succeed or if the instrument
is set to use alternate TCP/IP configuration, the addresses must be set manually.

By default, the instrument is configured to use dynamic TCP/IP configuration and
obtain all address information automatically. This means that it is safe to establish a
physical connection to the LAN without any previous instrument configuration.

Risk of network errors!

Connection errors can affect the entire network.

If your network does not support DHCP, or if you choose to disable dynamic TCP/IP
configuration, you must assign valid address information before connecting the instru-
ment to the LAN.

Contact your network administrator to obtain a valid IP address.

Assigning the IP address on the instrument
1. Press the SETUP key and select the "Network Settings" dialog.
2. Set the "Address Mode" to Static.

3. Select the "IP Address" and enter the IP address, for example 7192.168.0.1..
The IP address consists of four number blocks separated by dots. Every block con-
tains 3 numbers in maximum.

4. Select the "Subnet Mask" and enter the subnet mask, for example 255.255.255.0.
The subnet mask consists of four number blocks separated by dots. Every block
contains 3 numbers in maximum.

@ Use computer names to identify the instrument

In networks using a DHCP server, it is recommended that you address the instrument
by its unambiguous computer name, see Chapter 2.6.3, "Using Computer Names",

on page 37.

A computer name (hostname) is an unique dedicated identification of the instrument,
that remains permanent as long as it is not explicitly changed. Hence, you can address
an instrument by the same identification (computer name), irrespectively if a network or
a point-to-point connection is used.
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To assign the IP address manually on the remote computer

» Obtain the necessary information from your network administrator. If you use more
than one LAN connector, you need separate address information for each connec-
tor.

For information on how to perform the configurations, refer to the documentation of
the operating system the remote computer uses.

2.6.3 Using Computer Names

In a LAN that uses a DNS server (Domain Name System server), each PC or instru-
ment connected in the LAN can be accessed via an unambiguous computer name
instead of the IP address. The DNS server translates the host name to the IP address.
This is especially useful when a DHCP server is used, as a new IP address may be
assigned each time the instrument is restarted.

Each instrument is delivered with an assigned computer name, but this name can be
changed.

The default instrument name is a non-case-sensitive string that follows the syntax
rs<instrument><serial number>.

The serial number can be found on the rear panel of the instrument. It is the third part
of the device ID printed on the bar code sticker:

&> 1D: 1419.0035K02 - (101441 Zd | serat number

Querying and changing a computer name

1. Press the "Setup” key and select "Network Settings".

The computer name is displayed under "Hostname".

2. Press the "Setup" key, select "Protection" and enable the "Protection Level 1".
The default password is 123456.

The parameter "Hostname" in the "Network Settings" dialog is now enabled for
configuration.

3. Change the "Hostname".

2.7 Remote Access via an External Controller

The R&S SMB can be remote accessed from a remote computer (external controller)
via a network link. This allows convenient operation of the instrument from the desktop
although the instrument is integrated in a rack somewhere else.
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and operate the instrument, see Chapter 3.1, "Brief Introduction to the Instrument's

@ For an overview of the instrument's operating concept and the different ways to control
Concept", on page 54.

There are different ways to establish a remote access connection to the signal genera-
tor but all of them require an established LAN connection between the instrument and
the remote computer. The simplest way to remote access the instrument is to use a
Web browser, such as Windows Internet Explorer or Mozilla Firefox for instance. Alter-
natively a remote access via a special application can be used.

For example, the free-of-charge program Ultr@VNC for PCs with Linux/Unix or Win-
dows operating system is available for setting up the remote access connection. Using
this application requires additional installation.

See the following table for an overview of the different ways to establish a remote
access connection to the signal generator.

Table 2-1: Remote access via an external computer

Remote access via Installation of the additional

LAN application

connec-
tion on the on the remote
instrument computer

Any web browser required no Java Runtime must
for example Windows Internet Explorer or Mozilla Firefox, be {nstalclje_d a:d
see Chapter 2.7.1, "Using a Web Browser for Remote bactlvate |n.t e
Access’, on page 39 rowser settings.
Web browser with HTML5 required no Web sockets must
for example LXI Browser, see Chapter 2.8.2.4, "Web be supported.
Control", on page 50
VNC Client required required VNC Viewer
for example Ultr@VNC or other dedicated client software required

for PCs with Linux/Unix or Windows operating system

see Chapter 2.7.2, "Remote Access via a VNC Client
Software", on page 40

When the connection is set up with a VNC client software (Ultr@VNC), direct control
on the instrument is possible while remote access is established.

For return to direct operation on the instrument, the connection must be cut. After cut-
ting the connection, it is still enabled and can be established again any time. The con-
nection is disabled only after deactivation of the program.

This section gives an information on how to use the Web browser for remote access,
how to install the applications for remote access and how to establish the connection
between the instrument and an external computer with Windows operating system.
Remote access via an external computer with Linux/Unix operating system is per-
formed accordingly.
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@

Default password

Remote-access and file access require the user "instrument" with default password
"instrument".

Changing the default user and security passwords

It is highly recommended to change the default user and security passwords in the
menu "Setup > Security" before connecting the instrument to the network (see section
Chapter 5.2.3.18, "Security", on page 114).

271

Using a Web Browser for Remote Access

The instrument can be remote-accessed via any web browser, as for example the Win-
dows Internet Explorer or Mozilla Firefox.

Alternatively, you can also make use of the LXI browser, as described in Chap-
ter 2.8.2.4, "Web Control", on page 50.

To remote access the instrument via a web browser:

1. Connect the instrument and the remote computer to a LAN, see Chapter 2.6.1,
"Connecting the Instrument to the Network", on page 35.

2. Instal the Java Runtime Environment JRE on the remote computer.

3. Type the instruments' IP address in the address field of the Web browser on your
PC, e.g. http://10.111.11.1

The "VNC Authentication" screen appears.

= TightVNC applet - Windows Internet Explorer

P
Lo A & | hitp:/f10.111.11.1) =

File Edt Wiew Favortes Tools Help

o 4 |£Tid‘t'u'NCq:-pbt [ ‘

Disc -;:::ne::ll COptions | Cliphoard | Send Ctri-AltDrel | Refresh |

VNC Authentication

Password: | 0K |

4. Enter the password and select "OK".
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The default password is "instrument".

After the connection is established, the current signal generator screen with the
block diagram is displayed and the instrument can be remote-accessed from the
remote computer.

2.7.2 Remote Access via a VNC Client Software

A VNC client software is an application which can be used to access and control the
instrument from a remote computer via LAN.

The following description explains how to establish the remote access, represented by
means of the client software Ultr@VNC. The software is included in Linux/Unix operat-
ing system, but it is also available as a free-of-charge download on the Internet http://
www.uvnc.com/download/index.html. Thus, it is also available for remote computers
with Windows operating system.

The GUI appearance of Ultr@VNC may vary if you use a later release. Also, similar
programs may deviate in some details, but the basic procedure is the same.

Risk of Unauthorized Access

If the VNC service is enabled on the instrument, any user in the network who knows
the computer name and password can access it.

Disable the VNC service on the instrument to prevent unauthorized access.
See "LAN Services" on page 116.

Setting up a VNC connection

1. Connect the instrument and the remote computer to a LAN, see Chapter 2.6.1,
"Connecting the Instrument to the Network", on page 35.

2. |Install the Ultr@VNC application and enable it on the instrument.
3. Inthe ICF firewall, enable communication on the network via Ultr@VNC program.

4. |Install the VNC Viewer on the remote computer with Windows operating system,
see "Installing the VNC Viewer on a Windows PC" on page 42.

5. Set up the VNC connection between the instrument and:

a) the remote computer with Linux/Unix operating system, see "Setting up the
VNC connection on the Linux/Unix remote computer" on page 43;

b) the remote computer with Windows operating system, see "Setting up the VNC
connection on the Windows remote computer" on page 43.


http://www.uvnc.com/download/index.html
http://www.uvnc.com/download/index.html
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Enabled Direct Control
The direct control of the instrument is not disabled and the instrument can be control-
led from the front panel and via the remote computer alternately.

Installing the Ultr@VNC application

1. Download the program from the internet and copy it to a directory that can be
accessed.

2. On the instrument, shut down firmware using the ALT+F4 key combination.

3. Double click on the setup file to start the installation.

The setup wizard leads through the installation. This description focus only on the
relevant settings.

a) Select installation of all components.

Setup - Ultr@uh

Select Components
‘Which components should be installed?

Select the components you wank to install: clear the components you do not want to
inztall. Click Mest when vou are ready to confinus.

| Full installation

UlraNC Server
NC

Current selection requires at least 2. 7 MB of disk space.

[ <Back | Nem> | [ Cancel

b) In the "Additional Task Panel", enable all entries.

Select Additional Tasks
Wwhich additional tasks should be perfomed?

Select the additional tasks you would e Setup to perform while installing U@y C
Releaze 1.0.0 RC 18, then click Mext.

Server configuration:

Register UI@YNC Server as a system service
Start or restart Ur@VNC service

Additional icons:

Create a Uln@&WNC Wiewer desktop icon
Create a Uli@\NC Server deskiop icon
Create a Ln@VHE Fepeater deskiop icon
File Azsociations:

[v] Azznciate vne files with UInEWNT Viewsr

[ <Back | Nem> | [ Cancel

A successful installation is indicated by a message.
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Winvhe x|

S The WinWNC service was successfully registered
(% | The service may be started from the Control Panel, and will
automatically be run the next time this machine is reset

At the same time a warning is displayed stating that a password must be set.

WINWMC Error &

A ) WARNING : This machine has no default password set. WinWhC will present the Default
e Properties dialog now to allow one to be entered.

4. Select "OK".

The "Default Local System Properties" panel opens.

“WinvNC: Local System Properties =0/
“Incoming Connections [ Connection Sefttings

v Accept Socket Connections I~ Force Yiew Only [disable Viewers Inputs]
Password: = = " Disable Local Inputs [Keyboard & Mouse]
¥ Remove Desktop Wallpaper

Display Number or Ports to use & Auto

" Display N° |0 Update Handling
© Ports  Main: [5900 Http: {5600 ¥ Poll Full Screen [ Fast] [~ Poll Console
¥ Poll Foreground Window—|  “rndows Only
| g - Poll On Event
[~ Poll Window Under Cursor Received Only
v System HookDIl
¥ ¥ideo Hook Driver

MS Logon

¥ Enable Java Viewer (Http Connection)
¥ Enable Xdmcp [X11 Connection)

—Yhen Last Client Disconnects ————————————— I” Low Accuracy [ Turbo Speed )
£ ACuHothing -DSM Plugin
£ Lock Workstation [¥2K) I~ Use iNn Plugin detected... j Config |

 Logoff Workstation

~Share only the Window N d:

~Misc.
¥ Enable Blank Monitor on Viewer Request I” Bhare I
¥ Enable File Transfer ~Query on incoming connection
I Log debug infos to the Win¥NC.log file [~ Display Query Window Timeout:|1 [ s
I Allow Loopback Connections
Default Server Screen 11 l|_ oK Apply I Cancel |

5. Enter a password with a length of at least five digits.
This password is used on the remote computer to access the instrument. Other
settings may be changed according to the user-specific security requirements.

After the installation the Ultr@VNC program is automatically started together with
the operating system. On mouse over, the IP address of the instrument is indica-
ted.

This IP address and the user-defined password are the prerequisites to enable
remote access on the remote computer. Terminated connection is indicated by
changed icon color.

Installing the VNC Viewer on a Windows PC

1. Download the Ultr@VNC program form internet and follow the installation instruc-
tions.
Only the program component VNC Viewer is required.
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Note: The VNC Viewer program is included in the download for the installation of

the Ultr@VNC program on the signal generator if "Full installation" was selected in
the "Select Component" panel. In this case, the program ultr@vncviewer.exe

can be copied to the Windows PC.

2. Install VNC Viewer program component on the remote computer.

Setting up the VNC connection on the Linux/Unix remote computer
The VNC program is available per default for Linux/Unix operating systems.

1. Start a Web browser on the remote computer and enter the IP address of the
instrument.

2. Enter the following address:
vnc://<IP-address of the instrument>, e.g. vnc://192.168.1.1.

A dialog is opened and the password for the remote VNC connection is requested.

3. Enter the password as defined in the "Default Local System Properties" panel of
the Ultr@VNC program and select "Log On".

The connection is established, the instrument is remote accessed and the current
signal generator screen with the block diagram is displayed. The individual func-
tions are operated using the mouse and keyboard.

In contrast to remote access via Remote Desktop, the direct control of the instru-
ment is not disabled and the instrument can be controlled from the front panel and
via the remote computer alternately.

Setting up the VNC connection on the Windows remote computer

1. Start VNC Viewer program component on the PC, select "VNC Server" and enter
IP address of the instrument.

x
%‘ N Server [1927681.7 =]
wr

[ host:display or host:part

 Quick Options:
& AUTD [Auto select best sattings) | Connect |
© ULTRA  [>2Mbitds] - Experimental
C |
€ LAN (> TMbit/s) - Mas Colors _Coreel |
 MEDIUM  [> 128Kkit/s] - Max Colors

" MODEM (13- 128Kbit/s) - 256 Colors
£ 5L0%W [« 19kKhit/z] - 256 Colars, Fuzzy

™ View Ony I Auto Sealing Options... |
™ Use DSMPhgin ]No Plugin detected... ;i Config |
™ Prosy/Repeater |

2. Toinitialize the connection, select "Connect".

A message requesting the password appears.
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¥NC Authentication

3. Enter the password as defined in the "Default Local System Properties" panel of
the Ultr@VNC program and select "Log On".

The connection is established, the instrument is remote accessed and the current
signal generator screen with the block diagram is displayed. The individual func-
tions are operated using the mouse and keyboard.

Enabled Direct Control
The direct control of the instrument is not disabled and the instrument can be control-
led from the front panel and via the remote computer alternately.

Terminating VNC Connection

The remote access via VNC connection can be terminated either on the R&S SMB or
on the external PC. Terminating the connection does not disable it. It can be estab-
lished again any time. See the notice above concerning unauthorized access due to
VNC connection!

1. Terminate the connection on the R&S SMB

a) Press the "Windows" key to access the operating system.
b) Right-click on the VNC icon on the task bar and select "Kill all clients".

2. To terminate the connection on the external Linux/Unix PC, close the internet
browser or close the signal generator window.

3. To terminate the connection on the external Windows PC, close the VNC Viewer
program.

The connection is terminated. The color of the VNC icon in the status bar of the
instrument changes.
A message on the external PC indicates the disconnection.

Disabling Remote Access via Ultr@VNC

The VNC connection can be disabled by removing the program on the instrument or by
deactivating the VNC Server service.

1. Remove the VNC program

a) Press the "Windows" key to access the operating system and open the "Add or
Remove Programs" by selecting "Start > Settings > Control Panel > Add or
Remove Programs".

b) Remove the VNC program.

2. Deactivate the VNC Server service

a) Press the "Windows" key to access the operating system and open the "Ser-
vices" by selecting "Start > Settings > Control Panel > Services".
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b) Deactivate the VNC Server service.

The connection is disabled, the VNC icon disappears from the task bar of the
instrument.

2.8 LXI Configuration

LXI ("LAN eXtensions for Instrumentation" is an instrumentation platform for measuring
instruments and test systems that is based on standard Ethernet technology. LXI is
intended to be the LAN-based successor to GPIB, combining the advantages of Ether-
net with the simplicity and familiarity of GPIB.

Like GPIB, LXI determines and standardizes the way the instrument behaves in a LAN.
The LXI implementation by the Rohde&Schwarz signal generators allows you to
change certain LAN settings, to reset the LAN connection as well as to identify the
instrument easily.

For information about the LXI standard, refer to the LXI website at http://www.Ixistan-
dard.org. See also "News from Rohde & Schwarz, article 2006/I1 - 190".

The R&S SMB provides an integrated "LXI Status" dialog for LXI status indication and
reset of the LAN configuration ("LAN Configuration Initialize", LCI). To access the LXI
status dialog, press the SETUP key and select "Remote > LXI Status".

For further information, see Chapter 5.2.3.16, "LXI Status", on page 112.

Firmware update
After a firmware update, shut down and restart the instrument in order to enable the full
LXI functionality.

Default state of the network settings

According to the LXI standard, an LCI must set the following parameters to a default

state.
Parameter Value
TCP/IP Mode DHCP + Auto IP Address
Dynamic DNS Enabled
ICMP Ping Enabled
Password for LAN configuration LxiWeblfc

The LCI for the R&S SMB also resets the following parameters:
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Parameter Value

Hostname <Instrument-specific host name>
Description Vector Signal Generator
Negotiation Auto Detect

VXI-11 Discovery Enabled

The LAN settings are configured using the instrument's "LXI Browser Interface".

2.8.1 LXI Browser Settings

To access the instrument via the web browser:

» Type in the instrument's host name or IP address in the address field of the
browser on your PC, for example "http://10.113.1.205".
Note: Do not add the missing zeros in the IP address, while opening the instru-

ment home page.

The instrument home page (welcome page) opens.

'%Hnusc HWARZ

LXI

LXI

4 Instrument Properties

Home
p Lan Configuration
Status

) Utilities Instrument Model
Manufacturer
Instrument Control Serial Number
Web Control Description
File Download LXI Version
. LXI Extended Features
(RIS DNS Host Name(s)
- - MAC Address
Deagn IP Address

Device Screenshot
SCPI Remote Trace
SCPI Command Shell

Help

Firmware Revision
Current Time

Current Time source

VISA resource string

Glossary

www.rohde-schwarz.com

Device Indicator

Status

Mo error

R&S SMB

Rohde & Schwarz GmbH & Co. KG

100011

Rohde & Schwarz Signal Generator SME100A 100011
1.4 LXI Core 2011

instrument
00:25:64:C3:31:82

10.113.1.150

03.20.390.12

Wednesday, 2015/12/02, 11:54:06
Operating System

TCPIP:10.113.1.150:inst0::INSTR
TCPIP:10.113.1.150:hislip0:INSTR

ACTIVE (press to toggle) (]

@ 2015 ROHDE&SCHWARE. All rights reserved.

The navigation pane of the browser interface contains the following elements:

° IILXIII

"Home" opens the instrument home page.
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The home page displays the device information required by the LXI standard,
including the VISA resource string in read-only format.

— "Device Indicator" activates or deactivates the LXI status indication.
When activated, the LXI LEDs flash, both in the browser dialog and in the LXI
dialog of the connected instrument. A green LXI status symbol indicates that a
LAN connection has been established; a red symbol indicates that no LAN
cable is connected.

— "Lan Configuration" allows you to configure LAN parameters and to initiate a
ping, see Chapter 2.8.2.3, "Ping Client", on page 49.

— "Status" displays information about the LXI status of the instrument.

— "Utilities" provides access to the LXI event log functionality required by the LXI
standard.

® "Instrument Control"

"Web Control" provides remote access to the instrument, see Chapter 2.8.2.4,
"Web Control", on page 50.

® "Diagnostics"

"SCPI Remote Trace" records messages exchanged via the remote control
interface, see Chapter 2.8.2.5, "SCP| Remote Trace", on page 51.

. llHeIp"
"Glossary" explains terms related to the LXI standard.
— www.rohde-schwarz.com opens the Rohde & Schwarz home page.

» Press the "INACTIVE (press to toggle)" button to activate the connection.

ACTIVE (press to toggle) @

A green flashing status LED indicates the active connection. If the LAN connection
fails, the LED turns red.

The status of the LAN connection is also indicated by the "LAN Status indicator" in
the "LXI Status" dialog.

For further information, see section "LXI Status" in the Operating Manual.

2.8.2 LAN Configuration

The "LAN Configuration" web page provides access to the parameters required for
identifying the R&S SMB in the network, and allows modification.

Password protection

Changing the LAN configuration is password-protected. The default password is Lxi-
Weblfc (notice upper and lower case characters). This password cannot be changed in
the current firmware version.

It comprises the following navigation entries.


http://www.rohde-schwarz.com/en/home_48230.html
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® [P ConfIQuration. ... .. ... it e e e 48
o Advanced LAN Configuration............couiiiiiiieiiiiiie et 48
L I oo T 1= o | PP 49
A =T o T O o] o1 1 o] TP PR PR PTRP 50
®  SCPIREMOLE TraCe..cciiiiiiiiieiiiiieee ettt ettt ettt e et e e e s sbtee e e s s sbreee e s snnreeeeaens 51

2.8.2.1 IP Configuration

The "IP Configuration" page displays all mandatory LAN parameters.

&SCHWARZ LXT

LXI 4 LAN Parameters

Home

}» Lan Configuration
IP Configuration

Advanced Config Attention! Changing the hostname reboots
S Hostname rssmb100a100020 the devicel
(O E L DNS Hostname(s) rssmb100a100020.rsint net
Status . ;
Domain rsint.net
b Utilities
Description SMEB (3.20.x.x) 000000
Instrument Control IP Address Mode |DHCF' + Auto IP Address v
Web Control IP Address 10.113.1.150
File Download Subnet Mask 10.111.1.32
File Upload Default Gateway 10.111.0.1
Obtain DNS Server Address ~
Diagnostics automatically
Device Screenshot DNS Server(s) 10.0.2.1866 10.0.23.159
Register Device at DNS Server vl
SCPI Remote Trace dynamically
SCPI Command Shell HISLIP Port 4880
Help Submit (Password required!)
Glossary
www.rohde-schwarz.com ST
Mo error

& 2015 ROHDEESCHWARZ. Al rights reserved.

The "IP Address Mode" selects a configuration mode for the IP address of the

R&S SMB. With static configuration, the entered IP address, subnet mask, and default
gateway are used. With dynamic configuration, DHCP or dynamic link local addressing
(automatic IP) are used to obtain the instrument IP address.

See Chapter 2.6.2, "Assigning the IP Address", on page 36.
2.8.2.2 Advanced LAN Configuration

The "Advanced Config" page provides LAN settings that are not declared mandatory
by the LXI standard.
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ROHDE&SCHWARZ LXi
LX1
Home
Lan Configuration
IP Configuration
mDNS and DNS-SD MDNS & DNS-S0 v
Ping Client
ICMP Ping enabled
Status )
Utilities VXI-11 Discovery

Instrument Control

‘Web Control

Diagnostics

SCPI Remote Trace

Help

Glossary

www.rohde-schwarz.com

2.8.23

Submit (Password required!)

Mo error

© 2015 ROHDE&SCHWARZ. All rights reserved.

The following advanced parameters are available:

"mDNS and DNS-SD": The additional protocols "multicast DNS" and "DNS service
discovery" are used for device communication in zero configuration networks,
working without DNS and DHCP.

"ICMP Ping enabled": Must be enabled to use the ping utility.

If you disable this setting, the instrument does not answer ping requests. The set-
ting does not affect the LXI ping client. You can ping other hosts from the instru-
ment, even if the setting is disabled.

"VXI-11 Discovery": Must be enabled to detect the instrument in the LAN.

If you disable this setting, the instrument cannot be detected by the VXI-11 discov-
ery protocol mechanism. The setting does not affect other detection mechanisms.
Setting up a VXI-11 connection via the IP address or the host name is independent
of this setting.

Ping Client

The "Ping Client" page provides the ping utility to verify the connection between the
LXI-compliant instrument and another device.

The ping is initiated from the instrument. Using the 1CMP echo request and echo reply
packets, the function checks whether the communication with a device via LAN works.
Ping is useful for the diagnosis of IP network or router failures.

The ping utility is not password-protected.

| —
Operating Manual 1407.0806.32 — 21 49
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To initiate a ping from the instrument to the device:
1. Enable "ICMP Ping" on the "Advanced LAN Configuration" page.
2. Select the "Ping Client" page.

3. Inthe "Destination Address" field, enter the IP address of the device you want to
ping (without the ping command and without any further parameters), e.g.
10.113.1.203.

4. Select "Submit".

%HHEISBHWAHZ LXr

LXI

Home

p Lan Configuration
Status

) Utilities

Instrument Control

‘Web Control

Diagnostics

SCPI Remote Trace

Help

Glossary

www.rohde-schwarz.com

4 Ping Parameter

Destination Address

Clear | Submit

PING 10.111.1.32 (10.111.1.32): 56 data bytes
64 bytes from 10.111.1.32: seg=0 ttl=64 time=0.280 ms

——— 10.111.1.32 ping statistics ---
1 packets transmitted, 1 packets received, 0% packet loss
round-trip min/avg/max = 0.280/0.280/0.280 ms

Result

Status

No error

& 2015 ROHDE&SCHWARZ. All rights reserved

2.8.2.4 Web Control

The web control functionality provides remote operation via VNC using a Web browser
(with HTMLS5). This mode does not require additional installation or activation. The
VNC protocol allows simultaneous operation from several remote devices. The instru-
ment remains locally operable.

The GUI of the R&S SMB is visible. To perform the settings, you can operate the
instrument as with the manual control. The instrument controls are available via the
front panel simulation. File upload and download between the instrument and the
remote PC is also available.
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Starting a Remote Control via the LXI web browser

This section assumes that the instrument and the controller PC are connected in the
LAN.

1. Start a web browser that supports htmlI5 (W3C compliant).
2. Enter the IP address of the R&S SMB in the browser's address bar.
The R&S SMB's welcome page is displayed.

3. Inthe navigation pane, select "Instrument Control" > "Web Control".

Remote access to the instrument requires the password. The default password is
instrument.

4. Enter the password.

5. Confirm with the ENTER key.

After the connection is established, the current screen of the R&S SMB is dis-
played in the browser window.

File  Edit  “iew Favorites  Tools  Help
& A * [ Eé; v Page v Safetyw Toolsw I@lv

Connected (unencrypted) to: rssmb100a100020:0
Freq RFON  MODON

| 311.000 000 000 [ | l][] 0féen |

RfSweep, ALC-Auto Info

F [1IE|NRP—ZB1 -59.58 dBmmrg]

I Iv| I |

6. Use the mouse cursor and keyboard to access the functionality of the instrument
as you would directly perform the settings on the instruments front panel.

2.8.2.5 SCPI Remote Trace
The remote trace functionality allows you to trace input and output strings at the
remote control interface of the R&S SMB.

A recorded trace (message log) can be evaluated directly in the dialog. Use the high-
lighting and navigation functions provided in the lower toolbar to locate error messages
and messages containing arbitrary search strings. You can also export the message
log to a *. csv file and evaluate the file using a suitable program.

To trace and display messages:

1. In the navigation pane, select "Diagnostics" > "SCPI Remote Trace".

| —
Operating Manual 1407.0806.32 — 21 51
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2. In the toolbar bar of the "SCPI Remote Trace" page, select "live mode" > "on" and
llloggingll > "OI’]",

"live mode > on" displays all commands and responses, and "logging > on" also
traces messages.

3. If you now control the R&S SMB with SCPI commands, using an appropriate tool,
the SCPI remote trace records the information sent and received.

%ﬂ DE&SCHWARZ LXT

Lxi 4 SCPIRemote Trace

Home
) Lan Configuration

Status live mode: @on Ooﬂ logging: (® on off "? fitter - log file: a refresh {}, download K clear D details
) Utilities

rec MT| | message

1 *dn?

1 Rohde&Schwarz,<instrument, 12345 67890
1 *opt?

10

1 Freq?
1

1

1

1

=]

Instrument Control

Web Control

Diagnostics

1000000000
LEY -20
LEW?

-20

SCPI Remote Trace

cooeo oo
AMOW A Y AW AW

Help

Glossary
www.rohde-schwarz.com

Status

20 live records received

® 2015 ROHDEESCHWARZ. All rights reserved

The function records all sent commands, received responses and messages, and
stores them in an internal database. If "live mode" is disabled, you can display the
recent traces upon request, using the "refresh" button. You can also store the log in
a file.

Note: The diagnostics functionality is extended in later releases, e.g. to download
or upload SCPI command files from / to the instrument.

Toolbars

The toolbar at the top of the dialog provides basic settings and functions.

live mode: (® on () off logging: ® on | off 537 fitter - log file: | g refresh | #i) download = 3¢ clear =] details

® "Live mode" / "logging": If logging is switched on, messages are traced. They are
stored in an internal database and can be displayed upon request, using the
refresh button (live mode off) or they can be displayed automatically (live mode
on).

® "Filter": applies a filter to columns and/or rows when working (live mode off)

® "Refresh": reads the message log from the internal database and displays it
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® "Download": stores the SCPI trace log to a * . csv file
e "Clear": deletes all message log entries in the database and on the screen

e "Details": displays details of the selected message, for example an SCPI command
in hex format (also possible by double\-clicking a message)

Columns
The following columns are available if no column filter is applied:

® "Rec": record number of the message within the message log
® |: number of the subinstrument

e "MT": indicates the type of the message. Possible values and related message
contents are:

— > =incoming command
— < =outgoing response to a query
— E = error message, highlighted by red color

— T = execution time, i.e. time required by the instrument to process the com-
mand internally

® "message": indicates the type of the message. Possible values and related mes-
sage contents are:

— > =incoming command
— < =outgoing response to a query
— E = error message, denoted in red

— T = execution time, i.e. time required by the instrument to process the com-
mand internally
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3 Getting Started

This section helps you to get familiar with the R&S SMB. It provides an introduction to
the general concept of the instrument with a sample of the possible application fields,
and a description of the main blocks in the signal generation flow.

This section also explains the operating concept in general and includes a brief intro-
duction to operation by a step-by-step description of the configuration. The example is
intended to provide a quick overview of the settings provided. No additional equipment
is required.

3.1 Brief Introduction to the Instrument's Concept

The operating concept of the R&S SMB employs the following three ways of instru-
ment control:

® Manual operation
® Remote control
® Remote access

Manual Operation

The R&S SMB can be entirely operated from the front panel. Peripherals such as
mouse or keyboard can be connected but are not essential.

The R&S SMB is equipped with an intuitive user interface. The central element of the
display is the block diagram that shows the signal flow and processing from the left on
the display to most right, i.e. the generated signal can be seen at a glance.

Each block represents a functional unit of the instrument. Thus you always know the
position at which a parameter affects the signal flow. The main settings of a block are
indicated in the block. The interconnection of employed inputs and outputs is also
shown. The user is thus always informed about the connection of inputs and outputs in
the signal flow and where they can be configured. A window is opened for each menu
where parameters can be set. When the window is opened, an entry is made in the
"Winbar" below the display. All open menus are of equal priority (not modal) and can
be accessed any time.

The block diagram in the figure below shows a fully equipped instrument.
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Figure 3-1: Block diagram of a fully equipped R&S SMB

With the rotary knob, you can navigate in the block diagram and the dialogs, and oper-
ate the instrument with one hand. The cursor is moved line by line through the block
diagram or dialog. Turning the button clockwise advances the cursor. The selected
block can be activated or deactivated with the TOGGLE key. Active blocks are high-
lighted by a colored background.

The instrument comprises a comprehensive info and help system. You can access the
context-sensitive help with the HELP (F1) key at any time. The help system indicates
the currently selected parameter and offers additional services such as cross referen-
ces, index and contents. The content of the help system corresponds to the operating
manual of the instrument.

Warning and conflict messages caused by incorrect operation as well as further infor-
mation are displayed in the "Info" line. A complete list of existing conflicts is displayed
when the INFO (CTRL+I) key is pressed. Additional information on entries can be

requested from the help system. The history function permits display of all messages.

Assistants simplify the completion of tables. After data entry in the assistant, the table
is modified only after the "Accept” button has been pressed. Pressing the "Accept" but-
ton also stores the assistant data.

For an introduction into the manual operating of the instrument, detailed operating
instructions and an overview of menus refer to Chapter 4, "Manual Operation”,
on page 64.

For an in-depth description of the dialog boxes and the instrument functions, refer to
section Chapter 5.1, "Overview of Instrument Functions", on page 89.

Remote Control

Remote control is an operation of the instrument by means of remote control com-
mands or programs that automatize repeating settings. The instrument is connected to
a computer running the program.

The R&S SMB supports various remote control connections:

® Connecting the instrument to a (LAN) network

® Using the LXI browser interface in a LAN network

® Connecting a PC via the IEC-bus (IEEE 488) interface

® Remote control via the USB interface
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ment Software Architecture) library provided for download at the Rohde & Schwarz

@ Tip: For remote control over LAN or USB, you can use the R&S VISA (Virtual Instru-
website http://www.rohde-schwarz.com/rsvisa.

This way of operation and the instructions how to set up a connection for remote con-
trol are described in the Chapter 6, "Remote Control Basics", on page 235. The
description of the remote control commands is provided in Chapter 7, "Remote Control
Commands", on page 279.

Remote access

Remote access is the operating of the instrument from a remote computer. Both the
R&S SMB and the computer are connected in a LAN.

Remote access in contrast to remote control does not use remote-control commands
but a separate software which is installed on the remote computer. After its start, the
software simulates the user interface of the instrument. The instrument can thus be
operated from the remote computer as on the unit itself. The individual functions are
operated using the mouse and keyboard. Specific instrument functions can be execu-
ted using specific key combinations on the keyboard or a front panel key emulation that
can be operated with the mouse.

This way of operation and the instructions how to set up a connection for remote
access are described in Chapter 2.7, "Remote Access via an External Controller",
on page 37.

3.2 Application Field of the Instrument

The main field of application of the R&S SMB is the generation of sine wave signals
with very high spectral purity. These signals are needed e.g. for adjacent channel or
phase noise measurements. In addition, the RF signal can be modulated with the inter-
nal modulations waveforms sine waves and rectangular signals.

3.3 Description of Individual Diagram Blocks

The signal path of the instrument is configured by installing a frequency option that
comprises all required modules.
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Description of Individual Diagram Blocks

One of the following options must be installed.
® R&S SMB-B101 (up to 1.1 GHz)

® R&S SMB-B102 (up to 2.2 GHz)
® R&S SMB-B103 (up to 3.2 GHz)
® R&S SMB-B106 (up to 6 GHz)
® R&S SMB-B112 (up to 12,75 GHz)
® R&S SMB-B112L (up to 12,75 GHz without attenuator)
¢ R&S SMB-B120 (up to 20 GHz)
® R&S SMB-B120L (up to 20 GHz without attenuator)
® R&S SMB-B131 (up to 31,8 GHz)
® R&S SMB-B140/-B140N (up to 40 GHz)
e R&S SMB-B140L (up to 40 GHz without attenuator)
Instruments without step attenuator provide a restricted level range at the RF output.
Refer to the data sheet for detailed information.
You can additionally get the following options for microwave instruments:
® upto 20 GHz (R&S SMB-B120/-B120L)
— high output power option R&S SMB-B31
— low harmonic filter option R&S SMB-B25
® up to 40 GHz (R&S SMB-B140/-B140L/-B140N)
— high output power option R&S SMB-B32
— low harmonic filter option R&S SMB-B26

See data sheet for detailed information.

Up-to-date information is available at R&S SMB homepage on the internet http://
www.rohde-schwarz.com/product/smb100a.html.

mod Genj| Mod Gen block
COTig The internal modulation sources are configured in this block. Also, the "LF frequency
Ljon sweep" can be activated here.

An internal LF generator is available as the internal source for the analog modulations
AM, FM and PHiM. Available modulation shapes are sine and rectangle.

The internal modulation signals are provided at the LF output at the front of the instru-
ment. The LF output signal and the modulations sources for the analog modulations
AM, FM and PhiM can be selected independently from each other.

A pulse generator provides single and double pulse modulation with selectable pulse
widths and periods. Additionally, an option is available to generate pulse train signals.

The R&S SMB offers three different sweep types (frequency sweep, level sweep and
LF sweep) to be activated alternatively. Each type has 6 modes which differ with
respect to the sweep cycle mode (continuous, individual and step-by-step) and trigger-
ing mode (automatic, internal and external). In the "Mod Gen" block, the LF sweep is
configured. Frequency and level sweep settings are accessed via the "RF" block.
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The status display in the block shows whether LF generator and/or a sweep are active.
The selected internal LF generator and/or noise source are switched on or off with the
TOGGLE ON/OFF key.

Modulation] Modulation block
C‘:_Ll The internal and external analog modulations are configured and activated in this
on block. The MOD ON/OFF key switches the active modulation(s) on/off.

The internal modulation sources are configured in the "Mod Gen" block. External
amplitude, frequency or phase modulation signals can be fed in at the input connector
MOD EXT at the front of the instrument. An external pulse signal is fed in via the BNC
connector PULSE EXT at the rear of the instrument. AC or DC coupling for external
feed is possible.

Modulation signals of up to two sources (internal and external source) can be com-
bined for AM/FM and PhiM modulation.

Available internal and external analog modulation modes are:
Amplitude modulation (AM)

Frequency modulation (FM)

Phase modulation (PhiM)

Pulse modulation (Pulse)

Stereo modulation (Stereo)

Note: For modulation modes that can be simultaneously used, refer to the R&S SMB
data sheet.

The status display in the block shows the active modulation(s). Use the TOGGLE
ON/OFF key to switch the active modulation of the block on or off.

RF block

In this block, the RF parameters and frequency/level sweep settings are set.

The active sweep is displayed in the block. The RF ON/OFF key switches the RF sig-
nal on and off. When the signal is switched off, the switch before the RF output symbol
is open.

RF settings include:

® Frequency and reference frequency

Level settings; if required.

NRP-Z Power Viewer using power sensors

Frequency and level sweep

List Mode settings. In this mode, extremely fast frequency and level settings can be
made.

The RF 50 OHM output connector at the front of the instrument provides the RF signal.
An external trigger/gate signal for sweeps is input via the INST TRIG connector at the
rear of the instrument

Note: Frequency and level are set fast with the aid of the FREQ and LEVEL keys.

Use the TOGGLE ON/OFF key to switch the RF output on or off.
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3.4 Example of Setup

This section provides an example on how to configure the instrument for generating of
an amplitude modulated signal.

Generation of an Amplitude-Modulated Signal

To generate a simple AM-modulated signal, proceed as follow:

1. Activate default (preset) state
Press the PRESET key to set a defined instrument state.

Freq| RFOFF__| MODOFF | Level

| 1.000 000 000 0 o+ =] | -30.00dem -]

| ALC-S&H Info
Mod Gen | Mndulitiorll RF |
config... config... config... w; RF
-+ + —
™ on [ on [ on

2. Select and activate AM modulation

a) Turn the rotary knob and select the "Modulation" block.

IModulation
config...

" On

b) Press the rotary knob to open the dialog where the modulation can be selected.
Note: Different modulation modes are available depending on the options
installed.

Modulation
Amplitude Modulation..
Freguency Modulation...
Phase Modulation. ..
Pulse Modulation...

The "Amplitude Mod..." menu is the first menu and is highlighted per default.
c) Turn the rotary knob and highlight "Amplitude Mod...".
Press the rotary knob to open the "Amplitude Modulation" dialog.

SIE
State Off

AM Source Int hd

AM Depth I 30.0 I %h 'l

AM Source = INTernal

LFGen Freq I 1.000 00 IkHz Vl
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d) Turn the rotary knob to select parameter "AM Depth", press the rotary knob to
allow editing and enter the preferred AM depth with the aid of the numeric key-
pad and the unit keys.

Amplitude Modulation

State Off |
AM Source Ilnt 'I
[AM Depth [ [% =

AM Source = INTernal

LFGen Freq | 1.000 00 |kHz 'l

e) Finally, select "State" and press the rotary knob to switch on the AM modula-
tion.

O
State

AM Source IInt vI
AM Depth | 200 |% vI

AM Source = INTernal

LFGen Freq I 1.000 00 IkHz 'I
f) Press the DIAGRAM key to display the complete block diagram.

To indicate the active state, the "Modulation" block is displayed in blue. The "RF" is
not yet active, which means that no RF signal is output.

3. Set frequency and level and activate RF signal

a) Press the FREQ key to activate the editing mode for frequency entry. The "Fre-
quency" entry field in the header section of the display is highlighted.

Freq [ _FF OFF J[INODONT]
11.000 000 000 00/ sz =

Enter the frequency using the numeric keypad and terminate the entry by
pressing a unit key.
b) Press the LEVEL key and enter the level settings in the same way.

Lewel

|-3[],[][] IdBm v[

c) Press the DIAGRAM key to display the complete block diagram.
d) Turn the rotary knob to select the "RF" block.
Press the RF ON/OFF key to activate the "RF" block.

The AM modulation signal is now present at the RF output.
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| 363[][][] 000 00 |m+e -] ﬂllllldﬁm -l

Generation of an RF Frequency Sweep Signal

LiSweep, ALC-S&H

Example of Setup

In the example, an RF frequency sweep is configured. Proceed as follow:

1. Activate default (preset) state

Press the PRESET key to set a defined instrument state.

Freq RF OFF I MOD OFF | Level

| 1.000 000 000 0 o= -1/ -30.00 [#em -

ALC-S&H
Mod Gen Modulation RF
config. . config. config. .
I~ on ™ on ™ on

a) Turn the rotary knob and select the "RF" block.

RF

™ ©on

config... I

Info

RF

e

Configure and activate RF frequency sweep.

b) Press the rotary knob to open the dialog where the RF frequency sweep can be
selected.

RF Sweep / List

Frequency Sweep. .

Level Sweep...
List Mode...
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c) Turn the rotary knob and highlight "RF Frequency Sweep...".
Press the rotary knob to open the "RF Frequency Sweep" dialog.

RF Freguency Sweep

State off |5
Mode |Autn =]
Start Freq 100.000 000 000 | MHz ~| —

4

Center Freq | 300.000 000 000 | MHz |

400.000 000 000 [MHz_~1 =]

|

Stop Freq | 500.000 000 000 | MHz |
|
I

Span

All sweep parameters are default except for the sweep mode. The default set-
tings are not changed.

d) Turn the rotary knob to select parameter "Mode", press the rotary knob to open
the selection list and select "Single".

RF Freguency Sweep

State Off |i

|Mnde Single j
Auto

Start Freq | 100.3inale . k...]—

Step
Stop Freq I 500 Extern Single

Conter Freq | 300 xscrn Srohystop
Soan [ 400.000 000 000 [mMHz_~I =I
e) Press the rotary knob to apply the selection.
For triggering, the "Execute Single Sweep" and "Reset Sweep" buttons are dis-
played.
f) Finally, select "State" and press the rotary knob to switch on the RF frequency
sweep.

REF Freguency Sweep

|State =
Mode | Single hd

Execute Single Sweep | L.

Reset Sweep |

Start Freq | 100.000 000 000 | MHz x|

Lo DR L Je I connnn ann nnn Tean_ 1

g) Press the DIAGRAM key to display the complete block diagram.

-

The "RF" is not yet active, which means that no RF signal is output.
3. Activate RF signal.

a) Turn the rotary knob to select the "RF" block.
b) Press the RF ON/OFF key to activate the "RF" signal output.
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To indicate the active state, the RF block is displayed in blue. An RF signal with the
default frequency and level settings is output, i.e. 1 GHz and -30 dBm.
The sweep is not yet active, it must be triggered in the sweep dialog.

4. Trigger RF frequency sweep

a) Press the WINBAR key to switch to the "RF Frequency Sweep" dialog.
Turn the rotary knob to select the "Execute Single Sweep" button.

RF Freguency Sweep
Mode | Single =]

| Execute Single Sweep | |

Reset Sweep |

Start Freq | 100.000 000 000 [MHz x|

-
[ar SR Je I ennnann ann ann Teann_ 1

Press the rotary knob to trigger (start) the frequency sweep.

A linear single sweep signal is now present at the RF output, starting at 100 MHz.
The sweep is processed in 1 MHz steps with dwell time of 10 ms per step up to the
stop frequency of 500 MHz.

The sweep starts at 100 MHz, stops at 500 MHz in 1 MHz steps is output with a
dwell time of 10 ms per step.
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4 Manual Operation

The R&S SMB can be operated intuitively either via the interactive block diagram or via
a menu tree. All menus are in the form of windows that can be operated in the same
way. Rotary knob, keys and softkeys, or alternatively a mouse, allow direct and there-
fore convenient access to entries and settings.

The clear-cut display shows the current signal generator state. Numerous help func-
tions support the user in signal configuration.

This section describes the concept of manual operation of the signal generator. This
includes a description of the general structure of a dialog box, working with dialog
boxes and the block diagram and the setting of parameters.

For an in-depth description of the dialog boxes and the instrument functions refer to
section "Instrument Functions".

4.1 Key Features

The manual operating concept of the R&S SMB enables the user to make settings as
intuitively as possible and at the same time gives a permanent overview of characteris-
tics of the generated signal and of the current instrument state. Numerous online help
functions support user settings.

Block diagram
The block diagram is the core of the operating concept.

A graphics display shows the current configuration and the signal flow in the form of a
block diagram. All graphical elements can be accessed for operation. An element is
selected by means of the arrow keys and the associated setting function is called by
pressing Enter. Required menus and graphs are displayed on the block diagram which
is displayed again in the foreground whenever the DIAGRAM (CTRL+D) key is
pressed.

Permanent frequency and level display

The main characteristics of the RF signal, frequency and level, are permanently dis-
played in the header section of the screen and can be directly set in the display fields
after the FREQ (CTRL+F) or LEVEL (CTRL+L) key is pressed. Status messages for
the output signal are displayed in addition to frequency and level.

Freq(RFON ) MODON ) Level

[1.000 000 000 000/ etz ~{[-30.00]éem |

Operation via Graphical User Interface

® Functional blocks
Menus are assigned to the specific function blocks in the block diagram. The func-
tion blocks represent elements of signal generation. Function blocks displayed with
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a blue frame can be directly switched on and off by means of the TOGGLE
ON/OFF (CTRL+T) key. The menus of the highlighted function blocks can be
called by pressing the ENTER key.

— Example:
The "Modulation" block contains all menus required for modulation signal con-
figuration.

In this block all modulations can be selected.

Modulation
Amplitude Modulation.
Freguency Modulation
Phase Modulation
Pulse Modulation

e Signal flow
The signal flow between the function blocks and the employed inputs and outputs
are also shown.

MOD

<
x
I | I | |

® Menu tree
The menu tree can be opened and closed with the MENU (CTRL+M) key. The
menu tree is organized in the same way as the directories under Windows. The

function blocks correspond to the first directory level, the menus to subdirectories.

i be=——Modulation Generator =
LF Generator / Output...
LF Frequency Sweep...
Pulse Generator...

Operation corresponds to the Windows concept

To offer the user a familiar environment, operation is very similar to operation of Win-
dows user interfaces. All menus and tables are made up of known elements, such as
selection lists, check boxes and entry fields.

A blue frame indicates that the selected item is active. In the highlighted element,
entries can be made.
Rotary knob

Operation is possible via front-panel keys, an external keyboard and the mouse. How-
ever, most of the settings can be easily made with the rotary knob:

® Turning the rotary knob shifts the entry focus to the target element.
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® Pressing the rotary knob activates the selected entry field.
Depending on the parameter, the submenu is called, the numeric value varied, the
list entry selected or the check box activated or deactivated.

e |f a value is entered, the entry is stored by another click on the rotary knob and the
editing mode is exited.

Clear settings with the aid of independent subdialogs

A separate window is opened for each dialog and subdialog. The dialogs can be oper-
ated independently of each other, i.e. none of the dialogs requires that settings in other
dialogs be completed before it can be closed. This ensures flexible operation at all
times.

Keys with assigned simple functions
Most keys on the front panel of the R&S SMB directly perform a simple function.

Since a great number of settings can thus be made by a keystroke, operation is easy.
For instance, the CLOSE (ESC) key closes the active menu; with the RF ON/OFF
(CTRL+R) key the RF output signal can be switched on or off.

An exception are keys that call a menu such as the MENU (CTRL+M) key which opens
the complete menu tree of the instrument, the SETUP (CTRL+E) key which opens the
menus for general instrument settings or the FILE (CTRL+S) key which opens the
menu for file management.

Help functions for user support
Numerous help functions support the user in signal configuration.

® Value ranges
The valid setting range is displayed for each numeric parameter. This requires a
short wait after activation of the entry field. The range is then displayed automati-

cally after a few seconds.
Phase Seftings

Delta Phase ii0||deg =
Reset Delta Phad Min =-720.0 deg

Max =720.0 deg

insert mode

If the entered value is outside the permissible range, the next permissible value is
automatically set and a message is output.

® Context-sensitive help
Context-sensitive help for each parameter can be called with the HELP or F1 key.

® Comprehensive online help

Each help page is part of a comprehensive online help function which can be
called by means of an index, a content tree or the "Previous/Next" buttons.

Info line with messages for indication of the current instrument state

A great variety of different messages such as status messages, error messages, warn-
ings or information are displayed in the header field of the screen. With the aid of the
INFO (CTRL+I) key, help pages can be called for most of the messages. They provide
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background information on the message and indicate operating steps that may be
required. All messages are explained in the online help which can be called with the
HELP (F1) key.

frea([REGNI)( WOD OFF JLevel
11.000 000 000 000/ stz -{}-30.00]ém -|
|

ALC-Auto Info |

4.2 Display

The display shows the current signal generator state and offers graphical elements for
direct operation. It is divided into three sections:

® The frequency and level display with info line indicates the main output signal
parameters and reports the current state with status, error and warning messages.

® The block diagram shows the instrument configuration, the signal characteristic as
well as the inputs and outputs used and permits interactive operation via graphics
elements. Active menus and graphs are displayed on top of the block diagram.

® Winbar with labeled softkeys for menu display.

The block diagram in the figure below shows a fully equipped instrument.

Freq Level
| 1.000 000 000 0 |z -|| -30.00 | éem -]
| ALC-S&H _Info|

MOD

Mod Gen
config... | REF
[~ on

Figure 4-1: Block diagram of a fully equipped R&S SMB

4.21 Settings Displayed in the Header Section

Frequency/level settings and a few status messages (see Chapter 4.2.2, "Status Infor-
mation and Messages", on page 68) are displayed in the header field of the screen.
The display may vary depending on the instrument's operating mode:

® |n the sweep mode, the current frequency or level of the output signal is displayed.
The status message "SweepMode" is displayed in the info line.

® |n the list mode, neither the current frequency nor level is displayed, the indication
is dimmed.

® |[f user correction is active, the status message "UCorr" is displayed in the info line.
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i

The values displayed in the "Freq" and "Level" fields include a set offset or multiplier
factor.

For more See alos Chapter 5.3.2, "RF Frequency", on page 137 and Chapter 5.3.5.1,
"Overview of RF Level", on page 145.

4.2.2

4221

4.2.2.2

4223

The frequency and level indication can be enlarged so that it covers the complete dis-
play of the R&S SMB by using the DIAGR key. This key toggles between block dia-
gram, magnified frequency and level indication and the display of the active dialog.
This requires the "Summary Screen Toggle" to be enabled.

See also "Toggle Summary Screen" on page 108.

Status Information and Messages

The instrument indicates status information and messages in the header section of the
screen. The messages differ with respect to their importance (errors, warnings, info)
and the time of their appearance (brief and permanent messages), and require differ-
ent treatment

For additional information refer to the info window (see Chapter 4.2.3, "Info Window",
on page 69).

Refer to Chapter 9, "Status Information, Error Messages and Troubleshooting",
on page 481 for an overview of all status information and messages and corrective
actions.

Status Information

The status information gives the user an overview of the main operating states and set-
tings of the instrument. The states are indicated for information only and do not neces-
sitate any action by the user.

Status information is displayed between the frequency and level fields, at the left of the
info line or in the info line itself.

Messages

Messages indicate errors in the instrument. They are displayed in the info line in differ-
ent colors depending on their importance and display duration. Errors (e.g. no calibra-
tion data) are displayed in red, information (e.g. file not found) and warnings in black.
Warnings indicate less significant errors (e.g. the instrument operates outside specified
data).

Volatile messages

Brief messages report automatic settings in the instrument (e.g. switching off of incom-
patible types of modulation) or on illegal entries that are not accepted by the instrument



4.2.2.4

423

Display

(e.g. range violations). They are displayed in the info line on a yellow background.
They are displayed on top of status information or permanent messages.

Volatile messages do not normally demand user actions and disappear automatically
after a brief period of time. They are stored in the history, however.

These messages can be read from remote using the commands : SYSTem:ERRor [ :
NEXT]? and : SYSTem:ERRor:ALL?.

Permanent Messages

Permanent messages are displayed if an error occurs that impairs further instrument
operation, e.g. a hardware fault. The error signalled by a permanent message must be
eliminated before correct instrument operation can be ensured.

The message is displayed until the error is eliminated. It covers the status display in
the info line. After error elimination, the message automatically disappears and is also
recorded in the history.

These messages can be read from remote using the command : SYSTem: SERRor?.

Info Window

A few operating states and the current message are displayed in the info line.

The INFO window with a list of current permanent messages and a detailed description
of each message can be opened with the INFO (CTRL+I) key.

[ A UCor, ALC-Auto | B: ALC-Auto [_Infa_1 |nfo line

.'J. ] J

e List of current
L B 200 wo currentiist messages with
* Em 463 Filename missing short message
* Infa D SawRcl Infa: i -Racall comp text.

- Mo pending errors.
Detailed

description for
highlighted
message

o | [owieu ] owrm =

The upper section of the info window contains a list of all current permanent messages
in the order of their occurrence, i.e. the most recent message is displayed first. In the
lower section of the window, additional information on the highlighted message is dis-
played. A history of all messages that have occurred since instrument switch-on can be
called with the "History" key. The most recent message is displayed first.

The messages are color-coded according to their level. Device-specific messages are
red, info and remote control error are black. The level is also indicated in the "Lev"
column (Err, Sys or Info). Column "SCPI" indicates the SCPI error code.

With the aid of the softkey buttons, error messages can be cleared and a history of all
messages called.
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Delete
Clears the highlighted message.

This button is available only if the history of the messages is displayed.

Delete All
Clears all messages.

This button is available only if the history of the messages is displayed.

History

Calls the list of all messages that have occurred since instrument switch-on. The most
recent messages are displayed at the top of the list. When the button is pressed again,
the list of current messages is displayed.

Remote command:

:SYSTem:ERRor [ :NEXT]? on page 435 or : STATus : QUEue [ : NEXT] ?

on page 432

Each time a SYST:ERR? or STAT : QUE? query is sent, the oldest entry in the error
queue is returned and at the same time cleared in the list.

4.2.4 Block Diagram

The block diagram shows provided options, signal configuration and the currently
selected signal flow of the generator with inputs and outputs used. Signal generation
can be completely operated from the block diagram. The highlighted function block can
be directly switched on and off with the TOGGLE ON/OFF (CTRL+T) key. Pressing the
Enter opens the associated setting menu.

LF MOD

«

Figure 4-2: Block diagram of the R&S SMB

4.2.41 Function Blocks in the Block Diagram

Each block represents a function of signal generation. The function is indicated in the

headline of the block. In the check box, the respective function can be quickly activa-

ted/ deactivated with the TOGGLE ON/OFF (CTRL+T) key. After activation, the block
is displayed in blue. Status information is displayed below the check box. It is different
for the different blocks.

Pressing the rotary knob (front panel) or the "Config..." button (mouse) opens the asso-
ciated setting menu.
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Example: Modulation block

Modulation
Amplitude Modulation...
Freguency Modulation. ..
Fhase Modulation...
Fulse Modulation...

In this block, the modulation signals are set. The status information of the "Modulation”
block indicates the selected modulation.

4.2.4.2 Signal Flow and Input/Output Symbols in the Block Diagram

The input/output symbols in the block diagram show the currently used inputs and out-
puts of the signal generator. Unused inputs and outputs are not shown. The lines indi-
cate the signal flow.

Symbols and labels refer to the corresponding inputs and outputs on the front and rear
panel of the signal generator. The direction - input or output - is indicated by an arrow.

Example:

PULSE The symbols indicate the input for the external pulse signal on the
instrument rear panel.

4.2.5 Structure of the Dialogs

The parameters are set in the menus. Menus are accessed either via the function
blocks in the diagram or by means of the MENU (CTRL+M) key. The menus are dis-
played on top of the block diagram.

The WINBAR key toggles between the active menus. The REARR key toggles
between the enlarged and normal sized menus.

Working with menus and dialog boxes is described in Chapter 4.3, "Accessing Dia-
logs", on page 72; the setting of parameters in Chapter 4.4, "Setting Parameters”,
on page 73.

The menus are in Windows format. The menus differ in details depending on their
function but they consist of the same main elements. Each menu consists of a menu
header and one or more menu areas with various fields for setting parameters.

The header line contains the name of the menu and the buttons for minimizing and
closing the menu. To operate the buttons, use the mouse or the front key CLOSE
(ESC).
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Several fields of associated but separately set parameters are organized in menu
areas. A menu area is framed and labelled with the function common to all parameters.

Example: Pulse Generator

Pulse Generator

Fulse Mode ISingIe vl
Pulse Period I 1.0000 Ims vl
Pulse Width I 500.0 Ius vl

Each of the setting fields is assigned a parameter name. The kind of setting varies
depending on the parameter to be set. Some settings can only be made in a specific
configuration. If setting is not permitted with the specific configuration selected, the
respective item is disabled and displayed in gray and the entry or selection field cannot
be accessed.

4.3 Accessing Dialogs
The MENU (CTRL+M) key opens the complete menu tree. Selecting a functional block
and pressing the ENTER key opens the menu associated with this block.

An alternatively way to access a dialog is to use the CLOSE (ESC), DIAGRAM (CTRL
+D) and REARR (CTRL+A) keys on the front panel.

For a quick access to the dialogs, use one of the following alternative methods.

Displaying the block diagram or a dialog in the foreground

» Press the DIAGRAM (CTRL+D) key to move the cursor to the block diagram.

All active menus are minimized.

Enlarging the indication of the header section

> Press the DIAGRAM key twice to enlarge the indication of the header section.
Tip: Use the REARR key to toggle between the enlarged and normal sized dialogs.

Accessing the menu tree

> Press the MENU (CTRL+M) key to open the complete menu tree.

Calling the File or Setup dialog
» Use the FILE (CTRL+S) or SETUP (CTRL+E) keys to open the respective dialog.

Closing an active menu

» Press the CLOSE key to close an active menu.

Tip: If the cursor is at the highest menu level, you can also use the ESC key to
close the active menu.
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Accessing the header area

» Press the FREQ (CTRL+F) and LEVEL (CTRL+L) keys to activate the "Frequency"
or "Level" entry fields in the header area.

Keyboard Shortcuts

Keyboard shortcuts (e.g. "Ctrl + D" for the displaying the block diagram in the fore-
ground) provide direct access to all utility dialogs of the instrument (see Chapter 4.8,
"Legend of Front-Panel Controls", on page 86).

4.4

Setting Parameters

The R&S SMB offers several and sometimes alternative possibilities for setting param-
eters. Operation is possible from the front panel, with the aid of a mouse and/or from a
PC keyboard.

The examples whitin this description focus on the operation from the front panel.

O @

For more information, refer to:

® Chapter 4.8, "Legend of Front-Panel Controls", on page 86 for an overview of key
functions and a cross-reference between the front panel keys and the keyboard
shortcuts

® section "Instrument Functions" for a detailed description of key functions.

Most of the parameters are set in the different menus. The R&S SMB provides alterna-
tive ways for accessing the dialogs. Turn the rotary knob and navigate to the corre-
sponding block in the block diagram and press the knob to open the dialog or perform
a mouse click on the "Config..." button.

An exception are the "Setup" and "File" dialogs. In the "Setup" dialog, general settings
are made which are not directly concerned with signal generation, e.g. setting of the
GPIB-bus address. In the "File" dialog, files and lists are managed.

These menus can only be called with the SETUP (CTRL+E) and FILE (CTRL+S) keys.

Frequency and level are directly set in the header area of the display using the FREQ
and LEVEL keys.

Specific settings can also be made directly in the block diagram, e.g. activating a func-
tion block by means of the TOGGLE ON/OFF (CTRL+T) key or switching the RF out-
put on and off with the aid of the RF ON/OFF (CTRL+R) key. Changes affecting the
signal flow are immediately visible in the graphics display.

This section provides an information about the parameter handling that comprises of
the following main steps:

® Chapter 4.4.1, "Working with the Cursor", on page 74
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® Chapter 4.4.2, "Selecting a Control Element", on page 74

® Chapter 4.4.3, "Switching Parameters On/Off", on page 75

® Chapter 4.4.4, "Entering a Value", on page 75

® Chapter 4.4.5, "Working with Units ", on page 77

® Chapter 4.4.6, "Selecting a Value from a List", on page 77

® Chapter 4.4.7, "Terminating Entries with Confirmation", on page 78
® Chapter 4.4.8, "Restoring the Previous Value", on page 78

441 Working with the Cursor

After the instrument is switched on, the cursor is always on the first function block of
the diagram (default setting).

Moving the cursor on the display

» To move the cursor, use one of the following alternative methods:

a) Use the rotary knob or the arrow keys.
b) Use the WINBAR key to toggle between the active dialogs.
c) Use the ESC key.

Tip: Be aware that the function of the ESC key depends on the current cursor posi-
tion.

The function of this key depends on the current cursor position.

e Calls the next higher selection level.

e Closes the open window without accepting new entries; the old value or param-
eter is retained.

In dialog boxes that contain a "Cancel" button it activates that button.

Closes all kinds of dialog boxes, if the edit mode is not active.

Quits the edit mode, if the edit mode is active.

Switches between different entry fields of a menu.

Shifts the entry cursor from the header display to the previously active menu, or
to the previously highlighted block in the block diagram if no menu is active.

Moving the coursor to the heading area
» Press the FREQ (CTRL+F) or LEVEL (CTRL+L) key to move the cursor to the
header area.
4.4.2 Selecting a Control Element
Control elements are always selected in the same way no matter whether a function
block in the diagram, a menu in the menu tree, a parameter in the menu or an entry in

a list or table is concerned.

» To activate an element, put the cursor on it.
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Source |Imernal jl

An active element is highlighted by a blue frame.

Switching Parameters On/Off

A parameter can be activated and deactivated using a button or a check box.

1. Select the parameter.

2. To change the state of a parameter, use the "Enter" function of the different control
media:
e Press the rotary knob
e Press ENTER
e Press the TOGGLE ON OFF (CTRL+T) key.

Colour and label of a button change, the check box is ticked or the tick is removed.

Entering a Value

Numeric and alphanumeric values can be edited in the entry fields. In the editing
mode, cursors of different colour are used. A blue cursor indicates the overwrite mode,
a green cursor the insert mode.

Numeric and alphanumeric values can either be newly entered or the existing value
can be changed. Incorrect entries are cleared with the BACKSPACE key.

Entering a new numerical value

1. Select the parameter.

2. Press a numeric key to activate the editing mode.

The previous value is cleared and the new value can be entered.

Editing a value in the insert mode (default setting)

1. Press the rotary knob (= Enter) to activate the editing mode.

If the cursor is placed at the right of the total value, the insert mode is always
active.

2. Set the cursor to the left of the number to be changed using the LEFT/RIGHT
arrow keys.

The cursor is displayed in green.

3. Click on a numeric key to insert a new value.

||Dwe||Tu-ne | 1o.ocofms =|[owall Time | sl ms =
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Editing a value in the overwrite mode
1. Activate the editing mode.

2. Set the cursor on the numeric digit to be changed using the LEFT/RIGHT arrow
keys.

The cursor is displayed in blue and the number to be replaced is highlighted.

3. Click on a numeric key to overwrite the highlighted value.

||DweIITIme | 10.000|ms ;""Dwell Time | 10.080 | ms =]

Varying a value
1. Activate the editing mode.

2. Set the cursor to the left of the number to be changed using the LEFT/RIGHT
arrow keys.

The value at the cursor position is varied.
3. To vary the selected value, use the UP/DOWN arrow key or turn the rotary knob.

The value is increased or decreased.

Entering a new alphanumerical value
1. Select the parameter.
2. Press an alphanumeric key to start the editing mode.

The new value is entered.

Editing an alphanumerical value

An existing value, e.g. a file name, can be changed in the insert mode (see example)
or in the overwrite mode.

1. Select the paramter and activate the editing mode.

2. Set the cursor to the left of the alphanumerical value using the LEFT/RIGHT arrow
keys.

Tip: If hexadecimal values are to be entered, the numeric front-panel keys are
automatically changed to hexadecimal values.

3. Click on an alphanumeric key to insert a new alphanumerical value.

Terminating the entry of a numeric value
To terminate the entry of a numeric value:
1. Press the rotary knob (= Enter).

2. Press a UNIT key on the front panel.

3. Select a "Unit" in the selection field next to the parameter value.
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4.4.5 Working with Units

The unit of a parameter is displayed next to the value. When the parameter is edited,
the unit is selected either from the list or by means of the front-panel keys. When the
entry is completed, the unit can be changed. In this case the value remains unchanged
but is automatically adapted to the new unit.

While operating the instrument by means of a mouse, assign the unit to the selected
parameter before entering its value.

Assigning a unit
To assign a unit to a value, use one of the following alternatives:

1. Press a UNIT key on the front panel.

B
Frequency | 10 IGHz;"+ w =|Frequency | 10000000 UUUlMHzL"

2. Select a "Unit" in the selection field next to the parameter value.
Press the ENTER key.

The unit displayed in the entry field next to the value is assigned.

Changing a unit

To subsequently change a unit, i.e. after the entry has been terminated and when the
editing mode is not active, use one of the following alternatives:

1. Press a UNIT key on the front panel.
2. Select"Unit" in the selection field next to the parameter value.

The value remains unchanged but the display is automatically adapted to the new
unit, i.e. the value is recalculated to suit the new unit.

B
Frequency |  10000.000 000 [kHz jJ+ u =|Frequency | 10.000 000 DDDIMH:L"

The new unit is indicated in the value field of the menu.

4.4.6 Selecting a Value from a List

Selection lists provide a list of predefined values for the selected parameter.

Source Internal  +

Internal
External

Output

To select a item from a list, proceed as follow:

1. Press ENTER key to open the list.

| —
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2. Use one of the following alternatives to navigate through the list:

a) Turn the rotary knob or use the UP/DOWN arrow keys.
The selected item is highlighted.

b) Press TOGGLE ON/OFF key several times until the preferred entry is dis-
played in the selection field.

3. To confirm the selection, press the ENTER key.

4.4.7 Terminating Entries with Confirmation

The instrument behaves different by the termination of entries deppending on the
parameter type and the way this parameter is set.
Confirming settings

> To confirm the settings, press the rotary knob or one of the UNIT keys (see also
Chapter 4.4.5, "Working with Units ", on page 77) .

Note: Variations by means of the rotary knob are immediately set.

Confirming multiple values

In some cases, like for instance when editing data in a user correction table, it is useful
first to enter few values and to confirm them together. Such settings require additional
confirmation. Not yet confirmed settings are displayed on a yellow background as an
indication that the currently displayed values do not represent the target signal.

» To confirm these settings, select the "Save" or "Accept” button, respectively.

Confirming parameters with On/Off state

Most of the instrument functions with enabled and disabled states are calculated and
effective only after this functions have been enabled. However, there are functions like
the frequency variation of the reference oscillator for instance, that are immediately set
after confirmation.

» To confirm a parameter with On/Off state, enable the parameter.

4.4.8 Restoring the Previous Value

Parameter variations with the rotary knob are immediately set and therefore not rever-
sible.

Normally, values cannot be restored in the case of mouse control because no explicit
confirmation is required in this case and entries are automatically confirmed when the
entry or selection field is exited.
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Restoring values

In the case of front-panel control or operation from the keyboard, previous values can
be restored as long as the new value is not confirmed, i.e. the entry is not completed.

> To restore the values, press the ESC key.

Restoring values that require confirmation

All settings that are not confirmed with the "Accept" button but require this additional
confirmation can be restored.

1. Press the ESC key.

A confirmation query is displayed.

You changed some parameter(s) which require a new calculation of the signal.
Do you really want to abort your changes without ACCEPT ?

OK Canm:l,

2. Confirm with "OK" to abort the changes.
Select "Cancel" to return to the dialog. The previous selected settings are dis-
played.

Restoring values after an extended calculation has been started

Calculation and setting might require different period of time. Many settings are made
without noticeable calculation times; such operations are indicated by a "BUSY" mes-
sage displayed in the status field of the header section.

A window with a progress indicates that the instrument performs an extended calcula-
tion that requires longer calculation time. The termination of such a calculation restores
the previous values.

» Press the ABORT button to terminate the calculation.

All previous values are restored.

Editors

The R&S SMB provides user-friendly editors for defining lists. Lists containing fre-
quency and level value pairs are used for the list mode and the user-defined level cor-
rection.

The lists are saved to files and may thus have any length. The file name of the lists and
the directory to which the files are saved are user-selectable. The file prefix is different
for each list type and is permanently assigned by the system.

For information about file handling and overview of the automatically assigned file pre-
fixes, refer to Chapter 4.7, "File Management", on page 82.
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4.5.1 Working with List Editor

The "User Correction" and "List Mode" dialogs provide a list editor for defining the fre-
quency/level value pairs.

Editing list mode data lists

1. To access a list editor and open an existing data list for editing, use the cursor keys
to select the associated button "Edit User Correction Data..." or "Edit List Mode
Data..." (if available) in the individual menu.

The selected list is displayed and the cursor marks the first row of the
"Frequency/Hz" column.

FrequencyHz Power/dBm |~
100 000.000 -140.00
100 010.000 -140.00
100 020.000 -140.00
100 030.000 -140.00
100 040.000 -140.00
100 050.000; -140.00
100 080.000: -140.00
100 070.000 -140.00
100 080.000 -140.00)

Wlo|~|@ || |r |-

Goo | Eat | sae |

If no list has been selected, a blank list of only one row is displayed.

2. Press the LEFT/RIGHT arrow keys to change between the colums.
Use the UP/DOWN arrow keys to mark a row.

3. Use the numeric keys to enter the value for the value pairs in the "Frequency/Hz"
and "Power/dBm" table columns. A blank row is inserted at the end of the list.
Terminate the entry by pressing a UNIT key.

4. To select a row, select the "GoTo" button and press the ENTER key.
Use the numeric keys to enter the row index in the entry field and press the
ENTER key to confirm the entry.

The cursor moves to the selected row.
5. Toinsert a new row in the table, select the row above which the new row is to be
inserted and select "Insert Row(s)".

A row is inserted above the currently marked row.
If no row has been selected, a row is inserted at the beginning of the list.

6. Use the "Save" function to save the edited list under its current name.
Enter the file name in the "File Select" dialog and select the directory (see Chap-
ter 4.7.1, "File Select Dialog", on page 84).

Only complete value pairs are taken into consideration; rows containing an entry in
only one column are ignored.
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Creating a new list mode data list

A new list can be created under a new name either by generating a blank file in the
"File Select" menu (see section Chapter 4.7, "File Management", on page 82) or by
changing an existing list which will then be saved under a new name.

1. To create an empty data list, select "RF > List Mode > List Mode Data... > New
List" or respectively "RF > User Correction > User Cor. Data... > New User Correc-
tion Data" and enter the file name of the new data list.

2. To open the data list for editing, select the associated button "Edit User Correction
Data..." or "Edit List Mode Data..." in the individual menu.
Edit the list and save it under a new name.

4.6 How to Use the Help System

The R&S SMB is equipped with a context-sensitive help function. A help page is avail-
able for each parameter and can be called any time during instrument operation.
Calling context-sensitive and general help

» To display the general help dialog box, press the HELP (F1) key.

The help dialog is displayed. A topic containing information about the current menu
or the currently opened dialog box and its function is displayed.

heip- Sate ———— ————E@
Contents Index Back -

Instrument Function » Modulations >
Amplitude Modulation (AM) > Amplitude
Modulation Menu > State

State

Activates/deactivates AM modulation.

SCPI command: [

[:S0URce<hw>]:AM:5TATe |

On top, the help dialog box contains a navigation bar with:

® "Contents" - accesses a table of help contents

® "Index" - switches to an index table

e "Back "/"Previous"/"Next" for navigation to further help topics

Navigating in the table of contents

1. To navigate within the table of contents entries, use the UP/DOWN keys. Entries
that contain further entries are marked with a plus sign.

2. To display a help topic, press the "ENTER" key.

The corresponding help topic is displayed.
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Navigating in the help topics
1. To scroll through a page, use the UP/DOWN arrow keys.
2. To follow a cross-reference, select the link text.

3. To return to the previous page, select "Back".
This function scrolls back all steps that you have performed before.

4. Use the "Scroll Right" or "Scroll Left" buttons to shift the indicated area of the navi-
gation window to the left or right.

Using the Index

1. Select "Index".

2. Enter the first characters of the topic you are interested in. The entries starting with
these characters are displayed.

3. Press the ENTER key to change the focus.
4. Use the UP/DOWN keys to navigate and select the suitable keyword.
5. Press the ENTER key to display the help topic.

The corresponding help topic is displayed.

Closing the help window

» Press the HELP (F1) key.

File Management

The R&S SMB uses files to save all instrument data, i.e. system and user data.
The user data includes saved instrument settings and lists and the user correction.

The files are stored in the internal memory of the instrument or on a USB memory
stick. The /var directory can be used to save user-defined data; any subdirectory
structure can be created on /var. Some default subdirectories are predefined, but can
be changed at any time.

The /opt directory is a protected system drive and therefore unaccessible system
directory. The files on this directory contain data that must not be changed. Therefore,
this drive should not be accessed, since reconstruction of the system partition will lead
to data loss. To prevent inadvertent deletion or overwriting of system files, this drive is
not specified in the file menus.

Files can be exchanged either via a memory stick or a connected network. A memory
stick is connected to the USB interface and is assigned the var/usb/ drive. In the
case of a connected network, all network drives that can be accessed are available.
The files are accessed in a "Save/Recall" dialog in the individual menus.

The files are differentiated according to their extensions; each type of file is assigned a
specific file content. The extension is usually of no consequence to the user since
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access to the files occurs in the individual menus where only the relevant type of file is
available. See Chapter 4.7.2.1, "Extensions for User Files", on page 85 for an over-
view of the supported file extensions.

The user data can be roughly divided into the following data types:

® Settings
Instrument settings can be saved and loaded. In case of saveing, the current set-
ting is saved to the specified file.

e Lists
Lists, e.g. user correction lists, can be loaded. They can be generated either exter-
nally or internally. For internal generation, a new list must be created in the "File
Select" dialog which will then be edited in the list editor of the individual menu.

For more information, refer to:

® Chapter 4.8, "Legend of Front-Panel Controls", on page 86 for an overview of key
functions and a cross-reference between the front panel keys and the keyboard
shortcuts

® to section "Instrument Functions" for a detailed description of key functions.

Accessing files with user data

1. To access an editable user data file, select the "Save/Recall" or "File Manger" func-
tion in the individual dialog.

Recall Settings
Save Settings
File Manager...

2. To access a loadable data file, select the "Select/New" or "File Manager" function
in the individual dialog.

Select User Correction Data
MNew User Correction Data
File Manager...

3. To access the "File Manager" function, press the SETUP (CTRL+E) key and select
"Save/Recall > File Manager".

A "File Select" window for loading, saving or creating a file or the "File Manager"
dialog for managing all files is displayed.

Saving and loading of all instrument settings
All instrument settings are saved and loaded in the "File" menu.

To access the "File" menu, press the FILE (CTRL+S) key.

For more information, see Chapter 5.2.8, "Storing and Loading Instrument Data - File
Key", on page 126.
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4.7.1 File Select Dialog

The "Save/Recall" dialaog displays the available drives and directories. In the upper
part, "Recent Data Sets", the files last used are listed.

SaveRecall SaveRecall =
Select Operation ISa\re vl Recent files | Select Cperation IRecaII vI Recent files |
fvarfuser/Lists/SavRcl fvarfuser/Lists/SavRcl

T DI " @ DME ;I

@, LevelCalData

- LiGenCalData -0 LevelCalData

@ LfGenCalData

ﬁ&m J - Rf J
g SynCalibData - ?"?_ESE"RC'

File Name: .09 SunCalibNats |
presetsettings | Exclude Frequencyl™ Exclude Level ™
Save Save File Recall Recall File
e Imm 1 | Imm 2 | Mgr... | Recall | Imm 1 | Imm 2 Mgr...

The available drives and directories and the files of the selected directory are dis-
played. The currently selected path is displayed above the window. Only the relevant
files without file extensions are displayed. If the area is opened several times, the path
last selected is displayed. When a file is saved or created, its name is user-selectable;
the extension is assigned automatically and cannot be entered. The file is saved to the
selected path.

In addition to the files saved by the user, some menus also offer files containing prede-
fined contents. These files are saved to a specific directory on system drive; for this
reason, this directory cannot be chosen from the "File Select" menu.

Working with the File Select dialog
1. Access the "File Select" dialog (see "Accessing files with user data" on page 83).
2. Navigate in the "File Select" dialog.

3. Load an existing file.
In the "Recall Settings" dialog, mark a file and press the "Select" button.

4. Save afile.
In the "Save Settings" dialog, enter file name in the "File Name:" field.
Select the directory to which the file is to be saved and then select the "Save" but-
ton.

5. Create a new file.
To create a new file, use the "Save Settings" functionality, i.e. specify file name and
directory and save the file.

The created file is empty; it must be filled with the necessary values in the individ-
ual editor.
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4.7.2 File Manager

The "File Manager" allows general file management such as copying, shifting, renam-
ing and deleting files as well as generating new directories.

age =] i3
File Type Instrument State (*.savrcltxt) -

Ivar/user/Lists/SavRq All Files (%)
T ooy G4 nstrument State (. savrcltxt)

w3 DME ARB Waveform {*.w)
@ LevelCalp| NRP Setting (".nrp)

& LiGenCall EthFweosd?‘jLiSt (*.lsw)
w0 R

'Q_ SavRcl
-0, SynCalibData

Cut | Copy | Paste |
Rename | Delete | Create New Dirl

Use the "File Type" to select a file type from the list. This can be used to process either
all files (all files (*) selection) or a specific selection of files. See Chapter 4.7.2.1,
"Extensions for User Files", on page 85 for an overview of the supported file exten-
sions. The available drives and directories and the files of the selected directory are
displayed. The currently selected path is displayed above the windows. If the area is
opened several times, the path last selected is displayed. Unlike the "File Select" win-
dow, the "File Manager" displays the full file names including extensions.

Working with the File Manager dialog

1. Accessing the "File Manager" dialog (see "Accessing files with user data"
on page 83).

2. Navigating in the "File Manager" dialog.
Operation is very similar to the operation of a standard Windows explorer.

3. Moving, duplicating, deleting or renaming files
To move a file, select the file and press the "Cut" button. Mark the directory to
which the file is to be moved and select the "Paste" button. If the target directory
already contains a file with the same name, a confirmation query is displayed to
confirm overwriting of this file.
Perform the similar steps and cut/copy/rename/delete the file.

Tip: The operation corresponds to the Windows concept.

4. Creating a new directory
Mark drive or directory level where the new directory is to be created, select the
"Create New Directory" button and enter the name of the new directory in the entry
window that opens. Confirm with ENTER.

4.7.2.1 Extensions for User Files

The following table lists all available file extensions for user files. The currently availa-
ble files on the instrument depend on the installed options.
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Table 4-1: List of the automatically assigned file extensions in the instrument

Function List type Contents File suffix
Instrument State Settings Instrument settings *.savrcltxt
"User Correction" List User-defined level correction values *.uco

Export Data * . txtor *.csv
"List Mode" List User-defined frequency/level value pairs * . lsw

Export Data *.txtor*.csv
"Pulse Train List" User-defined offtime/ontime/repetition values * . pulstrn
SMZ Settings Settings Data (firmware) of a connected SMZ frequency | *.efmfirm

multiplier
NRP Settings Settings NRP Settings *.nrp

4.8 Legend of Front-Panel Controls

The following table lists all key functions available on the front panel. Key combinations
used on the PC keyboard to trigger key functions on the instrument front panel are also
described. Keyboard labels are described in alphabetical order.

In addition, a front panel key emulation and an on-screen keyboard can be used for
manual operation by mouse only.

Table 4-2: Cross-reference between the front panel keys and keyboard shortcuts

Front-panel key

Key of PC keyboard

Function

Turning the rotary
knob

Tab key (towards the right)
Shift + Tab (towards the left)

Sets the cursor with the rotary knob.

Pressing the rotary Enter Pressing the rotary knob confirms an entry; it has

knob the same function as the ENTER key.

Arrow keys Arrow keys Moves the cursor.

ENTER/*1/dB(m) Enter Terminates an entry.

ALT + F12 Confirms entries in the base unit and values with-

out a unit.
Selects dBm for the RF level and dB for level offset
and level step width.

RV L H# Enters a period/decimal point. Enters a special
character.

-/ A<->a -/ (shift+) a—z Enters the sign.
Switches between upper-case and lower-case let-
ters.

0-9/a..z CTRL+ 0-9/a...zCTRL Enters the number/letter.
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Front-panel key Key of PC keyboard Function

BACKSPACE Backspace Clears the last entry (number, sign or decimal
point)

ESC /CLOSE ESC/CTRL+G Selects the next higher menu/selection level. When

the editing mode is exited with ESC, the previous
value is restored.

Closes an active menu.

DIAGR CTRL+ D Sets the cursor on the block diagram and hides all
menus.

FILE CTRL+S Activates the menu for storing instrument settings.

FREQ CTRL+ F Activates the frequency entry.

G/n/ dBuV ALT + F9 Selects the unit Giga/Nano, dBuV for the RF level
and dBu for the LF level.

HELP F1 Opens/closes context-sensitive help.

INFO CTRL +1 Opens/closes the info window

k/m / mV ALT + F11 Selects the units kilo/milli and mV for RF levels.

LEVEL CTRL+L Activates the level entry.

LOCAL CTRL+Q Switches the instrument from remote control to

manual control.

M/u / uv ALT + F10 Selects the units Mega/Micro and uV for RF levels.

MOD ON/OFF CTRL + O Switches modulation on/off. "MOD OFF" is indica-
ted in the status line.

TOGGLE CTRL+T Switches a block or parameter on/off.

Toggles between the different possibilities of set-
ting a selection parameter.

PRESET CTRL+P Restores a defined basic instrument setup.

RF ON/OFF CTRL+R Switches the RF output signal on/off. "RF OFF" is
indicated in the status line.

SETUP CTRL +E Opens the setup menu for general instrument set-
tings.

WINBAR CTRL +W Toggles between the active menus.

4.8.1 Front Panel Key Emulation

The R&S SMB provides a front panel key emulation to enable execution of the front
panel key functions by mouse e.g. for remote access. The emulation is called by a right
mouse click. The front panel key functions are executed by a mouse click on the asso-
ciated button.
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Overview of Instrument Functions

Instrument Function

Overview of Instrument Functions

This chapter explains the functions of the R&S SMB and the options available in the
setting menus. The associated SCPI command is specified for each parameter (where
applicable).

The description starts with the general instrument settings which do not directly affect
signal generation. The majority of these settings can be accessed by means of front-
panel softkey menus and not by means of function block menus.

The signal generation functions are then described, beginning with the functions which
affect the RF signal ("RF" block) and the analog modulations ("Mod" block). The config-
uration of the modulation generators (LF generators and pulse generator) and of the
LF sweep is offered in the "Mod Gen" block. The clock synthesis signal is set in the
"Clock Synthesis" block.

The general instrument settings include various functions, such as:

® Setting a defined basic setup using the PRESET key
see Chapter 5.2.2, "Default Instrument Settings - Preset Key", on page 91

® Switching from remote control to manual control using the LOCAL key
see Chapter 5.2.4, "Switching to Manual Control - Local Key", on page 121

® Configuring the generator and its interfaces in the "Setup” dialog - e.g. setting the
GPIB address, starting an adjustment, querying instrument data
see Chapter 5.2.3, "General Configuration of Instrument - Setup Key",
on page 91
® (Calling up the online help using the HELP key
see Chapter 5.2.7, "Help System - Help Key", on page 125
® Querying messages using the INFO key
see Chapter 5.2.6, "Messages - Info Key", on page 125

® [oading and storing complete instrument settings in the "File" menu

see Chapter 5.2.8, "Storing and Loading Instrument Data - File Key", on page 126
The RF signal and the reference oscillator are configured in the "RF" function block:
e CW mode

see Chapter 5.3.1, "Overview of RF Signal", on page 135

® List mode

see Chapter 5.3.7.4, "List Mode", on page 187
® Frequency and Level Sweep mode

see Chapter 5.3.7.1, "Overview", on page 174

e Reference Oscillator
see Chapter 5.3.4, "Reference Oscillator”, on page 141

® RF Level
see Chapter 5.3.5.1, "Overview of RF Level", on page 145
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General Instrument Settings

® RF Level Sweep
see Chapter 5.3.7.3, "RF Level Sweep", on page 182

e ALC

see Chapter 5.3.5.4, "Automatic Level Control - ALC", on page 151
® Power Sensors

see Chapter 5.3.6.1, "NRP-Z Power Viewer", on page 166

® User Correction
see Chapter 5.3.5.6, "User Correction", on page 158

The analog and external digital modulations are activated in the "Modulation" function
block:

e Amplitude Modulation
see Chapter 5.4.2, "Amplitude Modulation (AM)", on page 198

® Frequency Modulation
see Chapter 5.4.3, "Frequency Modulation (FM)", on page 202

® Phase Modulation
see Chapter 5.4.4, "Phase Modulation (PhiM)", on page 206

® Pulse Modulation
see Chapter 5.4.5, "Pulse Modulation (PM)", on page 209

® Stereo Modulation
see Chapter 5.4.6, "Stereo Modulation", on page 211

The internal LF generators, the LF frequency sweep and the pulse generator are con-
figured in the "Mod Gen" function block:

® |F Frequency Sweep
see Chapter 5.5.3, "LF Frequency Sweep", on page 220

® | F output
see Chapter 5.5.2, "LF Output", on page 218

General Instrument Settings

Overview of General Instrument Settings

This section describes the settings which do not directly affect signal generation. Most
of these settings can only be accessed by means of menus which are opened using
keys or key combinations on the external keyboard or keys on the front panel key emu-
lation.

The general instrument settings therefore affect various functions, such as storing
instrument settings using the FILE key or setting the GPIB address in the menu of the
SETUP key. The order in which the descriptions are given corresponds to the layout of
the keys on the front panel of the R&S SMB (from top left to bottom right).
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5.2.2 Default Instrument Settings - Preset Key

The PRESET key performs a defined instrument setup. All parameters and switching
states are preset (also those of inactive operating modes). The default instrument set-
tings provide a reproducible initial basis for further settings.

However, functions concerning the integration of the instrument in a measurement
setup are not changed, for example the GPIB address or reference oscillator settings.

When the instrument is switched on, it is not the preset state that is active, but rather
the instrument state that was set before the instrument was switched on.

User-defined instrument states can be accessed and stored in the "File" menu.

@ Resetting the instrument to the factory state is possible with the Factory Preset func-
tion.

Preset
Presets all parameters and switching states.

The following list gives an overview of the presets for the most important generator set-
tings. The other presets can be found in the preset tables of the individual menus and
the information accompanying the remote commands.

® "RF frequency" =1 GHz

® "RF level" RF output switched off

e "Level" = 30 dBm for instruments including an attenuator

"Level" = -5 dBm for instruments with no attenuator

"Offsets" =0

"Modulations State" = Off

Uninterrupted level settings are switched off

"Level Attenuator Mode" = AUTO

Internal level control "Level ALC" = AUTO

User correction "Level Ucor" = OFF

"LF output State" = Off

"Sweep State" = Off

Settings that are not affected by the PRESET key

Reference frequency settings ("Ref Oscillator" menu)

Power on settings ("Level/EMF" menu)

Network settings ("Setup" menu)

GPIB address ("Setup" menu)

*IDN? Identification and emulation ("Setup" menu)

Password and settings protected by passwords ("Setup" menu)
Start/Stop Display Update ("Setup" menu)

Display and keyboard settings ("Setup" menu)

Remote command:
*RST on page 282

5.2.3 General Configuration of Instrument - Setup Key
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System
Reference Oscillator.
Internal Adjustments
Hardware Config.
Software / Options

5.2.3.1

General Instrument Settings

The "Setup" menu provides access to basic instrument settings, regardless of the cur-
rently set operating mode or measurement. It contains information on the insstrument's
equipment, and comprises all settings for the general configuration of the instrument
and its interfaces.

To access the "Setup" menu, press the SETUP key.

The "Setup" menu is divided into functional sections as follows:

® "System": covers general instrument parameters.

® "Test": used to perform function tests.

® "Environment": used to configure the controller interfaces.

® "Remote": used to configure the remote control interfaces.

® "Protection": used to set the protection level for service functions and security set-
tings.

® "Settings": used to save or recall instrument settings or to preset the instrument to
factory settings.

Most submenus of this key can be accessed only via the SETUP key or the menu tree

( MENU key), with the following exceptions:

® The "Reference Oscillator" dialog can also be accessed in the "RF" block and is
therefore described in the section on this block (see Chapter 5.3.4, "Reference
Oscillator", on page 141).

® The "Save/Recall" dialog can also be accessed with the FILE key and is therefore
described in the section on this key (see Chapter 5.2.8, "Storing and Loading
Instrument Data - File Key", on page 126.

Internal Adjustments

The R&S SMB is extremely accurate due to the integrated adjustment procedures,
which you can execute directly on the instrument.

Self-calibration routines that do require additional (external) measurement equipment
are either described in the Service Manual of the instrument, or they require to be per-
formed by a Rohde & Schwarz service center.

Risk of invalid adjustment

In order to achieve correct adjustment of the instrument, make sure that the instrument
is warm before performing adjustments. The warm-up time is 30 minutes.

When to perform adjustments?

It is recommended to perform internal adjustments prior to any application that requires
a maximum of level and frequency accuracy, especially when a long period of time has
passed or if the ambient temperature of the instrument significantly differs from the one
of the last adjustment.
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Additional Information to the Adjustments

During adjustments, a progress indicator shows the status of the process. If any error
occurs, the process aborts and an error message appears in the info line.

The extent of the adjustments depends on the installed options.

Risk of damage to the DUT

High power at the RF output may destroy a connected DUT (Device Under Test).

During level adjustments instruments without step attenuator, that means with fre-
quency options R&S SMB-BxxxL, temporarily apply high power at the RF output. This
may damage the DUT. Therefore, it is required that the RF connector is terminated
during the adjustments.

Disconnect the DUT and replace it by a 50 Ohm terminating resistor.

> To access the settings for internal adjusmtents, press the SETUP key and select
"System > Internal Adjustments".

Ihternal sdjustrents @
| Adjust All

‘Adjust Synthesis

Adjust Level |

—Ext Level Adjustment

Adjustment Data I Factory vI

———Stereo Coder
Adjust Analog Channels |

In this dialog you can perform internal calibration routines.

The remote commands required to define these settings are described in Chapter 7.4,
"CALibration Subsystem", on page 286.

Adjust All
Performs all available internal calibration routines of the instrument.

Adjustment may take some time. Especially in instruments with frequencies above 6
GHz, it may last up to 15 minutes.

Remote command:
:CALibration<hw>:ALL[:MEASure] ? on page 286

Adjust Synthesis
Performs all adjustments which affect the frequency.

Remote command:
:CALibration<hw>:FREQuency[:MEASure] ? on page 287
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Adjust Level
Performs all adjustments which affect the level. The acquired correction values
improve the settling time and the signal quality.

Remote command:
:CALibration<hw>:LEVel [ :MEASure]? on page 287

Adjust Stereo Coder
Performs all adjustments which affect the analog channels of the stereo coder. For the
adjustment of the S/P DIF see Service Manual, chapter 2, "Adjustment".

Remote command:
[:SOURce] :CALibration:STEReo:ANALog [ :MEAS] ? on page 288

5.2.3.2 Hardware Config

In the "Hardware Config" dialog, the installed assemblies together with their variants
and revision states can be displayed for servicing purposes.

To open the "Hardware Config" dialog, select "System" and press the SETUP or

MENU key.
Counter
(Operation Time /h 5]
Power On Count ]

Commaon Assembly

Rl

£ [y Partt Revisi
SMB100A 1406.6000k02 |-
Basis Board |1406.6600.00 (00.00

COM-FPGA 00.00.00

RF Assembly

£ bly Partt Revisi
RF Board 1406.7220.06 |01.01
MOD-FPGA 20.20.00

Baseband Assembly

bly Partt Revisi

Sterec Coder |[1407.3240.00 (00.00

Section "Counter" in the upper part of the menu shows the "Operation Time" (in hours)
and the number of power-on ("Power On Counter").

The second part of the menu is a table that lists the installed assembilies. It is divided
into the sections:

® "Common Assembly"

® "RF Assembly"

® "Baseband Assembly"

Operation Time / h
Displays the operation time in hours.

Remote command:
:DIAGnostic:INFO:0TIMe? on page 289
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Power On Count
Displays the number of power-on.

Remote command:
:DIAGnostic:INFO:POCount? on page 290

Assembly
The tables list the installed assemblies.

"Assembly" Assembly name
"Part Number" Part Number of assembly
"Revision" Revision state of assembly

Remote command:
:DIAGnostic<hw>:BGINfo? on page 288

Software / Options

The "Software/Options" dialog shows the firmware version of the instrument software
and all installed hardware and software options.

Software options purchased at a later stage can be activated with a keycode. The acti-
vation code is supplied with the software option.

How to install options is described in chapter 4 "Software Update / Installing Options"
of the service manual.

The installation of hardware options purchased at a later stage is also described in the
service manual. Most hardware options need to be installed at an authorized
Rohde&Schwarz service shop.

To access the "Software/Options" dialog, select "System" and press the SETUP or
MENU key.

The menu is divided into the following sections:

® "Firmware"

® "Hardware Options"

® "Software Options"

Package More...
SMB100A PW 02.05.19 beta (Release..
R&S COMPASS | 2.1.59.0 (Release)

Hardware Options

Option More...
SMB-B106 9 kHz t0 6 GHz

— Software Options {Internal}

Option More...
SMB-K22 Pulse Modulator (Desi..
SMB-K23 Pulse Generator (Desi..




General Instrument Settings

Firmware
The firmware section of the menu shows the firmware version and the version of the
software platform.

Note: Your instrument is delivered with the latest firmware version available. Firmware
updates and the "Release Notes" describing the improvements and modifications are
provided on the Internet at the download site of the Rohde & Schwarz signal generator
home page. This home page always offers the latest information on your signal gener-
ator, e.g. also on changes of the firmware update procedure.

Remote command:
n.a.

Hardware Options / Software Options
The tables in the sections "Hardware" and "Software" list the installed hardware and
software options.

"Option" Short name of option
"Designation"  Name of option

Remote command:
*OPT? on page 281
*TIDN? on page 281

Loaded Modules
Section "Loaded Modules" is provided for service purposes. It lists all loaded software
modules with their versions and offers a short description of each module.

Remote command:
n.a.

5.2.3.4 Manage License Keys

This dialog is the central dialog for managing licenses, like enabling newly purchased
and/or newly registered options or performing the required instrument related steps
during the process of unregistration of licenses.

il

|Device ID 1405.5000K02-000000-ED)|

Enter License Key
[Enter Licenze Key

Import License Key From File... |

Export Deaclivation Response To File... |

An option is ready to operate after it is enabled by means of a license key code sup-
plied with the option. The license key is delivered as a file or on paper. Unregistered
licenses must be registered for a particular instrument prior to the corresponding option
can be enabled for operation.
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License Registration

If your purchased license is delivered unregistered, you must register it before you can
activate the option.

For detailed information about the license registration, refer to the installation instruc-
tions provided with the option (Supplement A) and the documentation of the online tool
"Manage Licenses" (https://extranet.rohde-schwarz.com/service).

prior to enabling the software option may be required. The information on the valid
firmware versions for the purchased software option is provided together with the
option.

The firmware update is described in the service manual, chapter 4.

6 Only if the R&S SMB is equipped with an older firmware version, a firmware update

Device ID
Displays the instrument specific identification number. The device ID is an unique
string with the following structure:

<stock number>-<serial number>-<checksum>

Enter License Key
Type here the license key provided with the option.

For license keys delivered as a file, use Import License Key from File....

Import License Key from File...
Opens a dialog for selecting the file with the license key.

Export Deactivation Response to File...
Exports the generated deactivation response key to a file and opens a file manage-
ment dialog to save the file. This key is required during the unregistration process.

Status Information
Displays status information.

5.2.3.5 NRP-Z Info/Update

The "NRP-Z Info/Update..." dialog covers information on connected power sensors,
like serial number, revision state and features of the particular sensor. You can directly
perform an update of the sensor firmware.

» To access this dialog, select "Setup > System > NRP-Z Info/Update...".

HRP:Z Info / Update

1-NRP-Z81

Update
1- NRP-Z81 vl Run Update

None  Select NRP File
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The "NRP-Z Info / Update" dialog indicates the connected R&S NRP-Z Power Sen-
sors with specific information and contains the functions to update the firmware of
a connected sensor.

The remote commands required to remotely configure the power sensor settings are
described in Chapter 7.12, "SENSe, READ and INITiate Subsystems", on page 315.

How to update an R&S NRP sensor

To perform an R&S NRP sensor update proceed as follows:

1. Open the R&S website http://www.rohde-schwarz.com in section "Power Meters &
Voltmeters > R&S NRP-Z Sensors".

2. Select the respective sensor, e.g. R&S NRP-Z81.
3. Select "Downloads > Firmware" and the offered firmware suitable for your sensor.

4. Transfer and save the firmware on the instruments, for example in the /var/
directory.

5. Connect the sensor to the R&S SMB and select "Setup > System > NRP-Z Info
Update" to open the dialog.

6. Select the sensor in the left sensor selection field.
7. Select the update file with "Select NRP File".
8. Start the update procedure with "Run Update".

The update starts and a bar indicates the progress.
How to restart an interrupted update of an R&S NRP sensor

An accidental removal of the sensor during the update process interrupts the update.

If no other sensor is connected to the instrument, proceed as follows to restart the
update process:

1. Do not reconnect the sensor but keep it ready to be connected.

2. In the "Setup > System > NRP-Z Info Update" dialog, select "Rescue" in the left
sensor selection field

3. Activate "Run Update".
4. Confirm query in message box
5. Connect sensor within 4 seconds
The update starts, a bar informs about the progress.
Current Sensors

Shows the sensors that are connected to the generator with information on serial num-
ber, the revision state and some features.
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Tip: Click on a sensor to get quick information about the firmware version and whether
this sensor measures the peak of the signal.

Remote command:

SENSe<ch>[:POWer] : TYPE? on page 324
SENSe<ch>[:POWer] : SVERsion? on page 323
SENSe<ch>[:POWer] : SNUMber? on page 322

Update

Section "Update" provides access to the file system in order to select a file for an R&S
NRP sensor update (Button "Select NRP File"), the selected file is indicated to the left
of the button. On the left side, the sensor to be updated is selected.

Button "Run Update" starts the update.

Note: If the update is interrupted for example by accidental removal of the sensor dur-
ing the process, the button "Rescue" appears. Thus, you can restart the update proc-
ess.

Prerequisite is that no other sensor is connected to the instrument.

Refer to "How to update an R&S NRP sensor" on page 98 and "How to restart an inter-
rupted update of an R&S NRP sensor" on page 98 for detailed instructions.

Remote command:
n.a.

5.2.3.6 SMZ Info Update

The "SMZ Info/Update" dialog covers information on a connected frequency multiplier,
like type, serial number revision state, frequency range and firmware version. You can
directly perform an update of the multiplier firmware.

=
El- Setup N
System
Reference Oscillator..
Internal Adjustments...
Hardware Config. .. J
Software/Options. ..
Manage License Keys. ..
Start/Stop DisplayUpdate. ..
- NRP-Z Info/Update. ..

“Opiate. |

Toet

To access the "SMZ Info/Update" dialog, perform one of the following
® On the front panel, press the SETUP key and select "SMZ > SMZ Info Update".
® |n the block diagram, select "RF Block > Configure > SMZ Info Update"

SMZ Info / Update O]
[ Available Multipl
IMIi:IHType Serial Number| Revision |Min Freq Max Freq FW-Version BL-Version
IWVSMZNU 101643 01.00 75GHz  110GHz FW_ 18 BL 186

SMZ Input Cable Compensation Standard -
Cable Loss (10GHz) 10|dB =

Update
1-SMZ110 | Run Update |
Mone Select SMZ File |
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® Where you can find the description...

6 Since this section is relevant when an R&S SMZxxx frequency multiplier is connec-
ted, you can find a detailed description in the user manual of the frequency multi-
plier. It is included in the online help of the R&S SMB, but can also be found in pdf
format on the CD, or on the R&S website http://www.rohde-schwarz.com/product/
SMZ.html.

5.2.3.7 Display Update
The "Start/Stop Display Update" dialog provides the possibility to switch off update of
the displayed parameters in order to increase speed for certain settings.

The indicated values are not updated and may therefore differ from the intern, used
values.

Start / Stop Display Update

Display Update is

Please, be aware:
If "Display Update is OFF", the values of displayed parameters could differ from their internal, used values.
This mode is mainly provided to support unjittered signal output, e.g. in fast sweep or list mode.

Changes in remote state changes the value of "Display Update is" to OM.

Display Update is On/Off
Switches on/off update of the displayed parameters.

Switching off the update of the displayed parameters increases the speed for certain
settings.

Note: For optimum sweep performance with short dwell times and for fast settling
times, it is recommended to switch off the display update .

Remote command:
:SYSTem:DISPlay:UPDate on page 445

5.2.3.8 Selftest
A selftest is provided for service purposes.

Access:

1. Select "Setup > Test > Selftest"

2. Select "Start Selftest".



http://www.rohde-schwarz.com/product/SMZ.html
http://www.rohde-schwarz.com/product/SMZ.html

General Instrument Settings

The following tests are only available via remote control:
® :TEST<hw>:DIRect on page 449

Start Selftest
Performs a selftest on all installed hardware options.

When completed, the R&S SMB displays a list of all performed test cases and the test
results (passed or failed).

Note: While the self test is in progress, the actual signal level at the RF output is -50
dBm. This value is not indicated in the status bar.

Remote command:
:TEST<hw>:ALL:STARt on page 448
:TEST<hw>:ALL:RESult? on page 448

5.2.3.9 Check Front Panel

With the functions provided in this dialog you can verify the functionality of the control
keys of the R&S SMB.

In case of malfunctions, contact your Rohde & Schwarz Customer Support Center for
technical support, see http://www.customersupport@rohde-schwarz.com.

6 Accessing the online help in the check front panel dialog or exiting via ESC

During the test, the actual functions of all keys are disabled, including the HELP and
the ESC keys.

Check Front Panel Settings

» To access this dialog, Press the "setup" key and select "Setup > Test > Check

Front Panel".
Preset Rolll. | Roll 1.
Help Roll click ESC
ILI _Diagr |
Left Right | Mod
Dovml RF
|| Lecal | Freq
Setup | Level 7 8 9 Gin
File |Toggle 4 6 M
Info | Back 1 2 kin
Winbar| 0 +L “

Reflecting the front panel, the "Check Front Panel" dialog contains all functions to
test the operating elements of the instrument.
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Performing the Front Panel Tests

To perform the front panel test, you operate the keys at the front panel, and check the
response of the instrument in the "Check Front Panel" dialog. To perform this test
properly, it is essential that you check each key of the front panel. The test is only com-
pleted, when you have veryfied all keys.

During the test, the actual functions of the keys are disabled.

Proceed as follows:
1. Press the SETUP key.

2. Select "Test > Check Front Panel"
The "Check Front Panel" dialog opens.

3. Press a key on the front panel.
Check if the corresponding key in the "Check Front Panel" dialog turns green.

4. Press the same key a second time.
Check that the key in the dialog turns red.
Note: Pressing the same key again has no further effect, with the exception of the
ESC key, see Press the ESC key a third time.

5. Continue with the next key on the front panel and repeat step 3 to step 5 until all
keys are tested.
Test Passed X

All front panel keys were accessed comectly.

OK

The test is completed, when each key is verified successfully, confirmed by a "Test
passed" message.
Select "OK" to exit the test.

» Press the ESC key a third time.
Exits the "Check Front Panel" dialog, even if you have not yet checked all the keys.

Expected responses:

® Pressing a key once (green), pressing twice (red)

® Pressing the ESC key a third time exits the dialog.

If you detect a malfunction, for example, you press the front panel key the first time,
and the color of the button in the dialog turns red (instead of green), the front panel key

may be stuck. In this case, contact the Rohde & Schwarz Customer Support Center for
technical support, see http://www.customersupport@rohde-schwarz.com.

Shutting Down and Rebooting the Instrument

The POWER ON/STANDBY front panel key switches the instrument from the standby
to the ready state or vice versa. In remote operation form a remote computer or in
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manual control, the R&S SMB provides you with another possibility to shut the instru-
ment down or to reboot the system.

» To access the required settings, select "Setup > Environment > Shut Down".
B —

Shut down

Reboot |

Remote control commands:

® :SYSTem:SHUTdown on page 445

® :SYSTem:REBoot on page 444

® seealso :SYSTem:RESTart on page 444

5.2.3.11 Date and Time

The R&S SMB uses an internal real time clock to determine the date and time. It
adjusts the time and date to the timezone of your location automatically, by providing a
selection list of continents and cities.

The instrument records the time whenever you create or modify files on your instru-
ment or you use timed licences.
To access the required settings:

> Select "Setup > Environment > Date/Time" via the SETUP or MENU key.

Date / Time

|Date [DD.MM.YYYY]I D-I.IJ?JHII
Time [hh:mm:ss] | 10:28:50

Timezone UTC h

The "Date / Time" dialog contains the time and data settings of the operating sys-
tem.

6 The parameters "Date" and "Time" are protected to prevent accidental changes.

To enable editing, unlock protection level 1, see Chapter 5.2.3.17, "Protection”,
on page 113.

Date
Displays the date set in the operating system in the format [dd.mm.yyyy].

Remote command:
:SYSTem:DATE on page 445

Time
Displays the time set in the operating system in the format [hh.mm.ss].
The time setting corresponds to the selected Time Zone.
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Remote command:
:SYSTem: TIME on page 446

Time Zone
Selects the time zone.

You can select the time zone according to the major cities on the respective conti-
nents.

Note: By typing the first letter, you can quickly navigate through the lists to find the
desired destination.

Remote command:
:SYSTem: TIME : ZONE on page 446
:SYSTem: TIME: ZONE : CATalog? on page 446

5.2.3.12 Network Settings

The "Network Settings" dialog shows the parameters relevant for identifying the instru-
ment in a network. The R&S SMB is equipped with a network interface and can be
connected to an Ethernet LAN (local area network).

How to connect the signal generator to the network is described in Chapter 2.6.1,
"Connecting the Instrument to the Network", on page 35.

Risk of network errors!

Connection errors can affect the entire network.

If your network does not support DHCP, or if you choose to disable dynamic TCP/IP
configuration, you must assign valid address information before connecting the instru-
ment to the LAN.

Contact your network administrator to obtain a valid IP address.

» To access this dialog, press the SETUP or MENU key and select "Environment >
Network Settings".
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Metwark Status O Connected |
Hostname |rssma1l|l|]aiﬂﬂﬂ21
Warkgroup |NSTRLI|ENT
Address Mode | Auto (DHCP) |
IP Address | 10.111.10.136
Subnet Mask | 255255.0.0
Default Gateway | 10.111.0.1
DNS Suffix |rsint.net
DNS Server | 10.0.23.159
MAC Address [o0 2564 C33182

Restart Netwark

In the "Network Settings" dialog, you can configure the settings of the general net-
work environment and specific identification parameters of the instrument in the
network.

The remote commands required to remotely configure the network are described in
Chapter 7.15, "SYSTem Subsystem", on page 433.

Network Status
Indicates that the instrument is connected to the network.

Remote command:
:SYSTem:COMMunicate :NETWork: STATus? on page 440

Hostname
Displays the host name.

Each instrument is delivered with an assigned host name, a logical name which can be
used instead of the IP address. With the default network settings, the IP address is
allocated by the DHCP server. This address may change each time the instrument is
reconnected. Unlike the IP address, the host name does not change.

Note: Since the host name of the instrument is a protected parameter, you must first
unlock protection level 1 to enable the entry (see Chapter 5.2.3.17, "Protection”,

on page 113).

It is recommended that you neither change the default network settings nor the host
name in order to avoid problems with the network connection.

However, if you change the host name be sure to use an unique name.

Remote command:
:SYSTem:COMMunicate :NETWork [ :COMMon] : HOSTname on page 438

Workgroup
Sets the individual windows workgroup name of the R&S SMB. This parameter is
required in case the instrument is integrated in a windows network.

Note: Since the workgroup name of the instrument is a protected parameter, you must
first unlock protection level 1 to enable the entry (see Chapter 5.2.3.17, "Protection",
on page 113).
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Remote command:
:SYSTem:COMMunicate :NETWork [ : COMMon] : WORKgroup on page 438

Address Mode
Selects the mode for assigning the IP address.

"Auto (DHCP)" Assigns the IP address automatically, provided the network supports
DHCP (Dynamic Host Configuration Protocol)
The network used must support automatic assignment of the IP
address via DHCP or APIPA (Zeroconf) in order to use this function.

"Static" Enables you to assign the IP address manually.

Remote command:
:SYSTem:COMMunicate:NETWork: IPADdress : MODE on page 439

IP Address
Displays the IP address.

By default, the R&S SMB is configured to use dynamic TCP/IP configuration and to
obtain the whole address information automatically.

If the network does not support DHCP or the attempt does not succeed, the instrument
tries to obtain the IP address via Zeroconf (APIPA) protocol. IP addresses assigned via
Zeroconf start with the number blocks 169.254 . * ., *.

Note: An IP address that is assigned via the Zeroconf protocol while the network
requires an IP address assigned via the DHCP server may cause network connection
failures.

See Chapter 9.5, "Resolving Network Connection Failures", on page 487.

To assign the IP address manually, select Address Mode "Static".

Remote command:
:SYSTem:COMMunicate:NETWork: IPADdress on page 439

Subnet Mask
Displays the bit group of the subnet in the host identifier.

To assign the subnet mask manually, select Address Mode "Static".

Remote command:
:SYSTem:COMMunicate :NETWork[: IPADdress] : SUBNet : MASK on page 440

Default Gateway
Displays the gateway address.

To assign the gateway address manually, select Address Mode "Static".

This address identifies the router on the same network as the instrument that is used to
forward traffic to destinations beyond the local network.

Remote command:
:SYSTem:COMMunicate:NETWork [ : IPADdress] : GATeway on page 439

DNS Suffix

Displays the primary DNS (Domain Name System) suffix, that means the DNS name
without the host name part.
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The DNS system uses the suffix for registration and name resolution to uniquely iden-
tify the instrument in the entire network.
To assign the DNS suffix manually, select Address Mode "Static".

Remote command:
:SYSTem:COMMunicate :NETWork [ :COMMon] : DOMain on page 438

DNS Server

Determines the preferred server for name resolution. The DNS server contains the
underlying numerical values that are required for name resolution of the host name as
part of the IP address.

To select the DNS server manually, select Address Mode "Static".

Remote command:
:SYSTem:COMMunicate :NETWork [: IPADdress] : DNS on page 439

MAC Address
Indicates the MAC (Media Access Control) address, a unique identifier of the network
adapter in the R&S SMB.

Remote command:
:SYSTem:COMMunicate:NETWork:MACaddress on page 440

Restart Network
Terminates the network connection to the instrument and subsequently re-establishes
it.

Used this function to resolve network problems.

Note: Only the connection of the instrument to the network restarts, the network itself
is not affected.

Remote command:
:SYSTem:COMMunicate:NETWork:RESTart on page 440

5.2.3.13 Display/Keyboard Settings

In the "Display/Keyboard Settings" dialog the power-save mode and external keyboard
settings are made. It is opened using the SETUP or MENU key under "Environment".

Display Settings
Screen Saver [ Active
Wait time [10] min =]

Toggle Summary Screen [T Active

Gui Language |Eng|i5h {US}j
USE Keyboard Settings
Layout |English (US) =]
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Screen Saver Active
Activates/deactivates the screen-save mode of the display.

If activated, the display including backlight is completely switched off after the elapse of
the "Wait Time" when no entries via front panel, external mouse or external keyboard
are made.

This mode is recommended for preserving the display especially if the instrument is
exclusively operated via remote control.

Remote command:
:DISPlay:PSAVe | :STATe] on page 292

Wait Time
Enters the idle time that must elapse before the display lamp is shut off when no
entries are made.

Remote command:
:DISPlay:PSAVe:HOLDoff on page 292

Toggle Summary Screen
Activates/deactivates the magnified frequency and level indication. If activated, the fre-
quency and level indication covers the complete display.

Remote command:
n.a.

GUI Language
Selects the language of the graphical user interface.

Remote command:
n.a.

Layout (USB Keyboard Settings)
Selects the keyboard layout for the selected keyboard language.

The assignment of some keys depends on the selected layout and language.

Remote command:
:KBOard:LAYout on page 302
:KBOard:LANGuage on page 302

Remote Channel Settings

The "Remote Channel Settings" dialog provides access to the settings for remote con-
trol. The dialog is opened using the SETUP or MENU key under "Remote".

» To access this dialog, press the SETUP or MENU key and select "Remote >
GPIB,...".
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[GPIB Channel Address | 28

RS232 using USB Adapter

Baud Rate |1152[][] 'I
Parity INone 'I

Stop Bits

]

Visa Resource Strings

HISLIP |TCPIP::10.111.10.136:: hislipD: INSTR
VX1 [TCPIP:10.111.10.136:inst0:INSTR

Socket |TCPIP::10.111.10.136::5025: SOCKET
GPIB  |GPIB::28:INSTR

USB  |USB:0xOAAD:0x0048::100021:INSTR
SERIAL [ASRL1:INSTR

GOTO LOCAL

The "Remote Channel Settings" dialog contains the GPIB address and displays the
VISA resource strings provided for remote control via the various interfaces.

GPIB channel address
Sets the address of the GPIB channel the instrument is connected to.

Remote command:
:SYSTem:COMMunicate:GPIB[:SELF] : ADDRess on page 438

RS232 using USB adapter

Remote control via a serial interface is possible via a USB. The controller and the
instrument must be connected with the external USB/serial-adapter R&S TS1-USB
(see recommended extras in the data sheet) and a serial crossover (null modem)
cable. A USB connection requires the VISA library to be installed on the controller.
VISA will detect and configure the R&S SMB automatically when the USB connection
is established.

In addtion, you can also use a Bluetooth connection for remote control via the serial
interface. The settings are effective for both interfaces (see also Chapter 5.2.3.18,
"Security", on page 114 ).

Baud Rate < RS232 using USB adapter
Sets the baudrate for the serial remote control interface.

Remote command:
:SYSTem:COMMunicate: SERial :BAUD on page 442

Parity — RS232 using USB adapter
Sets the parity for the serial remote control interface.

Remote command:
:SYSTem:COMMunicate:SERial:PARity on page 442
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Stop Bits — RS232 using USB adapter
Sets the number of stop bits for the serial remote control interface.

Remote command:
:SYSTem:COMMunicate:SERial:SBITs on page 443

Visa Resource Strings

Displays the visa resource strings, used for remote control of the instrument. Each
interface requires an individual unique address, to identify the instrument for remote
control.

Remote command:
:SYSTem:COMMunicate:HISLip:RESource? on page 441
:SYSTem:COMMunicate :NETWork:RESource? on page 441
:SYSTem:COMMunicate:SOCKet :RESource? on page 443
:SYSTem:COMMunicate:GPIB:RESource? on page 441
:SYSTem:COMMunicate:USB:RESource? on page 441
:SYSTem:COMMunicate:SERial :RESource? on page 442

Goto Local
Switches the instrument to operate in local control mode.

Switching from remote to local control mode can be also done with one of the following
actions:

® manually with the LOCAL key on the front panel

® with the interface command &GTL via the remote control interface

® with the key combination CTRL + Q.

Remote command:
&GTL

Instrument Emulations

It is also possible to remotely control the R&S SMB via the command set of another
signal generator, as for example of an HP generator. With this function you can, for
example, replace a signal generator with an R&S SMB in an automated test setup,
without adjusting the command scripts used.

You find all the remote control command sets supported by the R&S SMB in a selec-
tion list. For more information on this topic, an application note describes in detail how
to use this feature. See the product site of the R&S SMB.

The selected instrument also defines the identification string that is retrieved with query
*IDN?. In addition to the preset values, you can enter a user-defined identification
string, for example to provide individual identification for each generator, like

'MY_R&S SMB' (see Mode and IDN String).

As any other parameter, you can additionally change the remote control command set
to be emulated via the Language command. However, once you have switched to an
emulation, the R&S SMB specific command set is disabled, that means this command
is no longer effective. To return, you need to know the corresponding remote control
command of the simulated instrument. If you emulate an HP generator for example,
the HP command EX returns to the SCPI command set.
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» To access this dialog, press the SETUP or MENU key and select "Remote > Instru-
ment Emulations".

Instrument Emulations X

*DNPFOPT? Identification - -
AF2023
Made AUt e 5057
IDM String AF2030
Rohde&Schwarz, SMB1004,1406,6000k02/00000 =
0,3.1.17.1-03.01.113 beta (Debug) =]

QPT String
SMB-B5, SMB-B106, SMB-K22, SMB-K23

The "Instrument Emulations" dialog enables you to emulate a remote control com-
mand set of several other signal generators.

The remote commands required to remotely configure the emulation settings are
described in Chapter 7.15, "SYSTem Subsystem", on page 433.

Language
Selects the instrument whose remote command set is emulated by the R&S SMB.

Remote command:
:SYSTem: LANGuage on page 443

Mode
Selects the way the instrument identification is performed.

"Automatic” Sets the "IDN String" and the "OPT String" automatically for the
instrument selected with the parameter Language.

"User Defined" Enables you to define the "IDN String" and the "OPT String" for the
instrument selected with the parameter Language.

Remote command:
:SYSTem: IDENtification on page 443

Set to default
Enables you to reset the *IDN and *OPT strings in user defined mode, see "Mode"
on page 111.

The default strings vary depending on the selected emulation mode (Language)

IDN String

Indicates the identification string of the instrument when queried with the common
command *IDN?.

To assign a user defined identification string, select Mode "User defined".

Remote command:
*TIDN? on page 281

OPT String

Indicates the option string of the instrument as queried with the common command
*OPT?.
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If a "User defined"(see Mode) IDN String is selected, you can create a user defined
option string in addition to the automatically created one.

Remote command:
*OPT? on page 281

5.2.3.16 LXI Status

The "LXI - LAN eXtensions for Instruments - Status..." dialog displays the settings and
status of the LAN and allows to reset the LAN connection.

For more information on LXI, see Chapter 2.8, "LXI Configuration", on page 45.

KI LAN eXten...ruments - Status X

w0 L X

Hostname | rssmx100a100020|

M}\CAddressl 0080bB1a1 cf
IP Address | 10.111.1.32

LAN Reset |

LAN Status
The LED indicates the LXI status.

The LAN Status is also indicated with the LED "LAN Status" on the front panel of the
instrument.

"green" normal operation

"green (flashing)"
device identification

"red" LAN fault
Remote command:

n.a.

LAN Reset

Initiates the network configuration reset mechanism for the instrument and resets the
hostname, MAC address, and IP address.

According to the LXI standard, a LAN Reset must place the following network settings
to a default state:

Parameter Value

TCP/IP Mode DHCP + Auto IP Address
Dynamic DNS Enabled

ICMP Ping Enabled

Password for LAN configuration LxiWeblfc

The LAN Reset for the R&S SMB also resets the following parameters:
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Parameter

Hostname Instrument-specific host name
Description RF and microwave signal generator
Negotiation Auto Detect

VXI-11 Discovery Enabled

The LAN settings are configured using the instrument's LXI Browser Interface descri-
bed in Chapter 2.8, "LXI Configuration", on page 45.

To open the "Instrument Home Page" (welcome page), type the instrument's computer
name (host name) or IP address in the address field of the browser on your PC, for
example http://10.111.10.175.

Note: Do not add the missing zeros in the IP address, while opening the Instrument
Home Page.

Remote command:
n.a.

Protection
This "Protection" dialog provides access to the unlocking of different protection levels .

Access:
» Select "Setup > Protection”
After power on the instrument, all protection levels are locked. To unlock the protec-

tion, the correct password must be entered, see "To unlock or lock a protection level..."
on page 114.

Protection

Protection Level 1 W On IPasswurdI I

Protection Level 2 W On Passwaord

Protection Level 3 W Cn Passwurdl ——
Protection Level 4 W Cn Passwurdl ———

Protection Level 5 W On Passwaord

The following functions are protected in the respective levels:

® Protection Level 1
Protects against accidental changes to certain settings, e.g. clock and date, net-
work settings or instrument names. You can access this protection level with the
password 7123456.

® Protection Level 2
Provides access to the unlocking of protected service functions. It is accessible for
authorized personnel of Rohde & Schwarz service departments.

® Protection Level 3-5
Are reserved for factory internal use.



R&S®SMB100A

Instrument Function

5.2.3.18

To unlock or lock a protection level...

1. In the "Password" entry field, enter the password for the corresponding protection
level.

2. Confirm with the ENTER key.

The checkbox of the protection level is disabled, i.e. the protection is unlocked.

3. To lock a protection level again, select the checkbox.

Protection Level/Password
Locks or unlocks the corresponding protection level.

E.g. protection level 1 expands the functionality of the internal adjustment and to
access the selftests.

The password is 123456.

For access to service functions of protection level 2, see the service manual of your
R&S SMB.

Remote command:
:SYSTem: PROTect<ch>[:STATe] on page 444

Security

The security concept of the R&S SMB helps you to protect your instrument against
uncontrolled access and changes. All provided security services require that you enter
the security password.

Provided security services are:

® Password management secures controlled user access to the instrument
With the two-step password concept, you can assign a user-defined password for
the operating system, as well as a security password for accessing the mass stor-
age of the instrument.
For more information concerning the security password, see the description
Resolving Security Issues when Working with an R&S SMB. You can find this
document on the R&S SMB product page at "Downloads" > "Manuals".

® LAN Services secures controlled network access.
You can individually lock and unlock the supported LAN interface services, see
"LAN Services" on page 116.
Remote control via LAN interface requires that the interface is activated, but you
can enable the required services specifically.

® General security parameters as:

— USB Storage secures controlled access to the mass memory of the instru-
ment.

— Write nonvolatile memory protects against modification or deletion of data in
the file system.

— Annotation frequency and amplitude prevents reading the display.
— User Interface prevents front panel operation and/or reading the display
— Bluetooth enables operation of the instrument via Bluetooth.

e
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Changing the password for the operating system or the security password requires that
you enter the old password, the new password and that you confirm the new pass-
word.

To assign the password, press the "Accept" button. This action can not be undone!

Keep also in mind, that security settings are never reset, even if you perform a factory
preset.

» To access this dialog, press the SETUP or MENU key and select "Protection " >

"Security".

Change User Password
Valid for VNG, FTP and SMB (Samba) access
User Name |l|slnlned

Old Password I
MNew Password I
Confirm Passwordl

Change Password |

Change Security Password

Old Password I
MNew Password I
Confirm Password I

Change Password |

Security Settings

LAN Services... |
USB Storage Im
Write Nonvolatile Memory Im
Annotation Frequency Im
Annotation Amplitude Im
User Interface Im
Security Password l—

Accept |
Bluetooth
Bluetooth Pin I ]

The "Security" dialog comprises the parameters for configuring the passwords, as
well as the security settings of the mass storage and the LAN services.

The settings in this dialog will not be assigned until you enter the Security Password
and confirm with the Accept button.

User Name
Indicates the user name used for access to the Linux operating system.

The user name and password are required for remote access to the instrument via
VNC, FTP or SAMBA.

Change User Password
Allows you to change and confirm the user password.
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Old Password — Change User Password
Enters the current user password. The default password is "instrument".

Note: It is highly recommended to change the default user password before connect-
ing the instrument to the network.

New Password «— Change User Password
Enters the new user password.

Confirm Password — Change User Password
Confirms the new user password by reperating.

Note: The new password will not be assigned until you select the Change Password
button.

Change Password «— Change User Password
Changes the user password accordingly.

Note: Keep in mind, that a changed password is never reset, even if you perform a
factory preset.

Change Security Password
Enables you to change and confirm the security password.

Old Password — Change Security Password
Enters the currently used security password. The default password is '123456'.

Note: It is highly recommended to change the default security password before con-
necting the instrument to the network.

The security password is required when changing the status of the USB and LAN inter-
face.

New Password < Change Security Password
Enters the new security password.

The security password may contain decimal characters only.

Confirm Password «— Change Security Password
Confirms the new password by repeating.

Note: The new password will not be assigned until you select the Change Password
button.

Change Password < Change Security Password
Changes the password accordingly.

Note: Keep in mind, that a changed password is never reset, even if you perform a
factory preset.

LAN Services

Opens the "LAN Services" dialog for individually enabling or disabling the available
LAN interface services.
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|Enab|e LAN Interface ¥ On |
SCP! aver LAN [Enabled ~]
VNC [Enabled ~]
SSH [Enabled ~]
FTP [Enabied =]
SMB (Samba) [Enabled ~]
Awvahi (Zeraconf) lm
Software Update lm
Security Passwaord l—
Accept |

Enable LAN Interface < LAN Services
Enables the LAN interface in general, and thus provides remote access via all
unlocked services.

Note: The activated LAN services will not be assigned until you enter the Security
Password and confirm with Accept.

Enable LAN Services individually — LAN Services
Enables or disables the following interface services individually.

"SCPI over LAN"
activates access over LAN to remotely control the instrument using
SCPI (Standard Commands for Programmable Instruments) com-
mands.

"VNC" activates access via VNC (Virtual Network Computing) interface, a
graphical desktop sharing system that uses RFB protocol to remotely
control the instrument.

"SSH" activates access via SSH (Secure Shell), a network protocol for
secure data communication.

"HTTP" activates access via HTTP (Hyper Text Transfer Protocol), the appli-
cation protocol for hypermedia information systems.

"FTP" activates access via FTP (File Transfer Protocol), used to transfer
files from a host to the instrument and vice versa.

"SMB (Samba)"
activates access to SMB (Server Message Block), used for providing
shared access to files, printers and serial ports of a network.

"Avahi (Zeroconf)"
activates Avahi, a service for automatic configuration of the instru-
ment in a network environment.

"Software Update"
allows updating the instrument firmware via the LAN interface.
For more information on this topic see the release notes of the instru-
ment, provided on the Internet at the download site or the Rohde &
Schwarz Signal Generator home page.
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USB Storage
Activates the access to external USB storage media.

This setting has no effect on a mouse or a keyboard, connected via USB.

Note: The setting will not be assigned until you enter the Security Password and con-
firm with Accept.

Write Nonvolatile Memory
Acitivates write protection on the file system to prevent modification or erasure of val-
uable data.

Note: The setting will not be assigned until you enter the Security Password, confirm
with Accept, and reboot the instrument.

Annotation Frequency
Enables/disables the display of the currently used frequency in the header of the
instrument.

Note: The setting will not be assigned until you enter the Security Password and con-
firm with Accept.

Remote command:
:DISPlay:ANNotation:FREQuency on page 291

Annotation Amplitude
Enables/disables the display of the currently selected level in the header of the instru-
ment.

Note: The setting will not be assigned until you enter the Security Password and con-
firm with Accept.

Remote command:
:DISPlay:ANNotation:AMPLitude on page 290

User Interface

Allows you to lock the manual of the controls of the instrument, and to hide even the
entire display.

The setting requires the entry of the security password 723456 and is only accepted
after the "Accept" button is pressed.

Tip: Section "Enabling a locked user interface for manual operation" on page 119
describes how you can unlock the control elements and the user interface.

"Enabled" Enables the display and all controls for the manual operation of the
instrument.

"VNC Only" Locks the keys at the front panel and externally connected keyboard
and mouse.

The display on the screen remains and shows the current settings
and changes.
Unlocking is possible via VNC or turning off and on again.
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"Display only"
Locks the manual operation of the instrument. The display on the
screen remains and shows the current settings and changes.
This security feature protects the instrument against unauthorized
access, but still shows the current settings and processes, for exam-
ple when you operate the instrument via remote control.

The function disables:
® the keys at the front panel of the instrument
® the external mouse and keyboard

The instrument indicates the locked controls by a padlock & softkey
in the taskbar.

"Disabled" Locks the display and all controls for the manual operation of the
instrument.
This security feature protects the instrument against unauthorized
reading and access, for example when you operate the instrument via
remote control.

The function disables:

e the display

® the keys at the front panel of the instrument
® the external mouse and keyboard

The screen shuts off and shows a padlock instead.

Remote command:

:SYSTem:ULOCk on page 437
:SYSTem:DLOCk on page 436
:SYSTem:KLOCk on page 436

Enabling a locked user interface for manual operation

To unlock the user interface for manual operation you have the following options:

® On the instrument's keypad or external keyboard, enter the security password
123456.
Even if you press any key, the instrument prompts you to enter the security pass-
word for unlocking.

Security password to unlock
[

ok | cancel |

Note The character of the first key you pressed is immediately added in the input
field. Prior to inserting the password delete this entry.

® |n remote control mode, send the command SYST:ULOC ENABled to release all
locks at once.
Alternatively, you can use the command SYST:KLOC OFF to unlock the keyboard,
or SYST:DLOC OFF to release the display.
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Via remote control, there is no password required.

Remote command:

:SYSTem:ULOCk on page 437
:SYSTem:DLOCk on page 436
:SYSTem:KLOCk on page 436

Security Password
Enters the password that is required to enable or to disable the settings protected by a
security password. Default is '123456'.

Note: It is highly recommended that you to change the default security password
before connecting the instrument to the network.

All settings are only accepted after the "Accept" button is pressed.

Accept
Applies the modified settings, provided the security password is entered correctly.

Note: This action can not be undone. Keep in mind, that a changed password is never
reset, even if you perform a factory preset.

Bluetooth Pin
Sets the Bluetooth pin of an external Bluetooth device. The pin is required to enable
remote control via an external Bluetooth device.

Requires a Bluetooth adapter (recommended extra, see data sheet) .

Save/Recall

The "Save/Recall" submenu can also be called up with the FILE key and is therefore
described in the section of this key (see Chapter 5.2.8, "Storing and Loading Instru-
ment Data - File Key", on page 126).

Factory Preset

The "Factory Preset" dialog provides a function to reset the instrument's settings to
their factory state. This function is activated by pressing the "Execute Factory Preset"
button.

Factory Preset

Execute Factory Preset

Resets instrument to factory configuration.
Security settings and user data are not effected.

Factory Preset
Reset the instrument's settings to their factory state.

Note: "Factory Preset" resets the "Remote Channel" and network settings to the
default values.

Executing "Factory Preset" via remote control terminates the connection to the instru-
ment, if these settings had been configured to values different to the default ones.
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The factory preset function resets nearly all instrument settings. In addition to the regu-
lar preset by means of the PRESET key, a "Factory Preset" resets also the following
values:

Reference frequency settings ("Ref Oscillator" menu)

Power on settings ("Level/EMF" menu)

Network settings including hostname ("Setup" menu)

Remote channel settings including GPIB address ("Setup" menu)

Start/Stop display update ("Setup" menu)

Display and keyboard settings ("Setup" menu).

To maintain security, password settings and all settings protected by these passwords
like disabled USB and LAN connections are not changed.

Not affected by the "Factory Preset" are also user data, lists or instrument settings
files, created for example by means of the Save/Recall function.

Remote command:
:SYSTem: FPReset on page 285

Help

The "Help" dialog offers comprehensive online help for the R&S SMB. A desired topic
can be selected via the table of contents (select "Manual") or the index (select "Index").

For context-sensitive information about a marked parameter, press the HELP key. For
a description of the "Help" menu, refer to the section covering to the HELP key (see
Chapter 5.2.7, "Help System - Help Key", on page 125).

Switching to Manual Control - Local Key

The local key switches from remote control to manual control (local state).

In remote control mode the instrument indicates the remote state in the display header.
The rest of the display remains unchanged and shows the current instrument status,
that means the status which exists under the remote control settings. The instrument
can be operated (for example dialogs can be opened). However, it is not possible to
enter or change values.

The status message additionally indicates whether the LOCAL key is disabled or
enabled.

The following states are indicated:

e "REMOTE"
The LOCAL key switches the instrument from remote control to manual control.
The current command must be fully processed before the mode is switched, other-
wise the instrument switches immediately back to remote control.

e "REM-LLO"
The LOCAL key is locked, inititated by the sLLO (local lockout) command. The
instrument can be switched from remote state to local state only via remote control,
for example with &GTR or the Visual Basic command CALL IBLOC
(generator%). The LOCAL key has previously been locked by the remote com-
mand &LLO.

e
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When switching from remote to manual control, the display update function is automati-
cally deactivated ("SETUP" > "Start/Stop Display Update" > "Off").

5.2.5 Generating a Hard Copy of the Display

The save/recall function enables you to store the settings in a file. In addition, you can

create a hard copy of the current display to save the most important settings of a per-
formed signal generation in an image file.

5.2.5.1 Hard Copy Settings

Creating a hardcopy of the display requires that you have an external keyboard con-
nected to the instrument.

> To access the dialog, use the key combination CTRL+Z, or CTRL+Y depending on
the used keyboard settings.

Hatd Copy

Destination | File
[Format  [JPG ;“
Automatic Naming M

Options... [

I fush/sdal/smb20081127000.jpg
Save I

The dialog contains the parameters for configuring the output format and location
of a hardcopy.

The remote commands required to define the hard copy settings are described in
Chapter 7.8, "HCOPy Subsystem", on page 294.

Destination
Indicates that the hardcopy is stored in a file (see also "File Options" on page 123).

Remote command:
:HCOPy:DEVice on page 295

Options

Opens the "Hardcopy Options" dialog for configuring the corresponding parameters
(see "File Options" on page 123.

Remote command:
n.a.

File

Some configuration parameters are already offered in the Hardcopy dialog. All configu-
ration parameters are available in "File Options" on page 123.
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Automatic Naming
Activates automatic generation of the file name. Automatic naming is configured in the
"Options..." sub dialog , see "File Options" on page 123.

Remote command:
:HCOPy:FILE[:NAME] : AUTO:STATe on page 301

File Info

Indicates the file name. The file name can be entered either manually via the file man-
ager (button "File...") or generated automatically (Automatic naming checkbox). Auto-
matic naming is configured in the "Options..." submenu.

Remote command:
:HCOPy:FILE [ :NAME] on page 296
:HCOPy:FILE[:NAME] : AUTO: FILE? on page 297

5.2.5.2 Hardcopy Options

This section describes the "Hardcopy Options" dialog.

————— Image
Format [PNG ~||Size [4807272 ~]

Automatic Naming
Automatic Naming ¥ On

Path_. | INar."user
Delete All Image Files In Path Clear Path |

Prefix ¥ On |sgll

Year ¥ On Month ¥ On Day W On
Current Auto Number W
Resulting File Name

Isg_... png

File Options

Dialog for setting the file parameters.

"Format" Selects the output file format, for example * . bmp,
*.Jjpg*.xpm*.png.

Remote command:

:HCOPy: IMAGe : FORMat on page 301

:HCOPy:DEVice:LANGuage on page 296

"Automatic If enabled, creates the output filenames automatically according to
Naming" rules following the activated components.
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"Path..." Selects the directory.

Note: To select the destination path, you have to specify a file name
as well. Otherwise an error message is displayed and the selection is
canceled.

Directory, path and file name are displayed in the infoline right to the
"Path" button.

Remote command:
:HCOPy:FILE[:NAME] : AUTO: DIRectory on page 297
:HCOPy:FILE[ :NAME] : AUTO? on page 297

"Clear Path" Deletes all image files with extensions bmp, img, png, xpm and csv
in the directory set for automatic naming.
Before deleting the image files a warning message is displayed
requiring the confirmation.

Remote command:
:HCOPy:FILE[:NAME] : AUTO:DIRectory:CLEar on page 297

"Prefix, Year, Determines the rules for "Automatic Naming".

Month, Day" Per default, the automatically generated file name is composed of:
<Path>/<Prefix><YYYY><MM><DD><Number>.<Format>, where
Y, M and D mean Year, Month, Day; Number is the "Current Auto
Number".
You can deactivate/activate each component separately.
The "Resulting File Name" indicates the current file name syntax.

Remote command:

:HCOPy:FILE[:NAME] :AUTO[:FILE] : PREFix:STATe on page 300
:HCOPy:FILE[:NAME] : AUTO[:FILE] : PREFix on page 300
:HCOPy:FILE[:NAME] :AUTO[:FILE] : YEAR: STATe on page 300
:HCOPy:FILE[:NAME] : AUTO[:FILE] :MONTh:STATe on page 299
:HCOPy:FILE[:NAME] : AUTO[:FILE] : DAY : STATe on page 298

"Current Auto  Indicates the number which is used in the automatically generated file
Number" name.

Note: When initially switching on the instrument the number is reset
to the lowest possible value. Starting with number 0 the output direc-
tory is scanned for already existing files. As long as files with the
same name are existing the number is increased by 1. The number is
automatically set so that the resulting file name will be unique within
the selected path. The current number is not in the save/recall file but
will be temporarily stored within the database. At following save oper-
ations the number is increased.

Remote command:
:HCOPy:FILE[:NAME] : AUTO[:FILE] : NUMBer? on page 299

"Resulting File Indicates the automatically generated file name.
Name"

Remote command:
:HCOPy:FILE[:NAME] : AUTO: FILE? on page 297



General Instrument Settings

Save
Stores the hardcopy.

Remote command:
:HCOPy [ :EXECute] on page 296

5.2.6 Messages - Info Key

The INFO key opens a window containing a detailed description of every message dis-
played in the info bar, see Chapter 4.2.3, "Info Window", on page 69 and Chapter 9,
"Status Information, Error Messages and Troubleshooting”, on page 481.

5.2.7 Help System - Help Key

The HELP key opens a browser window containing a context-sensitive description of
the highlighted parameter.

elp - State )]
Contents Index Back =
Instrument Function > Modulations =

Amplitude Modulation (AM) > Amplitude

Modulation Menu > State

State

Activates/deactivates AM modulation.

SCPI command: =

[:S0URce<hw>]:AM:STATe LI

The context-sensitive page which is opened with the HELP key is part of a comprehen-
sive help system. It is possible to move from this context-sensitive page to any page of
the help system. The following navigation aids are available:

® |[nternal links in the text
They open pages which are directly linked to the described function. In this way it
is possible, for example, to call up the description of the GPIB command for any
particular function.

® Back
The "Back" button calls up the page last viewed.

® Contents in the navigation panel
The contents list is used to open the individual help pages. It has a hierarchical
structure. The highlighted line indicates where the currently displayed page is
within the contents list.

® Index in the navigation panel
The index is used to call up all pages which contain the selected entry. The index
has an alphabetical structure and also contains all GPIB commands.

® Find
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The find function allows you to look for freely selectable terms in all help pages. A
list of the pages containing the entered term is displayed as the search result. The
search can be limited to words in the page title to increase the number of hits.

Storing and Loading Instrument Data - File Key

The R&S SMB allows complete instrument settings to be stored in files either on the
internal flash memory or on external USB memory devices.

Defined and complex instrument settings can then be reproduced at any time by load-
ing this data. If required, these settings can be loaded to various signal generators.

The corresponding menu is available under "Save/Recall" in the "Setup" menu. The
instrument settings are saved in files which can be stored in data directories.

Additionally there are intermediate memories in which the current instrument setting
can be stored and then called up again by just pressing a key. This provides fast
switching between different instrument settings.

Only settings which differ from the preset values and configuration data for the operat-
ing elements (e.g. window positions) are stored. As a result the files remain relatively
small. Furthermore, instrument settings can easily be transferred between different
equipped signal generators since the files contain only relevant information. When loa-
ded, the referenced settings are implemented and all non-referenced parameters are
set to the associated preset values.

If list data is part of the instrument settings, e.g. a list of user correction data, a refer-
ence to this list is stored, not the list itself. The list is reactivated when the associated
settings are loaded, but the list may have been modified or deleted in the meantime or
may not be available on a different instrument. If the list has been modified, the new
entries will be used. An error message appears if an attempt is made to access a non-
existing list or to activate settings which are not supported by the instrument.

® Network settings and remote settings are not saved and restored.

® | ists are stored and loaded in the appropriate menus. For example, the user cor-
rection data list is created and stored in the "User Correction" menu.

When loading an instrument setting, it is possible to select whether the current fre-
quency and level setting is to be retained or whether the stored settings are to be acti-
vated. It is possible to delete stored instrument settings. A file can be copied by loading
it with "Recall" and then storing it under a new name.

Settings can be transferred easily between instruments with different equipment
options and/or firmware versions because only the settings which differ from the preset
values are affected. When settings are loaded, only those which are possible on the
instrument are implemented. Error messages indicate the settings which cannot be
implemented.

The stored file is transferred from one instrument to another using the memory stick.

| —
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General file management functions such as copying and moving data are available in
the "File Manager" dialog.

5.2.8.1 Save/Recall Menu

The settings available in the File menu "Save/Recall" depend on the operation selected
under "Select Operation".

Select Operation Save T

For more information, see Chapter 4.7.1, "File Select Dialog", on page 84.

Select Operation
Selects the file function.

Accesses the settings for storing ("Save") and loading ("Recall") of the instrument set-

tings.

"Save..." Calls the menu for storing the current instrument setting (see Chap-
ter 5.2.8.2, "Storing Instrument Settings", on page 127).

"Recall..." Calls the menu for calling up a stored instrument setting (see Chap-

ter 5.2.8.3, "Loading Instrument Settings", on page 128).

5.2.8.2 Storing Instrument Settings

If "Save" is selected under "Select Operation”, the File menu provides options for stor-
ing the current instrument setting in a file.

Save/Recall

®E3
Select Operation ISa\re vI Recentﬁlesl

Mvarfuser/Lists/SavRcl
by o )

@ LevelCalData
& LfGenCalData

=G R J
g SynCalibData -

File Name:

presetsettings |

Save Save File
Irmm 1 Imm 2 Mar...

Save

Recent files
Displays the files last used.

Directory, File List and File Name

Note:

You access this generic standard function each time you perform one of the following:
® store or load (settings) files

® define a folder these files are to be stored in or

® navigate through the file system.
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The name of the dialog is context sensitive but the provided functions are self-explana-
tory and very similar.

With the provided settings, you can perform the following:

® {o navigate through the file system, use the directory tree

® toload and store files, use the dedicated functions "Select", "Save" and Recent
files

® {o perform standard file management functions, like create new directories, move,
copy, delete files and/or directories, use the standard "File Manager" function (see
"File Manager" on page 128).

Remote command:

to list all files in a directory:

:MMEMory:CDIRectory on page 306
:MMEMory:CATalog? on page 306

[:SOURce] : CORRection:CSET:CATalog? on page 329

Save
Stores the current instrument settings under the specified path.

Remote command:
*SAV on page 283
:MMEMory: STORe : STATe on page 311

Save Immediate x
Stores the current instrument setting in one of the three intermediate memories.

These instrument settings are retained until a different instrument setting is stored in
the intermediate memory. When the instrument is switched off, the contents of the
intermediate memories are retained.

Remote command:
*SAV on page 283

File Manager
Accesses the "File Manager" dialog, see Chapter 5.2.8.4, "File Manager",
on page 130.

Remote command:
n.a.

5.2.8.3 Loading Instrument Settings

If "Recall" is selected under "Select Operation”, the "File" menu provides options for
loading complete instrument settings. Here it is possible to select whether the current
or stored frequency and level settings are to be used.
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SaveRecall = E

Select Operation IRecaII v| Recent files |

fvar/user/Lists/SavRc|
- @ DME B
@ LevelCalData
@ LfGenCalData
& R

. .08 Suntalibnata ||
Exclude Frequency™ Exclude Level ™
Recall Recall Recall File
Irmm 1 Imim 2 Magr...
Recent files

Displays the files last used.

Directory, File List and File Name

Note:

You access this generic standard function each time you perform one of the following:
® store or load (settings) files

e define a folder these files are to be stored in or

® navigate through the file system.

The name of the dialog is context sensitive but the provided functions are self-explana-
tory and very similar.

With the provided settings, you can perform the following:

® {o navigate through the file system, use the directory tree

® {oload and store files, use the dedicated functions "Select", "Save" and Recent
files

® to perform standard file management functions, like create new directories, move,
copy, delete files and/or directories, use the standard "File Manager" function (see
"File Manager" on page 128).

Remote command:

to list all files in a directory:

:MMEMory:CDIRectory on page 306

:MMEMory:CATalog? on page 306

[:SOURce] :CORRection:CSET:CATalog? on page 329

Exclude Frequency
The current frequency is retained when a stored instrument setting is loaded.

Remote command:
[ : SOURce<hw>] : FREQuency [ :CW|FIXed] : RCL on page 342

Exclude Level
The current level is retained when a stored instrument setting is loaded.

Remote command:
[ :SOURce<hw>] : POWer [:LEVel] [ : IMMediate] : RCL on page 380

Recall
Load the selected configuration.
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If an instrument setting in which a sweep was activated is stored, the sweep is started
when the recall command is called.

If an instrument setting which accesses lists is stored, this list is also loaded.

If the list has been deleted in the meantime, an error message appears when the
instrument setting is loaded. If the list has been overwritten in the meantime, the new
entries will be used.

Remote command:
:MMEMory: LOAD: STATe on page 309
*RCTL on page 282

Recall Immediate x
Loads the selected configuration from one of the three intermediate memories.

If an instrument setting in which a sweep was activated is stored, the sweep is started
when the recall command is called.

If an instrument setting which accesses lists is stored, this list is also loaded.

If the list has been deleted in the meantime, an error message appears when the
instrument setting is loaded. If the list has been overwritten in the meantime, the new
entries will be used.

A message appears if no instrument configuration is stored in this memory.

Remote command:
*RCTL on page 282

File Manager
Accesses the "File Manager" dialog, see Chapter 5.2.8.4, "File Manager",
on page 130.

Remote command:
n.a.

File Manager

The "File Manager" is a tool very similar to a standard Windows Explorer and helps
you manage mass storage media and files stored on the R&S SMB.
You can perform the following tasks:

® Copying multiple files from disk to other media and vice versa, see Chapter 5.2.8.5,
"Accessing the File System of the Instrument and Transferring Files from and to
the Instrument”, on page 132

® Copying files into another directory, see Copy and Paste
® Renaming and deleting files, see Rename and Delete
® Creating new directories on the follwoing drives:

— hard disk

— internal flash memory

— memory stick

See Create New Directory
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age =1 E3
File Type Instrument State (* savrcltxt) -

fvarfuser/Lists/SavRq Al Files (")
T o yreat Instrument State (. savreltxt)

-3 DME ARB Waveform (*.w)
(3 Levelcalp| NRP Setting (*.nrp)
(3 LiGenCall] List Mode List (*.1sw)

! & Rt All Files (™
E| 'Q SavRel
5 SynCalibData
Cut | Copy | Paste |
Rename | Delete | Create New Dir |

For more information, see Chapter 4.7.2, "File Manager", on page 85.

File Type
Selects the file type to be listed. If you select a file type with a specific file extension,
only files with this extension are listed in the directory.

Remote command:
n.a.

Directory and File Name

Selects the directory in which the file to be deleted or copied is located. The dialog lists
all files in this directory. Selected files are highlighted. The path is indicated above the
directory window.

Unlike the "Save/Recall" and "File Select" dialogs, the "File Manager" displays the full
file names including extensions.

Remote command:
:MMEMory:CDIRectory on page 306

Cut
Cuts the selected file. It can be pasted into a different directory using the "Paste" but-
ton.

Remote command:
:MMEMory: DELete on page 309

Copy
Copies the selected file. It can be pasted into a different or the same directory using

the "Paste" button. When pasting the file into the same directory file name
Copy of <file name> is given automatically. When pasting the file into a different
directory, the original file name is kept.

Remote command:
:MMEMory: COPY on page 307

Paste
Pastes the file that has been copied or cut before.

Remote command:
n.a.
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Rename
Renames the selected file or directory. The new name can be entered in the "New File-
name" dialog.

Remote command:
:MMEMory : MOVE on page 310

Delete
Deletes the selected file. Before the file is deleted, a message appears prompting the
user to confirm deletion of the file.

Remote command:
:MMEMory:DELete on page 309

Create New Directory
Creates a new directory. The name of the new directory can be entered in the "New
Directory" dialog.

Note: When the subdirectory is entered, it is possible to enter an absolute path name
(e.g. /var/MEAS) or the path relative to the current directory (e.g. . . /MEAS).
The directory is created as a subdirectory in the selected level.

Remote command:
:MMEMory:MDIRectory on page 310

5.2.8.5 Accessing the File System of the Instrument and Transferring Files from and to
the Instrument

To access files and the file system of the instrument or to use the general file manage-
ment functions such as copying and moving data, use the standard "File Manager" dia-

log.
To transfer files from and to the instruments or to exchange files, use one of the follow-
ing alternatives:

® Connect a memory stick to one of the USB interfaces.
The instrument recognizes automatically a connected memory stick.

® Connect the instrument to a LAN.
For information on how to set up a LAN connection, refer to Chapter 2.6, "Setting
Up a Network (LAN) Connection", on page 34.

An instrument connected to a LAN supports the standard file transfer methods from
a remote client:

— FTP (file transfer protocol)
see "To access the file system of the R&S SMB via ftp" on page 133

— File sharing according to the SAMBA/SMB (server message block) protocol
see "To access the file system of the R&S SMB via SMB (Samba)"
on page 134

Both file transfer methods access the folder /var/user/share.

This section provides an introduction to this topic. For comprehensive information, refer
to the Application Note 1GP72 "Connectivity of Rohde&Schwarz Signal Generators".
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To access the file system of the R&S SMB via ftp

If the R&S SMB is connected to a LAN and the required configurations are completed,
you can use File Transfer Protocol (ftp) to access the file system and to transfer files
from and to the instrument.

1. Connect the instrument and the remote PC to a LAN.

2. Find out the "IP Address" of the instrument:
a) Select "Setup > Environment > Network Settings".
b) Write down the "IP Address" of the instrument, e.g. 70.713.710.105.
3. On the remote PC, start the Windows Explorer.
4. Inthe address field, enter ftp://<"IP Address" of the Instrument>,e.g.
ftp://10.113.10.105
A log on dialog opens and requests a password.

Tip: Default password. The FTP file access use the user instrument with default
password instrument.

It is highly recommended that you change the user password in the "Security" dia-
log before connecting the instrument to the network!

See Chapter 5.2.3.18, "Security", on page 114.

5. Enter the password to access the /var/user/share directory.

File Edit “iew Faverites Tools Help
>

Qs - @ F F| Do

Address |E§I ftp://10.113. 10, 105/ v| Go
MName = Size | Type

[Cbin File Folder

File Folder

= il ] B

User: instrument ."3 Local intranet

You can access the files in the /var/user/ directory, perform standard function
like creating directory, etc.

Open the /var/user/share directory and create a new directory, e.g. testftp.

On the instrument, press the FILE key and open the /var/user/share directory.

The dialog displays the testftp dircetory.
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&4 Save/Recall

Select Operation IReu:aII vl Recent ﬁlesliI
d: fearfuser/share
=-"q wvaruser/share |
itestftn
Ji |
Exclude Frequency ™ Exclude Lavel I_Z|
Recall Recall Recall Recall File
FLd Irrirm 1 [ 2 [ 3 Manager...

To access the file system of the R&S SMB via SMB (Samba)

The SMB (Samba) protocol is an alternative way to access the file system of the instru-
ment form a remote PC, if both the instrument and the PC are connected to a LAN.

1. Connect the instrument and the remote PC to a LAN.

2. Find out the "IP Address" of the instrument:

a) Select "Setup > Environment > Network Settings".
b) Write down the "IP Address" of the instrument, e.g. 70.7113.70.105.

3. On the remote PC, start the Windows Explorer and open the "Map Network Drive"
dialog.
a) Select a valid "Drive", e.g. W.
b) In the "Folder" field, enter:
//<"IP Address" of the Instrument>/share or
//<"Hostname" of the Instrument>/share, e.g./10.113.10.105/share
c) Select "Finish".

A log on dialog opens and requests an user name and a password.

4. Enter the user name and the password of your instrument.
The default user name and password is instrument.

Tip: Default password. The SAMBA/SMB file access use the user instrument with
default password instrument.

It is highly recommended that you change the user password in the "Security" dia-
log before connecting the instrument to the network!

See Chapter 5.2.3.18, "Security", on page 114.

The /var/user/share directory of the instrument is mapped to and displayed as
a network drive of the remote PC.

You can access the files in this directory, perform standard function like creating
directory, storing files, etc.
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5.3 RF Block

5.3.1

5.3.1.1

Overview of RF Signal

Settings for the RF output signal and analog modulation are made under "RF Signal".
These settings can be accessed in the block diagram by way of the "RF" function
block, or by means of the menu with the same name which is opened using the MENU
key.

The function block is available for the basic unit (R&S SMB + frequency option) without
additional equipment options.

RF Output

Basically, the RF output signal is deactivated. The previous state is restored, when the
signal is reactivated.

Activating RF Signal Output

If the settings for the RF signal are done, you can activate RF signal output via:
® the RF ON/OFF key (the current entry focus is irrelevant)
® the checkbox in the "RF" block (see "RF On" on page 135)

® the "RF Frequency > RF ON" checkbox in the RF block (see "RF Output State"
on page 136).
To open the menu, select the "Configure" button in the RF block.

The current state of the RF output (activated and deactivated) is indicated in the block
diagram by means of the different block color and the status of the "On" checkbox.

An active sweep is also indicated in the block.

RF
config... I RF RF
I_ On @" e

To query the impedance of the RF outputs, use the command : OUTPut<hw>:
IMPedance? on page 314.

RF On
Activates RF signal output.

This function corresponds to the RF ON /OFF key.
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See also Chapter 5.3.1.1, "RF Output", on page 135.

Remote command:
:OUTPut<hw>[:STATe] on page 314

RF Output State
Activates the RF output signal by selecting the RF checkbox in the "Configure" dialog
of the "RF" block.
—RF Frequency

W REON
Frequency / Phase...

Remote command:
:OUTPut<hw>[:STATe] on page 314

5.3.1.2 RF Signal Modes and Characteristics

e Cw
The RF signal is generated with the set frequency and level. This is the default
mode.

® Sweep

The RF signal is generated as a sweep with the set parameters.
It is not possible to activate frequency, level and LF sweep simultaneously.

® List Mode
The RF signal is generated on the basis of a list of predefined frequency and level
values. The duration of the individual steps can be predefined.

Instruments connected downstream can be taken into consideration when setting the
frequency and level by entering a frequency and/or level offset.

Automatic level control ("ALC") ensures maximum level accuracy.

User-specific lists which contain level correction values for any frequency range ("User
Correction") can be created to, for example, compensate the cable attenuation in a test
assembly setup.

The R&S SMB generates the RF signal in unmodulated or analog form. The signal
generator is equipped therefore with the following sources for analog modulations:
® aninternal LF generator

® an internal pulse generator

® the external modulation inputs MOD EXT and PULSE EXT.

An external trigger signal for the sweeps and the LIST mode can be provided at the
INST TRIG input.

The input REF IN is used to input an external instrument reference, and the output
REF OUT serves as the output of the reference frequency (internal or external).
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5.3.2.1

RF Block

RF Frequency

The value of the RF frequency is displayed in the header of the display ("Freq"). This
field provides the direct input of the RF frequency. Alternatively, you can enter the RF
frequency in the "Frequency/Phase" dialog.

Freq(RFON J(C_MODON ) Level

[1.000 000 000 000/ etz ~1[-30.00]éem -]

Note that the displayed RF frequency in the header, and the RF output frequency,
entered in the "Frequency/Phase" dialog can be different, as explained in the following
section.

RF Frequency vs. RF Output Frequency

If you are working with a downstream instrument, e.g. a mixer or a frequency multiplier,
you can enter the related parameter value in the frequency settings dialog ("Offset",
"Multiplier").

The generator includes these parameters and displays the result in the "Freq" field in
the status bar, as if the downstream instrument and the generator were one unit. This
displayed frequency corresponds to the value at the RF output of the downstream
instrument. However, the frequency provided at the RF output of the signal generator
corresponds to the frequency value set in the "Frequency/Phase" dialog.

The instrument activates the "Freq Offset" icon in the status bar, when a frequency off-
set or multiplication factor is set.

The correlation between the RF frequency, the RF output frequency and the frequency
offset is as follows:

"Freq" (in header) = "RF output frequency" (Frequency in dialog) * "Multiplier" factor
(Multiplier in dialog) + "Freq offset" (Offset in dialog)

Downstream instrument:
- frequency offset / multiplication factor
- "Offset""Multiplier" in the settings dialog

RF output (downstream instrument)

connector frequency

"Freq" in the display of the signal generator
(status bar)

Mixer/Multiplier |——»

RF output:
- connector frequency
- "Frequency" in the settings dialog

If you have the R&S SMB equipped with one of the microwave frequency options
R&S SMB-B112, -B120, or -B140, you can, in addition, operate an R&S SMZxx fre-
quency multiplier.

xx represents the multiplier type that you can use according to the target frequency
range.
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5.3.2.2 Setting the RF Frequency

To change the RF frequency, press the FREQ key and enter the desired frequency.
Changes to the RF frequency have an immediate effect (without confirmation with the
ENTER key) on the output signal.

RF Freq
Enters the RF frequency, considering the frequency offset.

Note: The SCPI command sets the level of the "Freq" display, that means an entered
frequency offset and multiplier factor are considered in the frequency value.

Remote command:
[ : SOURce<hw>] : FREQuency [ :CW|FIXed] on page 341

5.3.2.3 RF Frequency Dialog

The combined "RF Frequency / Phase..." dialog contains the parameters required for
configuring the frequency and settings like a frequency offset, or a multiplier factor of
an externally connected multiplier, see Chapter 5.3.2.4, "Frequency Settings",

on page 138.

RF Frequency / Phase 3
Frequency Settings

|»

Frequency |  403.000 000 000 |MHz x|
Offset | 0.000fHz ~|
Multiplier I 1.000
—— User Variation =
Variation Active r
Variation Step | 1.000 000 000 |MHz x|
Phase Settings ——
Delta Phase | D.Dldeg j
Reset Delta Phase Display —
l e
Furthermore, the dialog provides additional settings parameters which are described
in:

® Chapter 5.3.3, "Phase", on page 140

5.3.2.4 Frequency Settings

P Prequency ——]  Access:
i RF ON
Frequency / Phase... » Select "RF > config... > RF Frequency > Frequency/Phase".
Frequency Settings
Frequency | 1.000000 000 000 |GHz x|
Offset | 0.000|Hz ~|
Multiplier I 1.000

In the upper section of the combined "RF Frequency / Phase ..." settings dialog,
you can configure the frequency of the RF signal.
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The remote commands required to define the settings are described in Chapter 7.13.4,
"SOURce:FREQuency Subsystem"”, on page 340.

Frequency

Sets the RF frequency of the RF output connector. The frequency entered and dis-
played here corresponds to the frequency at the RF output, that means any offset entry
is not considered.

Note: Suppressed values in the status bar

For security concerns or certain operating modes you can hide the frequency and level
display in the status bar.
L4 I***************IGHZJ I*****IdEm J

The display has been disabled for security reasons, see Annotation Frequency and
Annotation Amplitude.

The display is disabled when list mode is running, see "State - List Mode"
on page 189.

Remote command:

[ :SOURce<hw>] : FREQuency [ :CW|FIXed] on page 341

Note: This command sets the frequency of the "FREQ" display, that is the frequency
containing offset and multiplier.

Offset
Sets the frequency offset relative to the RF frequency. The frequency offset of a down-
stream instrument (for example a mixer) is entered.

The entry does not change the value of the RF frequency at the RF output. It only
changes the RF frequency displayed in the display header. The value of the RF fre-
quency in the header corresponds to the frequency at the output of the downstream
instrument, see also Chapter 5.3.2.1, "RF Frequency vs. RF Output Frequency",

on page 137.

Remote command:
[ :SOURce<hw>] : FREQuency: OFFSet on page 344

Multiplier
Sets the multiplication factor for the RF frequency.

In the frequency field of the status bar, the instrument adjusts its frequency display
according to the set multiplication factor. This frequency value shows the frequency at
the output of the downstream multiplier. The entry does not change the RF frequency
at the RF output of the R&S SMB, see also Chapter 5.3.2.1, "RF Frequency vs. RF
Output Frequency", on page 137.

Remote command:
[ :SOURce<hw>] : FREQuency:MULTiplier on page 344
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5.3.2.5 User Variation Settings

Access:

» Select "RF > config... > RF Frequency > Frequency/Phase".

e E T ——————
Variation Active Il
Variation Step | 1.000 000 000 | MHz |

The combined "RF Frequency / Phase ..." settings dialog contains the parameters
determine the step size for adjusting the frequency with the rotary knob.

Variation Active
Activates the user-defined step width used when varying the frequency value with the

rotary knob.

"ON" The frequency value set with the rotary knob is varied using the user-
defined step width which is entered under "Variation Step".

"OFF" The frequency value set with the rotary knob is varied in steps of one

unit at the cursor position (standard operating mode).

Remote command:
[ : SOURce<hw>] : FREQuency: STEP: MODE on page 347

Variation Step

Sets the user-defined step width. This step width is used when entering the RF fre-
quency using the rotary knob. Frequency variation with this step width must also be
activated with "Variation Active".

Remote command:
[ : SOURce<hw>] : FREQuency:STEP [ : INCRement] on page 346

5.3.3 Phase

The phase of the RF output signal can be changed in the "Phase Settings" section of
the "RF Frequency/Phase" dialog.

5.3.3.1 Phase Settings

[“;*F O ] > To access the dialog for configuring the phase settings, perform one of the follow-
ing:

e Select "RF > config... > RF Frequency > Frequency/Phase".
e Press the MENU key and select "RF > RF Frequency > Frequency/Phase".
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The combined "RF Frequency / Phase ..." settings dialog contains the parameters
to configure the phase settings of the RF signal.

The remote commands required to define the settings are described in Chap-
ter 7.13.10, "SOURce:PHASe Subsystem", on page 372.

Delta Phase

Sets the phase of the RF signal. The current phase of the signal is used as the refer-
ence. This function allows, for example, the phase of the output signal to be synchron-
ized with the phase of a signal from a second signal generator.

Remote command:
[ : SOURce<hw>] : PHASe on page 372

Reset Delta Phase Display
Resets delta phase value. The set phase is adopted as the new current phase, i.e. the
delta phase value is reset to 0.

Remote command:
[ :SOURce<hw>] : PHASe :REFerence on page 373

5.3.4 Reference Oscillator

The R&S SMB is equipped with an internal reference oscillator that generates a refer-
ence frequency of 10 MHz. It is used as internal reference source for the synthesizer
and the local oscillator. Alternatively, you can apply an external reference signal.

Regardless of the used reference source (internal or external), the R&S SMB always
provides the configured reference frequency at the output. You can use it, for example
to synchronize several interconnected instruments.

6 The settings of the reference oscillator are not affected by an instrument preset ("PRE-
SET" key).

The following examples briefly explain the possible test setups and the settings to be
considered.

e Internal f.; = 10 MHz (10 MHz REF OUT)

Rohde & Schwarz Signal Generator Measurement
= Instrument
= =
®1OMHZ 10 MHz © o Z10 MHz 3
Internal i i o .
Reference iz = i

\J
REF IN

RE

JRF 1

Figure 5-1: Synchronizing a subsequent instrument using the internal 10 MHz reference signal of
the R&S SVB

The internal reference oscillator supplies the reference frequency.
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Settings:
— Source: "Internal"

® External f4 =10 MHz (10 MHz REF OUT)

If you have a clean external reference signal with 10 MHz frequency, you can
directly pass it to the output. The signal quality remains the same.

Measurement
Instrument

- ;10 MHz

=ni

o

REF OUT
Iy

_10 MHz External Reference

-
!—Reference Frequency Source !
| (Rohde & Schwarz Spectrum |
| Analyzer, for example)

|
e e———

Figure 5-2: Synchronizing instruments by means of an externally applied reference signal having
10 MHz

Settings:
— Source: "External”
— External Reference Frequency: "10 MHz"

Set the additionally provided parameters, as for example the synchronization band-
width according to the requirements of the application.

® External f,; = 5/10 MHz (5/10 MHz REF OUT)
If you have an external reference signal with 5 or 10 MHz, you can directly pass it
to the output. The signal quality remains the same.

Measurement
Instrument

f
5, 10 MHz o

REF IN

REF OUT

!_Reference Frequency Source |
| (user test system for example)

Figure 5-3: Synchronizing a subsequent instrument an externally applied reference frequency of
5or 10 MHz

Settings:
— Source: "External"
— External Reference Frequency: "5 or 10 MHZz"
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Input and output connectors of the reference frequency

The appropriate connectors are located at the rear panel, see "REF IN" on page 24
and "REF OUT" on page 24.

5.3.4.1 Reference Oscillator Settings

RF Frequency

To access the settings dialog for configuring the reference signal, perform one of the
Frequency / Phase fO“OWing:

Reference Oscillatar,

® |n the block diagram, select "RF > config... > RF Frequency > Reference Oscillator"
® Press the MENU key and select "RF > RF Frequency > Reference Oscillator"
® Press the SETUP key and select "Setup > System > Reference Oscillator"

Reference Oscillator { Reference Oscillator {
Source Internal = Source External =
i Deactivate RF Output
) . Adjustment ————— (if external reference is missing) L
s I External Reference Frequency |1 0 MHz "I
Adjustment DAC Value 476 o . -
Synchronisation Bandwidth |W|de "I

In the "Reference Oscillator Settings" dialog, you can select the signal source and fre-
quency to be used as the reference frequency, and determine a user-defined adjust-
ment value.

The remote commands required to define the reference oscillator settings are descri-
bed in Chapter 7.13.14, "SOURce:ROSCillator Subsystem"”, on page 405.

Source
Selects the source of the reference frequency.

See Chapter 5.3.4, "Reference Oscillator”, on page 141, which provides an overview of
the different test scenarios for configuring the reference frequency.

"Internal” Uses the internal 10 MHz reference signal, either with the calibrated
or a user-defined adjustment value.

"External" Uses an external reference signal.
The frequency of the external reference signal must be selected
under "External Reference Frequency" on page 144.

Remote command:
[:SOURce] :ROSCillator:SOURce on page 407

Deactivate RF Output (if external reference is missing)
Turns the RF output off when the external reference signal is selected, but no signal is
supplied.

This function prevents that no improper RF signal due to the missing external refer-
ence signal is used for measurements. A message indicates that the external signal is
missing and the RF output is deactivated.

This setting is not affected by a reset.
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Remote command:
[:SOURce] :ROSCillator:EXTernal :RFOFf[:STATe] on page 406

External Reference Frequency
Determines the frequency of the external reference signal.

You can select an external reference signal having a frequency of 5 MHz or 10 MHz.

Note: The installed hardware determines the available settings. Use the Hardware
Config dialog to check the hardware the instrument is equipped with.

For information on the required hardware revision, refer to the release notes.

Remote command:
[:SOURce] :ROSCillator:EXTernal : FREQuency on page 405

Synchronization Bandwidth
Selects the synchronization bandwidth for an external reference signal.

"Narrow" Synchronization bandwidth is 50 Hz.

"Wide" The synchronization bandwidth is approximately 350 Hz.
This mode is useful for very precise reference sources of high spec-
tral purity.

Remote command:
[:SOURce] :ROSCillator:EXTernal : SBANdwidth on page 406

Adjustment Active
Selects the adjustment mode.

"OFF" Uses the calibrated internal reference frequency.

"ON" Allows you to apply a deviation to the internal reference frequency,
according to your requirements. To enter the value, use Adjustment
DAC Value.

Remote command:
[:SOURce] :ROSCillator[:INTernal] :ADJust [:STATe] on page 407

Adjustment DAC Value

Sets a user-defined deviation for the internal reference frequency. This value takes
effect when it is activated with Adjustment Active. "0" represents the calibrated state.
The setting range depends on the reference oscillator type and its factory calibration
value.

Note: A factory preset resets this setting to the calibration value of the instrument.

Remote command:
[:SOURce] :ROSCillator[:INTernal] :ADJust:VALue on page 406
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5.3.5.1

RF Block

RF Level

Overview of RF Level

i

Message "Level overrange/underrange"

If this message appears in the status line, the set level ("Level") is out of range (see
data sheet).

In this case, the signal level at the output can deviate from the set value.

Level

[-30.00]¢en -]

The value of the RF level is displayed in the level field in the header of the display
("Level"). This field provides the direct input of the RF level value. Alternatively, you
can enter the level in the "Level/EMF/..." dialog.

Note that the displayed RF level in the header, and the RF output level, set in the
"Level/EMF" dialog can be different, as explained in the following section.

RF level vs. RF output level

If you are working with a downstream instrument, e.g. an attenuator or ampilifier, you
can enter the related parameter value in the level settings dialog ("Offset").

The generator includes these parameters and displays the result in the "Level" field in
the status bar, as if the downstream instrument and the generator were one unit. This
displayed level value corresponds to the value at the RF output of the downstream
instrument. However, the level provided at the RF output of the signal generator corre-
sponds to the level value set in the "Level/EMF/..." dialog.

The instrument activates the "Level Offset" icon in the status bar, when a level offset is
set.

The correlation is as follows:

"Level" (in header) = "RF output level" (Level in menu) + "Level offset" (Offset in menu)

Downstream instrument:
- level offset
- "Offset" in the settings dialog

RF output:
Attenuation/gain - level at the connector
- "Amplitude" in the settings dialog

RF output (downstream instrument)
- ouiput level
- "Lev" in R&S signal generator's display (status bar)

The RF output is protected against overloading by an external signal applied to the RF
output (see Chapter 5.3.5.7, "Reverse Power Protection”, on page 165).

Setting the RF level

To change the RF level, press the LEVEL key and enter the desired level. Changes to
the RF level have an immediate effect (without confirmation with the Enter key) on the
output signal.
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RF Level

Enters the RF level, considering the level offset (see "RF level vs. RF output level"
on page 145).

dBm, dBuV, mV and pV can be used as the level units. The four unit keys are labeled
with these units.

Note: The SCPI command sets the level of the "Level" display, i.e. an entered level off-
set is considered in the level value.

Remote command:
[ :SOURce<hw>] : POWer [:LEVel] [ : IMMediate] [ :AMPLitude] on page 379

5.3.5.2 RF Level Dialog

Access:

» Select "RF > config... > RF Level > Level/Attenuator".

RF Level /| EMF x
——— Level Settings
Mode |Mormal |

Amplitude I —3D.DD|dBr‘r‘| vl
Limit I SD.DﬂldBm vl
Offset I [J.[J[JIdB vl

Ignore Level Range Warnings [~ On

Attenuator Settings

Mode I.ﬂtuto "I

Fixed Range (PFPY In-
4865 .. | -2965 dBm

RF OFF Mode IFuII.ﬂLﬂenuation vI

UserVariation
Variation Active

r
“ariation Step I 1.DD|dB "I

Power-On / EMF Settings

Power-0On State IFEF off vl

Display Level as Voltage of EMF - [

Ext Level Adjustment
Adjustment Data Factory -

The offset-free level, level offset and level limit are set in the top section of the dia-
log. The attenuator mode is set in the "Attenuator Settings" section.

In section "User Variation", you can determine the step size for adjusting the level
with the rotary knob (with "Variation Active On").

The power-on behavior of the instrument and the level display in the display
header are set in the "Power-On / EMF Settings" section (see Chapter 5.3.5.3,
"Power-On/EMF Settings", on page 151).

The remote commands required to define the settings are described in Chap-
ter 7.13.12, "SOURce:POWer Subsystem", on page 376.
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Level Settings

The offset-free level, attenuation mode, level offset and level limit are set in the top
section of the dialog.

If you have the instrument equipped with a harmonic filter, you can also configure the
filter.

RF Mode
Selects the level mode for signal output.

This function allows you, to optimize the RF output signal for applications, where
improved harmonic suppression or a low Signal-to-Noise ratio is required.

Note: The modes "Low Distortion" and "Low Noise", for improving harmonic suppres-
sion or the S/N ratio require that an attenuator is fitted.

"Normal" The generator provides an RF output signal with high signal to noise
ratio as well as low distortion, according to the data sheet.

"LOW Noise" This setting forces the generator to optimize the signal to noise ratio.

"LOW Distortion"
The generator reduces distortion (harmonics) of the RF signal.

Remote command:
[ : SOURce<hw>] : POWer : LMODe on page 381

Amplitude
Sets the RF level of the RF output connector.

The level entered and displayed here corresponds to the level at the RF output, that
means any offset entry is not considered.

Note: Suppressed values in the status bar

For security concerns or certain operating modes you can hide the frequency and level
display in the status bar.
L4 ***************IGHZJ I*****Idﬁm J

The display has been disabled for security reasons, see Annotation Frequency and
Annotation Amplitude.

The display is disabled when list mode is running, see "State - List Mode"
on page 189.

Remote command:

[ :SOURce<hw>] : POWer : POWer on page 383

Note: The SCPI command [ : SOURce<hw>] : POWer [ :LEVel] [ : IMMediate] [ :
AMPLitude] sets the level of the "Level" display, that is the level containing offset.

Limit - RF Level
Sets an upper limit for the RF output power.

You can use it to protect your DUT from damage due to high input power. If you enter
an RF level above this value, the instrument limits the output power to this specified
value, and generates a warning message.
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However, the level indication in the status bar is not affected.

Note: The limit value is always effective, regardless of whether you work with "NRP-Z
Power Control" or not.

The value is not affected by an instrument preset (PRESET key), *RST and the "Save/
Recall" function. It is influenced only by the Factory Preset and the factory value is
equal to maximum level.

Remote command:
[ :SOURce<hw>] : POWer:LIMit [ :AMPLitude] on page 380

Offset (Level)
Sets the level offset relative to the RF level.

The level offset of a downstream instrument (for example an attenuator or amplifier) is
entered.

The entry does not change the value of the RF level at the RF output. It only changes
the RF level displayed in the display header. The value of the RF level in the header
corresponds to the level at the output of the downstream instrument.

Remote command:
[ : SOURce<hw>] : POWer [:LEVel] [: IMMediate] : OFFSet on page 379

Ignore Level Range Warnings

Suppresses warnings the instrument generates when either the level, or the PEP value
are out of range. This function prevents automated measurements from being stopped
due to a level warning.

The following warnings are suppressed in both, the history and in the error queue:

® [ evel overrange / level underrange

® PEP value greater than defined upper bound / PEP value less that defined lower
bound (fix range)

Remote command:
[ :SOURce] : POWer : WIGNore on page 381

Low Harmonic Filter Settings

In 20 GHz or 40 GHz instruments (option R&S SMB-B120(L) /-B140(L)), you can install
a low harmonic filter (option R&S SMB-B25 /-B26), to improve the harmonic perform-
ance.

See the website http://www.rohde-schwarz.com/product/smb100a.html or the data-
sheet for more information on the options available according to the features of your
instrument.

For a fitted low harmonic filter, you can define its operating mode in section "Low Har-
monic Filter" of the "RF Level / EMF" dialog. Otherwise, the section is hidden.

> To access the filter settings, select "RF > Config > RF Level > Low Harmonic Fil-
ter".

Lowe Harmanic Filter

Maode IManuaI vl

State on =
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Mode
Selects between automatic or manual switching of the filter.
"Auto" The filter switches automatically on and off, according to the given

operating conditions. It is active within a certain frequency and level
range and automatically turns off, if the frequency falls below the
lower limit, or the level exceeds the upper limit.

The corresponding limit values are given in the data sheet.

Note: The State field shows the current state of the filter.
"Manual” In this mode, you can switch the filter individually.

Remote command:
:OUTPut<hw>:FILTer:AUTO on page 313

State
Switches the filter in manual mode.

Note: If you work in the "Auto" Mode, this parameter shows the current state of the fil-
ter. If you then change the state, the operation mode automatically turns to manual
operation.

Remote command:
:OUTPut<hw>:FILTer [:LPASs] :STATe on page 313

Attenuator Settings

The R&S SMB can be configured to provide level settings without interruption. It is pos-
sible for instruments with or without step attenuator. The attenuator mode is set in the
"Attenuator Settings" section of the "RF level / EMF" dialog.

Attenuator Mode
Sets the attenuator mode at the RF output.

"Auto" Standard mode.

"Fixed" When this operating mode is switched on, the attenuator, relays and
amplifier stages are fixed in their current positions to provide level
settings without interruption. The resulting variation range is defined
and displayed under "Attenuator Fixed Range".

Note: The function is effective when automatic level control is activa-
ted ("ALC State = On").

If the normal variation range is overranged or underranged, level
errors increase considerably and the warning "Level under/over-
range" appears in the info line. The spectral purity of the output signal
decreases with high attenuation.

Remote command:
:OUTPut<hw>:AMODe on page 313

Fixed Range (PEP) In

Displays the level range in which the level is set without interruption for the "Attenuator
Mode fixed" setting.
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Remote command:
:OUTPut<hw>:AFIXed:RANGe:UPPer? on page 312
:OUTPut<hw>:AFIXed:RANGe:LOWer? on page 312

RF OFF Mode
Selects the attenuator mode, when the RF signal is switched off.

The setting of the RF OFF mode is not affected by an instrument preset (PRESET
key), *RST and the "Save/Recall" function. This parameter is influenced only by the
Factory Preset.

"Unchanged" Freezes the setting of the attenuator when RF is switched off. The
attenuator is only activated when RF is switched on.
This setting is recommended if a constant VSWR (Voltage Standing
Wave Ratio) is required.
Furthermore, on instruments equipped with a mechanical attenuator,
it provides fast and wear-free operation.

"Full Attenuation"
Sets attenuation to maximum when the RF signal is switched off. This
setting is recommended for applications that require a high level of
noise suppression.

Remote command:

[ : SOURce<hw>] : POWer : ATTenuation:RFOFf :MODE on page 378

User Variation

If the level is set using the rotary knob, the step width is defined in the "User Variation"

section.

Variation Active
Activates the user-defined step width used when varying the level value with the rotary

knob.

"ON" The level value set with the rotary knob is varied using the user-
defined step width which is entered under "Variation Step".

"OFF" The level value set with the rotary knob is varied in steps of one unit

at the cursor position (standard operating mode).

Remote command:
[ :SOURce<hw>] : POWer: STEP:MODE on page 386

Variation Step
Sets the user-defined step width for entering the RF level using the rotary knob. Level
variation with this step width must also be activated with "Variation Active".

Remote command:
[ : SOURce<hw>] : POWer: STEP [ : INCRement ] on page 386

External Level Adjustment

The external level adjustment provides information about the data that has been used
for calibrating the RF level.
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By default the instrument uses correction data obtained in the factory before delivery.
In exceptional cases, you can determine the calibration values with an R&S NRP
power sensor, and use these values for the external level correction. This feature is a
protected function (see Service Manual, chapter 2, "Adjustment").

Adjustment Data
Indicates what data has been used for level calibration.

Remote command:
:CALibration<hw>:LEVel:EXTern:DATA on page 287

Power-On/EMF Settings
The power-on behavior of the R&S SMB and the level display in the display header are
set in the "Power-On / EMF Settings" section of the "RF Level/EMF" dialog.

To open the "RF Level/EMF" dialog, select "RF > Configure > EMF" or use the MENU
key under "RF".

Power-On / EMF Settings

Power-On State IPre\ﬂ'ous Setting v|

Display Level as Voltage of EMF (I

Power-On State - RF Signal
Selects the state which the RF output is to assume after the instrument is switched on.

"RF Off" The output is deactivated when the instrument is switched on.

"Previous Set- When the instrument is switched on, the output assumes the same
ting" state as it had when the instrument was switched off.

Remote command:
:OUTPut<hw>[:STATe] : PON on page 315

Display Level as Voltage of EMF - RF Level
Activates display of the signal level as voltage of the EMF (no-load voltage). If this set-
ting is deactivated, the level is displayed as a voltage over a 50 Ohm load.

Note: This setting is not affected by an instrument preset (PRESET key), *RST) or the
"Save/Recall" function. Only the Chapter 5.2.3.20, "Factory Preset", on page 120
resets the setting.

Remote command:
[ :SOURce<hw>] : POWer :EMF: STATe on page 378

Automatic Level Control - ALC

Your signal generator is equipped with an automatic level control unit to obtain best RF
level accuracy.

Automatic Level Control (ALC) is an adaptive control system to stabilize the RF output
level. It continuously monitors the current level and adjusts it to keep a steady state
over temperature and time.
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mode excludes ALC, as the control loop would detect incorrect values and result in

6 ALC is active in almost all applications by default. However, the Pulse Modulation
level deviations.

Also note that ALC may detect incorrect values in multi-transmitter test setups. If mul-
tiple generators are coupled, reverse power may affect the ALC readings. Based on
incorrect values, ALC would have an impact on the signal to intermodulation ratio.

ALC States

The following description basically explains the ALC states and their principle of opera-
tion. In particular ALC OFF (Sample & Hold) gives an overview on the function in
terms of the equipment of the generator.

The R&S SMB offers the ALC states:

e AUTO

automatically adjusts the output level to the operating conditions.
e On

enables ALC permanently, regardless of the currently selected mode.
o Off

deactivates ALC.

The instrument switches to Sample & Hold (S&H) state, which still allows to main-
tain a constant output level.

The following section explains the functionality of "Sample & Hold", to provide an over-
view and to indicate what is to be considered. "On" and "Auto" require no additional
explanation. Furthermore, find the ALC state settings described in detail in State - ALC.

ALC OFF (Sample & Hold)

In "S&H" mode, the signal generator switches for a short period of time into CW mode
and activates ALC. ALC adjusts the level to the set value and the generator holds the
value (freeze). Then, the generator switches ALC off again and back to the operating

mode.

RF output behavior during Sample & Hold depends on the configuration of your instru-
ment. Instruments equipped with...:

® an electronic step attenuator
The level is decreased by 30 dB.

® amechanical step attenuator
By default, the mechanical step attenuator is not switched during S&H cycles to
optimize the settling time. The instrument provides the output power for 3 ... 5 ms.
However, you can affect the attenuation at the output by the setting "RF during
Power Search" to "Minimum", see RF During Power Search - ALC. Then the gen-
erator decreases the level by 30 dB with the mechanical attenuator. Note that this
may take a certain period of time.
High frequency instruments, such as the R&S SMB with one of the high frequency
options R&S SMB-B120 or R&S SMB-B140, are equipped with a mechanical step
attenuator.

® no step attenuator
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The signal generator outputs the set level for 3 to 5 ms after level or frequency set-
ting during a Sample & hold measurement.

Instruments equipped with one of the options R&S SMB-B112L, R&S SMB-B120L
or R&S SMB-B140L come without step attenuator.

The level control status is permanently displayed as a status message in the info line.

| ALC-Auto Infa

Automatic Level Control Settings

RF Level

e 10 Open the "Automatic Level Control" dialog, select "RF" > "Configure" > "Automatic
famestamEael | evel Control" or use the MENU key under "RF".

The combined dialog "ALC / UCOR" is divided into the several sections and provides
access to the "Automatic Level Control" settings and to function "User Correction", see
Chapter 5.3.5.6, "User Correction", on page 158).

‘Automatic Level Control
State On o

Rf During Power Search |Normal 8

Search Once ]

State - ALC
Activates/deactivates internal level control.

"Auto" The instrument selects the most appropriate ALC mode automati-
cally.
ALC is on in most operating conditions. Default state.

"On" Activates ALC, regardless of the operating conditions.

"Off (Sample & Hold)"
Deactivates internal level control.
Sample & hold closes the level control loop at every frequency and
level change for a short period of time. The level control voltage is
sampled and then clamped.

Remote command:
[ : SOURce<hw>] : POWer :ALC[: STATe] on page 377

RF During Power Search - ALC
Activates the mode for the mechanical step attenuator and for output during ALC
power search.

"Normal" The RF output is active during power search.
"Minimum" The RF output is inactive during power search.

Remote command:
:OUTPut<hw>:ALC:SEARch:MODE on page 312

Search Once - ALC

Forces the generator to execute level adjustment once, although the "Sample & Hold"
mode is active.
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Remote command:
[ : SOURce<hw>] : POWer : ALC: SONCe on page 377

5.3.5.5 NRP-Z Level Control

With the NRP-Z Level Control function, you can achieve a very stable and accurate RF
power supplied to your DUT. With the aid of a downstream control circuit, a CLPC
(Closed Loop Power Control), you can detect frequency response characteristics of the
used components, such as losses due to cables, modules or components like power
amplifiers, and compensate these effects accordingly.

Example: How to set up a closed loop power control

R&S SMB100A Signal
Generator g,

- Amplifier DuUT Antenna
‘g _RF level ™ xdB | inputlevel
L~ Coupler |
R&S NRP-Zxx
Power Sensor
target level
S Parameter (optional)

power controf

Figure 5-4: Example of a test setup with NRP-Z Level Control

As shown in the example, the sensor measures a proportional power in defined time
intervals, derivated from a coupler. It considers optionally given S-parameters and
returns the results to the generator. The signal generator compares the measured level
with the set value and adjusts its output level accordingly.

This allows you to control the external signal level continuously and reliably reach a
constant input level at the DUT in real time.
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6 Impact of the NRP-Z Level Control and the Operating Modes

Since the frequency and level of the RF output signal are continuously adjusted during
"NRP-Z Level Control", this operating mode interferes those with varying frequency
and level values.

The reason is, that the generator regularly transmits the output frequency to the con-
nected R&S NRP-Zxx power sensor, which in turn requests the signal generator to
adjust the output level according to its measurement. In contrast to this real time con-
trol loop, for example the list operating mode already generates the RF output signal
on previously optimized frequency and level value pairs. In this case, the "NRP-Z Level
Control" as a second control loop would impact the already determined RF signal val-
ues and also considerably slow down the measurement. Similar impacts occur in
sweep mode, and also the "NRP-Z Power Viewer" and "NRP-Z Level Control" affect
each other's functionality.

Hence, the operating modes exclude each other as follows:

® "NRP-Z Level Control" automatically disables NRP-Z Power Viewer, and vice
versa.

® Activating the RF frequency sweep, RF level sweep or the list mode instantly deac-
tivates a running "NRP-Z Level Control".

® A running list or RF sweep mode blocks "NRP-Z Level Control". It can not be acti-
vated.

Also keep in mind that modulated signals may differ from CW signals regarding mean
power and peak power. This affects the operation of "NRP-Z Level Control".

NRP-Z Level Control Settings

RF Level » To access the dialog for configuring the level control settings, perform one of the

Level § Attenuatar. i
Autamatic Level Cantrol f0||0W|ng:

MNRP-Z Level Control...
Yeer Correction.. e Select "RF > config... > RF Level > NRP-Z Level Control".
e Press the MENU key and select "RF > RF Level > NRP-Z Level Control".

B NRP-2 Level Control (REJNM =] [

|1 NRP-Z81 5N 800004 =l

= |
Measured Level -54.53 dBm

Zero |
Target Level mm
RfLevelLimit [ 30.00[dBm <]
Catch Range +- lﬁlﬂ
Delay Time I—Dm

Use Peak Power [~ On

Use SParameter [~ On

The dialog contains all parameters for configuring the settings for level control test
setup.

The remote commands required to define these settings are described in Chap-
ter 7.13.12, "SOURce:POWer Subsystem", on page 376
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Sensor
Selects the R&S NRP-Z power sensor for power control.

Note: In remote control, the sensors are set up using the SENSe commands. The
remote measurement is triggered by the READ query which also provides the measure-
ment results.

The software version of the connected power sensor can be retrieved by means of the
remote control command : SENS: POW: TYPE?.

Use the "Setup >" Chapter 5.2.3.5, "NRP-Z Info/Update", on page 97 dialog to update
the sensor software.

Remote command:
[ :SOURce<hw>] : POWer:SPC:SELect on page 384

State
Activates power control using the selected sensor.

The control loop periodically adjusts the generator output. After switching off, the run-
ning loop is completed.

Remote command:
[ :SOURce<hw>] : POWer:SPC:STATe on page 385

Measured Level
Indicates the current reading of the sensor.

Zero - Power Sensors
Activates the auto zero function.

Zeroing calibrates the external power sensor by adjusting its reading at zero signal
power. For this purpose, the RF power source must be switched off or disconnected
from the sensor. If a Rohde & Schwarz power sensor receives an input power during
the zeroing process, it aborts zeroing and generates an error message. Zeroing takes
a few seconds, depending on the sensor model. Refer to the documentation of your
power sensor for more information.

Tips for zeroing

When to perform zeroing:

® During warm up after switching on or connecting the instrument

After a substantial change of the ambient temperature

After fastening the power sensor module to an RF connector at high temperature

After several hours of operation

When low-power signals are to be measured, e.g. less than 10 dB above the lower

measurement limit.

e Switch off the RF power source for zeroing, but do not disconnect it from the power
sensor. This proceeding keeps the thermal equilibrium, and the zeroing process
also compensates the noise that superimposes the measured signal (e.g. from a
broadband amplifier).

Remote command:
:SENSe<ch>[:POWer] : ZERO on page 324
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Target Level

Specifies the nominal level expected at the input of the sensor. The signal generator
adjusts the output power accordingly, in order to meet the target value at the sensor
input, and thus the power required at the DUT.

Remote command:
[ :SOURce<hw>] : POWer:SPC:TARGet on page 385

Limit - RF Level
Sets an upper limit for the RF output power.

You can use it to protect your DUT from damage due to high input power. If you enter
an RF level above this value, the instrument limits the output power to this specified
value, and generates a warning message.

However, the level indication in the status bar is not affected.

Note: The limit value is always effective, regardless of whether you work with "NRP-Z
Power Control" or not.

The value is not affected by an instrument preset (PRESET key), *RST and the "Save/
Recall" function. It is influenced only by the Factory Preset and the factory value is
equal to maximum level.

Remote command:
[ :SOURce<hw>] : POWer:LIMit[:AMPLitude] on page 380

Catch Range +/-
Sets the capture range of the control system.

Within the range:
Target Level +/- Catch Range

the power control locks and tries to achieve the target level. Readings outside the
range are not considered.

Remote command:
[ :SOURce<hw>] : POWer: SPC: CRANge on page 383

Delay Time
Defines a waiting period between the level adjustment of the generator and the next
measurement of the power sensor.

With this parameter, you compensate any dead times in the controlled system.

Remote command:
[ :SOURce<hw>] : POWer:SPC:DELay on page 384

Use Peak Power
Activates control by means of the peak power values, provided the power sensor sup-
ports this function. Otherwise, the dialog does not show this parameter.

Remote command:
[ :SOURce<hw>] : POWer: SPC: PEAK on page 384

Use SParameter - Power Sensors

Activates the use of the S-Parameter correction data of the connected power sensor.
For sensors with attenuator this checkbox is automatically checked.



R&S®SMB100A

Instrument Function

5.3.5.6

RF Level
Lewel / Attenuatar.
Automatic Level Control...
MNRP-Z Lewvel Contral
User Carrection

Refer to the manual of the connected R&S NRP-Zxx power sensor for a description on
how to use the SParameter table.

Remote command:
:SENSe<ch>[:POWer] : CORRection:SPDevice: STATe on page 317

User Correction

The "User Correction" function is used to create and activate lists in which level correc-
tion values predefined by the user are freely assigned to RF frequencies. Correction is
performed by the user-defined table values being added to the output level for the
respective RF frequency.

With frequencies which are not contained in the list, the level correction is determined
by interpolation of the closest correction values.

The lists are created in the "List Editor". Each list is stored in its own file with the prede-
fined file extension * . uco. The name of the User Correction file can be freely
selected. The files are loaded from the "Lists..." file manager. Externally created tables
with pairs of frequency and level values can be converted into User Correction files
using the import function. The external files must have the file extension * . txt or

* _csv. These file formats are provided e.g. by the Microsoft Excel program. The sepa-
rators for table columns and for decimal floating-point numerals can be set. In addition,
internally created User Correction data can be exported into ASCII files using the
export function.

The amplitude can also be linearized automatically by means of an R&S NRP power
sensor connected to one of the generator output signals. With the aid of the "Fill with
Sensor" function, a table with correction values for external test assemblies can be
automatically determined, e.g. for compensating the frequency response of cables.
The User Correction list with the correction values acquired by the sensor is generated
in the "Edit User Correction List" menu. The correction values can be acquired any
time irrespective of the modulation settings of the generator.

If user correction is activated, the "UCOR" display (User Correction) is shown in the
header together with the "Level" display. The RF output level is the sum of both values.

"Level" + "UCOR" = Output level

If activated, user correction is effective in all operating modes.

User Correction Menu

To open the "User Correction" menu, select "RF > Configure > User Correction" or use
the MENU key under "RF".

The combined menu "ALC/UCOR" is divided into the several sections.

User Correction Settings

The "User Correction" settings are set in the most lower section of the combined dia-
log; this section is used to activate/deactivate user correction, and to create, select and
activate the lists.

| —
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The upper section provides access to the automatic level control settings, see Chap-
ter 5.3.5.4, "Automatic Level Control - ALC", on page 151.

User Correction Seftings——

User Correction I 0.00 dB

User Cor. Data... | ucaor
Edit User Cor. Data... |

ImportExpart == |

State - User Correction
Activates/deactivates user correction.

The "UCOR" status message appears in the frequency and level display.

Remote command:
[ :SOURce<hw>] : CORRection[:STATe] on page 336

User Correction Value - User Correction
Indicates the current value for level correction.

Remote command:
[ :SOURce<hw>] : CORRection:VALue? on page 336

User Cor. Data - User Correction
Calls the "File Select" menu for selecting and creating a list or the "File Manager".

Select User Correction Data
MNew User Correction Data
File Manager...

Remote command:

[ :SOURce] :CORRection:CSET:CATalog? on page 329

[ :SOURce<hw>] : CORRection:CSET[:SELect] on page 335
[:SOURce] :CORRection:CSET:DELete on page 331

Edit User Cor. Data - User Correction
Calls the editor for editing the selected user correction list.

A list consists of any number of frequency/level value pairs. The currently selected list
is displayed.

Each list is saved as a separate file with extension * . uco. The file name and the direc-
tory to which the file is saved are user-selectable.

Note: Save list only after filling both columns (frequency and level), otherwise the
entries are lost.
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=[S

Frequency/Hz Power/dB|
R 5 300 000.00 540
72 6 300 000.00 4.73

8 7 300 000.00 415 ‘I
9 B 300 000.00 3.72

10 9300 000.00 328 =]
Goto || Edt |  sae |

"Frequency /
Hz"

"Power/dB"

"Goto"

llEditll

"Insert Row"

"Insert Range

"Fill...."

Enters the frequency to which the level correction value applies.

Note: The "Fill..." function allows to automatically enter any number
of frequencies with freely selectable range and increment.

Using the "Fill With Sensor" function of the "Edit" sub menu requires
only the entry of the frequency values. The level values are automati-
cally acquired by the connected power sensor.

Enters the level correction value to which the specified frequency
applies. The values can be entered manually or automatically with the
"Fill With Sensor" function (available in the "Edit" sub menu).

Selects row for editing.

Goto First
Goto Last
Goto Row...

If Goto row is selected, a window opens for entering the requested
row.

0K | Cancel |

Calls a selection of possible actions described below.

Insert Row
Insert Range...
Fill...

Fill With Sensor...
Delete Row
Delete Range...

Insert a new row before the marked row.

Insert new rows before the marked row. The number of rows to be
inserted can be defined in an entry window.

IRnws to Insert I I

OK | Cancel |

Opens a sub menu for defining a set of list values to be automatically
entered in the ucor list (see "Filling the Correction List automatically"
on page 162).
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"Fill With Sen-  Calls the menu to activate the filling of the user correction list with
sor" level values acquired by the selected power sensor (see "Filling the
Correction List with Power Sensor Measurement Data"
on page 164).

"Delete Row" Deletes the marked row.

"Delete Allows to delete any number of rows starting with the marked row.
Range..." The number of rows to be deleted can be defined in an entry window.
IRuws to Delete | | I
OK | Cancel |
"Save" The list is saved under its current name.

Remote command:

[ : SOURce<hw>] : CORRection:CSET[:SELect] on page 335

[ :SOURce<hw>] : CORRection:CSET:DATA: FREQuency on page 330
[ : SOURce<hw>] : CORRection:CSET:DATA: POWer on page 330

Import/Export

User correction list can be imported from externally created files or exported into text or
CSV-files. The import/export settings are available after clicking the "Import/Export"
button.

Import/Export >>>
Expands the menu with the area for import and export of user correction files.

Externally edited Excel tables with any number of frequency/level value pairs can be
imported as text or CSV-files and used for user correction.

Conversely, you can also export internally created user correction lists as text or CSV-
files.

=== Hide Imporb'Exportl == Hide |mp0rL|'Export|

Import / Export UCOR Files ———Impaort/Export UCOR Files
hiode fimport ~ ode [Export 'li

ASCII File Settings ASCIIFile Settings

Extension ITXT l Extension ITXT l

=B Paint M Decimal Point |Point [
Column Separator IComma :I' Column Separator IComma l

Select ASCIl Source | Select ASCII Destinatiolj
Mone

Select Destination | Select Source |
Mone

-
-
-

Mone

Mone

&I Expaort |

Mode - User Correction
Selects if user correction lists should be imported or exported. The settings offered
depend on the selected mode.

Remote command:
[ : SOURce<hw>] : CORRection:DEXChange : MODE on page 334
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Extension - User Correction
Selects the file extension of the ASCII file to be imported or exported. Selection "TXT"
(text file) or "CSV" (Excel file) is available.

Remote command:
[ : SOURce<hw>] : CORRection:DEXChange:AFILe:EXTension on page 332

Decimal Point - User Correction
Selects the decimal separator used in the ASCII data between '.' (decimal point) and ',
(comma) with floating-point numerals.

Remote command:
[ :SOURce<hw>] : CORRection:DEXChange:AFILe:SEParator:DECimal
on page 333

Column Separator- User Correction
Selects the separator between the frequency and level column of the ASCII table the
user correction list is exported to or imported from.

Remote command:
[ :SOURce<hw>] : CORRection:DEXChange:AFILe:SEParator:COLumn
on page 333

Select ASCII Source / Destination - User Correction
Calls the "File Manager" for selecting the ASCII file to be imported into a user correc-
tion list (source) or the ASCII file the user correction list is exported (destination) in.

Remote command:
[ : SOURce<hw>] : CORRection:DEXChange:AFILe: SELect on page 332

Destination / Source - User Correction
Calls the "File Manager" for selecting the user correction list to be exported (source)
into an ASCII file or the destination for the ASCII file to be imported (destination) in.

Remote command:
[ : SOURce<hw>] : CORRection:DEXChange: SELect on page 335

Import / Export - User Correction
Starts the export or import of the selected file.

When import is selected, the ASCII file is imported as user correction list.
When export is selected, the user correction list is exported into the selected ASCII file.

Remote command:
[ : SOURce<hw>] : CORRection:DEXChange:EXECute on page 334

Filling the Correction List automatically

The "Fill Table" menu enables you to automatically set the level correction values.
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Fill User Correction Data

From |—1
Range |—3
Select column to fill IW
Start Value | 0.00 [Hz =]
End Value | 0.000 000000000 [Hz =]
Increment Value | 0.000 000 000 000 [Hz x|

The start line and the number of rows to be filled are defined under "From" and
"Range."

The column to be filled is selected under "Select column to fill". Depending on the
selection here, the default for start, end, and increment value are set. As the settings
are interdependent, a change of one parameter may result in the automatic change of
one or more of the other parameters. The filling of the column with the selected value
settings is started with button "Fill".

6 The correction list entries are only computed when the "Fill" button is pressed.

From
Sets the start value of the index range.

Remote command:
n.a.

Range
Sets the range for filling the table.

Remote command:
n.a.

Select column to fill
Selects either the frequency or the level column to be filled with the value defined
below.

Remote command:
n.a.

Start value
Sets the start value for the frequency or the level entries.

Remote command:
n.a.

End value
Displays the end value for the frequency or the level entries.

Remote command:
n.a.
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Increment value
Sets the increment for the frequency or the level entries.

Remote command:
n.a.

Fill
Fills the selected column in the set range with values, starting with the start value and
using the set increment.

Remote command:
n.a.

Filling the Correction List with Power Sensor Measurement Data

The level correction values for the user correction list can be acquired by means of
R&S NRP power sensors. The R&S NRP sensors are connected to either the
SENSOR connector or to one of the USB interfaces. Configuration of the connection is
performed in the "Power Sensor" menu (see Chapter 5.3.6.1, "NRP-Z Power Viewer",
on page 166). The filling of the user correction list with measurement data is per-
formed in the ucor list editor (see "Edit User Cor. Data - User Correction"

on page 159).

In the editor, the frequencies for which the correction values are to be acquired are
entered in the frequency column (either manually or by means of the "Fill..." menu).

there are no entries for the level column also. In the following these entries are auto-

ﬁ Do not save the list at this point, because the frequency entries are lost as long as
matically acquired by the connected power sensor.

All level correction values for the given frequency values are measured using the
Power Sensor and automatically filled in the selected list after the "Execute" button is
pressed. The list is automatically stored and recalled again after filling.

Fill User Correction Data with Sensor Settings

The "Fill with Sensor" button of the "Edit User Correction Data" menu opens the asso-
ciated menu.

Sensor |1 -MNRP-Z11 SiM 900001 -
List Ta Fill Id:.l!.lselCumacidea

— Used SMB Settings For Measurement—

Modulation Off (CW)
Amplitude -30.00 [dBm «
Use SParameter Off

Attenuator Mode Auto -
Fixed Range (PEF) In
|5980,0 60000 dBm

This dialog describes all parameters for filling a table automatically with sensor read-
ings.
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To select the sensor and determine its parameters, refer to Chapter 5.3.6.1, "NRP-Z
Power Viewer", on page 166.

To fill the table, press the "Execute" button.

Fill User Correction Data with Sensor
Enables you to fill the table with correction data acquired by a connected power sensor
from Rohde & Schwarz.

"Sensor" Displays connected sensors for selection.
"List To Fill" Indicates the used list file.

"Include Zeroing"
Performs a zeroing procedure before acquiring the user correction
data to improve precision. Since during zeroing no signal may be
applied to the sensor, RF is temporarily switched off at the generator.
When unchecked, the zeroing procedure is skipped. The RF signal
level might be blanked shortly. This setting is recommended if blank-
ing of RF is undesirable or the absence of power at the sensor can
not be guaranteed.

"Execute" Performs automatic filling of the list, provided a sensor is detected
and the user correction list contains at least one frequency value.

Remote command:

[ : SOURce<hw>] : CORRection:ZERoing:STATe on page 336

[ : SOURce<hw>] : CORRection:CSET:DATA[ : SENSor<ch>] [ : POWer] : SONCe
on page 331

Used SMB Settings for Measurement
Displays the settings relevant for the measurement.

"RF Source" Shows the path for which the correction menu settings are made.
"Modulation" Indicates the modulation state
"Amplitude" Shows the currently set level.

"Use SParameter"
Indicates whether SParameter correction is used.

"Attenuator Mode"
Displays the selected mode of the attenuator.

"Fixed Range (PEP) In:"
Shows the level range.

Remote command:
n.a.

5.3.5.7 Reverse Power Protection

The reverse power protection prevents against overload by an external signal applied
to the RF output of the R&S SMB.
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protection as standard. For instruments equipped with frequency option R&S SMB-
B112 or R&S SMB-B112L a reverse power protection option R&S SMB-B30 is availa-
ble. Refer to the data sheet for additional information and the respective option.

6 The R&S SMB equipped with frequency options up to 6 GHz includes a reverse power

The reverse power protection is tripped when the power of the external signal becomes
too high. A relay opens and interrupts the internal connection to the RF output. This
condition is indicated in the display header by the "OVERLOAD" status message.

Overload
If an "Overload" status message is indicated in the display header, reset the overload
protection by pressing the RF ON/OFF key.

The RF input is activated when the overload protection is reset.

Remote command:
:OUTPut<hw>:PROTection:TRIPped? on page 314
:OUTPut<hw>:PROTection:CLEar on page 314
:OUTPut<hw>[:STATe] on page 314

5.3.6 RF Measurement

5.3.6.1 NRP-Z Power Viewer

The R&S SMB features the power viewer function for measuring or monitoring either
the RF output power, or a freely selectable signal source with R&S NRP-Z power sen-
SOrs.

The instrument can perform up to 4 power measurements simultaneously.

To connect the sensors you have the following options:

® connect the sensor directly at a USB connector
To connect a sensor directly via USB, use one of the appropriate adapter cables
R&S NRP-Z3 or R&S NRP-Z4.

® connect the sensor indirectly via USB using the R&S NRP-Z5 USB Sensor Hub.

For the assignment to the available connectors, see Chapter 2, "Preparing for Use",
on page 15.
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Using the R&S NRP-Z5 Sensor Hub

The R&S NRP-Z5 USB Sensor Hub (high-speed USB 2.0) can host up to 4 R&S NRP-
Z sensors and provides simultaneous internal and external triggering of all connected
sensors. You can directly connect the R&S NRP-Z Sensors to the standard NRP sen-
sor connectors of the hub.

The hub is connected to the R&S instrument via USB with the adapter cable R&S
NRP-Z4.

See also the R&S website http://www.rohde-schwarz.com in section "Power Meters &
Voltmeters > R&S NRP-Z Sensors" for information on the sensor hub and the available
accessories.

The instrument automatically detects a connected R&S NRP-Z power sensor and indi-
cates it in the "NRP-Z Power Viewer" dialog. Each connected sensor is assigned to
one of the four channels, according to the sequence of connection.

For device specific information on the connected sensor see the Chapter 5.2.3.5,
"NRP-Z Info/Update", on page 97 dialog. For information on the scope of your power
sensor refer to the manual of your R&S NRP-Zxx power sensor.

A sensor continuously measures the average signal power of the selected source,
such as an external signal, or the output signal of the signal generator with the RF level
used as reference value. The signal generator shows the result in the NRP-Z Power
Viewer Settings settings dialog, but you can also permanently display the readings in
the block diagram.

@ Further functions of the R&S SMB related to R&S NRP-Z power sensors are:

® Acquisition of level correction data, see Chapter 5.3.5.6, "User Correction”,
on page 158.
The acquired level correction data is used to create and activate lists in which level
correction values predefined by the user are freely assigned to RF frequencies.
Correction is performed by the user-defined table values being added to the output
level for the respective RF frequency.

® NRP-Z Level Control, see Chapter 5.3.5.5, "NRP-Z Level Control", on page 154.
Note that "NRP-Z Power Viewer" automatically disables "NRP-Z Level Control",
and vice versa.

® The software version of the connected power sensor can be retrieved by means of
the remote control command SENSe<ch>[: POWer] : TYPE? on page 324.

Use the Chapter 5.2.3.5, "NRP-Z Info/Update", on page 97 dialog to update the
sensor software.

6 "NRP-Z Power Viewer" automatically disables NRP-Z Level Control, and vice versa.

NRP-Z Power Viewer Settings

» To access the dialog for configuring the RF signal level, perform one of the follow-
ing:
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e Select "RF > config... > RF Measurement > NRP-Z Power Viewer".
e Press the MENU key and select "RF > RF Measurement > NRP-Z Power

Viewer".
NRP-Z Power Viewer A
2 - NRP-Z81 S/N 900008 M=
Sensor QE
Level (Peak) -19.35[aBm =]
Level (Average) _53 .63 ’dBm v|
Display Permanent Priarity m
Zero |
Source |RF j
Level Offset lﬂ mlﬂ
Fitter [Ate =] [ 5%
Use Default Aperture Time ¥ On
Aperture 'I'lme| 1ﬂ_[III||.Js j
Use SParameter [~ On
Enable Logging [T On ]

The dialog shows the settings and measurement values of the sensor selected in
the field next to the connector symbol. For indicating the parameters of another
sensor, switch to the respective sensor in the selection list.

When you connect your power sensor(s) via the R&S NRP-Z5 USB sensor hub, each
channel of the hub is firmly assigned to the associated sensor channel in the genera-
tor.

The remote commands required to define the settings are described in Chapter 7.12,
"SENSe, READ and INITiate Subsystems", on page 315.

Sensor
Selects the R&S NRP-Z power sensor for display.

In remote control, the sensors are set up using the SENSe commands. The remote
measurement is triggered by the READ query which also provides the measurement
results.

The sensor is selected by suffix 1, 2, 3 or 4 in key word SENSe or READ of the com-
mand header.

Suffix 1 denotes the sensor connected at the first USB interface, and suffix 2, 3 and 4
are assigned to further sensors connected via USB. The suffix is identical to the index
which is assigned automatically to each sensor upon connection.

Note: The software version of the connected power sensor can be retrieved by means
of the remote control command : SENS: POW: TYPE?.

Use the "Setup >" Chapter 5.2.3.5, "NRP-Z Info/Update", on page 97 dialog to update
the sensor software.



RF Block

Remote command:
SENSe<ch>[:POWer] : STATus [ : DEVice] ? on page 323

Type
Indicates the type and the serial number of the connected R&S NRP-Z power sensor.
The sensor type is automatically detected.

Remote command:
SENSe<ch>[:POWer] : TYPE? on page 324
SENSe<ch>[:POWer] : SNUMber? on page 322

State
Activates/deactivates level measurement by the power sensor.

The local state is set with the INTT command. Switching the local state off enhances
the measurement performance.

In remote control, the sensors are set up using the SENSe commands. The remote
measurement is triggered by the READ query which also provides the measurement
results. The state is not influenced by these commands, measurements results can be
retrieved with local State on or off.

The sensor is selected by suffix 1, 2, 3 or 4 in key word SENSe or READ of the com-
mand header.

Suffix 1 denotes the sensor connected at the first USB interface, and suffix 2, 3 and 4
are assigned to further sensors connected via USB. The suffix is identical to the index
which is assigned automatically to each sensor upon connection.

To query the availability of a sensor at a given connector, use the command
SENSe<ch>[:POWer] :STATus [ :DEVice]? on page 323.

Remote command:
:INITiate<ch>[:POWer] :CONTinuous on page 316

Level (Peak)
With certain power sensors only, for example R&S NRP-Z81.

Indicates the measured peak level value with the selected unit.

Remote command:
:READ<ch>[:POWer] ? on page 317

Level (Avg.)
Indicates the measured level value with the selected unit.

Remote command:
:READ<ch>[:POWer] ? on page 317

Unit
Selects the unit used for result display.
The power sensor provides the measured value in Watt.

In which unit the measured value is indicated is selected here and might be Watt, dBm
or dBuV.
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Remote command:
:SENSe<ch>:UNIT[:POWer] on page 324

Permanent Display State

Activates the permanent indication of the power measurement result in the upper right
corner of the block diagram. The instrument shows the type of sensor, the correspond-
ing connector, the measurement source and - if set - the offset.

[1|§|NRP-221 66.45 dBm A-.rg]

It is possible to switch the permanent display active for several sensors. In this case,
the instrument indicates the values of the sensor with the lowest port number in the
display.

Remote command:
:SENSe<ch>[:POWer] : DISPlay: PERManent: STATe on page 318

Display Priority
Determines whether the instrument displays the measured average or the peak power
permanently on the screen.

To select the peak power display, it is required that the R&S NRP-Zxx sensor supports
this feature. On power-on or connecting a sensor the average power value is set by
default.

To enable the permanent display in the block diagram, select Permanent Display
State.

Remote command:
:SENSe<ch>[:POWer] :DISPlay:PERManent:PRIority on page 318

Zero - Power Sensors
Activates the auto zero function.

Zeroing calibrates the external power sensor by adjusting its reading at zero signal
power. For this purpose, the RF power source must be switched off or disconnected
from the sensor. If a Rohde & Schwarz power sensor receives an input power during
the zeroing process, it aborts zeroing and generates an error message. Zeroing takes
a few seconds, depending on the sensor model. Refer to the documentation of your
power sensor for more information.

Tips for zeroing

When to perform zeroing:

® During warm up after switching on or connecting the instrument

After a substantial change of the ambient temperature

After fastening the power sensor module to an RF connector at high temperature

After several hours of operation

When low-power signals are to be measured, e.g. less than 10 dB above the lower

measurement limit.

® Switch off the RF power source for zeroing, but do not disconnect it from the power
sensor. This proceeding keeps the thermal equilibrium, and the zeroing process
also compensates the noise that superimposes the measured signal (e.g. from a
broadband amplifier).
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Remote command:
:SENSe<ch>[:POWer] : ZERO on page 324

Source
Selects the source for measurement.

"RF" Measurement source is the RF signal of the generator. The RF fre-
quency is used as the measurement frequency of the sensor and the
corresponding correction factor is used.

In this mode the RF frequency of the generator is send to the sensor
automatically if changed.

"User" Measurements source is any freely selectable source. The frequency
is entered manually under frequency (e.g. for measurement of ampli-
fier gain with 2 sensors).

Remote command:
:SENSe<ch>[:POWer] : SOURce on page 323

Frequency
Source User only

Enters the frequency for measurement source "User".

Remote command:
:SENSe<ch>[:POWer] : FREQuency on page 321

Level Offset

Activates and defines a level offset which is added to the measured value. This allows
e.g. an attenuator in the signal path to be considered. The offset is always entered in
dB, irrespective of the selected unit for result display.

Remote command:
:SENSe<ch>[:POWer] : OFFSet : STATe on page 322
:SENSe<ch>[:POWer] : OFFSet on page 322

Filter
Determines the length of the filter used for the measurement. The filter length affects
the measurement time directly.

The averaging filter is used to reduce fluctuations in the measured result to the extent
desired. Such fluctuations can be caused by inherent noise of the measuring instru-
ment, modulation of the measurement signal or beats from the superposition of adja-
cent carriers. A more stable display has to be traded off against longer measurements.
The measurement result is obtained from a two-stage averaging process.

Note: Longer measurements do not mean that it takes longer to display a new result,
but rather that it takes longer for the result to settle when the power changes.

Measurements are continuously repeated in a predefined time window. The measure-
ment result is obtained by averaging the measured values for the last 2N time win-
dows. The number N is the filter length, the factor of 2 arises because the output sig-
nals from the microwave detector to suppress low-frequency noise are chopped at the
same rate as the time windows, which means that an independent measured value can
only be obtained from two consecutive values. As the filter length is the multiplier for
the time window it directly influences the measurement time.

e
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The filter length can be selected automatically or can be manually set to a fixed value.
As a preliminary, you should always check if the auto mode is giving satisfactory
results because you will always have to adjust an optimal, manual filter-length setting if
the power is not constant.

Selection "Fixed Noise" is offered for achieving defined measurement accuracy.

"Auto" The filter length is automatically selected and adapted to the currently
measured value. With very high signals the filter length and therefore
the measurement time can be short. With very low signal levels the
filter length and therefore the measurement time is increased in order
to reduce noise. The used filter length is indicated in the field to the
right, see Filter Length.

"User" The filter length is set manually.
The filter length is entered in the entry window to the right. As the fil-
ter length works as a multiplier for the time window, this results in a
constant measurement time.

Note: The time window varies depending on the used sensor. For
most sensors it is fixed to 20 ms. For the R&S NRP-Z81 sensor it is
10 us. Therefore, the user filter length for the R&S NRP-Z81 has be
about 1000 times larger than the filter length for other sensors in
order to achieve the same filtering result.

The Auto Once button can be used to search for the optimum filter
length for the current measurement conditions. The found filter length
is indicated in the field to the right, see Filter Length.

"Fixed Noise"  The averaging factor is selected so that the sensors intrinsic noise (2
standard deviations) does not exceed the specified noise content.
The desired noise content is entered in the entry field to the right, see
Noise Content.
To avoid very long settling times when the power is low, the averag-
ing factor can be limited with the Timeout parameter.

Remote command:
:SENSe<ch>[:POWer] :FILTer: TYPE on page 320

Filter Length — Filter
Indicates the used filter length for filter type "Auto" or "User".

Remote command:
:SENSe<ch>[:POWer] :FILTer: LENGth:AUTO? on page 318
:SENSe<ch>[:POWer] : FILTer:LENGth [ :USER] on page 319

Noise Content — Filter
Sets the noise content for filter type "Fixed Noise".

Remote command:
:SENSe<ch>[:POWer] : FILTer:NSRatio on page 319

Timeout — Filter
Sets a time limit for the averaging process.

Remote command:
:SENSe<ch>[:POWer] :FILTer:NSRatio:MTIMe on page 320
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Auto Once « Filter
Calculates the optimum filter length for the current measurement conditions and indi-
cates the value in the Filter Length.

Remote command:
:SENSe<ch>[:POWer] : FILTer : SONCe on page 320

Use Default Aperture Time
Enables you to specify a user-defined aperture time for the respective sensor.

The sensor default setting is usually sufficient. If however, the readings vary, it is rec-
ommended that you adjust the aperture time exactly to one modulation period, in order
to obtain stable readings. To specify the aperture time, see Aperture Time.

Remote command:
:SENSe<ch>[:POWer] : APERture:DEFault:STATe on page 316

Aperture Time
Defines the acquisition time for the respective sensor, provided the entry field is
enabled, see Use Default Aperture Time.

For example you can adjust the aperture time exactly to one signal period, in order to
obtain a sufficient low average value.

Remote command:
:SENSe<ch>[:POWer] : APERture: TIMe on page 316

Use SParameter - Power Sensors
Activates the use of the S-Parameter correction data of the connected power sensor.
For sensors with attenuator this checkbox is automatically checked.

Refer to the manual of the connected R&S NRP-Zxx power sensor for a description on
how to use the SParameter table.

Remote command:
:SENSe<ch>[:POWer] : CORRection:SPDevice:STATe on page 317

Enable Logging
Activates recording of R&S NRP-Z power sensor readings.

If enabled, every value measured by a connected power sensor and indicated in the
user interface, is written to a log file. Per measurement the function logs the measured
value (2 readings when you work with peak sensors), the sensor type and the mea-
surement time (time stamp).

The function automatically creates the file name SensLog<n>. txt and stores the file
in *txt format under /var/user/SensorLogging on the hard disk. You can enable
logging for each connected sensor separately. If enabled, one file per sensor is written.

Note: This specific function is intended for measurements with long time intervals, or if
there is a risk that the connection to the sensor can be interrupted and you need the
data for reconstruction.

The simplified recording function continuously writes the values in the file of the corre-
sponding sensor number, like Sens1Log. txt. When you start a new measurement,
the existing data will not be overwritten, but added to the file.

| —
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If you use this function, it is recommended that you regularly remove the files from the
hard disk, since they require storage capacity.

Remote command:
:SENSe<ch>[:POWer] : LOGGing:STATe on page 321

RF Sweep and List Mode

Overview

The R&S SMB offers three different sweep types (frequency sweep, level sweep and
LF sweep) to be activated alternatively. Each type has 6 modes which differ with
respect to the sweep cycle mode (continuous, individual and step-by-step) and trigger-
ing mode (automatic, internal and external).

® Sweeps and list mode can not be activated simultaneously, they deactivate each
other.

® Activating a sweep mode immediately disables NRP-Z Level Control.
Vice versa, a running sweep mode blocks "NRP-Z Level Control". It can not be
activated.

® |f you want to remain at a specific frequency or level value during a sweep, enter
the value directly in the status bar. The sweep stops immediately.

Setting a sweep

A sweep is set in five basic steps which are shown below taking a frequency sweep as
an example.

The LF sweep is activated and configured in the "Mod Gen" block.

1. Set the sweep range ("Start Freq" and "Stop Freq" or "Center Freq" and "Span").
Select linear or logarithmic sweep spacing ("Spacing").

Set the step width ("Step Lin/Log") and dwell time ("Dwell Time").

Activate the sweep ("Mode" to Auto, Single, Step or Extern Single, Extern Step).

o >~ o DN

Trigger the sweep, except for Auto mode ("Execute Single Sweep", Current Fre-
quency or External Trigger Signal).

It is recommended to switch off the display update for optimum sweep performance
especially with short dwell times (see Chapter 5.2.3.7, "Display Update", on page 100).
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5.3.7.2 RF Frequency Sweep

The dialog enables you to activate and configure a sweep for the RF frequency.

RF Sweep i/ List To open the "RF Frequency Sweep" dialog, select "RF > Configure > RF Frequency
F S " " n
Lrei‘;fg:\fe"’ep‘f‘_'_eep Sweep" or use the MENU key under "RF".
List Mode...

In the top section of the dialog, the RF sweep is activated and the sweep mode is
selected.

The buttons are used to reset the RF sweep (all sweep modes) or to execute the RF
sweep ("Single" mode).

The sweep range, sweep spacing and dwell time are set in the bottom section.

For the frequency sweep, an output signal at the LF connector can be activated. It pro-
vides a linear voltage ramp from start to stop of the sweep. The output voltage can be
used for example to control an oscilloscope.

You can configure the sweep range of the RF sweep in two ways, either by entering
the "Start" and "Stop" values or by entering the "Center" frequency and the "Span".
The two sets of parameters correlate as follows:

e "Start Freq" = "Center Freq" - "Span"/2

e "Stop Freq" = "Center Freq" + "Span"/2

e "Center Freq" = ("Start Freq" + STOP FREQ)/2

® "Span" ="Stop Freq" - "Start Freq"

RF Frequency Sweep X

Mode |Extern Single |
Reset Sweep |
Start Freq | 100.000 000 000 [MHz x|
Stop Freq | 500.000 000 000 [MHz ~|
Center Freq | 300.000 000 000 [MHz |
Span | 400.000 000 000 [MHz ~|
Current Freq | 100.000 000 00O [MHz ~|
Spacing |Linear |
Shape |Sawtooth |
Refrace [C On
Step Lin | 1.000 000 000 [MHz ~|
Dwell Time | 10.0|ms |
Use LF connector to output sweep voltage [~ On
Outp Volt Start Freq | ojmv |
Outp Volt Stop Freq | oo0fv |
Ext Trig Inp Slope  |Positive |
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RF Frequency Sweep Settings

» To access the sweep dialog, select "RF > configure > Sweep/List > RF Frequency
Sweep".

In these dialogs you can configure the corresponding sweep signal.

State - Frequency Sweep
Activates RF sweep mode.

Note:
Activating a sweep mode automatically deactivates other sweeps and the list mode.

Remote command:
[ : SOURce<hw>] : FREQuency : MODE on page 343

Mode - RF Frequency Sweep
Selects the RF frequency sweep mode.

If you change the sweep mode during the execution, the signal generator stops the
sweep and starts with the next trigger event at the initial value.

The "Reset Sweep" button sets the sweep to the start value.

"Auto" Generates a continuously repeating sweep signal immediately after
activating the sweep mode.
The sweep steps are performed atomatically, controlled by the dwell
time, see "Dwell Time - Frequency Sweep" on page 181.

Example:
SOUR: SWE : FREQ:MODE AUTO
TRIG:FSW:SOUR AUTO
SOUR: FREQ:MODE SWE

"Single" Generates a single sweep cycle after a trigger event.
The sweep steps within the cycle are performed automatically, con-
trolled by the dwell time. If one cycle is completed, the instrument
waits for the next trigger event.
To trigger the sweep, use "Execute Single Sweep" button, or the cor-
responding remote control commands, for example *TRG.

Example:
SOUR: SWE : FREQ:MODE AUTO
TRIG:FSW:SOUR SING
SOUR: FREQ:MODE SWE
SOUR: SWE : FREQ: EXEC



llStepll
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Generates the sweep signal step-by-step, manually triggered.

To perform the sweep steps, enter the frequency value under Current
Freq - Frequency Sweep. You can directly enter the value, but also
use the UP and DOWN navigation keys or the ROTARY KNOB.

You can determine the step width below in the entry field "Step Lin" or
"Step Log", see Step Lin/Log - Frequency Sweep.

If a step is out of the sweep range ("Start Freq" or "Stop Freq"), it is
ignored.

Note: To step through the sweep frequencies in remote control
mode, use the FREQ: MAN command with the UP or DOWN parameter.

Example:

SOUR:FREQ:CENT 300MHz

SOUR:FREQ:SPAN 400MHz
SOUR: SWE: FREQ: SPAC LIN

SOUR: SWE: FREQ:STEP:LIN 100MHz

SOUR: FREQ:MODE MAN

TRIG:FSW:SOUR SING

set sweep mode "Step".

SOUR: FREQ:MODE SWE

activate sweep mode, the frequency is set to "Start Freq".
SOUR:FREQ:MAN UP

set the frequency to the next higher sweep frequency.
SOUR: FREQ:MAN DOWN

set the frequency to the next lower sweep frequency.

Generates a single sweep cycle when an a external trigger event
occurs.

The sweep steps within the cycle are performed automatically, con-
trolled by the dwell time. If one cycle is completed, the instrument
waits for the next trigger event.

To trigger the sweep, apply an external trigger signal.

Refer to the description of the rear panel for information on the con-
nectors for external trigger signal input (see Chapter 2.2, "Rear Panel
Tour", on page 21).

Example:

SOUR: SWE : FREQ:MODE AUTO
TRIG:FSW:SOUR EXT

SOUR: FREQ:MODE SWE (External trigger)
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"Extern Step"  Generates the sweep signal step-by-step, manually triggered.
To trigger a sweep step, apply an external trigger signal. The step
width corresponds to the step width set for the rotary knob.

Example:

SOUR:SWE: FREQ:MODE STEP
SOUR: SWE: FREQ:SPAC LIN
SOUR:SWE:FREQ:STEP:LIN 1MHz
TRIG:FSW:SOUR EXT
SOUR:FREQ:MODE SWE (External trigger)

"Extern Start/Stop"
Generates a continuously repeating sweep signal that is started,
stopped and restarted by subsegeunt external trigger events. The
sweep steps are performed automatically, controlled by the dwell
time.
Refer to the description of the rear panel for information on the con-
nectors for external trigger signal input (see Chapter 2.2, "Rear Panel
Tour", on page 21).

Example:
SOUR: SWE : FREQ:MODE AUTO
TRIG:FSW:SOUR EAUT
SOUR:FREQ:MODE SWE (External trigger)
Remote command:
[ :SOURce<hw>] : SWEep [ : FREQuency] : MODE on page 419

:TRIGger<hw>:FSWeep: SOURce on page 450
[ :SOURce<hw>] : FREQuency : MODE on page 343

Execute Single Sweep - Frequency Sweep
Starts a sweep manually. This trigger button is displayed in "Single" mode.

Remote command:

[ : SOURce<hw>] : SWEep [ : FREQuency] : EXECute on page 419
:TRIGger<hw>:FSWeep[:IMMediate] on page 451
:TRIGger<hw>[:SWEep] [ : IMMediate] on page 455

Reset Sweep - Frequency Sweep
Resets the sweep.

With the next trigger event, the sweep starts with at the initial value.

Remote command:
[ :SOURce<hw>] : SWEep:RESet [ :ALL] on page 429

Start Freq - Frequency Sweep
Sets the start frequency.

Remote command:
[ :SOURce<hw>] : FREQuency: STARt on page 345
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Stop Freq - Frequency Sweep
Sets the stop frequency.

Remote command:
[ : SOURce<hw>] : FREQuency: STOP on page 346

Center Freq - Frequency Sweep
Sets the center frequency.

Remote command:
[ : SOURce<hw>] : FREQuency : CENTer on page 341

Span - Frequency Sweep
Sets the span.

Remote command:
[ : SOURce<hw>] : FREQuency: SPAN on page 345

Current Freq - Frequency Sweep
Displays the current frequency.

In sweep "Step" mode, the parameter is editable and you can enter frequency for the
next step.

Remote command:
[ : SOURce<hw>] : FREQuency:MANual on page 342

Spacing - Frequency Sweep
Selects the mode for the calculation of the frequency sweep intervals.

"Linear" Takes the frequency value entered as an absolute value in Hz.

"Logarithmic"  Takes the value entered as a lograithmic value, that means as a con-
stant fraction of teh current frequency in %.

Remote command:
[ : SOURce<hw>] : SWEep [ : FREQuency] : SPACing on page 423

Shape - RF Frequency Sweep
Selects the waveform shape of the sweep signal.

f

siop
Trequency

stan
draguinsy

stop
Fraquancy

starf
Erequancy

"Sawtooth" One sweep runs from start to stop frequency. Each subsequent
sweep starts at the start frequency, that means the shape of the
sweep sequence resembles a sawtooth.

"Triangle" The sweep runs from the start to the stop frequency and back, that
means the shape of the sweep resembles a triangle. Each subse-
quent sweep starts at the start frequency.
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Remote command:
[ : SOURce<hw>] : SWEep [ : FREQuency] : SHAPe on page 422

Retrace - RF Frequency Sweep
Activates that the signal changes to the start frequency value while it is waiting for the
next trigger event.

You can enable this feature, when you are working with sawtooth shapes in sweep
mode "Single" or "External Single", see Mode - RF Frequency Sweep.
fA

Trigger Event | Trigger Event [

Retrace Off
stop frequency —

start frequency —
- —stoppedfﬂ+ — — —running— — — —bld— —stopped— 7DL¢ — — —running— — — —ﬂd— -stopped — —
B | | ! }

\

\

Retrace On | |
stop frequency —

start frequency 4

T T T T Vt

| | | [
- —stoppedf% — — —running— — — —b|¢ —stopped— 7}'-& — — —running— — — —bﬂ— -stopped — —

Remote command:
[ : SOURce<hw>] : SWEep [ : FREQuency] : RETRace on page 422

Step Lin/Log - Frequency Sweep
Sets the step width for the individual frequency sweep steps.

At each step this value is added to the current frequency.

Depending on the Spacing - Frequency Sweep mode you have set, the corresponding
parameter is displayed.

"Step Lin" The step width is a constant value in Hz.

Remote command:
[ : SOURce<hw>] : SWEep [ : FREQuency] : STEP [ : LINear] on page 423
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"Step Log" The step width is determined logarithmically in %, that means as a
constant fraction of the current frequency.
Successive frequencies are calculated as follows:
e start_f < stop_f
f2=11*(1+ step_log/100)
If f2 > stop_f: f2 is set to stop_f.
e start_f > stop_f
f2=11/(1+ step_log/ 100)
If f2 < stop_f: 2 is set to stop_f.
When the shape "Triangle" is set, the frequency values on the slope
from stop_f back to start_f are the same as on the slope from
start_f to stop_f.
Remote command:

[ : SOURce<hw>] : SWEep [ : FREQuency] : STEP: LOGarithmic on page 424

Dwell Time - Frequency Sweep
Sets the dwell time. The dwell time determines the duration of the individual sweep

steps.

&

T

& ; Setting, Dwell time
- | time | (effective) |

g i o
=
L]

P Time

LDwell Time"
{set by the user)

The "Dwell Time" set by the user is used as the step time of the sweep. The effective
net dwell time is shorter, reduced by the setting time. This setting time may be greater
than the time specified in the data sheet.

Note:

It is recommended to switch off the display update for optimum sweep performance
especially with short dwell times (see Chapter 5.2.3.7, "Display Update”, on page 100).

Remote command:
[ : SOURce<hw>] : SWEep [ : FREQuency] : DWEL1 on page 418

Use LF connector to output sweep voltage - RF Frequency Sweep
Activates the output of a linear voltage ramp from sweep start to sweep stop at the LF

connector. This signal can be used for the X-deflection of an oscilloscope. The voltage
range is determined below.

Remote command:
[ : SOURce<hw>] : SWEep [ : FREQuency] : LFConnector on page 419

Output Voltage Start Freq - RF Frequency Sweep
Sets the voltage at the sweep start frequency.
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Frequency Sweep...

Level Sweep...

List Mode...
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Remote command:
[ : SOURce<hw>] : SWEep [ : FREQuency] : OVOLtage : STARt on page 420

Output Voltage Stop - RF Frequency Sweep
Sets the voltage at the sweep stop frequency.

Remote command:
[ : SOURce<hw>] : SWEep [ : FREQuency] : OVOLtage : STOP on page 421

Ext. Trigger Input Slope
Sets the polarity of the active slope of an externally applied instrument trigger.

This setting affects the INST TRIG input (BNC connector at the rear of the instrument).
"Positive" activates the rising edge of the trigger signal.
"Negative" activates the falling edge of the trigger signal.

Remote command:
[ :SOURce] : INPut : TRIGger: SLOPe on page 348

RF Level Sweep

To open the "Level Sweep" menu, select "RF > Configure > Level Sweep" or use the
MENU key under "RF".

RF Level Sweep Settings

In the top section, the RF level sweep is activated and the sweep mode is selected.
The buttons are used to reset the level sweep (all sweep modes) or to execute the
level sweep ("Single" mode).

The sweep range, sweep spacing and dwell time are set in the bottom section.

State

Mode IEx‘tem Single vl

Reset Sweep |

Start Level I —3D.UD|dBm vl
Stop Level I —10.[J[J|dBm "l
Current Level | —fﬂ_llnldElm vl

Shape ISawtooth vl
Retrace I~ On
Step | 1.[J[J|dB vl

Dwell Time | 1U.D|ms "I
Ext Trigger Input SIopeIPositive vl

State - Level Sweep
Activates Level Sweep mode.

Note:
Activating a sweep mode automatically deactivates other sweeps and the list mode.
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Remote command:
[ : SOURce<hw>] : POWer : MODE on page 382

Mode - Level Sweep
Selects the level sweep instrument operating mode and the sweep mode.

If you change the sweep mode during the execution, the signal generator stops the
sweep and starts with the next trigger event at the initial value.

The "Reset Sweep" button sets the sweep to the start value.
"Auto" Sets an automatically repeated sweep cycle.

Example:
SOUR: SWE : POW: MODE AUTO
TRIG:PSW:SOUR AUTO
SOUR: POW:MODE SWE

"Single" Sets a single sweep cycle. The sweep is triggered by the "Execute
Single Sweep" button, or by means remote trigger commands, e.g.
*TRG.

Example:
SOUR: SWE : POW:MODE AUTO
TRIG:PSW:SOUR SING
SOUR: POW:MODE SWE
SOUR: SWE : POW: EXEC



RF Block

"Step" Sets a step-by-step sweep cycle.
If this mode is activated, the cursor moves to the value displayed for
"Current Level". Each sweep step is triggered by a variation of the
value in the "Current Level" entry window. The step width is set below
at entry field "Step".
If this mode is activated, the cursor moves to the value displayed for
"Current Level". If a different sweep mode was activated prior to the
"Step" mode, the current sweep is stopped. The step sweep starts at
the current level value.

Example:

SOUR: SWE : POW: MODE MAN

TRI:PSW:SOUR SING

SOUR:SWE: POW:STEP 0.5

SOUR: POW:MODE SWE

SOUR:POW:MAN -16

The value entered with command SOUR: SWE : POW: STEP sets the
step width.

The value entered with command SOUR: POW : MAN has no effect, the
command only triggers the next sweep step. However, the value has
to be in the currently set sweep range (start to stop). In remote con-
trol only a step-by-step sweep from start to stop frequency is possi-
ble.

"Extern Single" Sets a single sweep cycle. The sweep is triggered by an external trig-
ger signal.
Refer to the description of the rear panel for information about the
connectors for external trigger signal input (see Chapter 2.2, "Rear
Panel Tour", on page 21).

Example:

SOUR: SWE : POW:MODE AUTO
TRIG:PSW:SOUR EXT
SOUR:POW:MODE SWE (External trigger)

"Extern Step"  Sets a step-by-step sweep cycle. Each sweep step is triggered by an
external trigger signal (trigger source as described under "Extern Sin-
gle"). The step width corresponds to the step width of the rotary knob.

Example:

SOUR: SWE : POW: MODE STEP
SOUR: SWE: POW:STEP 0.5
TRIG:PSW:SOUR EXT
SOUR:POW:MODE SWE (External trigger)
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"Extern Start/Stop"
Sets an automatically repeated sweep cycle that is started, stopped
and restartet by subsequent external trigger events.
The first external trigger signal starts the sweep (Start).
The next external trigger signal stops the sweep at the current fre-
quency (Stop).
The third external trigger signal starts the sweep at the start fre-
quency (Start).
Refer to the description of the rear panel for information about the
connectors for external trigger signal input (see section "Legend for
Rear Panel View").

Example:

SOUR: SWE : POW: MODE AUTO
TRIG:PSW:SOUR EAUT
SOUR:POW:MODE SWE (External trigger)

Remote command:

[ : SOURce<hw>] : SWEep : POWer : MODE on page 425
:TRIGger<hw>:PSWeep: SOURce on page 453.

[ : SOURce<hw>] : POWer : MODE on page 382

Reset Sweep - Level Sweep
Resets the sweep. The start level is set and the next sweep starts from there.

Remote command:
[ :SOURce<hw>] : SWEep:RESet [ :ALL] on page 429

Execute Single Sweep - Level Sweep
Triggers the sweep manually. A manual sweep can only be triggered if "Mode Single"
is selected.

Example:
SOUR: SWE : POW:MODE AUTO
TRIG:PSW:SOUR SING
SOUR: POW:MODE SWE
SOUR: SWE : EXEC

Remote command:

[ :SOURce<hw>] : SWEep: POWer : EXECute on page 425
:TRIGger<hw>:PSWeep[:IMMediate] on page 453
:TRIGger<hw>[:SWEep] [ : IMMediate] on page 455

Start Level - Level Sweep
Sets the start level.

Remote command:
[ :SOURce<hw>] : POWer: STARt on page 385
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Stop Level - Level Sweep
Sets the stop level.

Remote command:
[ : SOURce<hw>] : POWer : STOP on page 387

Current Level - Level Sweep
Displays the current level.

If "Step" is set, the level for the next level step of the sweep is entered here.

Remote command:
[ :SOURce<hw>] : POWer:MANual on page 382

Shape - RF Level Sweep
Selects the cycle mode for a sweep sequence (shape).

"Sawtooth" One sweep runs from the start level to the stop level. The subsequent
sweep starts at the start level again, i.e. the shape of sweep
sequence resembles a sawtooth.

"Triangle" One sweep runs from start to stop level and back, i.e. the shape of
the sweep resembles a triangle. Each subsequent sweep starts at the
start level again.

Remote command:
[ :SOURce<hw>] : SWEep: POWer : SHAPe on page 427

Retrace - RF Level Sweep
Activates that the signal changes to the start level value while it is waiting for the next
trigger event. It allows you to shift down the power during the waiting period.

You can enable this feature, when you are working with sawtooth shapes in sweep
mode "Single" or "External Single", see Mode - Level Sweep.

Signal Levely

Trigger Event [ Trigger Event [

Retrace Off | |
stop level —

start level

- —stopped—ﬂq— — — —running— — — —>|4— —stopped— —ﬂ-q— — — —running— — — —>1<— -stopped — —
| |

Retrace On | |
stoplevel 4 —— —— 4 ———— — — — — o — — — — — —

startlevel 4 —m _ -7 __ __

| | | |
. 7stopped7>|+ — — —running— — — —>|<— —stopped— - —— running— — — —>[<— -stopped — —
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Remote command:
[ : SOURce<hw>] : SWEep : POWer : RETRace on page 427

Step - Level Sweep

Sets the step width for the individual sweep steps. This entry is effective for all sweep
modes.

With the level sweep, the logarithmic step width is a constant fraction of the current
level. This fraction is added to the current level. The logarithmic step width is entered in
dB.

Remote command:

[ :SOURce<hw>] : SWEep: POWer: STEP [ : LOGarithmic] on page 428

Dwell Time - Level Sweep
Enters the dwell time and determines the duration of the individual sweep steps.

h

=

| Setting, Dwell time
| time | (effective)

Signal Level

M Time
LDwell Time"

{set by the user)

The "Dwell Time" set by the user is used as the step time of the sweep. The effective
net dwell time is shorter, reduced by the setting time. This setting time may be greater
than the time specified in the data sheet.

Note:

It is recommended to switch off the display update for optimum sweep performance
especially with short dwell times (see Chapter 5.2.3.7, "Display Update", on page 100).

Remote command:
[ :SOURce<hw>] : SWEep:POWer : DWEL1 on page 425

Ext. Trigger Input Slope
Sets the polarity of the active slope of an externally applied instrument trigger.

This setting affects the INST TRIG input (BNC connector at the rear of the instrument).
"Positive" activates the rising edge of the trigger signal.
"Negative" activates the falling edge of the trigger signal.

Remote command:
[ :SOURce] : INPut: TRIGger : SLOPe on page 348

5.3.7.4 List Mode

Similar to a sweep, a series of previously defined frequency and level points is pro-
cessed in List mode. In contrast to a sweep, however, a list with freely selectable value
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pairs (frequency and level) can be created. The value range for frequency and level
covers the entire configurable value range of the instrument.

6 Interactions between List mode and other operating modes or settings

® List mode and sweeps can not be activated simultaneously, they deactivate each
other.

® Activating the list mode instantly disables NRP-Z Level Control.
A running list mode blocks "NRP-Z Level Control". It can not be activated

The lists can be created in the "List Editor". Each list is stored in its own file with the
predefined file extension * . 1sw. The name of the list file can be freely selected. The
files are loaded from the "Lists..." file manager. Externally created tables with pairs of
frequency and level values can be converted into List files using the import function.
The external files must have the file extension * . txt or *.csv. These file formats are
provided e.g. by the Microsoft?Excel program. The separators for table columns and
for decimal floating-point numerals can be set. In addition, internally created List data
can be exported into ASCII files using the export function.

The necessary hardware settings are calculated the first time a list is processed. With
long dwell times, this calculation can be performed while the list is being processed,;
the entered dwell times are observed. With very short dwell times, calculation of the
hardware settings increases the dwell time for the initial processing cycle; the entered
value is only observed from the second processing cycle onwards. In this case a mes-
sage appears to inform the user that there is a deviation between the current and set
dwell times. No further calculations are required after the first run through a list. The
current dwell times will definitely no longer deviate from the set dwell times.

The list is processed from the beginning to the end of the list (modes "Auto", ("Exter-
nal") "Single", ("External") "Step").

List Mode Dialog

Frjqz ;vcv;esu vietei;t To open the "List Mode" menu, select "RF > Configure > List Mode" or use the MENU

Level Sweep... key under "RF".
List Maode

The menu is used to activate/deactivate the operating mode List, to create, select and
activate the lists, and to select the trigger mode and the dwell time.
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List Mode

State

Mode | Extern Single |
Dwell Time I 10.000 I ms 'I
Current Index I 0

Learn List Mode Data |

List Mode Data... | None

Edit List Mode Data... |
List Range In: | I 0 I 9 (wl

Import/Export >=> |

General Settings

State - List Mode
Activates/deactivates the List mode. The currently selected list is processed.

In case of a new or modified list, the necessary hardware settings are automatically
determined on activation of the list mode. The data determined in this way is stored
along with the list and is available whenever the list is used again.

This means that when activating the list mode, the system checks whether any hard-
ware settings are present. If so, the list is started immediately, but if not they are auto-
matically determined (the list is learnt).

A "Learn List Mode Data" button is available for deliberately activating list learning.

Note: Activating the list mode automatically deactivates all sweeps. During list mode
the frequency and level indications do not display the currently set values.

Remote command:
[ : SOURce<hw>] : FREQuency : MODE on page 343

Mode - List Mode
Selects the cycle mode of the List mode.

"Auto" Cycle from the beginning to the end of the list with automatic restart
at the beginning. If a different mode was activated prior to the Auto
mode, the cycle continues from the beginning of the list. The duration
of a list step is determined by the set dwell time.

Button "Reset" restarts the list at the starting point.

"Single" Single cycle from the beginning to the end of the list. If "Single" is
selected, the cycle is not started immediately. The "Execute Single"
button appears under the "Mode" line. The cycle is started with this
button. The duration of a list step is determined by the set dwell time.
Button "Reset" restarts the list at the starting point.

IMude | Single J
Execute Single |

Operating Manual 1407.0806.32 — 21 189
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"Step" Manual, step-by-step processing of the list. Activating "Step" stops
the current list and the cursor moves to the value displayed for "Cur-
rent Index". It is now possible to scroll up and down in the list in dis-
crete steps by varying the index. The duration of a list step is deter-
mined by the time between two index entries.

Button "Reset" restarts the list at the starting point.

ICurrent Index | 1] I

"Extern Single" Single cycle from the beginning to the end of the list as with "Single",
but started by an external trigger.
The external trigger signal is input at the BNC connector INST TRIG.
Button "Reset" restarts the list at the starting point.

"Extern Step"  Step-by-step cycle using the external trigger signal. Each trigger
event starts a single step. The duration of a list step is determined by
the time between two trigger events.

The external trigger signal is input at the BNC connector INST TRIG.
Button "Reset" restarts the list at the starting point.

Remote command:
[ :SOURce<hw>] : LIST:MODE on page 368
[ :SOURce<hw>] :LIST:TRIGger : SOURce on page 370

Execute Single - List Mode
Triggers the list manually. This button is available only if mode "Single" is selected.

Remote command:
[ :SOURce<hw>]:LIST:TRIGger :EXECute on page 370

Reset - List Mode
Resets the list to the starting point.

Remote command:
[ :SOURce<hw>] :LIST:RESet on page 369

Dwell Time - List Mode

Enters the dwell time. The dwell time determines the duration of a list step in list oper-
ating modes "Auto", "Single" and "Extern Single". In these modes a complete list is pro-
cessed either once or continuously.

In list operating modes "Step" and "Extern Step", the set dwell time does not affect sig-
nal generation. In this case, the duration of a list step is determined by the time
between two (internal or external) trigger events.
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-
L

ISetting Dwell time
| time | (effective)

Signal Level

PN Time
LDOweell Time™

{set by the user)

The "Dwell Time" set by the user is used as the step time of the list mode. The effec-
tive net dwell time is shorter, reduced by the setting time. This setting time may be
greater than the time specified in the data sheet.

Remote command:

[ :SOURce<hw>]:LIST:DWELL on page 365

Current Index - List Mode
Sets the list index in "Step" mode.

Remote command:
[ :SOURce<hw>] :LIST: INDex on page 366

Learn List Mode Data... - List Mode
Starts the determination of the hardware setting for the selected list. The data deter-
mined in this way is stored along with the list.

It may be necessary to deliberately activate list learning in the event of greatly altered
environmental conditions that require new hardware settings.

If this is not done, a previously learned hardware setting will continue to be used when
list mode is switched on ("State = On"). If no setting is available, e.g. when the list is
used for the first time, learning is automatically activated.

Remote command:
[ :SOURce<hw>] :LIST:LEARn on page 368

List Mode Data... - List Mode
Calls the "File Select" menu for selecting and creating a list or the "File Manager".

T

New List '
File Manager...

Remote command:

[ :SOURce<hw>]:LIST:SELect on page 370

[ :SOURce<hw>] : LIST:DELete on page 360
[:SOURce<hw>]:LIST:DELete:ALL on page 361
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Edit List Mode Data... - List Mode
Calls the editor for editing the selected list. A list consists of any number of frequency/
level value pairs. The currently selected list is displayed.

Edit List Mode Data data_list

1 1 000 000 000.000 -125.0
2 1 250 000 000.000 -120.0
3 1 500 000 000.000 -115.0
4 1 750 000 000.000 -110.0
5 2 000 000 000.000 -105.0
6 2 250 000 000.000 -100.0
7
o
Goto | Edit | Save As... | Save |

"Frequency / Enter the frequency of the frequency/power value pair.
Hz"

Remote command:
[ :SOURce<hw>] : LIST: FREQuency on page 365

"Power /dBm"  Enter the level of the frequency/power value pair.

Remote command:
[ :SOURce<hw>] : LIST:POWer on page 368

"Goto" Selects row for editing.

Goto first
Goto last
t

If "Goto row" is selected, a window opens for entering the requested

row.
oK | cancer |
"Edit" Calls a selection of possible actions described below.
Insert Row
Insert Range...
Fill...
Delete Row
Delete Range...
"Insert Row" Inserts a new row before the marked row.

"Insert Range" Inserts new rows before the marked row. The number of rows to be
inserted can be defined in an entry window.

IRuws to Insert | I

OK | Cancel |
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"Fill...." Opens a sub menu for defining a set of list values to be automatically
entered in the List Mode table (see "Filling the List Mode Data auto-
matically" on page 195).

"Delete Row" Deletes the marked row.

"Delete Allows to delete any number of rows starting with the marked row.
Range..." The number of rows to be deleted can be defined in an entry window.
IRnws to Delete I | I
OK | Cancel |
"Save" The list is saved under its current name.

List Range In - List Mode

Defines an index range in the current list by setting the start and stop index. Only the
values in the selected index range are processed in List mode, all other list entries are
ignored.

Remote command:
[ :SOURce<hw>] :LIST:INDex:STARt on page 367
[ :SOURce<hw>] :LIST:INDex:STOP on page 367

Ext. Trigger Input Slope
Sets the polarity of the active slope of an externally applied instrument trigger.

This setting affects the INST TRIG input (BNC connector at the rear of the instrument).
"Positive" activates the rising edge of the trigger signal.

"Negative" activates the falling edge of the trigger signal.

Remote command:

[ :SOURce] : INPut: TRIGger: SLOPe on page 348

Import/Export

Lists can be imported from externally created files or exported into text or CSV-files.

The import/export settings are available after clicking the "Import/Export" button.

Import/Export - List Mode
Expands the menu with the area for import and export of list mode files.
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I <<< Hide Import/Export I
Import f/ Export List Files

Maode I Import vl

ASCIl File Settings

Extension ITXT 'I
Decimal Point I Paint vl
Column Separataor I Semicolon 'I

Select ASCI Source |

None

Externally edited Excel tables with frequency/level pairs can be imported as text or
CSV-files and used for list mode.

On the other hand, internally created list mode lists can be exported as text or CSV-
files.

Mode - List Mode
Selects if list mode lists should be imported or exported. The settings offered below
depend on the selected mode.

Remote command:
[ :SOURce<hw>] : LIST:DEXChange : MODE on page 364

Extension - List Mode
Selects the file extension of the ASCII file to be imported or exported. Selection TXT
(text file) or CSV (Excel file) is available.

Remote command:
[ :SOURce<hw>] :LIST:DEXChange:AFILe:EXTension on page 362

Decimal Point - List Mode
Selects the decimal separator used in the ASCII data between '." (decimal point) and ;'
(comma) with floating-point numerals.

Remote command:
[ :SOURce<hw>] : LIST:DEXChange:AFILe:SEParator:DECimal on page 363

Column Separator- List Mode
Selects the separator between the frequency and level column of the ASCII table.

Remote command:
[ :SOURce<hw>] : LIST:DEXChange:AFILe:SEParator:COLumn on page 363

Select ASCII Source / Destination - List Mode
Calls the "File Manager" for selecting the ASCII file to be imported into a list mode list
(source) or the ASCII file the list mode list is exported (destination) in.

Remote command:
[ :SOURce<hw>] : LIST:DEXChange:AFILe:SELect on page 362
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Select Destination / Source - List Mode
Calls the "File Manager" for selecting the list mode list to be exported (source) into an
ASCII file or the destination for the ASCI! file to be imported (destination) in.

Remote command:
[ :SOURce<hw>] : LIST:DEXChange: SELect on page 364

Import / Export - List Mode
Starts the export or import of the selected file.

When import is selected, the ASCII file is imported as list mode list.
When export is selected, the list mode list is exported into the selected ASCII file.

Remote command:
[ :SOURce<hw>] : LIST:DEXChange :EXECute on page 363

Filling the List Mode Data automatically

The "Fill List Mode Data" menu enables you to automatically set the values in the List

Mode table.
Fill List Hode Data
From |—1
Range |—3
Select column to fill IW
Start Value | 9000.000 |Hz x|
End Value | 9200.000 [Hz |
Increment Value | 100.000 I Hz |
' W 1

The start line and the number of rows to be filled are defined under "From" and
"Range".

The column to be filled is selected under "Select column to fill". Depending on the
selection here, the default for start, end, and increment value are set. As the settings
are interdependent, a change of one parameter may result in the automatic change of
one or more of the other parameters.

The filling of the column with the selected value settings is started with button "Fill".

6 The list entries are only computed when the "Fill" button is pressed.

From
Sets the start value of the index range.

Remote command:
n.a.

Range
Sets the range for filling the table.
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Remote command:
n.a.

Select column to fill
Selects either the frequency or the level column to be filled with the value defined
below.

Remote command:
n.a.

Start value
Sets the start value for the frequency or the level entries.

Remote command:
n.a.

End value
Sets the end value for the frequency or the level entries.

Remote command:
n.a.

Increment value
Sets the increment for the frequency or the level entries.

Remote command:
n.a.

Fill
Fills the selected column in the set range with values, starting with the start value and
using the set increment.

Remote command:
n.a.

Modulation

Overview of Modulation

Analog modulation is a method used to transmit information of an LF (Low Frequency)
signal in accordance with a second signal, typically one of a higher frequency. This is
done by varying one or more properties of a high frequency waveform, called the mod-
ulation or carrier signal, with the modulating signal that contains the information to be
transmitted.

The three key parameters of the modulation signal are the amplitude, phase and fre-
quency. These parameters are modified in accordance with the low frequency signal to
obtain the modulated RF signal.
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The R&S SMB provides all the various types of modulation, such as:

® AM (Amplitude Modulation)

® FM (Frequency Modulation)

® PhiM (Phase Modulation)

® PULM (Pulse Modulation)

® Stereo Modulation

In addition, the RF signal can be modulated with various internally generated modula-

tion waveforms, like sine or rectangular signal waves. The basic unit (R&S SMB + fre-

quency option) provides amplitude, frequency and phase modulation without additional

equipment options, as well as a standard LF generator provided for internal modula-
tion. Further available options are:

® R&S SMB-B5, Stereo/RDS Coder for performing stereo modulation
® R&S SMB-K21, Pulse Modulation for instruments with high frequency options

® R&S SMB-K22, Pulse Modulation for instruments equipped with frequency-options
up to 6 GHz

® R&S SMB-K23, Pulse Generator for pulse signals
® R&S SMB-K27 Pulse Train for generating pulse train signals (only for instruments
with serial number higher than 102400)

Settings for the modulation are made in separate modulation menus. These menus
can be accessed in the block diagram by way of the "Modulation" function block, or by
means of the menu with the same name which is opened using the MENU key.

5.4.1.1 Enabling/Disabling Analog Modulations using the MOD On/Off Key
The MOD ON/OFF key switches the modulations on and off.

MOD ON/OFF
Press the MOD ON/OFF key to enable/disable analog modulations.

Pressing the key again restores the status that was active before the last switch-off.
"MOD OFF" is displayed in the info line of the header next to the "Level" field.

Remote command:
[ :SOURce<hw>] :MODulation[:ALL] [:STATe] on page 371

5.4.1.2 Modulation Sources

The following modulations use internal and external modulation sources:
® Amplitude modulation

® Pulse modulation

® Frequency modulation

® Phase modulation
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Internal Modulation Sources

An LF generator and a pulse generator are available as internal modulation sources for
a fully equipped instrument. The LF generator supplies sinusoidal or rectangular sig-
nals.

The optional pulse generator (option R&S SMB-K27) provides single and double pulse
modulation with selectable pulse widths and periods or a user-definable pulse train.

See also Chapter 5.5.1, "Overview of LF Generator", on page 218.

External Modulation Sources

The modulation input MOD EXT at the instrument front provides the external modula-
tion sources for amplitude, frequency and phase modulation.

The external audio signal for stereo modulation is input via the analog L and R inputs
or via the digital S/P DIF interface at the rear of the instrument.

The external modulation signal for AM, FM and PM at the input must have a voltage of
Us =1V (Ugee = 0.707 V) in order to achieve the displayed modulation depth and
range. The input voltage should not exceed 1 V, otherwise modulation distortions might
occur.

The PULSE EXT connector at the rear of the instrument controls the external pulse
modulation. The input shows some hysteresis with threshold levels of 0.5 V/1.5 V. The
voltage must not exceed 5 V.

Simultaneous Operation of Several Modulations or Other Operating Modes

The table shows the modulations and operating modes which can be activated simulta-
neously (+) or which deactivate each other (-).

AM FM PhiM Pulse
Amplitude modulation (AM) / + + (+)
Frequency modulation (FM) + / - +
Phase modulation (PhiM) + - / +
Pulse modulation (Pulse) (+) + + /

5.4.2 Amplitude Modulation (AM)
An internal and/or external source can be selected for amplitude modulation. The LF
modulation generator is available as the internal source.

Two-tone AM is possible by simultaneously switching on the external and internal
source.

The MOD EXT input connector for external feed of analog modulation signals is at the
front of the instrument. The coupling mode of the input (AC or DC) can be selected.

The AM modulation depth is limited by the maximum peak envelope power (PEP).
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Exponential AM (Instruments with high frequency options)

Besides the linear amplitude modulation, whereby the signal voltage is proportional to
the modulation signal, instruments equipped with the frequency options (R&S SMB-

B112(L) /-B120(L) /-B140(L)) provide a level-proportional power or amplitude modula-
tion.

In this case, the R&S SMB exponentially distorts the modulation signal, before it is out-

put at the LF CONNECTOR - regardless of the AM Source Int, or Ext . The AM Depth
is then indicated in dB.

6 Signal Sources for Exponential AM

You can perform exponential AM using either the internal, or an external modulation
signal. However, in contrast to linear AM, the signal at the LF output connector is dis-
torted in any operating mode. AM Source Int+Ext is not available.

5.4.2.1 Amplitude Modulation Settings

e 10 open the "Amplitude Modulation” dialog, select "Modulation > Configure > Ampli-
Frequency Modulation

Freauercy Wodula tude Modulation" or use the MENU key under "Modulation".

Pulse Modulation

In the upper section of the dialog, the modulation source is selected and the modula-
tion switched on. The modulation source can be selected independently for the differ-
ent modulation types and the LF output.

The configuration of the selected external and/or internal modulation source is per-
formed in the lower section of the dialog or in the "LF Output" dialog (internal source
only).

These settings affect all modulations which use the same modulation source.
Amplitude Modulation d
State

AM Source Ext hd

AM Depth I 30.0'% vl

AM Source = External
AM Sensitivity | 30.0 % perVolt
Mod Ext Coupling AC hd

Ext Impedance IHigh vl

lgnore Overvoltage Warning r

State
Activates amplitude modulation.

Remote command:
[ : SOURce<hw>] :AM: STATe on page 328

AM Source
Selects the source for the AM modulation signal.

"Internal” Uses the internal LF generator as modulation signal source for AM.
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"External" Uses an externally applied modulation signal.
The external signal is input via the MOD EXT connector.

"Intern + Extern"
Uses both, the internal and externally applied modulation signal, for
example to perform two-tone AM.
Note: This setting applies to linear AM, see "Exponential AM (Instru-
ments with high frequency options)" on page 199.

Remote command:
[ :SOURce<hw>] : AM: SOURce on page 327

AM Type
Selects between linear or exponential (logarithmic) amplitude modulation, if you work
with an instrument that is equipped with a 12 GHz, or higher frequency option.

Remote command:
[ : SOURce<hw>] : AM: TYPE on page 328

AM Depth
Sets the modulation depth in percent.

Note: With two-tone modulation, observe that the set modulation depth applies to both
signals and the sum modulation depth is determined by doubling the set modulation
depth. This results in overmodulation if the maximal value for modulation depth is
exceeded (see data sheet).

For instruments with frequency option 12 GHz or higher, you can additionally select
AM Type Exponential. In this case, the generator sets modulation depth in dB (logarith-
mic).

Modulation is possible both, upwards and downwards. Accordingly, the dynamic range
extends for instruments without attenuator from minimum to maximum level. For instru-
ments with attenuator, the dynamic range corresponds to the Fixed Range (PEP) In;
these are downwards about 20 dB, and upwards about 5 dB, that means in total about
25 dB around the set level.

Effects of positive/negative modulation depth:
® AM Source Int

— positive depth -> downwards modulation

— negative depth -> upwards modulation
® AM Source Ext
positive depth and negative external voltage -> downwards modulation
positive depth and positive external voltage -> upwards modulation
negative depth and negative external voltage -> upwards modulation
negative depth and positive external voltage -> downwards modulation

Remote command:
[ :SOURce<hw>] :AM: DEPTh:LINear on page 326
[ : SOURce<hw>] : AM: DEPTh:EXPonential on page 325

LF Gen Freq
Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.
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Remote command:
[ :SOURce] : LFOutput<ch>:FREQuency on page 349

LF Gen Shape
Selects the waveform shape of the LF signal.

ILFGen Shape |Sine |z|

Source Impedance Square

Triangle
Sawtoaoth
Inv. Sawtooth

Note: The installed hardware determines the available settings. Use the Hardware
Config dialog to check the hardware the instrument is equipped with.

For information on the required hardware revision, refer to the release notes.

Remote command:
[ :SOURce] : LFOutput : SHAPe on page 357

AM Sensitivity
Displays the input sensitivity of the externally applied modulation signal at the MOD
EXT input in %/V in AM Type Linear mode, and dB/V in AM Type Exponential mode.

The modulation depth entered under AM Depth is achieved with 1 Volt modulation of
the input.

Remote command:
[ :SOURce<hw>] :AM: SENSitivity? on page 327

AM External Coupling
Selects the coupling mode (AC or DC) for external feed.

Note: Coupling for external feed via input MOD EXT can be set independently for all
modulations using the external modulation signal.

"AC" Disconnects the DC voltage component and uses only the AC com-
ponent of the modulation signal.

"DC" Uses the modulation signal with both components, AC and DC.

Remote command:
[ :SOURce<hw>] :AM:EXTernal : COUP1ing on page 326

Ext. Impedance
(Source "External" only)

Sets the impedance for the external modulation signal, applied at the MOD EXT con-
nector.

You can select 600 Ohm or high (>100 kOhm).
This setting affects all analog modulations which use the external modulation signal.

Remote command:
[ :SOURce<hw>] : INPut :MODext : IMPedance on page 347
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Ignore Overvoltage Warning
Suppresses warnings the instrument generates when the modulation signal input is
overloaded.

This function prevents a warning caused by signals, that generally comply with the
specification, but temporarily overload the input, for example due to spikes. The warn-
ing is suppressed in the history, and in the error queue.

Note: This setting is not affected by an instrument preset (PRESET key), *rst or the
Save/Recall function. Only the factory preset resets (enables) this setting.

Remote command:
[ : SOURce<hw>] : INPut :MODext :WIGNore on page 348

5.4.3 Frequency Modulation (FM)

An internal and/or external source can be selected for frequency modulation. The LF
GEN modulation generator is available as the internal source. Two-tone FM is possible
by simultaneously switching on the external and internal source.

The MOD EXT input connectors for external feed of analog modulation signals are at
the front of the instrument. The coupling mode of the input (AC or DC) can be selected.
Selection between three modulation modes is possible:

® "Normal" mode with full setting range for modulation bandwidth and FM deviation.

® "Low Noise" mode with better signal/noise ratio, but reduced setting range for mod-
ulation bandwidth

® "High Deviation" mode with full setting range for FM deviation and a reduced set-
ting range for modulation bandwidth (see data sheet).

6 It is not possible to use frequency modulation simultaneously with phase modulation.

See "Simultaneous Operation of Several Modulations or Other Operating Modes"
on page 198 for an overview in detail.

5.4.3.1 Frequency Modulation Settings

Modulation

To access the "Frequency Modulation" dialog, select "Modulation > Configure > Fre-
feaienaiceaol  quency Modulation" or use the MENU key under "Modulation”.

Pulse Madulation..

In the upper section of the dialog, you can select the modulation source and activate
modulation. The modulation source can be selected independently for the different
modulation types and the LF output.

The configuration of the selected external and/or internal modulation source is per-
formed in the lower section of the menu (internal source only).

These settings affect all modulations which use the same modulation sources.
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Frequency Modulation X

FM Source IInt+Ext vl
FM Mode INormaI "I
FM Deviation | 1D.DUD|kHz vl

FM Source = Internal
LFGenFreq |  1.00000|kHz |

LFGen Shape ISine "I

FM Source = External
Adjust FM Offset |

FM Sensitivity | 5000 Hziolt
Mod Ext Cnuplinglﬁc vl
Ext Impedance IHigh "I

lgnore Overvoltage Warning r

State
Activates frequency modulation.

Activation of FM deactivates phase modulation.

Remote command:
[ :SOURce<hw>] : FM: STATe on page 340

FM Source
Selects the source for the FM signal.

"Internal” Uses the internal LF generator as modulation signal source for FM.

"External" Uses an externally applied modulation signal.
The external signal is input via the MOD EXT connector.

"Internal + External"
Uses both, the internal and externally applied modulation signal, for
example to perform two-tone FM.

Remote command:
[ :SOURce<hw>] : FM: SOURce on page 339

FM Mode

Selects the mode for the frequency modulation.

"Normal" The maximum range for modulation bandwidth and FM deviation is
available.

"Low Noise" Frequency modulation with phase noise and spurious characteristics

close to CW mode. The ranges of modulation bandwidth and FM
deviation are reduced (see data sheet).

"High Deviation"
Frequency modulation with full setting range for FM deviation. The
range of modulation bandwidth is reduced (see data sheet).

Remote command:
[ : SOURce<hw>] : FM: MODE on page 338
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FM Deviation
Sets the modulation deviation in Hz.

The maximum deviation depends on the RF frequency and the modulation mode (see
data sheet).

Note that you can set a deviation that is too high for a specific RF frequency, or set an
RF frequency outside of the adjustable range of the deviation. In both cases, the instru-
ment sets the maximum deviation and displays an error message.

In "Int + Ext" modulation source mode, the instrument devides the deviation into half for
each source.

Remote command:

[ :SOURce<hw>] :FM[:DEViation] on page 337

[ :SOURce<hw>] :FM: INTernal :DEViation on page 338
[ :SOURce<hw>] :FM:EXTernal :DEViation on page 338

LF Gen Freq
Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

Remote command:
[ :SOURce] : LFOutput<ch>:FREQuency on page 349

LF Gen Shape
Selects the waveform shape of the LF signal.

ILFGen Shape |Sine [~

Source Impedance Square

Triangle
Sawtooth
Inv. Sawtooth

Note: The installed hardware determines the available settings. Use the Hardware
Config dialog to check the hardware the instrument is equipped with.

For information on the required hardware revision, refer to the release notes.

Remote command:
[ :SOURce] : LFOutput : SHAPe on page 357

FM Sensitivity
Displays the input sensitivity of the externally applied modulation signal at the MOD
EXT input in Hz/V.

The modulation deviation entered with FM Deviation is achieved with 1 Volt (= Upeq) Of
the input signal.

Note: The input voltage must not exceed 1.1 V, otherwise modulation distortions
occur.

Remote command:
[ :SOURce<hw>] :FM: SENSitivity? on page 339
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Adjust FM Offset
Starts the adjustment for the FM/PhiM modulator. The option is adjusted concerning
DC-offset.

Remote command:
:CALibration<hw>:FMOFfset[:MEASure]? on page 286

FM External Coupling
(Source "External" only)

Selects the coupling mode (AC or DC) for the externally applied frequence modulation
signal.

Note: Coupling for external feed via input MOD EXT can be set independently for all
modulations using the external modulation signal.

"AC" Disconnects the DC voltage component and uses only the AC com-
ponent of the modulation signal.

"DC" Uses the modulation signal with both components, AC and DC.

Remote command:
[ :SOURce<hw>] :FM:EXTernal :COUP1ling on page 337

Ext. Impedance
(Source "External" only)

Sets the impedance for the external modulation signal, applied at the MOD EXT con-
nector.

You can select 600 Ohm or high (>100 kOhm).
This setting affects all analog modulations which use the external modulation signal.

Remote command:
[ :SOURce<hw>] : INPut :MODext : IMPedance on page 347

Ignore Overvoltage Warning
Suppresses warnings the instrument generates when the modulation signal input is
overloaded.

This function prevents a warning caused by signals, that generally comply with the
specification, but temporarily overload the input, for example due to spikes. The warn-
ing is suppressed in the history, and in the error queue.

Note: This setting is not affected by an instrument preset (PRESET key), *rst or the
Save/Recall function. Only the factory preset resets (enables) this setting.

Remote command:
[ :SOURce<hw>] : INPut :MODext : WIGNore on page 348
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5.4.4 Phase Modulation (PhiM)

6 It is not possible to use phase modulation simultaneously with frequency modulation.

See "Simultaneous Operation of Several Modulations or Other Operating Modes"
on page 198 for an overview in detail.

An internal and/or external source can be selected for phase modulation. The LF GEN
modulation generator is available as the internal source.

The MOD EXT input connector for external feed of analog modulation signals is at the
front of the instrument. The coupling mode of the input (AC or DC) and the impedance
can be selected.

Selection between the following modulation modes is possible:

e "Normal" mode with full setting range for modulation bandwidth and ¢M deviation.

® "High Deviation" mode with full setting range for $M deviation and a reduced set-
ting range for modulation bandwidth. Phase noise is reduced in the lower modula-
tion frequency range compared to the default mode.

® "Low Noise" mode with better signal/noise ratio, but reduced setting range for mod-
ulation bandwidth and deviation (see data sheet)

5.4.4.1 Phase Modulation Dialog

Modulation

e .| 10 Open the "Phase Modulation” dialog, select "Modulation > Configure > Phase Modu-
femmamen.l - [ation” or use the MENU key under "Modulation".

Pulse Modulation...

Phase Modulatio

State

PhiM Source IInt+Ext 'I
PhiM Mode INormaI vl
PhiM Deviation |1.DDD Dﬂlrad vl

PhiM Source = Internal
LFGenFreq |  1.00000kHz »|

LFGen Shape |Sine 'I

PhiM Source = External
PhiM Sensitivity Iﬂ.!iﬂlllln rad perVolt

Mod Ext Coupling AC -
Ext Impedance IHigh vI
lgnore Overvoltage Warning r

In the upper section of the dialog, the modulation source is selected and the modula-
tion switched on. The modulation source can be selected independently for the differ-
ent modulation types and the LF output.

The configuration of the selected external and/or internal modulation source is per-
formed in the lower section of the dialog (internal source only).

These settings affect all modulations which use the same modulation sources.
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An LF generator and a pulse generator are available as internal sources.

State
Activates $M modulation.

Activation of M deactivates frequency modulation.

Remote command:
[ :SOURce<hw>] : PM: STATe on page 376

$M Source
Selects the source for the M signal.

"Internal” Uses the internal LF generator as the modulation signal source for
oM.

"External" Uses an externally applied modulation signal.
The external signal is input via the MOD EXT connector.

"Internal + External"
Uses both, the internal and externally applied modulation signal.

Remote command:
[ : SOURce<hw>] : PM: SOURce on page 375

$M Mode
Selects the mode for the phase modulation.

"Normal"
The full range for modulation bandwidth and PM deviation is availa-
ble.

"High Deviation"
The maximum range for $M deviation is available. Phase noise is
improved for low frequencies compared to the default mode. The
range of modulation frequency is limited (see data sheet).
This mode is recommended for low modulation frequencies and/or
high ¢M deviation.

"Low Noise" Phase modulation with phase noise and spurious characteristics
close to CW mode. The range for modulation bandwidth and PM
deviation is limited (see data sheet).

Remote command:
[ : SOURce<hw>] : PM: MODE on page 375

¢M Deviation
Sets the modulation deviation in RAD.

The maximum deviation depends on the set RF frequency and the selected modulation
mode (see data sheet).

If the entered deviation is too high for the set RF frequency, the instrument provides
the maximum value and displays an error message. The same applies, if the RF fre-
quency is set to a value, at which the deviation cannot be determined.

The deviation of the internal source must not exceed the deviation of the external
source in case of modulation source "Int+Ext".
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Remote command:

[ :SOURce<hw>] :PM[:DEViation] on page 373

[ :SOURce<hw>] :PM: INTernal :DEViation on page 374
[ :SOURce<hw>] :PM:EXTernal :DEViation on page 374

LF Gen Freq
Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

Remote command:
[ :SOURce] : LFOutput<ch>:FREQuency on page 349

LF Gen Shape
Selects the waveform shape of the LF signal.

ILFGen Shape |Sine [~

Source Impedance Square

Triangle
Sawtooth
Inv. Sawtooth

Note: The installed hardware determines the available settings. Use the Hardware
Config dialog to check the hardware the instrument is equipped with.

For information on the required hardware revision, refer to the release notes.

Remote command:
[ :SOURce] : LFOutput : SHAPe on page 357

$M Sensitivity
Displays the input sensitivity of the externally applied modulation signal at the MOD
EXT input in RAD/V.

The modulation deviation entered with &M Deviation"$M Deviation" is achieved with 1
Volt (=Ueq) Of the input signal.

Note: The input voltage must not exceed 1.1 V, otherwise modulation distortions
occur.

Remote command:
[ :SOURce<hw>] : PM: SENSitivity? on page 375

PhiM Ext Coupling
Selects the coupling mode ("AC" or "DC") for the external modulation signal.

Note: Coupling for external feed via input MOD EXT can be set independently for all
modulations using the external modulation signal.

"AC" Disconnects the DC voltage component and uses only the AC com-
ponent of the modulation signal.

"DC" Uses the modulation signal with both components, AC and DC.

Remote command:
[ :SOURce<hw>] :PM:EXTernal :COUPling on page 373
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Ext. Impedance
(Source "External" only)

Sets the impedance for the external modulation signal, applied at the MOD EXT con-
nector.

You can select 600 Ohm or high (>100 kOhm).
This setting affects all analog modulations which use the external modulation signal.

Remote command:
[ :SOURce<hw>] : INPut :MODext : IMPedance on page 347

Ignore Overvoltage Warning
Suppresses warnings the instrument generates when the modulation signal input is
overloaded.

This function prevents a warning caused by signals, that generally comply with the
specification, but temporarily overload the input, for example due to spikes. The warn-
ing is suppressed in the history, and in the error queue.

Note: This setting is not affected by an instrument preset (PRESET key), *rst or the
Save/Recall function. Only the factory preset resets (enables) this setting.

Remote command:
[ :SOURce<hw>] : INPut :MODext : WIGNore on page 348

5.4.5 Pulse Modulation (PM)

The available options for performing pulse modulation include:
® option Pulse Modulator (R&S SMB-K22)

® option Pulse Generator (R&S SMB-K23) , comprises "Single" and "Double" pulse
generation

® option Pulse Train (R&S SMB-K27), enables generation of pulse trains.

As modulation signal, you can either use the signal of the internal pulse generator or
an externally supplied signal. In case of external source, the external signal is input via
the PULSE EXT connector at the rear of the instrument. In case of internal source, this
connector can be used as external trigger or gate signal input for internal pulse modu-
lation. The polarity and input impedance of the connector can be selected.

The pulse signal is output at the PULSE VIDEO connector at the rear of the instru-
ment.
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6 Automatic Level Control is deactivated with pulse modulation!

When pulse modulation is activated, the R&S SMB deactivates ALC automatically
("ALC OFF", i.e. switches to "Sample & Hold" state).

The "Sample&Hold" state opens the ALC loop, and disables the automatic control of
the output level. The level modulator is set directly.

However, to correct the output level, the R&S SMB executes a "Sample & Hold" mea-
surement after each change of frequency or level settings.

The level is decreased by 30 dB during "Sample & Hold" measurement.

5.4.5.1 Pulse Modulation Settings

Modulation
Amplitude Modulation..
Freguency Modulation...

» To access the "Pulse Modulation" settings, select "Modulation > config... > Pulse

Phase Modulation... MOdUIat'On"
Pulse Modulation. .
Pulse Modulation E3 Pulse Modulation X
State State
Source IPuIse Generatar vl
Source IExlernaI v[
— Pulse Generator————————————
Pulse Mode ISingIe vl Polarity INarmal vI
FPulse Period | 1D-UU|I-'S 'l ConnectorTrigger Settings
Pulse WWidth | 2.UU||JS 'l External Impedance |5E] 0 'l
Fulse Delay I 0.01 ||.|S vl
ConnectorTrigger Settings

Trigger Mode IExtTriggered vl
Ext Trigger Input Slope IPositive vl
External Impedance ISD ] vl

Use SIGHNALVALID as Pulse Syne ¥ on

The dialog contains all parameters for configuring a pulse modulation signal, com-
prising the signal source, pulse generator and trigger settings.

Depending on the selected modulation source, the provided parameters vary:

® "Source Pulse Generator"
Displays the parameters for configuring the pulse generator signal, which in turn
vary according to the selected "Mode > Single / Double ...".
Note: Extended features as the generation of double pulse signals or selectable
trigger mode require option R&S SMB-K23.

e "External"
Enables you to configure the polarity of an externally supplied pulse modulation
signal.

Additionally, you can use the internally generated Valid Signal for synchronization of
the pulse modulation, and assign this signal to the VALID SIGNAL connector, see
Chapter 5.5.4.1, "Pulse Generator Settings", on page 226 for description.

Note: The pulse generator settings in this dialog are mirrored from the actual "Pulse
Generator" dialog of the "Mod Gen" block. Therefore find the description on the access
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and the corresponding parameters under in Chapter 5.5.4.1, "Pulse Generator Set-
tings", on page 226.

Option R&S SMB-K27 enables the generation of pulse trains. For description of the
pulse train dialog, see Chapter 5.5.4.2, "Pulse Train Generation", on page 230.

State
Activates pulse modulation.

When the internal modulation source (pulse generator) is selected, the pulse generator
is switched on automatically and the video/sync signal is output at the PULSE VIDEO
output at the rear of the instrument. Signal output can be switched off in the "Pulse
Generator" dialog (see Chapter 5.5.4, "Pulse Generator", on page 226).

Remote command:
[ : SOURce<hw>] : PULM: STATe on page 394

Source
Selects the modulation signal source for pulse modulation.

"Pulse Generator"
Uses the pulse generator as modulation signal source.
Uses the internally generated rectangular signal pulse modulation.

"External” Uses an externally applied modulation signal.
The external modulation signal is input via the PULSE EXT connec-
tor.

Remote command:
[ : SOURce<hw>] : PULM: SOURce on page 393

Polarity
(External Source only)

Selects the polarity of the modulation signal.
"Normal" The RF signal is On while the level is high at the modulation input.
"Inverse" The RF level is Off if the level is high at the modulation input.

Remote command:
[ :SOURce<hw>] : PULM: POLarity on page 393

Stereo Modulation

Options R&S SMB-B5, Stereo/RDS Coder enables generation of stereo-modulated RF
signals according to standard. Beside the MPX (FM stereo multiplex) signal, also the
radio traffic service ARI (Automotive Radio Information) and Radio Data System (RDS)
are supported by the option.

An internal or external source can be selected for the audio signal of the stereo modu-
lation. In case of external source, the external signal is input via the analog L and R
inputs or via the digital S/P DIF interface at the rear of the instrument. In case of inter-
nal source, the LF generator is used. Measurements can be performed in the operating
modes L and R, and L =R, L =-R and R!=L (ext. signals only).
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A typical setup with the R&S SMB with the option Stereo/RDS Coder in connection
with the Audio Analyzer UPV is shown in the following graph.

R&S SMB100A Signal Generator
incl. Stereo/RDS Coder (R&S SMB-B5)

) g RF modulated test signal
=% including ARI and RDS
» FM stereo tuner
Analog or digital audio signals
R&S UPV Audio Analyzer
Signal generation and analysis Analog audio signals

5.4.6.1 Stereo Modulation Dialog

To open the "Stereo Modulation" dialog, select "Modulation > Configure > Stereo Mod-
ulation" or use the MENU key under "Modulation".

H Modulation
= Amplitude Mod...
i~ Frequency Mod...
= Phase Mod...
i~ Pulse Mod

In the upper section of the menu, the stereo modulation is configured and switched on.
The configuration and activation of the additional pilot tone, ARI and RDS settings is
performed in the lower section of the dialog.
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e o ]
FII Deviation I 40.000 IkHz -
Audio Source IExt LR -
Made IMnnn Left -
Ext R L Impedance IﬂDD kOhm -
Preemphasis ISD ys -
Max Modulation Freq I 1.000 IkHz -
Stereo Pilot Tone Settings
Pilot State
Pilot Deviation 5.750 IkHz 'l
Filot Phase 0.0 Ideg 'l
AR Setting
ARI State Qff |
ARI Deviation 3.500 IKHZ 'l
ARI Identification Off 'l
ARI BK & -l
RDS Setting
RDS Deviation 2.000 IKHZ 'l
RDS Data Set Ds1 'l
Program Service Mame
Pragram Identification
Traffic Program _
Traffic Announcement _
Stereo Coder
‘AdjustmentData [Factory
General Settings
State - Stereo Modulation
Activates/deactivates stereo modulation.
Remote command:
[:SOURce] : STEReo: STATe on page 416
FM Deviation - Stereo Modulation
Sets the MPX (Multiplex stereo signal) deviation.
Remote command:
[:SOURce] : STEReo [ :DEViation] on page 417
Audio Source - Stereo Modulation
Selects the source for the audio signal.
"Off" No audio signal is provided, ARl and RDS signal can be generated
separately.
"Ext L,R" The external audio stereo signal is feed in via the analog L and R
inputs.
"Ext S/P Diff" The external audio signal is feed in via the digital S/P DIF input.
"LF Gen" The audio stereo signal is internally generated by the LF generator.

Remote command:
[ :SOURce] : STEReo: SOURce on page 416
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Mode - Stereo Modulation

Selects the mode for the audio signal. If the internal LF generator is selected as audio
source, the signal is generated according to the selection here. For external signals,
the signal type has to be entered.

"Mono Left" A mono signal containing the left channel is generated/fed in.
"Mono Right" A mono signal containing the right channel is generated/fed in.

"Stereo R=L" A stereo signal with right and left channel is generated/fed in. The
channels have the same frequency and phase.

"Stereo R=-L"  The signal on the left external audio input is used for both channels,
left and right. The right channel is inverted.

"Stereo R!=L"  (External source only)
A stereo signal containing different, independent right and left chan-
nels is fed in. It is possible, for example, to feed a fixed audio fre-
quency to the first channel while a frequency sweep is being per-
formed in the second channel.

Remote command:
[ :SOURce] : STEReo: AUDio :MODE on page 410

LF Gen Freq - Stereo Modulation
(Audio source "LF Gen" only)

Sets the frequency of the LF generator signal.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

Remote command:

(two alias commands are available)

[:SOURce] : STEReo:AUDio [ : FREQuency] on page 412
[:SOURce] : LFOutput<ch>:FREQuency on page 349

LF Gen Shape - Stereo Modulation
(Audio source "LF Gen" only)

Selects the shape of the LF generator signal.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

Remote command:
[:SOURce] : LEOutput : SHAPe on page 357

External R/L Impedance - Stereo Modulation
(External analog audio signal input only)

Selects the input impedance for the external analog audio signal inputs L and R.

Remote command:
[:SOURce] : STEReo:EXTernal : IMPedance on page 413

Preemphasis - Stereo Modulation
Activates and sets the pre-emphasis used for signal generation.
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Remote command:
[:SOURce] : STEReo: AUDio: PREemphasis: STATe on page 412
[:SOURce] : STEReo : AUDio: PREemphasis on page 411

Max Modulation Freq- Stereo Modulation
Sets the maximum modulation frequency that may be used.

This parameter is valid/required only when pre-emphasis has been activated and an
external modulation source is used.

Pre-emphasis increases the high-frequency portions of the signal in the level before
the FM modulator is reached. This can lead to internal overload of the modulator in the
case of sinewave signals with full modulation. The MMF parameter is used to reduce
the internal full modulation to such an extent that sinewave signals with nominal volt-
age can be transmitted with low distortion at the stereo input even when pre-emphasis
up to the set frequency has been activated. However, this reduces the S/N ratio on the
basis of the increase in level by the pre-emphasis (at the MMF that has been set).

In the case of normal modulation signals such as voice or music, this parameter can be
left at its default value because the amplitude of the high-frequency portions of these
signals normally decreases substantially.

Remote command:
[ :SOURce] : STEReo : MME on page 413

Stereo Pilot Tone Settings

The 19 kHz pilot tone is configured in the "Stereo Pilot Tone Settings" section.

Pilot State - Stereo Modulation
Activates/deactivates the pilot tone generation.

Remote command:
[:SOURce] : STEReo: PILot: STATe on page 414

Pilot Deviation - Stereo Modulation
Sets the deviation of the pilot tone.

Remote command:
[:SOURce] : STEReo:PILot [ :DEViation] on page 414

Pilot Phase - Stereo Modulation
Sets the phase of the pilot tone in relation to the 38 kHz carrier signal of the receiver.
For a correct demodulation, the pilot tone must be in phase with the 38 kHz carrier.

Remote command:
[:SOURce] : STEReo: PILot : PHASe on page 413
ARI Settings

The radio traffic service ARI (Automotive Radio Information) is configured in the "ARI
Settings" section.
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ARI State - Stereo Modulation
Activates/deactivates the ARI signal generation. ARI signals can be generated simulta-
neously with MPX and RDS signals.

Remote command:
[:SOURce] : STEReo:ART : STATe on page 409

ARI Deviation - Stereo Modulation
Sets the frequency deviation of the ARI subcarrier signal.

Remote command:
[:SOURce] : STEReo:ARI [ :DEViation] on page 410

ARI Identification - Stereo Modulation
Selects the generated identifiers of the ARI signal.

"Off" Only the 57 kHz subcarrier is generated (Senderkennung). It marks
the stations which broadcast traffic programs and enables the
receiver to recognize the frequency as being ARI-capable.

"DK" The message identification (Durchsagekennung) is generated in addi-
tion (low-frequency 30% AM). It signalizes that a traffic message is
currently broadcasted.

"BK" The area identification (Bereichskennung) is generated in addition
(60% AM). This code is used to identify the geographical region cov-
ered by the radio station. The specific code is selected below.

"DK+BK" The area and message identification are generated in addition.

Remote command:
[ :SOURce] : STEReo:ART : TYPE on page 409

ARI BK - Stereo Modulation
Selects the specific area identification (BK) code of the ARI signal. The six letters (six
different frequencies) identify a specific region in each country.

Remote command:
[ :SOURce] : STEReo:ART :BK[:CODE] on page 408

RDS Settings

The RDS (Radio Data System) is configured in the RDS Settings section, RDS is a
communications protocol standard from the European Broadcasting Union for sending
digital information embedded in conventional FM radio broadcasts. The RDS system
standardises several types of transmitted information, including time, track/artist info
and station identification.

RDS State - Stereo Modulation
Activates/deactivates the RDS signal generation. RDS signals can be generated simul-
taneously with MPX and ARI signals.

Remote command:
[:SOURce] : STEReo :RDS: STATe on page 414
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RDS Deviation - Stereo Modulation
Sets the deviation of the RDS subcarrier.

Remote command:
[:SOURce] : STEReo:RDS [ :DEViation] on page 415

RDS Data Set - Stereo Modulation

Selects the data set used in the RDS signal. Five data sets are provided on the instru-
ment. The values of the data sets can be defined via remote control (command
SOURce: STEReo:DIRect)

Each of these data sets contains predefined values for:

PI (program identification, identifies the broadcast station )

PS or scrolling PS (program service name, represents the station identity name)
TP (traffic program, mark stations with regular traffic programs )

TA (traffic announcement, marks the start of a traffic program)

PTY (program type, predefined genres of broadcasting programs, e.g. news)
PTYN (program type name)

DI (decoder information)

MS (music /speech)

CT (clock time, used for synchronization)

The following values are empty:

e RT (radio text, two text blocks with 64 symbols each)

® AF (alternative frequencies, maximum of five lists with 25 frequencies each, ena-
bles the receiver to re-tune to a different frequency providing the same station
when the first signal becomes too weak)

® TMC (traffic message channel)

® EON (enhanced other networks, eight PS with five EON AF lists each, enables the
receiver to automatically tune into these stations if a traffic programs are broadcas-
ted)

The program identification and the program service name of the selected data set are
indicated in the menu.

Remote command:
[:SOURce] : STEReo:RDS:DATaset on page 414

RDS Program Service Name - Stereo Modulation
Indicates the RDS program service name.

Remote command:
[ :SOURce] : STEReo:DIRect on page 412

RDS Program ldentification - Stereo Modulation
Indicates the RDS program identification.

Remote command:
[ :SOURce] : STEReo: DIRect on page 412

RDS Traffic Program State - Stereo Modulation
Activates the RDS traffic program (TP function). The receiver can recognize a fre-
quency as being capable of traffic information only if the TP function is active.

[
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Remote command:
[:SOURce] : STEReo:RDS: TRAFfic: PROGram[ : STATe] on page 415

RDS Traffic Announcement State - Stereo Modulation

Activates the RDS traffic announcement (TA function). If activated, the receiver
switches from the current status, e.g. playing a CD, to the receive mode and enables
the broadcast of a traffic announcement. The TP state has to be on.

Remote command:
[:SOURce] : STEReo:RDS: TRAFfic:ANNouncement [ : STATe] on page 415

Adjustment Data
Indicates the adjustment state of the analog channels of the stereo coder. For the
adjustment of the S/P DIF see service manual, chapter 2, "Adjustment”.

See also "Adjust Stereo Coder" on page 94.

Modulation Generator and LF Output

Overview of LF Generator

The internal modulation generator of the instrument provides a sinusodial or rectangu-
lar LF modulation signal without additional equipment options. The corresponding key
data, as for example the frequency range, is specified under "Modulation sources" in
the data sheet.

You can use the internal LF signal as modulation signal source for the analog modula-
tions, as for example the amplitude modulation. The signal applies to all modulations
which are using the internal modulation signal. Therefore, any modification of the LF
signal impacts all currently active modulations immediately.

To configure the LF generator signal, see Chapter 5.5.2.1, "LF Output Dialog",

on page 219. However, you can also configure the LF signal directly in the settings
dialogs of the analog modulations.

Optionally, the instrument provides the following modulation sources:

® Pulse Generator (option R&S SMB-K23) for generating single and double pulse
signals, see Chapter 5.5.4, "Pulse Generator", on page 226.

® High-performance pulse generator (option R&S SMB-K27) for generating pulse
train signals.

The R&S SMB also provides the configured LF signal at the corresponding output con-
nector, for example as modulation signal source for interconnected instruments.

LF Output
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FMfﬁg‘::gﬁa?;"fgﬁgﬂ » To open the "LF Generator / Output" dialog, select "Mod Gen > Configure > LF
Generator / Output" or use the MENU key under "Mod Gen".

LF Generator / Qutput
LF QOutput State

LF OutputVoltage I 1.DDU|V 'I

LF GenFreq |  1.00000 [kHz ~|

LF Gen Shape ISine vl
Source Impedance |L0w vI

The dialog provides access to the configuration of the internal modulation genera-
tors, and you can activate the output of the LF signal

The available settings depend on the source selected and on the installed options.
Alternatively, you can perform the settings also in the correpsonding dialogs of the
analog modulations, like "Amplitude Modulation". The configured LF signal applies
to all modulations which use the internal modulation sources, and to the LF output.

6 AM Exponential (Instruments with 12, 20, or 40 GHz frequency options)

If you perform exponential AM (AM Type Exponential) with the internal signal of the LF
generator, the LF output provides the exponential modulation signal.

Using AM Source External, the instrument supplies the distorted external signal. The
signal of the internal modulation generator is not available, as well as setting the
parameters LF Gen Freq and "LF Gen Shape" on page 201.

The remote commands required to define these settings are described in Chap-
ter 7.13.6, "SOURce:LFOutput Subsystem", on page 348.

5.5.2.1 LF Output Dialog

LF Output State
Activates the LF output. This setting has no effect on the modulations.

The modulation signal is output at the LF OUTPUT connector of the instrument.

Remote command:
[ :SOURce] : LFOutput [:STATe] on page 352

LF Output Voltage
Sets the voltage (peak) of the LF output signal.

Remote command:
[ :SOURce] : LFOutput :VOLTage on page 358

LF Gen Freq
Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.
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|— Wodulation Generator —|
LF Generator/ Cutput.

LF Freguency Sweep.

Modulation Generator and LF Output

Remote command:
[ :SOURce] : LFOutput<ch>:FREQuency on page 349

LF Gen Shape
Selects the waveform shape of the LF signal.

|Sine |z|

Square
Triangle
Sawtooth

Inv. Sawtooth

ILFGen Shape

Source Impedance

Note: The installed hardware determines the available settings. Use the Hardware
Config dialog to check the hardware the instrument is equipped with.

For information on the required hardware revision, refer to the release notes.

Remote command:
[ :SOURce] : LFOutput : SHAPe on page 357

LF Source Impedance
Selects the output impedance of the LF generator. Selection LOW and 600 Ohm are
available.

Note: The installed hardware determines the available settings. Use the Hardware
Config dialog to check the hardware the instrument is equipped with.

For information on the required hardware revision, refer to the release notes.

Remote command:
[:SOURce] : LFOutput: SIMPedance on page 358

LF Frequency Sweep
The "LF Frequency Sweep" dialog is used to configure and activate an LF frequency
sweep signal.

To open the "LF Frequency Sweep" dialog, select "Mod Gen > Configure > LF Fre-
quency Sweep" or use the MENU key under "Mod Gen".

The LF sweep mode is activated and the sweep mode is selected. The buttons are
used to reset the LF sweep (all sweep modes) or to execute the LF sweep ("Single"
mode).

The sweep range, sweep spacing and dwell time are set in the bottom of the section.
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LF Frequency Sweep _X
State
Mode |Auto j
Reset Sweep |
Start Freq | 1.000 0 |kHz x|
Stop Freg | 50.0000|kHz x|
Current Freq | H.IZIIII]|kHz =]
Spacing |Linear j
Shape |Sawtooth j
Step Lin | 1.000 0 |kHz x|
Dwell Time | 10.0ms =]
State
Activates the LF frequency sweep signal generation.
Note:

Activating a sweep mode automatically deactivates other sweeps and the list mode.

Remote command:
[ : SOURce<hw>] : LFOutput : FREQuency :MODE on page 350

Mode
Selects the LF frequency sweep mode.

If you change the sweep mode during the execution, the signal generator stops the
sweep and starts with the next trigger event at the initial value.

The "Reset Sweep" button sets the sweep to the start value.

"Auto" Generates a continuously repeating sweep signal immediately after
activating the sweep mode.
The sweep steps are performed atomatically, controlled by the dwell
time, see "Dwell Time - LF Sweep" on page 225.

Example:

SOUR:LFO:SWE: FREQ:MODE AUTO
TRIGO:SWE:SOUR AUTO
SOUR:LFO:FREQ:MODE SWE
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"Single" Generates a single sweep cycle after a trigger event.
The sweep steps within the cycle are performed automatically, con-
trolled by the dwell time. If one cycle is completed, the instrument
waits for the next trigger event.
To trigger the sweep, use "Execute Single Sweep" button, or the cor-
responding remote control commands, for example *TRG.

Example:
SOUR:LFO:SWE: FREQ:MODE AUTO
TRIGO:SWE:SOUR SING
SOUR:LFO:FREQ:MODE SWE
SOUR:LFO:SWE: FREQ:EXEC
"Step" Generates the sweep signal step-by-step, manually triggered.

To perform the sweep steps, enter the frequency value under Current
Freq.

Example:

SOUR:LFO: SWE: FREQ:MODE MAN
SOUR:LFO:FREQ:MODE SWE
SOUR:LFO:SWE:FREQ:SPAC LIN
SOUR:LFO:SWE:FREQ:STEP:LIN 1E34
SOUR:LFO:FREQ:MAN 12 kHz

The value entered with command
SOUR:LFO:SWE:FREQ:STEP:LIN|LOG sets the step width.

The value entered with command SOUR: LFO: FREQ: MAN has no
effect, the command only sets the next sweep step. In remote control
only a step-by-step sweep from start to stop frequency is possible.

"Extern Single"
Generates a single sweep cycle when an a external trigger event
occurs.
The sweep steps within the cycle are performed automatically, con-
trolled by the dwell time. If one cycle is completed, the instrument
waits for the next trigger event.
To trigger the sweep, apply an external trigger signal.
Refer to the description of the rear panel for information on the con-
nectors for external trigger signal input (see Chapter 2.2, "Rear Panel
Tour", on page 21).

Example:

SOUR:LFO:SWE: FREQ:MODE AUTO
TRIGO:SWE:SOUR EXT
SOUR:LFO:FREQ:MODE SWE (External trigger)
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"Extern Step"  Generates the sweep signal step-by-step, manually triggered.
To trigger a sweep step, apply an external trigger signal. The step
width corresponds to the step width set for the rotary knob.

Example:

SOUR:LFO:SWE: FREQ:MODE AUTO
TRIGO:SWE:SOUR EXT
SOUR:LFO:FREQ:MODE SWE (External trigger)

"Extern Start/  Generates a continuously repeating sweep signal that is started,
Stop" stopped and restarted by subseqgeunt external trigger events. The
sweep steps are performed automatically, controlled by the dwell
time.
Refer to the description of the rear panel for information on the con-
nectors for the external trigger signal input (see Chapter 2.2, "Rear
Panel Tour", on page 21).

Example:

SOUR:LFO:SWE: FREQ:MODE AUTO
TRIGO:SWE:SOUR EAUT
SOUR:LFO:FREQ:MODE SWE (External trigger)

Remote command:

[ : SOURce<hw>] : LFOutput : SWEep [ : FREQuency] :MODE on page 353
:TRIGger<hw>[:SWEep] : SOURce on page 454

[ : SOURce<hw>] : LFOutput : FREQuency : MODE on page 350

Execute Single Sweep
Starts a sweep manually. This trigger button is displayed in "Single" mode.

Example:

SOUR:LFO:SWE: FREQ:MODE AUTO
TRIG:LFFS:SWE:SOUR SING
TRIG:LFFS

Remote command:

[ : SOURce<hw>] : LFOutput : SWEep [ : FREQuency] : EXECute on page 352
:TRIGger<hw>:LFFSweep: IMMediate on page 452
:TRIGger<hw>:LFFSweep on page 452

:TRIGger<hw>[:IMMediate] on page 455

Reset Sweep
Resets a sweep.

With the next trigger event, the sweep starts with at the initial value.

Remote command:
[ :SOURce<hw>] : SWEep:RESet [ :ALL] on page 429
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Start Freq
Sets the start frequency.

Remote command:
[ : SOURce<hw>] : LFOutput : FREQuency: STARt on page 351

Stop Freq
Sets the stop frequency.

Remote command:
[ : SOURce<hw>] : LFOutput : FREQuency: STOP on page 351

Current Freq
Displays the current frequency.

In sweep "Step" mode, the parameter is editable and you can enter frequency for the
next step.

Remote command:
[ : SOURce<hw>] : LFOutput : FREQuency:MANual on page 350

Spacing
Selects the mode for the calculation of the frequency sweep intervals.

"Linear" Takes the frequency value entered as an absolute value in Hz

"Logarithmic"  Takes the value entered as a lograithmic value, that means as a con-
stant fraction of teh current frequency in %.

Remote command:
[ :SOURce<hw>] : LFOutput: SWEep [ : FREQuency] : SPACing on page 355

Shape
Selects the waveform shape of the sweep signal.

r

slo@
frequency)

stan
dragquinsy

stop

Eraquancy

start
Ersgquancy

"Sawtooth" The sweep runs from the start to the stop frequency. Each subse-
quent sweep starts at the start frequency, that means the shape of
the sweep sequence resembles a sawtooth.

"Triangle" The sweep runs from start to stop frequency and back, that means
the shape of the sweep resembles a triangle. A subsequent sweep
starts at the start frequency.

Remote command:
[ : SOURce<hw>] : LFOutput : SWEep [ : FREQuency] : SHAPe on page 355
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Retrace - LF Frequency Sweep
Activates that the signal changes to the start frequency value while it is waiting for the
next trigger event.

You can enable this feature, when you are working with sawtooth shapes in sweep
mode "Single" or "External Single", see Mode.

fA

Trigger Event | Trigger Event [

Retrace Off
stop frequency —

start frequency —

- —stoppedfﬂ+ — — —running— — — —bld— —stopped— 7DL¢ — — —running— — — —ﬂd— -stopped — —
B | | ! }

\
Retrace On | | \
stop frequency —

start frequency 4

Y

| | | [
- —stoppedf% — — —running— — — —b|¢ —stopped— 7}'-& — — —running— — — —bﬂ— -stopped — —

Remote command:
[ : SOURce<hw>] : LFOutput : SWEep [ : FREQuency] : RETRace on page 354

Step Lin/Log - LF Sweep
Sets the step width for the individual frequency sweep steps.

At each step this value is added to the current frequency.

Depending on the Spacing mode you have set, the corresponding parameter is dis-
played.

"Step Lin" The step width is a constant value in Hz.

Remote command:
[ :SOURce<hw>] : LFOutput: SWEep [ : FREQuency] : STEP [ : LINear] on page 356

"Step Log" The step width is determined logarithmically in %, that means as a
constant fraction of the current frequency.

Remote command:
[ :SOURce<hw>] : LFOutput: SWEep [ : FREQuency] : STEP: LOGarithmic
on page 357

Dwell Time - LF Sweep
Defines the duration of the individual sweep steps.
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The "Dwell Time" set by the user is used as the step time of the sweep. The effective
net dwell time is shorter, reduced by the setting time. This setting time may be greater
than the time specified in the data sheet.

Note:

It is recommended to switch off the display update for optimum sweep performance
especially with short dwell times (see Chapter 5.2.3.7, "Display Update", on page 100).

Remote command:
[ : SOURce<hw>] : LFOutput:SWEep [ : FREQuency] : DWEL1 on page 352

Ext. Trigger Input Slope
Sets the polarity of the active slope of an externally applied instrument trigger.

This setting affects the INST TRIG input (BNC connector at the rear of the instrument).
"Positive" activates the rising edge of the trigger signal.
"Negative" activates the falling edge of the trigger signal.

Remote command:
[ :SOURce] : INPut: TRIGger: SLOPe on page 348

5.5.4 Pulse Generator

The "Pulse Generator" dialog is used to configure and activate a pulse modulation sig-
nal.

5.5.4.1 Pulse Generator Settings

e 1 To access the pulse generator settings ...
LF Freguency Sweep..
Pulse Generatar..

» Select "Mod Gen > config... > Pulse Generator" or use the MENU key under "Mod
Gen".
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Alternatively, the R&S SMB provides the pulse generator parameters in the "Pulse
Modulation" dialog accessed via the "Modulation" block.

Pulse Generator x
[Video/Sync SignalState

Pulse Generator

Pulse Mode [Single |
Pulse Period | 10.00fus =]
Pulse Width | 2.00fus =|
Pulse Delay | 0.01|us =J

ConnectorTrigger Settings

Trigger Mode IExtern Single vI
Ext Trigger Input Slope IF"nsitive vI
External Impedance IEU 0 vI

Lse SIGMALVALID as Pulse Sync [T On

The dialog provides the settings for the pulse characteristics and trigger mode.
Depending on the selected modulation source and pulse mode the provided
parameters vary.

Note: Extended features as the generation of double pulse signals with selectable
pulse widths and periods, or selectable trigger mode require option R&S SMB-K23.

Video Sync Signal State - Pulse Generator

Switches on/off the output of the video/sync signal at the PULSE VIDEO connector.
The signal output and the pulse generator are automatically switched on with activation
of pulse modulation if pulse generator is selected as modulation source. The signal
output can be switched off subsequently.

Pulse modulation of the RF carrier is activated in the "Pulse modulation" menu of the
"Modulation" block.

Remote command:
[ : SOURce<hw>] : PGENerator: STATe on page 372

Pulse Mode - Pulse Generator
Sets the mode of the pulse generator.

"Single" A single pulse is generated in one pulse period.

"Double" Two pulses are generated in one pulse period. Additional settings for
the double pulse are available in the menu.

"Train" Requires option R&S SMB-K27.

A user-defined pulse train is generated. Additional settings for the
pulse train are available in the menu after selection of the pulse train
mode (see Chapter 5.5.4.2, "Pulse Train Generation", on page 230).
A pulse train is a sequence of pulses with user-defined on and off
times. The on-time/off-time value pairs are defined in a pulse train list.
The currently used pulse train file is displayed in the sub menu.
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Remote command:
[ : SOURce<hw>] : PULM:MODE on page 391

Pulse Period - Pulse Generator
Sets the period of the generated pulse. The period determines the repetition frequency
of the internal signal.

Remote command:
[ : SOURce<hw>] : PULM: PERiod on page 392

Pulse Width - Pulse Generator
Sets the width of the generated pulse. The width determines the pulse length. The
pulse width must be at least 20 ns less than the set pulse period.

Remote command:
[ :SOURce<hw>] : PULM: WIDTh on page 404

Pulse Delay - Pulse Generator
(External trigger only)

Sets the pulse delay. The pulse delay determines the time that elapses after a trigger
event before pulse modulation starts. The pulse delay is not effective for double pulse
generation.

Remote command:
[ :SOURce<hw>] : PULM: DELay on page 390

Double Pulse Width - Pulse Generator
(Double Pulse only)

Sets the width of the second pulse.

Remote command:
[ : SOURce<hw>] : PULM: DOUBle : WIDTh on page 391

Double Pulse Delay - Pulse Generator
(Double Pulse only)

Sets the delay from the start of the first pulse to the start of the second pulse.

Remote command:
[ : SOURce<hw>] : PULM: DOUBle: DELay on page 391

Trigger Mode - Pulse Generator
Selects the trigger mode for pulse modulation.

Note: An external trigger signal is supplied via the PULSE EXT connector.

llAutoll
The pulse generator signal is generated continuously.

"Single"
The pulse generator signal is triggered by an internal trigger event,
initiated with the "Execute Single Trigger" on page 229.

"Extern Single"
The pulse modulation is triggered by an external trigger event.
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"Extern Gated"
The pulse generator signal is gated by an external gate signal.

Remote command:
[ :SOURce<hw>] : PULM: TRIGger : MODE on page 399

Execute Single Trigger
Initiates a single pulse sequence manually.

This function is enabled in "Single Trigger ", see Trigger Mode - Pulse Generator

Remote command:
[:SOURce] : PULM[ : INTernal] [ : TRAin] : TRIGger: IMMediate on page 400
*TRG on page 283

External Trigger Input Slope - Pulse Generator
(External Trigger only)

Sets the polarity of the active slope of an applied trigger signal.

"Positive" The pulse generator is triggered on the positive slope of the external
trigger signal.

"Negative" The pulse generator is triggered on the negative slope of the external
trigger signal.

Remote command:
[ : SOURce<hw>] : PULM: TRIGger :EXTernal : SLOPe on page 399

Gate Input Polarity - Pulse Generator
(Trigger Mode External Gated only)

Selects the polarity of the Gate signal.

The signal is supplied via the PULSE EXT connector.

"Normal" The pulse signal is generated while the gate signal is high.
"Inverse" The pulse signal is generated while the gate signal is low.

Remote command:
[ :SOURce<hw>] : PULM: TRIGger:EXTernal : GATE : POLarity on page 398

External Impedance
Selects the input impedance (10 kOhm or 50 Ohm) for the external trigger and gate
signal input (PULSE EXT).

Remote command:
[ : SOURce<hw>] : PULM: TRIGger :EXTernal : IMPedance on page 399

Use SIGNAL VALID as Pulse Sync
Configures the signal at the SIGNAL VALID connector (rear panel):

"selected" Indicates the validity of the RF signal at the output:
® high: while the signal settles.
® Jow: when it is stable (valid).

"cleared" Generates a single pulse at the beginning of a pulse sequence, e.g.
to synchronize pulse modulation.
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Remote command:
[ :SOURce<hw>] : PULM:OUTPut:SYNC [ : STATe] on page 392

5.5.4.2 Pulse Train Generation

In "Pulse Train" mode, the instrument provides the associated parameters for configur-
ing a user-defined pulse train signal.

A pulse train is a sequence of pulses with user-defined on and off times. The "ON
Time / OFF Time" value pairs are defined in a pulse train table and can be stored in a
file. The currently loaded file is displayed in the dialog. You can export an internally
created pulse train list as well as import an externally created one.

train mode. Otherwise you get the error message "No current list" in the "Info" line, see

6 In remote control mode, you must first create a data file, before you switch to pulse
Example "Generating a pulse train signal" on page 389.

How to configure a pulse train signal

To perform pulse train generation, perform the following steps:

1. In the block diagram, select "Modulation > config... > Pulse Modulation".
2. Select "Source > Pulse Generator".

3. Select "Pulse Mode > Train".

Pulse Modulation X
State

Source IPuIse Generator 'I

Pulse Generator
Pulse Mode | Train =l

Pulse Train Data... | adg

Edit Pulse Train Data...

ImportExport === |

ConnectorTrigger Settings

Trigger Mode IExtern Single vl
Ext Trigger Input Slope IPositive 'I
External Impedance ISD 0 vl

Lse SIGMAL WALID as Pulse Sync [~ On

The instrument displays the parameters required for configuring pulse train data.
4. Select "Pulse Train Data... > New List / Select List or File Manager".

5. Navigate to the target directory and select an existing file, or create a new file by
assigning the "File Name".

6. According to your selection, confirm with "Save" or "Select".

The R&S SMB automatically uses the new file for further editing. Pulse train data
files have the fixed file extension * .pulstrn.
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7. Inthe "Pulse Modulation" dialog, select "Edit Pulse Train Data... > Edit" to define
the on and off time value pairs and the repetition factor for each value pair.

8. When completed, save the file.

9. Starting in the block diagram, perform the following steps to activate signal genera-
tion:

a) Select "Mod Gen > config... > Pulse Generator > Video/Sync Signal State >
Oon".

b) Select "Modulation > config... > Pulse Modulation > State > On".

c) Activate RF signal generation in the "RF" block.

The R&S SMB generates an RF pulse sequence signal according to the values
specified in the file.

Pulse Train Data — Pulse Generator
Opens the "File Select" dialog for selecting and creating a pulse train file, and provides
access to the "File Manager".

Remote command:

[ :SOURce<hw>] : PULM: TRAin:CATalog? on page 394
[ :SOURce<hw>] : PULM: TRAin:SELect on page 398

[ : SOURce<hw>] : PULM: TRAin:DELete on page 394

Edit Pulse Train Data — Pulse Generator
Opens the Pulse Train Dialog.

Pulse Train Dialog

Pulss Train Datoa - job

Displays the pulse sequence as defined in the file.

"Edit" Opens the pulse train dialog, see Edit Pulse Train Data. The dialog
graphically represents the pulse train signal and provides access to
the data editor.

"Zoom Position"
Sets the blue marker in the pulse train graph. The marker defines the
center of any zoom in or zoom out action.

"Zoom In / Zoom Out"
Enlarges the diagram by factor 2 per "Zoom In", or scales it down
accordingly when you select "Zoom Out".
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Edit Pulse Train Data

Opens an editor allowing you to enter the "On-Time / OFF-Time" value pairs in a table.
In addition, you can assign a repetition rate to each pair. Based on these values, the
instrument then generates the pulse train signal. You can enter any number of value
pairs and save your list in a file. The file name is displayed in the header of the dialog.

"ON-Time/ps"  Determines the length of the respective pulse (signal is high).

Remote command:
[ :SOURce<hw>] : PULM: TRA1in :ONTime on page 396

"OFF-Time/ys" Determines the time length, the signal level of the pulse remains low.

Remote command:
[ :SOURce<hw>] : PULM: TRAin:OFFTime on page 395

"Count" Sets the number of repetitions for each pulse ("ON-Time/us"/"OFF-
Time/ps" value pair).
Tip: If you set "Count = 0", the corresponding value pair is ignored in
the pulse sequence. With this function you can skip value pairs indi-
vidually, without deleting them from the table. This allows re-enabling
a value pair by entering a number unequal to zero.

Remote command:
[ :SOURce<hw>] : PULM: TRAin:REPetition on page 397

"Goto" Selects row for editing.

Goto 'ﬁrst

If Goto row is selected, a window opens for entering the requested
row.

(it is not possible to change individual positions of the list)

"Edit" Opens a menu containing editing functions.

Insert Row

It Rangi...
L

Delete Row

Delete Range...

"Insert Row" Inserts a new row before the marked row.
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"Insert Range" Inserts new rows before the marked row. The number of rows to be
inserted can be defined in an entry window.

Rows to Insert
ok | cance |
"Fill..." Opens a dialog for defining a set of list values to be automatically

entered in the list.

The start line and the number of rows to be filled are defined under
"From" and "Range".

The column to be filled is selected under "Select column to fill".
Depending on the selection here, the default for start, end, and incre-
ment value are set. As the settings are interdependent, a change of
one parameter may result in the automatic change of one or more of
the other parameters.

The filling of the column with the selected value settings is started
with button "Fill".

"Delete Row" Deletes the marked row.

"Delete Range"
Deletes the selected number of rows including the marked row. The
number of rows to be inserted can be defined in an entry window.

"Save As" Opens the file dialog to save the list under a new name.
Each list is saved to the CompactFlash™ card as a separate file with
the file prefix * . pulstrn. The file name and the directory to which
the file is saved are user-selectable.

"Save" The list is saved under its current name.

Import/Export - Pulse Train Mode
Expands the menu with the area for import and export of pulse train files.

Externally edited Excel tables with on/off time and repetition triplets can be imported as
text files or CSV files and used for pulse train mode.

On the other hand, internally created pulse train lists can be exported as text files or
CSYV files.

Mode — Import/Export Pulse Train Files
Selects if pulse train lists should be imported or exported. The settings offered below
depend on the selected mode.

Remote command:
[ :SOURce<hw>] : PULM: TRAin: DEXChange : MODE on page 403

Extension — ASCII File Settings
Selects the file extension of the ASCII file to be imported or exported. Selection TXT
(text file) or CSV (Excel file) is available.

Remote command:
[ :SOURce<hw>] : PULM: TRAin:DEXChange:AFILe:EXTension on page 401



Modulation Generator and LF Output

Decimal Point - ASCII File Settings

Selects the decimal separator used in the ASCII data between '.' (decimal point) and ',
(comma) with floating-point numerals.

Remote command:

[ :SOURce<hw>] : PULM: TRAin:DEXChange:AFILe:SEParator:DECimal

on page 402

Column Separator- ASCII File Settings
Selects the separator between the frequency and level column of the ASCII table.

Remote command:
[ :SOURce<hw>] : PULM: TRAin:DEXChange:AFILe:SEParator:COLumn
on page 402

Select ASCII Source / Destination - Import/Export Pulse Train Files

Opens the "File Manager" for selecting the ASCII file to be imported into a pulse train
list (source) or the ASCII file the pulse train list is exported (destination) in.

Remote command:

[ :SOURce<hw>] : PULM: TRAin:DEXChange:AFILe:CATalog? on page 400

[ :SOURce<hw>] : PULM: TRAin:DEXChange:AFILe:SELect on page 401

Select Destination / Source - Import/Export Pulse Train Files
Opens the "File Manager" for selecting the pulse train list to be exported (source) into
an ASCII file, or the destination for the ASCII file to be imported (destination) in.

Remote command:
[ :SOURce<hw>] : PULM: TRAin: DEXChange: SELect on page 404

Import / Export - Import/Export Pulse Train Files
Starts the export or import of the selected file.

If import is selected, the ASCII file is imported as pulse train list.
If export is selected, the pulse train list is exported into the selected ASCII file.

Remote command:
[ : SOURce<hw>] : PULM: TRAin: DEXChange : EXECute on page 403
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6 Remote Control Basics

This chapter provides basic information on operating an instrument via remote control.

6.1 Remote Control Interfaces and Protocols

The instrument supports different interfaces for remote control. The following table

gives an overview.

Table 6-1: Remote control interfaces and protocols

Remarks

Interface Protocols, VISA" address string
Local Area Net- Protocols:
work (LAN) ®  HiSLIP High-Speed LAN Instrument

Protocol (IVI-6.1)
VISA" address string:
TCPIP::host address::
hislipO[::INSTR]
* VXI-11
VISA" address string:
TCPIP::host address[::
LAN device name] [::INSTR]
®  socket communication (Raw Ethernet,
simple telnet)
VISA" address string:
TCPIP::host address][::
LAN device name]::<port>::
SOCKET

A LAN connector is located on the front or rear panel of the
instrument, or both.

The interface is based on TCP/IP and supports various proto-
cols.

For a description of the protocols refer to:

®  Chapter 6.1.3.1, "HiSLIP Protocol", on page 239

® Chapter 6.1.3.2, "VXI-11 Protocol", on page 239

®  Chapter 6.1.3.3, "Socket Communication", on page 239

Serial Interface VISA") address string:

ASRL[0-9] [::INSTR]

For a description of the interface, refer to Chapter 6.1.5, "Serial
Interface”, on page 241.

GPIB (IEC/IEEE
Bus Interface)

VISA" address string:
GPIB::primary address[::INSTR]

(no secondary address)

Optional GPIB bus interfaces according to standard IEC 625.1/
IEEE 488.1 are located on the rear panel of the instrument.

For a description of the interface, refer to Chapter 6.1.6, "GPIB
Interface (IEC/IEEE Bus Interface)", on page 241.

Note: Within this interface description, the term GPIB is used as
a synonym for the IEC/IEEE bus interface.

"VISA Libraries", on page 236.

") VISA is a standardized software interface library providing input and output functions to communicate with instruments. A VISA
installation on the controller is a prerequisite for remote control over LAN (when using VXI-11 or HiSLIP protocol), USB and serial
interface. For remote control via socket communication VISA installation is optional. For more information, see Chapter 6.1.1,

Rohde & Schwarz provides the standardized 1/O software library R&S VISA for com-
munication via TCP/IP (LAN: HiSlip, VXI-11 and raw socket) or USB (USBTMC) inter-

faces.

R&S VISA is available for download at the Rohde & Schwarz website http://

www.rohde-schwarz.com/rsvisa.

How to configure the remote control interfaces, see Chapter 6.2, "Starting a Remote

Control Session", on page 244.
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SCPI (Standard Commands for Programmable Instruments)

SCPI commands - messages - are used for remote control. Commands that are not
taken from the SCPI standard follow the SCPI syntax rules. The instrument supports
the SCPI version 1999. The SCPI standard is based on standard IEEE 488.2 and aims
at the standardization of device-specific commands, error handling and the status reg-
isters. The tutorial "Automatic Measurement Control - A tutorial on SCPI and IEEE
488.2" from John M. Pieper (R&S order number 0002.3536.00) offers detailed informa-
tion on concepts and definitions of SCPI.

Tables provide a fast overview of the bit assignment in the status registers. The tables
are supplemented by a comprehensive description of the status registers.

6.1.1 VISA Libraries

VISA is a standardized software interface library providing input and output functions to
communicate with instruments. Thus, you can configure the interface and must not
adjust the application program to the used interface. The I/O channel (LAN or TCP/IP,
USB, GPIB,...) is selected at initialization time with the channel-specific address string
("VISA resource string"), or by a defined VISA alias (short name). See also Chap-

ter 6.1, "Remote Control Interfaces and Protocols", on page 235 for an overview.

Instrument access via VXI-11 or HiSLIP protocols is achieved from high level program-
ming platforms using VISA as an intermediate abstraction layer. VISA encapsulates
the low-level VXI or GPIB function calls and thus makes the transport interface trans-
parent for the user.

A VISA installation is a prerequisite for remote control using the following interfaces:

® [ AN Interface using Chapter 6.1.3, "LAN Interface", on page 237

® [ AN interface using Chapter 6.1.3.2, "VXI-11 Protocol", on page 239

® Chapter 6.1.4, "USB Interface", on page 240

® Chapter 6.1.6, "GPIB Interface (IEC/IEEE Bus Interface)", on page 241

® Chapter 6.1.5, "Serial Interface", on page 241

Instrument access via the LAN socket protocol or GPIB connections can be operated
both, with or without the VISA library.

See also Chapter 6.1.3.3, "Socket Communication”, on page 239 and Chapter 6.1.6,
"GPIB Interface (IEC/IEEE Bus Interface)", on page 241.

For more information about VISA, refer to the user documentation.

6.1.2 Messages

The messages transferred on the data lines are divided into the following categories:

® |Interface messages
Interface messages are transmitted to the instrument on the data lines, with the
attention line being active (LOW). They are used to communicate between the con-
troller and the instrument. Interface messages can only be sent by instruments that
have GPIB bus functionality. For details see the sections for the required interface.
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6.1.3

® |nstrument messages
Instrument messages are employed in the same way for all interfaces, if not indica-
ted otherwise in the description. Structure and syntax of the instrument messages
are described in Chapter 6.3, "SCPI Command Structure", on page 258. A detailed
description of all messages available for the instrument is provided in the chapter
"Remote Control Commands".
There are different types of instrument messages, depending on the direction they
are sent:

— Commands
— Instrument responses

Commands

Commands (program messages) are messages the controller sends to the instrument.
They operate the instrument functions and request information. The commands are
subdivided according to two criteria:

® According to the effect they have on the instrument:

— Setting commands cause instrument settings such as a reset of the instru-
ment or setting the frequency.

— Queries cause data to be provided for remote control, e.g. for identification of
the instrument or polling a parameter value. Queries are formed by directly
appending a question mark to the command header.

® According to their definition in standards:

— Common commands: their function and syntax are precisely defined in stan-
dard IEEE 488.2. They are employed identically on all instruments (if imple-
mented). They refer to functions such as management of the standardized sta-
tus registers, reset and self-test.

— Instrument control commands refer to functions depending on the features of
the instrument such as frequency settings. Many of these commands have also
been standardized by the SCPI committee. These commands are marked as
"SCPI confirmed" in the command reference chapters. Commands without this
SCPI label are device-specific; however, their syntax follows SCPI rules as per-
mitted by the standard.

Instrument responses

Instrument responses (response messages and service requests) are messages the
instrument sends to the controller after a query. They can contain measurement
results, instrument settings and information on the instrument status.

LAN Interface

To be integrated in a LAN, the instrument is equipped with a LAN interface, consisting
of a connector, a network interface card and protocols. For remote control via a net-
work, the PC and the instrument must be connected via the LAN interface to a com-
mon network with TCP/IP network protocol. They are connected using a commercial
RJ45 cable. The TCP/IP network protocol and the associated network services are

| —
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preconfigured on the instrument. Software for instrument control and (for specified pro-
tocols only) the VISA program library must be installed on the controller.

VISA library

Instrument access via VXI-11 or HiSLIP protocols is achieved from high level program-
ming platforms using VISA as an intermediate abstraction layer. VISA encapsulates
the low level VXI or GPIB function calls and thus makes the transport interface trans-
parent for the user. See Chapter 6.1.1, "VISA Libraries", on page 236 for details.

IP address

Only the IP address or the computer name (LAN device name) is required to set up the
connection. The IP address/computer name is part of the "visa resource string" used
by the programs to identify and control the instrument.

Forms of the VISA resource string:

® TCPIP::host address([::LAN device name] [::INSTR]

® TCPIP::host address::port::SOCKET

Where:
e TCPIP designates the network protocol used
® host address is the IP address or host name of the device

® IAN device name defines the protocol and the instance number of a subinstru-
ment:

— 1instO0 selects the VXI-11 protocol (optional, default)
— hislip0 selects the newer HiSLIP protocol
® TNSTR indicates the instrument resource class (optional)
® port determines the used port number
® SOCKET indicates the raw network socket resource class

Example:

® |Instrument has the IP address 792.1.2.3; the valid resource string using VXI-11
protocol is:
TCPIP::192.1.2.3::INSTR

® The DNS host name is RSSM1; the valid resource string is:
TCPIP::RSSM1::hislipO (HiSLIP)
TCPIP::RSSMI1: :INSTR (VXI-11)

® A raw socket connection can be established using:
TCPIP::192.1.2.3::5025::SOCKET

If several instruments are connected to the network, each instrument has its own IP
address and associated resource string. The controller identifies these instruments by
the resource string.

6 Identifying instruments in a network
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6.1.3.1 HiSLIP Protocol

The HiSLIP (High Speed LAN Instrument Protocol) is the successor protocol for
VXI-11 for TCP-based instruments specified by the VI foundation. The protocol uses
two TCP sockets for a single connection - one for fast data transfer, the other for non-
sequential control commands (e.g. Device Clear Or SRQ).

HiSLIP has the following characteristics:

® High performance as with raw socket network connections

® Compatible IEEE 488.2 support for Message Exchange Protocol, Device Clear,
Serial Poll, Remote/Local, Trigger, and Service Request

® Uses a single IANA registered port (4880), which simplifies the configuration of fire-
walls

® Supports simultaneous access of multiple users by providing versatile locking
mechanisms

® Usable for IPv6 or IPv4 networks

However, using HiSLIP, data is sent to the device using the "fire and forget" method
with immediate return. Thus, a successful return of a VISA operation such as
vilWrite () does not guarantee that the instrument has finished or started the reques-
ted command, but is delivered to the TCP/IP buffers.

6 Using VXI-11, each operation is blocked until a VXI-11 device handshake returns.

For more information see also the application note: 1MA208: Fast Remote Instrument
Control with HiSLIP.

6.1.3.2 VXI-11 Protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing Remote
Procedure Call) protocol which in turn relies on TCP/IP as the network/transport layer.
The TCP/IP network protocol and the associated network services are preconfigured.
TCP/IP ensures connection-oriented communication, where the order of the
exchanged messages is adhered to and interrupted links are identified. With this proto-
col, messages cannot be lost.

6.1.3.3 Socket Communication

An alternative way for remote control of the software is to establish a simple network
communication using sockets. The socket communication, also referred to as "Raw
Ethernet communication”, does not necessarily require a VISA installation on the
remote controller side. It is available by default on all operating systems.

The simplest way to establish socket communication is to use the built-in telnet pro-
gram. The telnet program is part of every operating system and supports a communi-
cation with the software on a command-by-command basis. For more convenience and
to enable automation by means of programs, user-defined sockets can be program-
med.
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Socket connections are established on a specially defined port. The socket address is

a combination of the IP address or the host name of the instrument and the number of

the port configured for remote-control. All R&S SMB use port number 5025 for this pur-
pose. The port is configured for communication on a command-to-command basis and
for remote control from a program.

LAN Interface Messages

In the LAN connection, the interface messages are called low—level control messages.
These messages can be used to emulate interface messages of the GPIB bus.

Command Long term Effect on the instrument
&ABO Abort Aborts processing of the commands just received.
&DCL Device Clear Aborts processing of the commands just received and

sets the command processing software to a defined initial
state. Does not change the instrument setting.

&GTL Go to Local Transition to the "local" state (manual control). (The
instrument automatically returns to remote state when a
remote command is sent UNLESS &NREN was sent

before.)

&GTR Go to Remote Enables automatic transition from local state to remote
state by a subsequent remote command (after sNREN
was sent).

&GET Group Execute Trigger Triggers a previously active instrument function (e.g. a

sweep). The effect of the command is the same as with
that of a pulse at the external trigger signal input.

&LLO Local Lockout Disables transition from remote control to manual control
by means of the front panel keys.

&NREN Not Remote Enable Disables automatic transition from local state to remote
state by a subsequent remote command. (To re-activate
automatic transition use &GTR.)

&POL Serial Poll Starts a serial poll.

USB Interface

For remote control via the USB connection, the PC and the instrument must be con-
nected via the USB type B interface. A USB connection requires the VISA library to be
installed. VISA detects and configures the R&S instrument automatically when the
USB connection is established. You do not have to enter an address string or install a
separate driver.

USB address
The used USB address string is:

USB: :<vendor ID>::<product ID>::<serial number>[::INSTR]

Where:
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e <vendor ID> is the vendor ID for Rohde&Schwarz
® <product ID> is the product ID for the R&S instrument
® <serial number> is the individual serial number on the rear of the instrument

Example:
USB::0x0AAD::0x0054::100001::INSTR
0x0AAD is the vendor ID for Rohde&Schwarz

0x0054 is the product ID for the R&S SMB

100001 is the serial number of the particular instrument

Serial Interface

Remote control via the serial interface is possible either via RS232 interface or via a
Bluetooth connection. The controller/Bluetooth device and the instrument must be con-
nected via an external USB/serial-adapter (see recommended extras, data sheet) and
a serial crossover (null modem) cable. A USB connection requires the VISA library to
be installed on the controller. VISA detects and configures the R&S SMB automatically
when the USB connection is established.

Serial address
The used serial address string is:
ASRL[0-9] [::INSTR]

Where ASRL[0-9] determines the number of the COM port on the controller side, that
has to be used for the serial connection.

Access via a bluetooth device requires the entry of the bluetooth pin in addition (see
Chapter 5.2.3.18, "Security", on page 114).

To enable an error-free and correct data transmission, the parameters of the generator
and the controller must have the same setting. The serial interface is preset for a baud
rate 115200, no parity and one stop bit. The parameters can be manually changed in
"Remote Channel Settings" dialog (see Chapter 5.2.3.14, "Remote Channel Settings",
on page 108).

GPIB Interface (IEC/IEEE Bus Interface)

To be able to control the instrument via the GPIB bus, the instrument and the controller
must be linked by a GPIB bus cable. A GPIB bus card, the card drivers and the pro-
gram libraries for the programming language used must be provided in the controller.
The controller must address the instrument with the GPIB bus address (see Chap-

ter 6.1.6.2, "GPIB Instrument Address", on page 243).

Characteristics
The GPIB interface is described by the following characteristics:

® Up to 15 instruments can be connected
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® The total cable length is restricted to a maximum of 15 m; the cable length between
two instruments should not exceed 2m.

e A wired "OR"-connection is used if several instruments are connected in parallel,
since the slowest instrument determines the speed.

6 Any connected IEC bus cable must be terminated by an instrument or controller.

6.1.6.1 GPIB Interface Messages

Interface messages are transmitted to the instrument on the data lines, with the atten-
tion line (ATN) being active (LOW). They are used for communication between the

controller and the instrument and can only be sent by a computer which has the func-
tion of a GPIB bus controller. GPIB interface messages can be further subdivided into:

® Universal commands: act on all instruments connected to the GPIB bus without
previous addressing

® Addressed commands: only act on instruments previously addressed as listeners

Universal Commands

Universal commands are encoded in the range 10 through 1F hex. They affect all
instruments connected to the bus and do not require addressing.

Command Effect on the instrument

DCL (Device Clear) Aborts the processing of the commands just received and sets the com-
mand processing software to a defined initial state. Does not change the
instrument settings.

IFC (Interface Clear) *) Resets the interfaces to the default setting.
LLO (Local Lockout) The LOC/IEC ADDR key is disabled.
SPE (Serial Poll Enable) Ready for serial poll.

SPD (Serial Poll Disable) End of serial poll.

PPU (Parallel Poll Unconfig- | End of the parallel-poll state.
ure)

*) IFC is not a real universal command, it is sent via a separate line; however, it also affects all instruments
connected to the bus and does not require addressing

Addressed Commands

Addressed commands are encoded in the range 00 through OF hex. They only affect
instruments addressed as listeners.
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Command Effect on the instrument

GET (Group Execute Trigger) Triggers a previously active instrument function (e.g. a sweep).
The effect of the command is the same as with that of a pulse at
the external trigger signal input.

GTL (Go to Local) Transition to the "local" state (manual control).

GTR (Go to Remote) Transition to the "remote" state (remote control).

PPC (Parallel Poll Configure) Configures the instrument for parallel poll.

SDC (Selected Device Clear) Aborts the processing of the commands just received and sets the

command processing software to a defined initial state. Does not

change the instrument setting.

GPIB Instrument Address

In order to operate the instrument via remote control, it must be addressed using the
GPIB address. The remote control address is factory preset, but it can be changed if it
does not fit in the network environment. For remote control, addresses 0 through 30
are allowed. The GPIB address is maintained after a reset of the instrument settings.

Changing the GPIB address of the instrument

The GPIB address can be changed manually or using a remote control command.
1. Manually: press the SETUP key.

2. Select "Remote > GPIB".

= Remote Channel Settings
|' B

GPIB Settings E
GPIB channel address I 28

3. Enter the GPIB address.

4. Remotely: use the remote control command:
SYST:COMM:GPIB:ADDR 18

LXI Browser Interface

LAN extension for instrumentation (LXI) is an instrumentation platform for measuring
instruments and test systems that is based on standard Ethernet technology, see also
Chapter 2.8, "LXI Configuration", on page 45.

The LXI browser interface allows easy configuration of the LAN and remote control of
the R&S SMB without additional installation requirements. The instrument's LXI
browser interface works correctly with all W3C compliant browsers.

The LAN settings are configured using the LXI Browser Interface of the R&S SMB
described in Chapter 2.8.2, "LAN Configuration", on page 47. The LXI status settings in
the R&S SMB are described in Chapter 5.2.3.16, "LXI Status", on page 112.
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Starting a Remote Control Session

The instrument and the controller have to be connected with the suitable cable and
switched on.

A remote control program must open a connection to the instrument (using VISA func-
tionality), before it can send commands to and receive device responses from the
instrument.

i

Instrument Address

In order to operate the instrument via remote control it must be addressed using the
defined interface address. See Chapter 6.1.3, "LAN Interface", on page 237, Chap-
ter 6.1.4, "USB Interface", on page 240, Chapter 6.1.5, "Serial Interface", on page 241,
Chapter 6.1.6, "GPIB Interface (IEC/IEEE Bus Interface)", on page 241 or Chap-

ter 6.1.7, "LXI Browser Interface", on page 243 for details.

The VISA resource strings are indicated in the "Setup > Remote Channel Settings"
menu.

@

Securing the display

To prevent unauthorized personnel from reading the display, you can disable the fre-
quency and level display explicitly. This is useful when you remotely control the instru-
ment from a different location.

For information on how to disable the frequency and level display, refer to "Annotation
Frequency" on page 118 and "Annotation Amplitude" on page 118.

6.2.1

Refer to Chapter 6.2.3, "Examples", on page 245 for practical examples on setting up
of a remote control link and starting of a remote control session.

Switching to Remote Control

After switching on, the instrument is usually in the local state and can be operated via
the front panel controls (for instruments equipped with a display), a mouse and an
external keyboard.

Starting remote control

1. Send a command from a controller to the instrument.

The instrument changes to remote state as soon as it receives the command from
the controller.

Note: If you have sent «NREN before, the automatic transition from local state to
manual control by a subsequent remote command is disabled (use «GTR to enable
it again).

In remote state, operation via the front panel or via mouse and keyboard is dis-
abled. The status line indicates the "REMOTE" state.
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The instrument remains in the remote state until it is reset to the local state, see
Chapter 6.2.2, "Returning to Manual Operation"”, on page 245).

Tip: Switching from manual operation to remote control and vice versa does not
affect the other instrument settings.

2. Although operation via front panel, mouse and keyboard is disabled, the dialog
boxes can still be opened, for example to verify settings. The buttons and setting
fields are grayed out and cannot be activated.

Additionally, you can disable the access to the dialogs with the command
SYST:KLOC ON to protect the instrument against unauthorized readings.

3. To prevent unintentional return to manual operation, disable the LOCAL key of the
instrument with the ¢L.1.0 command (see Chapter 6.1.3.4, "LAN Interface Mes-
sages", on page 240).

The instrument switches to "REM-LLO" state.

The automatic transition from local state to remote state by a subsequent remote
command, and the command *GTL are disabled.

To return to manual mode is only possible via remote control.

4. Unlock the LOCAL key with &GTR.

6.2.2 Returning to Manual Operation

Before returning to manual control, command processing must be completed. Other-
wise, the instrument switches back to remote control immediately.

To return to manual operation, perform one of the following:

® Press the LOCAL key on the front panel.

® Select "Setup > Remote Control Channels > Local".

® While using the socket communication, terminate the remote control session.
® Send the interface command &GTL via the remote control interface.

@ Use the &«GTR to enable the LOCAL key if it is locked.

6.2.3 Examples
This sections provides examples for setting up the remote control connection, and
starting a remote control session.

This section assumes basic knowledge of programming and operation of the controller.
A description of the interface commands can be obtained from the corresponding man-
uals.
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6.2.3.1 Remote Control over GPIB

The program example in this section is written in VISUAL BASIC. A condition for pro-
gramming in VISUAL BASIC is that the modules NIGLOBAL (Niglobal.bas) and
VBIB32 (Vbib 32.bas) are added to the projects.

Drivers for instrument, e.g. IVI-COM and LabVIEW drivers, are available in the down-
load area of the product website (http://www.rohde-schwarz.com/en/products/
test_and_measurement/product_categories/signal_generation/).

Starting a remote control session over GPIB

As a prerequisite, the GPIB address of the instrument, which is factory-set to 28, must
not have been changed.

1. Connect instrument and controller using GPIB cable and switch them on.

2. Execute following commands on the controller:

a) Open port to the instrument
CALL IBFIND("DEV1", generator$%)
b) Inform controller about instrument address
CALL IBPAD (generator$%, 28)
c) Resetinstrument
CALL IBWRT (generator%, "*RST;*CLS")
d) Setinstrument to new address
CALL IBWRT (generator%, "SYST:COMM:GPIB:ADDR 18")
e) Inform controller about new address
CALL IBPAD (generator$%, 18)

The GPIB address of the instrument is changed.

3. To return to manual operation sent CALL, IBLOC (generator$%) or press the
LOCAL key at the front panel.

6.2.3.2 Remote Control over LAN using VXI-11 Protocol

In this example, the 1/O software library R&S VISA from Rohde & Schwarz is used to
set up a LAN remote control link and remotely control the R&S SMB. R&S VISA is run-
ning on a controller PC with Windows operating system. When the connection is set up
you can send commands to the instrument, and receive the responses.

The remote control connection requires a VISA installation but no additional hardware
on the controller PC. The LAN I/O channel is selected at initialization time using the
VISA resource string (also referred to as "address string"). A VISA alias (short name) is
used to replace the complete resource string. The host address is either the

R&S SMB's hostname or IP address. See also Chapter 6.1.3, "LAN Interface",

on page 237.
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In this example, it is assumed that:
6 ® A LAN remote control link between the controller and the R&S SMB is already set
up.
® The R&S VISA program is installed on the remote PC, see "http://www.rohde-
schwarz.com/rsvisa > RS VISA Release Notes".

Configuring the controller

To remote control the R&S SMB, we use the R&S VISA Tester application.

protocol). If this configuration is used, enter the computer name in the position of the IP

@ The instrument is preconfigured for networks using DHCP (dynamic host configuration
address.

To enable the external controller to communicate with the R&S SMB via TCP/IP proto-
col, set up a remote control link as follows:

1. Make sure that the controller and the instrument are connected in the network (net-
work cable) and switched on.

2. On the controller, start "R&S VISA > Tester 32bit" or "R&S VISA > Tester 64bit",
respectively.

% RsVisaTester 5.5.4 Visa fram Rohde & Schwarz GmbH (5.5.4)

Find Resource  Change Log File  RsWisa Config  Choose Visa Implementation

Resource Timeout Current log file Shaw Log

2000 E Open Lag visaTesterllog20151109_104402 bxt ‘Write Log

- - - - Basics | Locking I Attributes I Events I Gpib I Tests |
Line Duration Status Wisa Operation
8 1ps WLSUCCESS wiGetdttribute(sessionid= .., -
9 1ps WLSUCCESS wiGetdttribute(sessionid= ..,
10 7 ps VI SUCCESS wiSetMtributefsessionid=1.. | | | wnte | [ Read | [ cquery | [ Clear History |
11 4 ps WLESUCCESS wiGetAttribute(sessionid= .., =
1 B ys VI SUCCESS wiGetAttribute(sessionid= ... ot Ee
13 11 ps WL SUCCESE wiGethttribute(sessionid= ...
14 14 s WI_SUCCESS wiOpenisesn= 3, rsre= TCPL.,
15 13 ps WL SUCCESE wiSetdttributeisessionid= 4.,
16 1ms WLSUCCESS wiClose{sessionid= 4)
17 13 s WI_SUCCESS wiOpenisesn= 3, rsre= TCPL.,
18 T ps WLSUCCESS wiSetAttribute{sessionid=5...
19 1ms WLSUCCESS wiClose{sessionid=5)
20 T ps WLSUCCESS wiGetAttribute(sessionid= ..,
21 1ps WLSUCCESS wiGetdttribute(sessionid= ..,
2 1ps VLSUCCESS viGetittribute(sessionid= .. Read count 1024 =3
23 D ps WLSUCCESS wiletAttribute{sessionid= 3.,
I—ILNE (ees | Unese 28 -m [ Read STB ] [ Trigger ] [ Clear ]
Displayed: 16 Ox----

Status: WL SUCCESS

3. Inthe menu bar, select "Choose VISA Implementation > Rohde & Schwarz Visa".
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@ Rohde & Schwarz Wisa
) Mational Instrurments

) Default Yisa

I (o4 I’ Cancel ]

Select "Rohde & Schwarz Visa" and confirm with "OK".

In the menu bar, select "Find Resource" to search for the instrument in the LAN.

Resource | Find Resources I

LK {mDME)
WRI-11

1000 =

Select
7 Cancel

Select "VXI-11" and "Find Resources".

R&S VISA scans the network for connected instruments and lists all detected instu-
ments in the "Resource" list.
Note: The search may take some time, particularly in large networks.

Select the required instrument and confirm with "Select".

(& Find mnd slectresouree |

Resource - | Find Resources I
4 TCPIPO:10.113.1.151 [ LT (mDNS)

| TEPIPO:10,113. 1,15 inst0:IMNETR |D _
b TCPIPO:10,113.1.154 Vw1t
[ TCPIPO:;10,113,1.179 1000 E
[ TCPIP0:10.113.1.188
[ TCPIP0:10.113.1.18
[ TCPIP0:10.113.1.23 -
TCPIPO::10,113.1. 151 tinsk0: INSTR

The "Find and select resource" dialog closes and R&S VISA indicates the instru-
ments IP address in the "Resource" field of the main application window.

As an alternative to the IP address, you can assign an alias name to the
R&S SMB:
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a) Inthe menu bar, select "RsVisaConfig".

=P QAN @O

Resource identifier Alias

b) In the toolbar, select "+" to access the "VISA Rexource String Composer".
c) Fillin the "Alias" name, the "VISA Resource String" and the "Device IP Address
or host name" as shown in the figure, and confirm with "OK".

(" Voa Rerouree somg Compr g

Resource String Build Interface
Alias Interface Type
RohdedSchwarz_SignalGeneratar [VXI*II -
WISA Resource String Board Mumber
TCPIPO::10,113,151 1 tinstr0n INSTR @ o
TCR(IP

Device IF Address or hostname

10.113.151.1

Dervice Id

i}

The "Alias" name is assigned to the instrument.

TCPIPO:10.113.151.., ef SignalGenerator

d) Close the dialog.
The R&S SMB is now registered in the program and can be addressed via the
resource string or alias name.

9. In the main window, select "Connect".
R&S VISA establishes the connection to the R&S SMB.

Now you can send settings to configure the instrument and receive its responses.
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Note: If the connection cannot be set up, R&S VISA displays an error in the log
view. For information on how to proceed when network failures occur, see Chap-
ter 9.5, "Resolving Network Connection Failures", on page 487.

For further information on the functions to read and write to an open session, as
well as the utility applications the software provides, see the R&S VISA User Man-
ual.

Starting a remote control over LAN (using VXI-11)

To set the instrument to remote control, you can use the addressed command &GTR, or
send any command from the controller.

1.

Start the R&S VISA Tester and establish the connection to the R&S SMB, see
"Configuring the controller” on page 247.

In the R&S VISA "Basics" tab, enter a SCPI command, e.g. "*IDN?" and confirm
with "Query".

The instrument is switched to remote control when it receives a command from the
controller.

3. Select "Read" to obtain the instrument response.

@) RsisaTester 5.5.4 Visa from Rohde & Schwarz GmbH (5.5.4)

Find Resource  Change Log File  RsWisa Config  Choose Visa Implementation

Resource Timeout Current log file Shaw Log

TCPIFD::10,113.1,150::inst0:5TR | | Discannect 2000 %] | Openlog | visaTesterilogz0151112_124312.bxt [] write Log

Basics | Locking I Attributes I Events I Gpib I Tests |

Line Duration Status Wisa Operation
10 452 ps WL SUCCESE witrite(sessionid= 4 buf= ...

-

[ ‘Write ] [ Read ] [ Query ] [ Clear History ]
Send End

Clear Text Read count 1024 E
Live Mode | Lines: 10 -
[ Read STE ] [ Trigger ] [ Clear ]
Displayed: 1 Ox----

Status: WL SUCCESS

Tip: If the "Show Log" checkbox is checked R&S VISA displays each VISA function
call in the log-view on the left. If you check the "Write Log" checkbox the log-view
entry is written to the log file as well. You can operate the log-view in two modes:
the "Live Mode" shows only the most recent messages whereas the "View Mode"
allows you to scroll the history.

To set, e.g. the frequency, enter SOUR1:FREQ 4 GHz and select "Write".
To check the performed setting, SOUR1 : FREQ? and select "Read".
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The instrument response is 4000000000, i.e. the frequency is returned in Hz.

While remote control is active, the "Remote" icon in the status bar indicates that the
instrument is in remote control mode. The operation via the front panel or via
mouse and keyboard are locked, allowing a remote control program to be per-
formed without interruption.

On the display, keys and entry fields are grayed out and cannot be activated or
modified, but you can still open dialogs, for example to verify settings.

5. To disable the access to the dialogs, use the command SYST : KL.OC ON.

6. To prevent unintentional return to manual operation, use the command sLLO.
See also Chapter 6.1.3.4, "LAN Interface Messages", on page 240.
The instrument switches to "Remote LLO" state. The LOCAL key is disabled.

7. To enable the LOCAL key, use the command &GTR.

8. To return to manual operation, see Chapter 6.2.2, "Returning to Manual Opera-
tion", on page 245.

Tip: Switching from manual operation to remote control and vice versa does not
affect the other instrument settings.

6.2.3.3 Remote Control over LAN using Socket Communication

This chapter provides an example on how to establish a remote control connection
over telnet protocol and a simple sockets-based program example that can be further
developed.

Setting up a Telnet Connection

To control the software, only a telnet program is required. The telnet program is part of
every operating system.

1. To establish a Telnet connection with the R&S SMB, start the telnet program.

2. Enter the access string to connect to the instrument and confirm with ENTER.
The access string is composed of the open command short form) and the socket
address. The socket address is a combination of the IP address or the host name
of the R&S SMB and the number of the port configured for remote-control via tel-
net. The R&S SMB uses the port number 5025 for remote connection via Telnet.
Example: o 10.113.1.150 5025



R&S®SMB100A Remote Control Basics

] Telnet 10.113.1.150 = B
el (2]

Uelcome to Microsoft Telnet Client

Ezscape Character is *CTRL++’

Microsoft Telnet> o 18.113.1.150 5825
Connecting To 18.113.1.158_.._

The connection to the instrument is set up and you can send remote-control com-
mands.

3. Even if the cursor is not visible on the screen, enter blind a remote-control com-
mand and confirm with "Enter".

@] Telnet 10.113,1,150 =2 EoR(

|
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@] Telnet 10.112.1.150 =N |E=R =5

After the first remote-control command has been sent, the instrument is in the
"REMOTE" state, i.e. instrument control from the front panel or via mouse and key-
board is disabled and "REMOTE" is displayed in the status line.

Telnet program examples

The following program example shows a simple TcpClient class that is intended to
explain on how to get started with programming of sockets.

The example sets up a socket communication to R&S SMB and opens a simple user
interface, very similar to the telnet, which allows input of commands. To enable real
automation, further development of the program is required.

TcpClient.h

#include <string>
//defines structs for socket handling
#include <netinet/in.h>
using namespace std;
typedef struct sockaddr in SockAddrStruct;
typedef struct hostent HostInfoStruct;
class TcpClient
{
public:
TcpClient () ;
~TcpClient () ;
void connectToServer ( string &hostname, int port );
void disconnect( );
void transmit( string &txString );
void receive( string &rxString );
string getCurrentHostName( ) const;
int getCurrentPort ( ) const;
private:
string currentHostName;

int currentPort;
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int currentSocketDescr;
SockAddrStruct serverAddress;
HostInfoStruct * currentHostInfo;
bool clientIsConnected;
int receiveBufferSize;

}i

TcpClient.cpp

#include <string>
//defines structs for socket handling
#include <netinet/in.h>
using namespace std;
typedef struct sockaddr in SockAddrStruct;
typedef struct hostent HostInfoStruct;
class TcpClient
{
public:
TcpClient () ;
~TcpClient () ;
void connectToServer ( string &hostname, int port );
void disconnect( );
void transmit( string &txString );

void receive( string &rxString );

string getCurrentHostName ( ) const;

int getCurrentPort ( ) const;
private:

string currentHostName;

int currentPort;

int currentSocketDescr;

SockAddrStruct serverAddress;
HostInfoStruct * currentHostInfo;
bool clientIsConnected;
int receiveBufferSize;

}i

#include <netdb.h>
#include <netinet/in.h>
#include <unistd.h>
#include "TcpClient.h"
TcpClient::TcpClient ()

: currentHostName ( "" )

, currentPort( 0 )

, currentSocketDescr( 0 )
, serverAddress ( )

, currentHostInfo( NULL )
, clientIsConnected( false )

, receiveBufferSize( 1024 )
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TcpClient::~TcpClient ()

{
currentHostInfo = NULL;

void TcpClient::connectToServer ( string &hostname, int port )

{

currentHostInfo = gethostbyname( hostname.c _str( ) );
if ( currentHostInfo == NULL )
{

currentHostName = "";

currentPort = 0;

currentHostInfo = NULL;

clientIsConnected = false;
printf ("error connecting host\n" );
}
currentHostName = hostname;
currentPort = port;
currentSocketDescr = socket (AF INET, SOCK STREAM, 0);

if ( currentSocketDescr == 0 )
{
currentHostName = "";
currentPort = 0;
currentHostInfo = NULL;

clientIsConnected = false;

printf ("can't create socket\n" );
}
serverAddress.sin family = currentHostInfo->h addrtype;
serverAddress.sin_port = htons( currentPort );
memcpy ( (char *) &serverAddress.sin addr.s_addr,
currentHostInfo->h addr 1ist([0], currentHostInfo->h length );

if ( connect ( currentSocketDescr, ( struct sockaddr *) &serverAddress,
sizeof ( serverAddress ) ) < 0 )

{

throw string("can't connect server\n" );

}

clientIsConnected = true;

}

void TcpClient::disconnect( )

{

if( clientIsConnected )

{

close( currentSocketDescr );

}

currentSocketDescr = 0;

currentHostName = "";
currentPort = 0;
currentHostInfo = NULL;
clientIsConnected = false;
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void TcpClient::transmit( string &txString )
{
if( !clientIsConnected )
{
throw string("connection must be established before any data can be sent\n");
}
char * transmitBuffer = new char[txString.length() +11;
memcpy ( transmitBuffer, txString.c str(), txString.length() );
transmitBuffer[txString.length()] = '\n'; //newline is needed!
if ( send( currentSocketDescr, transmitBuffer, txString.length() + 1, 0 ) < 0 )
{
throw string("can't transmit data\n");
}
delete [] transmitBuffer;
}
void TcpClient::receive( string &rxString )
{
if( !clientIsConnected )
{
throw string("connection must be established before any data can be received\n");
}
char * receiveBuffer = new char[receiveBufferSize];
memset ( receiveBuffer, 0, receiveBufferSize );
bool receiving = true;
while( receiving )
{
int receivedByteCount = recv( currentSocketDescr,
receiveBuffer, receiveBufferSize, 0 );
if ( receivedByteCount < 0 )
{
throw string("error while receiving data\n");

}

rxString += string( receiveBuffer );

receiving = ( receivedByteCount == receiveBufferSize );
}
delete [] receiveBuffer;
}
string TcpClient::getCurrentHostName ( ) const

{

return currentHostName;

}
int TcpClient::getCurrentPort( ) const

{

return currentPort;

TelnetClient.cpp

#include <iostream>

#include "TcpClient.h"
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void printUsage ()
{
cout<<"usage: EthernetRawCommand <server-ip> [scpi-command]"<<endl;
}
int main( int argc, char *argv[] )
{
int errorCode = 0; //no error

bool useSingleCommand = false;

string singleCommand = "";
string hostname =,
int port = 5025;
string input = .

TcpClient client;
switch( argc )
{

case 3:

useSingleCommand = true;

singleCommand = argv([2];
case 2:
hostname = argv([l];
break;
default:

printUsage () ;

return(-1);
try

client.connectToServer ( hostname, port );
bool terminate = false;
while( !terminate )
{
char buffer[1024];
if ( useSingleCommand )
{
input = singleCommand; //send string
}
else
{
cin.getline( buffer, 1024 );
input = buffer;
if( input == "end" )
{

terminate = true;

}

if( !terminate)

{
client.transmit ( input ); //send string
int gPos = input.find( "2", 0 );

//receive string only when needed
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if( gPos > 0 )

{
string rcStr = "";
client.receive( rcStr );

cout << rcStr << endl;

}

if ( useSingleCommand )

{

terminate = true;

}
}catch( const string errorString )
{
cout<<errorString<<endl;
}
client.disconnect ( );

return errorCode;

6.3 SCPI Command Structure

6.3.1

SCPI commands consist of a so-called header and, in most cases, one or more param-
eters. The header and the parameters are separated by a "white space" (ASCII code 0
to 9, 11 to 32 decimal, e.g. blank). The headers may consist of several mnemonics
(keywords). Queries are formed by appending a question mark directly to the header.

The commands can be either device-specific or device-independent (common com-
mands). Common and device-specific commands differ in their syntax.
Syntax for Common Commands

Common (=device-independent) commands consist of a header preceded by an aster-
isk (*) and possibly one or more parameters.

Examples:

*RST RESET Resets the instrument.

*ESE EVENT STATUS ENABLE Sets the bits of the event status enable
registers.

*ESR? EVENT STATUS QUERY Queries the contents of the event status
register.

*IDN? IDENTIFICATION QUERY Queries the instrument identification
string.
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Syntax for Device-Specific Commands

i

Not all commands used in the following examples are necessarily implemented in the
instrument.

For demonstration purposes only, assume the existence of the following commands for
this section:

® DISPlay[:WINDow<l...4>]:MAXimize <Boolean>

® FORMat:READings:DATA <type>[,<length>]

® HCOPy:DEVice:COLor <Boolean>

® HCOPy:DEVice:CMAP:COLor:RGB <red>,<green>,<blue>
® HCOPy[:IMMediate]

® HCOPy:ITEM:ALL

® HCOPy:ITEM:LABel <string>

® HCOPy:PAGE:DIMensions:QUADrant [<N>]

® HCOPy:PAGE:ORIentation LANDscape | PORTrait

® HCOPy:PAGE:SCALe <numeric value>

® MMEMory:COPY <file source>,<file destination>

® SENSE:BANDwidth|BWIDth[:RESolution] <numeric value>
® SENSe:FREQuency:STOP <numeric value>

® SENSe:LIST:FREQuency <numeric value>{,<numeric value>}

Long and short form

The mnemonics feature a long form and a short form. The short form is marked by
upper case letters, the long form corresponds to the complete word. Either the short
form or the long form can be entered; other abbreviations are not permitted.

Example:
HCOPy:DEVice:COLor ON is equivalent to HCOP: DEV:COL ON.

Case-insensitivity

Upper case and lower case notation only serves to distinguish the two forms in the
manual, the instrument itself is case-insensitive.

Numeric suffixes

If a command can be applied to multiple instances of an object, e.g. specific channels
or sources, the required instances can be specified by a suffix added to the command.
Numeric suffixes are indicated by angular brackets (<1...4>, <n>, <i>) and are replaced
by a single value in the command. Entries without a suffix are interpreted as having the
suffix 1.
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Example:

Definition: HCOPy : PAGE : DIMensions : QUADrant [<N>]
Command: HCOP: PAGE : DIM: QUAD2

This command refers to the quadrant 2.

For remote control, the suffix may differ from the number of the corresponding selec-
tion used in manual operation. SCPI prescribes that suffix counting starts with 1. Suffix
1 is the default state and used when no specific suffix is specified.

6 Different numbering in remote control

Some standards define a fixed numbering, starting with 0. If the numbering differs in
manual operation and remote control, it is indicated for the corresponding command.

Optional mnemonics

Some command systems permit certain mnemonics to be inserted into the header or
omitted. These mnemonics are marked by square brackets in the description. The
instrument must recognize the long command to comply with the SCPI standard. Some
commands are considerably shortened by these optional mnemonics.

Example:
Definition: HCOPy [ : IMMediate]
Command: HCOP: IMM is equivalent to HCOP

6 Optional mnemonics with numeric suffixes

Do not omit an optional mnemonic if it includes a numeric suffix that is relevant for the
effect of the command.

Example:
Definition:DISPlay [ :WINDow<1...4>] :MAXimize <Boolean>
Command: DISP:MAX ON refers to window 1.

In order to refer to a window other than 1, you must include the optional WINDow
parameter with the suffix for the required window.

DISP:WIND2:MAX ON refers to window 2.

Parameters

Parameters must be separated from the header by a "white space". If several parame-
ters are specified in a command, they are separated by a comma (,). For a description
of the parameter types, refer to Chapter 6.3.3, "SCP| Parameters", on page 261.

Example:
Definition:HCOPy : DEVice : CMAP: COLor :RGB <red>, <green>, <blue>
Command:HCOP : DEV: CMAP: COL:RGB 3,32, 44
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Special characters

| Parameters

A vertical stroke in parameter definitions indicates alternative possibilities in the sense of "or". The
effect of the command differs, depending on which parameter is used.

Example:

Definition:HCOPy : PAGE : ORIentation LANDscape | PORTrait
Command HCOP: PAGE : ORI LAND specifies landscape orientation
Command HCOP: PAGE: ORI PORT specifies portrait orientation
Mnemonics

A selection of mnemonics with an identical effect exists for several commands. These mnemonics are
indicated in the same line; they are separated by a vertical stroke. Only one of these mnemonics
needs to be included in the header of the command. The effect of the command is independent of
which of the mnemonics is used.

Example:

DefinitionSENSE : BANDwidth | BWIDth[:RESolution] <numeric value>
The two following commands with identical meaning can be created:
SENS:BAND:RES 1

SENS:BWID:RES 1

[1 | Mnemonics in square brackets are optional and may be inserted into the header or omitted.
Example: HCOPy [ : IMMediate]

HCOP:IMM is equivalent to HCOP

{} | Parameters in curly brackets are optional and can be inserted once or several times, or omitted.
Example: SENSe:LIST:FREQuency <numeric value>{,<numeric value>}

The following are valid commands:

SENS:LIST:FREQ 10

SENS:LIST:FREQ 10,20

SENS:LIST:FREQ 10,20,30,40

6.3.3 SCPI Parameters

Many commands are supplemented by a parameter or a list of parameters. The
parameters must be separated from the header by a "white space" (ASCII code 0 to 9,
11 to 32 decimal, e.g. blank). Allowed parameters are:

® Numeric values

® Special numeric values

® Boolean parameters

o Text

® Character strings

® Block data

The parameters required for each command and the allowed range of values are
specified in the command description.
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Numeric values

Numeric values can be entered in any form, i.e. with sign, decimal point and exponent.
Values exceeding the resolution of the instrument are rounded up or down. The man-
tissa may comprise up to 255 characters, the exponent must lie inside the value range
-32000 to 32000. The exponent is introduced by an "E" or "e". Entry of the exponent
alone is not allowed. In the case of physical quantities, the unit can be entered.
Allowed unit prefixes are G (giga), MA (mega), MOHM and MHZ are also allowed), K
(kilo), M (milli), U (micro) and N (nano). If the unit is missing, the basic unit is used.

Example: SENS:FREQ:STOP 1.5GHz = SENS:FREQ:STOP 1.5E9

Units

For physical quantities, the unit can be entered. Allowed unit prefixes are:

* G (giga)

® MA (mega), MOHM, MHZ
® K (kilo)

o M (milli)

® U (micro)

® N (nano)

If the unit is missing, the basic unit is used.

Example:
SENSe:FREQ:STOP 1.5GHz = SENSe:FREQ:STOP 1.5E9

Some settings allow relative values to be stated in percent. According to SCPI, this unit
is represented by the PCT string.

Example:
HCOP:PAGE:SCAL 90PCT

Special numeric values

The texts listed below are interpreted as special numeric values. In the case of a
query, the numeric value is provided.

e MIN/MAX
MINimum and MAXimum denote the minimum and maximum value.
e DEF

DEFault denotes a preset value which has been stored in the EPROM. This value
conforms to the default setting, as it is called by the *RST command.

e UP/DOWN
UP, DOWN increases or reduces the numeric value by one step. The step width
can be specified via an allocated step command for each parameter which can be
set via UP, DOWN.

® INF/NINF
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INFinity, Negative INFinity (NINF) represent the numeric values 9.9E37 or -9.9E37,
respectively. INF and NINF are only sent as instrument responses.

* NAN
Not A Number (NAN) represents the value 9.91E37. NAN is only sent as a instru-
ment response. This value is not defined. Possible causes are the division of zero
by zero, the subtraction of infinite from infinite and the representation of missing
values.

Example:
Setting command: SENSe:LIST: FREQ MAXimum
Query: SENS:LIST:FREQ?, Response: 3.5E9

Queries for special numeric values

6 The numeric values associated to MAXimum/MINimum/DEFault can be queried by
adding the corresponding mnemonics to the command. They must be entered follow-
ing the quotation mark.
Example: SENSe:LIST:FREQ? MAXimum

Returns the maximum numeric value as a result.

Boolean Parameters

Boolean parameters represent two states. The "ON" state (logically true) is represen-
ted by "ON" or a numeric value 1. The "OFF" state (logically untrue) is represented by
"OFF" or the numeric value 0. The numeric values are provided as the response for a

query.

Example:

Setting command: HCOPy : DEV: COL ON
Query: HCOPy : DEV:COL?

Response: 1

Text parameters

Text parameters observe the syntactic rules for mnemonics, i.e. they can be entered
using a short or long form. Like any parameter, they have to be separated from the
header by a white space. In the case of a query, the short form of the text is provided.

Example:
Setting command: HCOPy : PAGE: ORIentation LANDscape

Query: HCOP : PAGE : ORI ?
Response: LAND

Character strings

Strings must always be entered in quotation marks (' or ").
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Example:
HCOP:ITEM:LABel "Testl" or HCOP:ITEM:LABel 'Testl'

Block data

Block data is a format which is suitable for the transmission of large amounts of data. A
command using a block data parameter has the following structure:

Example:
FORMat :READings :DATA #45168XXXXXXXX

The ASCII character # introduces the data block. The next number indicates how many
of the following digits describe the length of the data block. In the example the 4 follow-
ing digits indicate the length to be 5168 bytes. The data bytes follow. During the trans-
mission of these data bytes all end or other control signs are ignored until all bytes are
transmitted.

#0 specifies a data block of indefinite length. The use of the indefinite format requires a
NL~END message to terminate the data block. This format is useful when the length of

the transmission is not known or if speed or other considerations prevent segmentation
of the data into blocks of definite length.

Overview of Syntax Elements

The following table provides an overview of the syntax elements:

The colon separates the mnemonics of a command. In a command line the separating semico-
lon marks the uppermost command level.

The semicolon separates two commands of a command line. It does not alter the path.

s The comma separates several parameters of a command.

? The question mark forms a query.

* The asterisk marks a common command.

v Quotation marks introduce a string and terminate it (both single and double quotation marks are
" possible).

# The hash symbol introduces binary, octal, hexadecimal and block data.
®  Binary: #810110

® Octal: #07612

® Hexa: #HF3A7

®  Block: #21312

A "white space" (ASCII-Code 0 to 9, 11 to 32 decimal, e.g. blank) separates the header from the
parameters.

6.3.5 Structure of a command line

A command line may consist of one or several commands. It is terminated by one of
the following:
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® a<New Line>
® a<New Line> with EOI
® an EOI together with the last data byte

Several commands in a command line must be separated by a semicolon ";". If the
next command belongs to a different command system, the semicolon is followed by a
colon.

Example:
MMEM:COPY "Testl", "MeasurementXY"; :HCOP:ITEM ALL

This command line contains two commands. The first command belongs to the MMEM
system, the second command belongs to the HCOP system.

If the successive commands belong to the same system, having one or several levels
in common, the command line can be abbreviated. To this end, the second command
after the semicolon starts with the level that lies below the common levels. The colon
following the semicolon must be omitted in this case.

Example:

HCOP:ITEM ALL; :HCOP:IMM

This command line contains two commands. Both commands are part of the HCOP
command system, i.e. they have one level in common.

When abbreviating the command line, the second command begins with the level
below HCOP. The colon after the semicolon is omitted. The abbreviated form of the
command line reads as follows:

HCOP:ITEM ALL; IMM
A new command line always begins with the complete path.

Example:
HCOP:ITEM ALL
HCOP:IMM

Responses to Queries

A query is defined for each setting command unless explicitly specified otherwise. It is
formed by adding a question mark to the associated setting command. According to
SCPI, the responses to queries are partly subject to stricter rules than in standard
IEEE 488.2.

® The requested parameter is transmitted without a header.
Example: HCOP: PAGE : ORI ?, Response: LAND

® Maximum values, minimum values and all other quantities that are requested via a
special text parameter are returned as numeric values.
Example: SENSe: FREQuency:STOP? MAX, Response: 3.5E9
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® Numeric values are output without a unit. Physical quantities are referred to the
basic units or to the units set using the Unit command. The response 3.5E9 in
the previous example stands for 3.5 GHz.

® Truth values (Boolean values) are returned as 0 (for OFF) and 1 (for ON).
Example:
Setting command: HCOPy : DEV: COL ON
Query: HCOPy : DEV:COL?
Response: 1

® Text (character data) is returned in a short form.
Example:
Setting command: HCOPy: PAGE: ORIentation LANDscape
Query: HCOP : PAGE : ORI ?
Response: LAND

6.4 Command Sequence and Synchronization

IEEE 488.2 defines a distinction between overlapped and sequential commands:

® A sequential command is one which finishes executing before the next command
starts executing. Commands that are processed quickly are implemented as
sequential commands. Sequential commands are not implemented in the instru-
ment, however the execution time of most commands is so short that they act as
sequential commands when sent in different command lines.

® An overlapping command is one which does not automatically finish executing
before the next command starts executing. Usually, overlapping commands take
longer to process and allow the program to do other tasks while being executed. If
overlapping commands do have to be executed in a defined order, e.g. in order to
avoid wrong measurement results, they must be serviced sequentially. Keeping the
order is called synchronization between the controller and the instrument.

Setting commands within one command line, even though they can be implemented as
sequential commands, are not necessarily serviced in the order in which they have
been received. To make sure that commands are actually executed in a certain order,
each command must be sent in a separate command line.
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Example: Commands and queries in one message

The response to a query combined in a program message with commands that affect
the queried value is not predictable.

The following commands always return the specified result:

:FREQ:STAR 1GHZ;SPAN 100 :FREQ:STAR?

Result:

1000000000 (1 GHz)

Whereas the result for the following commands is not specified by SCPI:

:FREQ:STAR 1GHz;STAR?;SPAN 1000000

The result could be the value of STARt before the command was sent since the instru-
ment can defer executing the individual commands until a program message termina-

tor is received. The result could also be 1 GHz if the instrument executes commands
as they are received.

6 As a general rule, send commands and queries in different program messages.

Example: Overlapping command with *OPC

The instrument implements INITiate[:IMMediate] as an overlapped command.
Assuming that INITiate[:IMMediate] takes longer to execute than *OpcC, sending
the following command sequence results in initiating a sweep and, after some time,
setting the OPC bit in the ESR:

INIT; *OPC.

Sending the following commands still initiates a sweep:
INIT; *OPC; *CLS

However, since the operation is still pending when the instrument executes *CLs, forc-
ing it into the "Operation Complete Command Idle" state (OCIS), *0OPc is effectively
skipped. The OPC bit is not set until the instrument executes another *OPC command.

6.4.1 Preventing Overlapping Execution

To prevent an overlapping execution of commands, one of the commands *OPC,
*OPC? or *WAI can be used. All three commands cause a certain action only to be
carried out after the hardware has been set. By suitable programming, the controller
can be forced to wait for the corresponding action to occur.
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Table 6-2: Synchronization using *OPC, *OPC? and *WAI

Com- Action Programming the controller

mand

*OPC Sets the Operation Complete bit in the ESR ®  Setting bit 0 in the ESE
after all previous commands have been exe- | ®  Setting bit 5 in the SRE
cuted. ®  Waiting for service request (SRQ)

*OPC? Stops command processing until 1 is Sending *OPC? directly after the command
returned. This is only the case after the Oper- | whose processing should be terminated
ation Complete bit has been set in the ESR. before other commands can be executed.
This bit indicates that the previous setting has
been completed.

*WAI Stops further command processing until all Sending *WAI directly after the command
commands sent before *WAI have been exe- | whose processing should be terminated
cuted. before other commands are executed.

Command synchronization using *WAI or *OPC? is a good choice if the overlapped
command takes only little time to process. The two synchronization commands simply
block overlapped execution of the command. Append the synchronization command to
the overlapping command, for example:

SINGle; *OPC?

For time consuming overlapped commands you can allow the controller or the instru-
ment to do other useful work while waiting for command execution. Use one of the fol-
lowing methods:

*OPC with a service request

1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

2. Setbit no. 5 in the SRE: *SRE 32 to enable ESB service request.
3. Send the overlapped command with *OPC

4. Wait for a service request

The service request indicates that the overlapped command has finished.

*OPC? with a service request

1. Set bit no. 4 in the SRE: *SRE 16 to enable MAV service request.
2. Send the overlapped command with *OPC?

3. Wait for a service request

The service request indicates that the overlapped command has finished.

Event Status Register (ESE)
1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1
2. Send the overlapped command without *OPC, *OPC? or *WAI
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3. Poll the operation complete state periodically (by means of a timer) using the
sequence: *OPC; *ESR?

A return value (LSB) of 1 indicates that the overlapped command has finished.

6.5 Status Reporting System

The status reporting system stores all information on the current operating state of the
instrument, and on errors which have occurred. This information is stored in the status
registers and in the error queue.

You can query both with the commands of the STATus Subsystem.

6.5.1 Hierarchy of the Status Registers

The Figure 6-1 shows the hierarchical structure of information in the status registers
(ascending from left to right).
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Figure 6-1: Graphical overview of the status registers hierarchy

OPER = Operation Status Summary Bit
RQS/MSS = Service Request Generation

ESB = Standard Event Status Summary Bit
MAV = Message Available in Output Queue
QUES = Questionable Status Summary Bit

2 = Error- /Event-Queue

1,0 = not used

Note: This legend explains the abbreviations to the Status Byte Register.

The R&S SMB uses the following status registers:

e Status Byte (STB) and Service Request Enable (SRE), see Chapter 6.5.3, "Sta-
tus Byte (STB) and Service Request Enable Register (SRE)", on page 273.

| —
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e Standard Event Status, i.e. the Event status Register (ESR) and the Event Status
Enable (ESE), see Chapter 6.5.4, "Event Status Register (ESR) and Event Status
Enable Register (ESE)", on page 274.

® Questionable Status and Operation Status, the (SCPI status registers, see
Chapter 6.5.2, "Structure of a SCPI Status Register", on page 271, Chapter 6.5.5,
"Questionable Status Register (STATus:QUEStionable)", on page 274 and Chap-
ter 6.5.6, "Operation Status Register (STATus:OPERation)", on page 275.

® Output-Queue
The output queue contains the messages the instrument returns to the controller. It
is not part of the status reporting system but determines the value of the MAV bit in
the sTB and thus is represented in the overview.

® Error- /Event-Queue
The error-/event-queue contains all errors and events that have occurred in the

past. When reading the queue, the instrument starts with the first occurred error/
event.

All status registers have the same internal structure.

SRE, ESE

The service request enable register SRE can be used as ENAB1e part of the STB if the
STB is structured according to SCPI. By analogy, the ESE can be used as the ENAB1e
part of the ESR.

6.5.2

Structure of a SCPI Status Register

Each standard SCPI register consists of 5 parts. Each part has a width of 16 bits and
has different functions. The individual bits are independent of each other, i.e. each
hardware status is assigned a bit number which is valid for all five parts. Bit 15 (the
most significant bit) is set to zero for all parts. Thus the contents of the register parts
can be processed by the controller as positive integers.

States, events or summary bits of other register:

B T T T T T A

13 | 12 CONDition part

by b d b v bbb

15| 14 | 13 | 12 PTRansition part

w |— w |e—
N |— N |
- e— - |le—
o e O |

15 14 | 13 | 12 NTRansition part 3 2 1 0

EEERERERERENEEN

15| 14 | 13 | 12 EVEN part 32 (1|0

NENNNRRNANEENY
'

Logic OR of
all bits

Summary bit of SCPI register,
written into a bit of the STB or
into the CONDition bit of a
superordinate register.

Logical AND of
EVENt and
ENABIe bits

15 | 14 | 13 | 12 ENABIle part 3|12 (1]0

Figure 6-2: The status-register model
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Description of the five status register parts

The five parts of a SCPI register have different properties and functions:

CONDition

The CONDition part is written into directly by the hardware or the sum bit of the
next lower register. Its contents reflect the current instrument status. This register
part can only be read, but not written into or cleared. Its contents are not affected
by reading.

PTRansition / NTRansition

The two transition register parts define which state transition of the CONDition
part (none, 0 to 1, 1 to 0 or both) is stored in the EVENt part.

The Positive-TRansition part acts as a transition filter. When a bit of the
CONDition partis changed from O to 1, the associated PTR bit decides whether
the EVENt bit is set to 1.

— PTR bit =1: the EVENt bit is set.
— PTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.

The Negative-TRansition part also acts as a transition filter. When a bit of the
CONDition partis changed from 1 to 0, the associated NTR bit decides whether
the EVENt bit is set to 1.

— NTR bit =1: the EVENt bit is set.
— NTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.

EVENt

The EVENt part indicates whether an event has occurred since the last reading, it
is the "memory" of the condition part. It only indicates events passed on by the
transition filters. It is permanently updated by the instrument. This part can only be
read by the user. Reading the register clears it. This part is often equated with the
entire register.

ENABIle

The ENAB1e part determines whether the associated EVENt bit contributes to the
sum bit (see below). Each bit of the EVENt part is "ANDed" with the associated
ENABIle bit (symbol '&'"). The results of all logical operations of this part are passed
on to the sum bit via an "OR" function (symbol '+').

ENABle bit = 0: the associated EVENt bit does not contribute to the sum bit
ENABle bit = 1: if the associated EVENt bit is "1", the sum bit is set to "1" as well.
This part can be written into and read by the user as required. Its contents are not
affected by reading.

Sum bit

The sum bit is obtained from the EVENt and ENAB1e part for each register. The result
is then entered into a bit of the CONDition part of the higher-order register.

e
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The instrument automatically generates the sum bit for each register. Thus an event
can lead to a service request throughout all levels of the hierarchy.

6.5.3 Status Byte (STB) and Service Request Enable Register (SRE)

The STatus Byte (STB) is already defined in IEEE 488.2. It provides a rough over-
view of the instrument status by collecting the pieces of information of the lower regis-
ters. A special feature is that bit 6 acts as the sum bit of the remaining bits of the status
byte.

The STB is read using the command *STB? or a serial poll.

The sSTatus Byte (STB)is linked to the Service Request Enable (SRE) register.
Each bit of the STB is assigned a bit in the SRE. Bit 6 of the SRE is ignored. If a bit is
set in the SRE and the associated bit in the STB changes from 0 to 1, a service
request (SRQ) is generated. The SRE can be set using the command *sRE and read
using the command *SRE?.

Table 6-3: Meaning of the bits used in the status byte

Bit No. | Meaning

0...1 Not used

2 Error Queue not empty

The bit is set when an entry is made in the error queue. If this bit is enabled by the SRE, each
entry of the error queue generates a service request. Thus an error can be recognized and
specified in greater detail by polling the error queue. The poll provides an informative error mes-
sage. This procedure is to be recommended since it considerably reduces the problems
involved with remote control.

3 QUEStionable status register summary bit

The bit is set if an EVENt bit is set in the QUEStionable status register and the associated
ENABle bit is set to 1. A set bit indicates a questionable instrument status, which can be speci-
fied in greater detail by querying the STATus : QUEStionable status register.

4 MAV bit (message available)

The bit is set if a message is available in the output queue which can be read. This bit can be
used to enable data to be automatically read from the instrument to the controller.

5 ESB bit

Sum bit of the event status register. It is set if one of the bits in the event status register is set
and enabled in the event status enable register. Setting of this bit indicates a serious error which
can be specified in greater detail by polling the event status register.

6 MSS bit (master status summary bit)

The bit is set if the instrument triggers a service request. This is the case if one of the other bits
of this registers is set together with its mask bit in the service request enable register SRE.

7 STATus:OPERation status register summary bit

The bit is set if an EVENt bit is set in the OPERat ion status register and the associated
ENABle bitis set to 1. A set bit indicates that the instrument is just performing an action. The
type of action can be determined by querying the STATus : OPERation status register.
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6.5.4 Event Status Register (ESR) and Event Status Enable Register
(ESE)

The ESR is defined in IEEE 488.2. It can be compared with the EVENt part of a SCPI
register. The event status register can be read out using command *ESR?.

The ESE corresponds to the ENAB1e part of a SCPI register. If a bit is set in the ESE
and the associated bit in the ESR changes from 0 to 1, the ESB bit in the STB is set.
The ESE register can be set using the command *ESE and read using the command
*ESE?.

Table 6-4: Meaning of the bits used in the event status register

Bit No. | Meaning

0 Operation Complete
This bit is set on receipt of the command *OPC exactly when all previous commands have been
executed.

1 Not used

2 Query Error

This bit is set if either the controller wants to read data from the instrument without having sent a
query, or if it does not fetch requested data and sends new instructions to the instrument
instead. The cause is often a query which is faulty and hence cannot be executed.

3 Device-dependent Error

This bit is set if a device-dependent error occurs. An error message with a number between
-300 and -399 or a positive error number, which denotes the error in greater detail, is entered
into the error queue.

4 Execution Error

This bit is set if a received command is syntactically correct but cannot be performed for other
reasons. An error message with a number between -200 and -300, which denotes the error in
greater detail, is entered into the error queue.

5 Command Error

This bit is set if a command is received, which is undefined or syntactically incorrect. An error
message with a number between -100 and -200, which denotes the error in greater detail, is
entered into the error queue.

6 User Request

This bit is set when the instrument is switched over to manual control.

7 Power On (supply voltage on)

This bit is set on switching on the instrument.

6.5.5 Questionable Status Register (STATus:QUEStionable)

This register contains information on questionable instrument states. Such states may
occur when the instrument is not operated in compliance with its specifications.

To read the register, use the query commands STAT:QUEST:COND? or
STAT:QUEST[:EVEN]?.



Status Reporting System

Table 6-5: Meaning of the bits used in the questionable status register

Bit No. | Meaning

0-15 Not used

6.5.6 Operation Status Register (STATus:OPERation)

This condition part contains information on the actions currently being performed by
the instrument, while the event part contains information on the actions performed by
the instrument since the last readout of the register.

To read the register, use the query commands STAT:OPER:COND? or
STAT:OPER[:EVEN]?.

Table 6-6: Meaning of the bits used in the operation status register

Bit No. | Meaning

0 Calibrating

The bit is set during the calibration phase.

1-2 Not used

3 Sweeping

This bit is set during a sweep in automatic or single mode.

4-15 Not used

6.5.7 Application of the Status Reporting System

The purpose of the status reporting system is to monitor the status of one or several
devices in a measuring system. To do this and react appropriately, the controller must
receive and evaluate the information of all devices. The following standard methods
are used:

® Service request (SRQ) initiated by the instrument

® Serial poll of all devices in the bus system, initiated by the controller to find out
who sent an SRQ and why

® Query of a specific instrument status by commands
® Query of the error queue

6.5.7.1 Service Request

Under certain circumstances, the instrument can send a service request (SRQ) to the
controller. Usually this service request initiates an interrupt at the controller, to which
the control program can react appropriately. An SRQ is always initiated if one or sev-
eral of bits 2, 4 or 5 of the status byte are set and enabled in the SRE. Each of these
bits combines the information of the error queue or the output buffer. To use the possi-
bilities of the service request effectively, all bits should be set to "1" in the enable regis-
ters SRE and ESE.
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6.5.7.3

6.5.7.4

Status Reporting System

Example:

Use command *OPC to generate an SRQ .

*ESE 1 - set bit 0 of ESE (Operation Complete)

*SRE 32 - set bit 5 of SRE (ESB).

After its settings have been completed, the instrument generates an SRQ.

The SRQ is the only possibility for the instrument to become active on its own. Each
controller program should set the instrument such that a service request is initiated in
the case of malfunction. The program should react appropriately to the service request.

Serial Poll

In a serial poll, just as with command *STB, the status byte of an instrument is queried.
However, the query is realized via interface messages and is thus clearly faster.

The serial poll method is defined in IEEE 488.1 and used to be the only standard pos-
sibility for different instruments to poll the status byte. The method also works for
instruments which do not adhere to SCPI or IEEE 488.2.

The serial poll is mainly used to obtain a fast overview of the state of several instru-
ments connected to the controller.

Query of an instrument status

Each part of any status register can be read using queries. There are two types of
commands:

® The common commands *ESR?, *IDN?, *IST?, *STB? query the higher-level
registers.

® The commands of the STATus system query the SCPI registers
(STATus:QUEStionable...)

The returned value is always a decimal number that represents the bit pattern of the
queried register. This number is evaluated by the controller program.

Queries are usually used after an SRQ in order to obtain more detailed information on
the cause of the SRQ.

Error Queue

Each error state in the instrument leads to an entry in the error queue. The entries of
the error queue are detailed plain text error messages that can be looked up in the
Error Log or queried via remote control using SYSTem:ERRor [ : NEXT] ?. Each call of
SYSTem:ERRor [ :NEXT] ? provides one entry from the error queue. If no error mes-
sages are stored there any more, the instrument responds with 0, "No error".

The error queue should be queried after every SRQ in the controller program as the
entries describe the cause of an error more precisely than the status registers. Espe-
cially in the test phase of a controller program the error queue should be queried regu-
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General Programming Recommendations

larly since faulty commands from the controller to the instrument are recorded there as
well.

Reset Values of the Status Reporting System

The following table contains the different commands and events causing the status
reporting system to be reset. None of the commands, except of *RST and

SYSTem: PRESet affect the functional instrument settings. In particular, DC1. does not
change the instrument settings.

Table 6-7: Resetting the status reporting system

Event Switching on supply | DCL, *RST or STATus: | *CLS
voltage SDC SYSTem: | PRESet
Power-On-Status- (Device | PRESet
Clear Clear,
Selected
Device
Effect 0 1
¢ Clear)
Clear STB, ESR - Yes - - - Yes
Clear SRE, ESE - Yes - - - -
Clear PPE - Yes - - - -
Clear error queue Yes Yes - - - Yes
Clear output buffer Yes Yes Yes 1) 1) 1)
Clear command processing Yes Yes Yes - - -
and input buffer
1) The first command in a command line that immediately follows a <PROGRAM MESSAGE TERMINA-
TOR> clears the output buffer.

6.6 General Programming Recommendations

Initial instrument status before changing settings

Manual operation is designed for maximum possible operating convenience. In con-
trast, the priority of remote control is the "predictability" of the instrument status. Thus,
when a command attempts to define incompatible settings, the command is ignored
and the instrument status remains unchanged, i.e. other settings are not automatically
adapted. Therefore, control programs should always define an initial instrument status
(e.g. using the *RST command) and then implement the required settings.

Command sequence

As a general rule, send commands and queries in different program messages. Other-
wise, the result of the query may vary depending on which operation is performed first
(see also Preventing Overlapping Execution).
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Reacting to malfunctions

The service request is the only possibility for the instrument to become active on its
own. Each controller program should instruct the instrument to initiate a service
request in case of malfunction. The program should react appropriately to the service
request.

Error queues

The error queue should be queried after every service request in the controller pro-
gram as the entries describe the cause of an error more precisely than the status regis-
ters. Especially in the test phase of a controller program the error queue should be
queried regularly since faulty commands from the controller to the instrument are
recorded there as well.
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7 Remote Control Commands

In the following, all remote-control commands will be presented in detail with their
parameters and the ranges of numerical values.

For an introduction to remote control and the status registers, refer to Chapter 6,
"Remote Control Basics", on page 235.

7.1 Conventions used in SCPI Command Descriptions

Note the following conventions used in the remote command descriptions:

e Command usage
If not specified otherwise, commands can be used both for setting and for querying
parameters.
If a command can be used for setting or querying only, or if it initiates an event, the
usage is stated explicitly.

® Parameter usage
If not specified otherwise, a parameter can be used to set a value and it is the
result of a query.
Parameters required only for setting are indicated as Setting parameters.
Parameters required only to refine a query are indicated as Query parameters.
Parameters that are only returned as the result of a query are indicated as Return
values.

® Conformity

Commands that are taken from the SCPI standard are indicated as SCPI con-
firmed. All commands used by the R&S SMB follow the SCPI syntax rules.

® Asynchronous commands
A command which does not automatically finish executing before the next com-
mand starts executing (overlapping command) is indicated as an Asynchronous
command.

® Reset values (*RST)
Default parameter values that are used directly after resetting the instrument (*RST
command) are indicated as *RST values, if available.

® Default unit
This is the unit used for numeric values if no other unit is provided with the parame-
ter.

® Manual operation
If the result of a remote command can also be achieved in manual operation, a link
to the description is inserted.

7.2 Common Commands

Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These
commands have the same effect and are employed in the same way on different devi-

| —
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ces. The headers of these commands consist of "*" followed by three letters. Many
common commands are related to the Status Reporting System.

Available common commands:

O] PP PP 280
B ] TP PTTPPPPP 280
B =T PP 280
10 PP PSPPSR 281
5 1 281
B PPN 281
B 281
P RE et 282
B O TP 282
O PP 282
S PP 282
ESAV et e 283
O RE . e 283
RS 1= 283
B 5P P PPN 283
LS 1 I TP P OURPR P 283
AT PP 284
*CLS

Clear status

Sets the status byte (STB), the standard event register (ESR) and the EVENt part of
the QUEStionable and the OPERation registers to zero. The command does not
alter the mask and transition parts of the registers. It clears the output buffer.

Usage: Setting only

*ESE <Value>
Event status enable

Sets the event status enable register to the specified value. The query returns the con-
tents of the event status enable register in decimal form.

Parameters:
<Value> Range: 0 to 255

*ESR?
Event status read

Returns the contents of the event status register in decimal form and subsequently
sets the register to zero.

Return values:
<Contents> Range: 0 to 255
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Usage: Query only

*IDN?
Identification
Returns the instrument identification.

Return values:

<|D> "Rohde&Schwarz,<device type>,<serial number>,<firmware ver-
sion>"
Example: Rohde&Schwarz, SMB,

1407.6004k02/000000,3.1.17.1-03.01.158
Usage: Query only

Manual operation: See "Hardware Options / Software Options" on page 96

*IST?
Individual status query

Returns the contents of the IST flag in decimal form. The IST flag is the status bit
which is sent during a parallel poll.

Return values:

<|STflag> 011
Usage: Query only
*OPC

Operation complete

Sets bit 0 in the event status register when all preceding commands have been execu-
ted. This bit can be used to initiate a service request. The query form writes a "1" into
the output buffer as soon as all preceding commands have been executed. This is
used for command synchronization.

*OPT?
Option identification query

Queries the options included in the instrument. For a list of all available options and
their description refer to the data sheet.

Return values:

<Options> The query returns a list of options. The options are returned at
fixed positions in a comma-separated string. A zero is returned
for options that are not installed.

Usage: Query only
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Manual operation: See "Hardware Options / Software Options" on page 96

*PRE <Value>
Parallel poll register enable

Sets parallel poll enable register to the indicated value. The query returns the contents
of the parallel poll enable register in decimal form.

Parameters:
<Value> Range: 0 to 255

*PSC <Action>
Power on status clear

Determines whether the contents of the ENAB1e registers are preserved or reset when
the instrument is switched on. Thus a service request can be triggered when the instru-
ment is switched on, if the status registers ESE and SRE are suitably configured. The
query reads out the contents of the "power-on-status-clear" flag.

Parameters:

<Action> 011
0
The contents of the status registers are preserved.
1

Resets the status registers.

*RCL <Number>
Recall

Loads the instrument settings from an intermediate memory identified by the specified
number. The instrument settings can be stored to this memory using the command
*SAV with the associated number.

It also activates the instrument settings which are stored in a file and loaded using the
MMEMory:LOAD <number>, <file name.extension>command.

Manual operation: See "Recall" on page 129

*RST
Reset

Sets the instrument to a defined default status. The default settings are indicated in the
description of commands.

The command is equivalent to SYSTem: PRESet.
Usage: Setting only

Manual operation: See "Preset” on page 91
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*SAV <Number>
Save

Stores the current instrument settings under the specified number in an intermediate
memory. The settings can be recalled using the command *RCL with the associated
number.

To transfer the stored instrument settings in a file, use the command : MMEMory :
STORe:STATe.

Manual operation: See "Save" on page 128

*SRE <Contents>
Service request enable

Sets the service request enable register to the indicated value. This command deter-
mines under which conditions a service request is triggered.

Parameters:

<Contents> Contents of the service request enable register in decimal form.
Bit 6 (MSS mask bit) is always 0.
Range: 0 to 255

*STB?

Status byte query

Reads the contents of the status byte in decimal form.

Usage: Query only

*TRG

Trigger

Triggers all actions waiting for a trigger event. In particular, “TRG generates a manual
trigger signal. This common command complements the commands of the TRIGger
subsystem.

Usage: Event

Manual operation: See "Execute Single Trigger" on page 229
*TST?

Self-test query

Initiates self-tests of the instrument and returns an error code
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Return values:
<ErrorCode> integer > 0 (in decimal format)
An error occurred.
(For details see the Service Manual supplied with the instru-

ment).

0

No errors occurred.
Usage: Query only
*WAI

Wait to continue

Prevents servicing of the subsequent commands until all preceding commands have
been executed and all signals have settled (see also command synchronization and
*OPC).

Usage: Event

Preset Commands

The preset commands are not bundled in one subsystem. Therefore, they are listed
separately in this section. In addition, a specific preset command is provided for each
digital standard and for the fader. These specific commands are described in the asso-
ciated subsystems.

Four presetting actions are available:

® Activating the default state of all internal instrument functions (*RST on page 282).
Functions that concern the integration of the instrument into a measurement setup
are not changed, e.g. GPIB address or reference oscillator source settings.

® Activating the preset state of the parameters related to the selected signal path (:
SOURce<hw>:PRESet on page 285)

® Activating the preset state of all parameters that are not related to the signal path
(:DEVice:PRESet on page 284)

® Activating the original state of delivery (factory reset, : SYSTem: FPReset
on page 285). Only functions that are protected by a password remain unchanged
as well as the passwords themselves.

:DEVice:PRESet

Presets all parameters which are not related to the signal path, including the LF gener-
ator.

Example: Presets all instruments settings that are not related to the signal
path
Usage: Event
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:SOURce<hw>:PRESet
Presets all parameters which are related to the selected signal path.
The following functions are only preset by command *RST: Fading, transient recorder.

Example: SOUR:PRES
Presets all settings that are related to signal path

Usage: Event

:SYSTem:PRESet

Triggers an instrument reset. It has the same effect as:
® The PRESET key
® The *RST command

For an overview of the settings affected by the preset function, see Chapter 5.2.2,
"Default Instrument Settings - Preset Key", on page 91.

Example: SYST:PRES
All instrument settings (also the settings that are not currently
active) are reset to their default values.

Usage: Setting only

:SYSTem:FPReset
Triggers an instrument reset to the original state of delivery.

Note: "Factory Preset" resets the "Remote Channel" and network settings to the
default values.

Executing "Factory Preset" via remote control terminates the connection to the instru-
ment, if these settings had been configured to values different to the default ones.

The factory preset function resets nearly all instrument settings. In addition to the regu-
lar preset by means of the PRESET key, a "Factory Preset" resets also the following
values:

® Reference frequency settings ("Ref Oscillator" menu)

® Power on settings ("Level/EMF" menu)

® Network settings including hostname ("Setup" menu)

® Remote channel settings including GPIB address ("Setup" menu)
® Start/Stop display update ("Setup" menu)

® Display and keyboard settings ("Setup" menu).

To maintain security, password settings and all settings protected by these passwords
like disabled USB and LAN connections are not changed.

Not affected by the "Factory Preset" are also user data, lists or instrument settings
files, created for example by means of the Save/Recall function.
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CALibration Subsystem

Example: SYST:FPR
All instrument settings (also the settings that are not currently
active) are reset to the factory values.

Usage: Event

Manual operation: See "Factory Preset" on page 120

CALibration Subsystem

The CALibration system contains the commands for adjustment. Adjustment is trig-
gered by the query commands. The response "0" indicates error-free adjustment, and
the response "1" means that an error occurred during adjustment.

:CALIbration<NW>:ALLMEASUIE] 2. ... it ieeietieeees ettt te e e e eetaee s e e s e eet s e e e e e eeane s e e e eeetanaeeeeeenen 286
:CALibration<hw>:FMOFfSEt[:MEASUIE]?.....ceiiiiiiiieieuiaeaaaaa e e e e e e e aeaaeeeeeeeeeeeeeeenenennaenas 286
:CALibration<hw>:FREQUENCY[IMEASUIE]?......cceeeeeeeeeeeeeieieieiieiieaeaaae e e e e e eeeeeaaaeeeeeeeeeees 287
:CALIbration<hW>:LEVEIIMEASUIE]?....cciiieiieeeeeeeee ettt e e s e s e e e e e aeaeaaeeeeeeeeeeeens 287
:CALibration<hw>:LEVel:EXTErM:DATA. .. ..coi ittt e e e e e e e eeecrreeeer e e e e e e e e e s sennnraraeeeeaeas 287
:CALibration<hw>:ROSCillator]:DATA]. . .cceeetueeeeeeeeteiee e e e eeetreeeeeeeeeteeeeeeeesaaaeeaesessaaaeaaeens 288
[:SOURCce]:CALibration:STERE0:ANALOGIMEAS]?....uieieieieiieieeeeee e 288

:CALibration<hw>:ALL[:MEASure]? [<Force>]
Starts all internal adjustments that do not require external measurement equipment.

Query parameters:

<Force> string

Return values:

<Measure> select
Example: CAL:ALL:MEAS?

// Response "0O"

// Adjustment has been performed successfully
Usage: Query only

Manual operation: See "Adjust All" on page 93

:CALibration<hw>:FMOFfset[:MEASure]?
The command starts all adjustment for the FM/PhiM modulator.

Return values:
<Measure> 011

Example: CAL:FMOF?
starts the adjustments for the FM/Phim modulator.
Response: "0"
the adjustments have been performed successfully

Usage: Query only
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Manual operation: See "Adjust FM Offset" on page 205

:CALibration<hw>:FREQuency[:MEASure]?
Starts all adjustments which affect the frequency.

Return values:
<Measure> 011

Example: CAL:FREQ:MEAS?
starts the adjustments for maximum frequency accuracy.
Response: "0"
the adjustments have been performed successfully.

Usage: Query only

Manual operation: See "Adjust Synthesis" on page 93

:CALibration<hw>:LEVel[:MEASure]? [<Force>]
Starts all adjustments which affect the level.
The acquired correction values improve the settling time and the signal quality.

Query parameters:

<Force> string
*RST: force
Return values:
<Measure> 0]1
Example: CAL:LEV:MEAS?

starts adjustments for maximum level accuracy.
Response: "0"
adjustment has been performed successfully.

Usage: Query only

Manual operation: See "Adjust Level" on page 94

:CALibration<hw>:LEVel:EXTern:DATA <Data>
Queries what data has been used for the level calibration.

By default the instrument uses correction data obtained in the factory before delivery.
In addition, customer data can be used for external level correction. The customer data
is obtained using a R&S NRP power sensor. External level correction is a protected
function (see service manual, chapter 2, "Adjustment”).

Parameters:
<Data> FACTory | CUSTomer

*RST: FACTory
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Example: CAL:LEV:EXT:DATA FACT
selects the use of the data aquired at the factory for external
level correction.

Manual operation: See "Adjustment Data" on page 151

:CALibration<hw>:ROSCillator[:DATA] <Data>

Sets the calibration value for the custom defined external adjustment.

Parameters:

<Data> integer
Range: 0 to INT_MAX
*RST: 0

[:SOURce]:CALibration:STEReo:ANALog[:MEAS]?

The command starts all adjustments which affect the analog channels of the stereo
coder option.

Return values:
<Meas> 011

Example: CAL:STER:ANAL?

starts the adjustments for analog channels of the stereo coder.
Response: 0

the adjustments have been performed successfully.
Usage: Query only
Options: R&S SMB-B5

Manual operation: See "Adjust Stereo Coder" on page 94

7.5 DIAGnostic Subsystem

The DIAGnostic system contains the commands used for instrument diagnosis and
servicing. SCPI does not define any DIAGnostic commands; the commands listed here
are all device-specific. All DIAGnostic commands are query commands which are
not influenced by *RsT.
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:DIAGnostic<hw>:BGINfo? [<Board>]

Checks the modules available in the instrument using the variant and revision state.
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If the command is sent without parameters being specified, a complete list of all mod-
ules is returned (the various entries are separated by commas). The length of the list is
variable and depends on the instrument equipment configuration.

If the command is sent with parameters, a list of the specified modules is returned (the
various entries are separated by commas). A list of modules names can be called up
using the command : DIAGnostic<hw>:BGINfo:CATalog? on page 289.

Query parameters:
<Board> string

Return values:
<Bglnfo> < Module name> <Module stock number incl. variant> <Module
revision> <Module serial number>

Each entry for one module consists of four parts which are sepa-
rated by space characters.

Example: DIAG:BGIN
Queries the instrument configuration.
Returns the data of all available modules.
DIAG:BGIN? 'MBRD'

Queries the configuration of the motherboard.
Response: MBRD 1141.3501.02 1.5.3 100023

Module motherboard with part number 1141.3501.01 has revi-
sion 1.5.3 and serial number 100023.

Usage: Query only

Manual operation: See "Assembly” on page 95

:DIAGnostic<hw>:BGINfo:CATalog?
Queries the names of the assemblies available in the instrument.

Return values:
<Catalog> string

A complete list of all assemblies is returned (the various entries
are separated by commas). The length of the list is variable and
depends on the instrument equipment configuration.

Example: DIAG:BGIN:CAT
Queries the names of the assembilies.

Usage: Query only

:DIAGnostic:INFO:OTIMe?
The command queries the number of operation hours.

Return values:
<OTIMe> float
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Example: DIAG:INFO:0TIM
queries the operation hours.
Response: 100023
The instrument was operated for 100023 hours up to now.

Usage: Query only

Manual operation: See "Operation Time / h" on page 94

:DIAGnostic:INFO:POCount?
The command queries the number of power-on events.

Return values:
<Pocount> float

Example: DIAG:INFO:POC
queries the number of power on events.
Response: 123
The instrument was switched on for 123 times up to now.

Usage: Query only

Manual operation: See "Power On Count" on page 95

DISPlay Subsystem

The DISP1ay subsystem contains the commands to set the power-save mode of the
instrument.
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:DISPlay:ANNotation:AMPLitude <State>

Indicates asterisks instead of the level values in the status bar.

Parameters:

<State> 0]1]OFF|ON
*RST: 1

Example: DISP:ANN:AMPL ON

Suppresses the level display.
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Manual operation: See "Annotation Amplitude" on page 118

:DISPlay:ANNotation:FREQuency <State>

Indicates asterisks instead of the frequency values in the status bar.

Parameters:

<State> 0|1]|OFF|ON
*RST: 1

Example: DISP:ANN:FREQ ON

Supresses the frequency display.

Manual operation: See "Annotation Frequency" on page 118

:DISPlay:ANNotation[:ALL] <State>

Displays asterisks instead of the level and frequency values in the status bar of the
instrument. This setting is useful when you remotely control the instrument.

Parameters:

<State> 0]1]OFF|ON
*RST: 1

Example: DISP:ANN:AMPL ON

Shows asterisks instead of frequency and level values.

:DISPlay:DIALog:CLOSe <Dialogld>

Closes the specified dialog. To determine the dialog identifier, use command :
DISPlay:DIALog:ID?.

Setting parameters:
<Dialogld> string

Example: DISP:DIAL:CLOS "<dialog ID>"
Closes the dialog, determined with the "<dialog ID>".

Usage: Setting only

:DISPlay:DIALog:CLOSe:ALL
Closes all open dialogs.

Example: DISP:DIAL:CLOS:ALL

Usage: Event

:DISPlay:DIALog:ID?

Returns the dialog identifiers of the open dialogs in a string separated by blanks.
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Return values:
<DialogldList> string

Example: DISP:DIAL:ID?
Response: "<dialog ID(1)> <dialog ID(2)> ...
<dialog ID(n)>"
Returns the dialog identifiers of all opened dialogs.

Usage: Query only

:DISPlay:DIALog:OPEN <Dialogld>

Opens the specified dialog. To determine the dialog identifier, use command :
DISPlay:DIALog:ID?.

Setting parameters:
<Dialogld> string

Example: DISP:DIAL:OPEN "<dialog ID>"
Opens the dialog, determined with the "<dialog ID>".

Usage: Setting only

:DISPlay:PSAVe:HOLDoff <HoldoffTimeMin>
Sets the waiting time for the screen-save mode of the display.

Parameters:
<HoldoffTimeMin> integer

Range: 1 to 60
*RST: 10
Default unit: minute

Example: DISP:PSAV:HOLD 8
Sets the timeout of the screen saver to 8 minutes.

Manual operation: See "Wait Time" on page 108

:DISPlay:PSAVe[:STATe] <State>
Activates the screen-save mode of the display.

If activated, the display including backlight is switched off after the wait time elapses
and if no entries via front panel, external mouse or external keyboard are made. To set
the wait time, use command :DISPlay:PSAVe:HOLDoff.

This mode is recommended for protecting the display, especially if you operate the
instrument via remote control.

Parameters:
<State> 0]1]OFF|ON

*RST: 0
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Example: DISP:PSAV ON
Activates screen saver mode.

Manual operation: See "Screen Saver Active" on page 108

:DISPlay:UPDate <Update>

Activates the refresh mode of the display.

Parameters:

<Update> 0]1]OFF|ON
*RST: 1

Example: DISP:UPD ON
Activates automatic update of the display at defined time inter-
vals.

FORMat Subsystem

The FORMat subsystem contains the commands which determine the format of the
data that the R&S SMB returns to the controller. This affects all query commands
which return a list of numerical data or block data. Reference is made to this in the
descriptions of the commands.
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:FORMat:BORDer <Border>

Determines the sequence of bytes within a binary block. This only affects blocks which
use the IEEE754 format internally.

Parameters:

<Border> NORMal | SWAPped
NORMal
The instrument expects (with setting commands) and sends
(with queries) the least significant byte of each IEEE754 floating-
point number first and the most significant byte last.

SWAPped

The instrument expects (with setting commands) and sends
(with queries) the most significant byte of each IEEE754 floating-
point number first and the least significant byte last.

*RST: NORMal

Example: FORM:BORD SWAP
The data is transferred with the most significant bit first.
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:FORMat[:DATA] <Data>

Determines the data format which the R&S SMB uses to return data. When data is
transferred from the control computer to the instrument, the instrument detects the data
format automatically. In this case, the value set here is irrelevant.

Parameters:

<Data> ASCii | PACKed
ASCii
Numerical data is transferred as plain text separated by com-
mas.

PACKed

Numerical data is transferred as binary block data. The format
within the binary data depends on the command. The various
binary data formats are explained in the description of the
parameter types.

*RST: ASCii

Example: FORM ASC
The data is transferred as ASCII data.

:FORMat:SREGister <Format>
Determines the numerical format which is returned when the status registers are quer-
ied.
Parameters:
<Format> ASCii | BINary | HEXadecimal | OCTal
ASCii
The register content is returned as a decimal number.

BINary
The register content is returned as a binary number. #B is
placed in front of the number.

HEXadecimal
The register content is returned as a hexadecimal number. #H is
placed in front of the number.

OCTal
The register content is returned as an octal number. #Q is
placed in front of the number.

*RST: ASCii

Example: FORM: SREG HEX
The register content is returned as a hexadecimal number.

7.8 HCOPy Subsystem

The HCOPy subsystem contains the commands to generate a hardcopy of the display.
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:HCOPy:DATA?

Transfers the hardcopy data directly as a NByte stream to the remote client.

Return values:
<Data> block data

Example: HCOP:DEV:LANG JPG
HCOP:DATA?
Transfers the hardcopy to the remote client.

Usage: Query only

:HCOPy:DEVice <Device>

Defines the output device. The hardcopy can be output in a file. The HCOPy:FILE:..
commands are used for configuration. The file is accessible using the MMEM: . . com-
mands. In addition, the hardcopy data can be directly transferred to the remote client
using command : HCOPy : DATA?.

Parameters:
<Device> FILE

*RST: FILE
Example: HCOP:DEV FILE

The hardcopy is stored in a file.

Manual operation: See "Destination” on page 122
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:HCOPy:DEVice:LANGuage <Language>
Selects the bitmap graphic format for the screenshot.

You can also retrieve the data using command HCOP : DATA?. This command is an
alias to command HCOPy : IMAGe : FORMat.

Parameters:

<Language> BMP | JPG | XPM | PNG
*RST: PNG

Example: HCOP:DEV:LANG BMP

Selects bitmap as image format.
HCOP:FILE '/usb/HCopy'

Defines the directory, path and filename for storing the hard-

copy.
HCOP

Triggers the hardcopy generation.

Manual operation: See "File Options" on page 123

:HCOPy[:EXECute]
Triggers the generation of a hardcopy.

Example: HCOP
Triggers the generation of a hardcopy of the current display.

Usage: Event

Manual operation: See "Save" on page 125

:HCOPy:FILE[:NAME] <Name>
Creates/selects a file into which the hardcopy is stored.

The path is specified together with the filename. Access to the file via remote control is
possible using the commands of the MMEM subsystem. In contrast, command
HCOPy:DATA? transfers the hardcopy contents directly to the remote client where they
can be further processed.

If automatic file naming is activated, the hardcopy is stored into a file with an automati-
cally generated name (commands HCOPY:FILE [ :NAME] : AUTO:...).

Parameters:
<Name> string
Example: HCOP:FILE:NAME '/usb/HCopy'

Defines the hardcopy filename.

Manual operation: See "File Info" on page 123
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:HCOPYy:FILE[:NAME]:AUTO?
Queries the path including the filename of the file with automatically generated name.

Return values:

<Auto> string
Example: See :HCOPy:FILE[:NAME] : AUTO: FILE? on page 297
Usage: Query only

Manual operation: See "File Options" on page 123

:HCOPy:FILE[:NAME]:AUTO:DIRectory <Directory>

Sets the directory into which the hardcopy files are stored if auto naming is activated
(HCOP:FILE:AUTO:STAT ON).The directory is created if it does not exist yet.

Parameters:
<Directory> string
*RST: \HCopy
Example: HCOP:FILE:AUTO:DIR '/usb/'

Defines the destination directory '/usb/'

Manual operation: See "File Options" on page 123

:HCOPy:FILE[:NAME]:AUTO:DIRectory:CLEar

Deletes all files with extensions "bmp", "img", "png" and "xpm" in the directory set for
automatic naming.

Example: HCOP:FILE:AUTO:DIR:CLE
Deletes all image files with extensions "bmp", "img", "png" and
"Xpm".

Usage: Event

Manual operation: See "File Options" on page 123

:HCOPy:FILE[:NAME]:AUTO:FILE?

Queries the filename that what generated using the automatic naming settings. By
default the automatically generated filename is composed of:

<Prefix><YYYY><MM><DD><Number>.<Format>.
Each component can be deactivated/activated separately.

Return values:
<File> string
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Usage:

Manual operation:

HCOPy Subsystem

HCOP:DEV:LANG BMP

Selects output format *.bmp.
HCOP:FILE:AUTO:DIR '/usb/'

Defines the destination directory '/usb/'
HCOP:FILE:AUTO:PREF 'gen'

The filename starts with the prefix 'gen'. The usage of auto-
matic naming with prefix and date in the filename is preset (...:
STAT ON).

HCOP

Triggers the generation of a hardcopy of the current trace.
HCOP:FILE:AUTO?

Queries the path including the filename

Response:

/usb/gen101012008001 .bmp'

HCOP:FILE:AUTO:FILE?

Queries the filename
Response: 'genl01012008001.bmp’

Query only
See "File Info" on page 123

:HCOPYy:FILE[:NAME]:AUTO[:FILE]:DAY?

Queries the day of the current system date which is used in the filename if automatic

naming is activated.

Return values:
<Day>

Example:

Usage:

integer

Range: 1 to 31
*RST: 1

HCOP:FILE:AUTO:DAY?
Returns the day in the date part of the automatic filename.

Query only

:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY:STATe <State>

Activates the usage of the day in the automatic filename.

Parameters:
<State>

Example:

Manual operation:

01| OFF | ON
*RST: 1
HCOP:FILE:AUTO:DAY:STAT OFF

Deactivates the use of the day in the automatically generated fil-
ename.

See "File Options" on page 123
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:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh?
Queries the month in the date part in the automatic filename.

Return values:

<Month> integer
Range: 1 to 12
*RST: 1

Example: HCOP:FILE:AUTO:MONT?

Queries the month in the date part in the automatic filename.

Usage: Query only

:HCOPy:FILE[:NAME]:AUTO[:FILE]:-MONTh:STATe <State>

Activates the usage of the month in the automatic filename.

Parameters:
<State> 0]1]|OFF|ON
*RST: 1
Example: HCOP:FILE:AUTO:MONT:STAT OFF

Deactivates the usage of the month in the automatic filename.

Manual operation: See "File Options" on page 123

:HCOPy:FILE[:NAME]:AUTO[:FILE]:NUMBer?

Queries the number in the automatic filename. The number is assigned in such a way
that always the lowest possible value for a unique filename within the selected path is
used.

On initially switching on the device, the number is reset to the lowest possible value.
Starting with number 0 the output directory is scanned for existing files. As long as files
with the same name are existing, the number is incremented by 1. The number is auto-
matically set to a number so that the resulting filename is unique within the selected
path. The current number is not saved in the save recall file but is temporarily stored
within the database. On subsequent saves, the number is incremented.

Return values:

<Number> integer
Range: 0 to 999999
*RST: 0

Example: HCOP:FILE:AUTO:NUMB?

Queries the number in the automatic filename.
Usage: Query only

Manual operation: See "File Options" on page 123
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:HCOPYy:FILE[:NAME]:AUTOI:FILE]:PREFix <Prefix>

Sets the prefix part in the automatic filename. The usage of the prefix is activated with
command HCOP:FILE :AUTO: PREF:STAT ON.

Parameters:
<Prefix> string
*RST: HCopy
Example: HCOP:FILE:AUTO:PREF 'Snapshot'

Appends "Snapshot" as prefix to the generated filename.

Manual operation: See "File Options" on page 123

:HCOPYy:FILE[:NAME]:AUTOI:FILE]:PREFix:STATe <State>

Activates the usage of the prefix in the automatic filename. The prefix is entered with
command HCOP: FILE:AUTO: PREF.

Parameters:
<State> 0|1]OFF|ON
*RST: 1
Example: HCOP:FILE:AUTO:PREF:STAT OFF

Deactivates the usage of the prefix in the automatic filename.

Manual operation: See "File Options" on page 123

:HCOPy:FILE[:NAME]:AUTOI:FILE]:YEAR?
Queries the year in the date part in the automatic filename.

Return values:

<Year> integer
Range: 1784 to 8000
*RST: 0

Example: HCOPy:FILE:AUTO:YEAR?

Queries the year in the date part in the automatic filename.

Usage: Query only

:HCOPYy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe <State>

Activates the usage of the year in the automatic filename.

Parameters:
<State> 0]1]OFF|ON
*RST: 1
Example: HCOP:FILE:AUTO:YEAR:STAT OFF

Deactivates the usage of the year in the automatic filename.
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Manual operation: See "File Options" on page 123

:HCOPYy:FILE[:NAME]:AUTO:STATe <State>

Activates/deactivates automatic naming of the hardcopy files.

Parameters:
<State> 0|1]OFF|ON
*RST: 1
Example: HCOP:FILE:AUTO:STAT OFF

Deactivates automatic naming.

Manual operation: See "Automatic Naming" on page 123

:HCOPy:IMAGe:FORMat <Format>

This command selects the bitmap graphic format for the screenshot. You can also
retrieve the data using command HCOP: DATA?.

This command is an alias to command HCOPy : DEVice : LANGuage.

Parameters:

<Format> BMP | JPG | XPM | PNG
*RST: PNG

Example: HCOP: IMAG:FORM XPM

Selects the image format XPM.

Manual operation: See "File Options" on page 123

:HCOPy:IMAGe:SIZE <Size>

Selects the image size of the hardcopy. The first value of the size setting defines the
width, the second value the height of the image.

Parameters:
<Size> string

*RST: depends on device
Example: HCOP:IMAG:SIZE 640,480

Sets width and height of the image.

7.9 KBOard Subsystem

The KBOard system contains the commands to set the external keyboard.
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:KBOard:LANGuage <Language>

This command selects the keyboard language. The assignment of some keys depends
on the selected language.

Parameters:
<Language> US | DE
*RST: us
Example: KBO:LANG US
selects keyboard language American English.
Usage: SCPI confirmed

Manual operation: See "Layout (USB Keyboard Settings)" on page 108

:KBOard:LAYout <Layout>

Selects the keyboard language. The assignment of some keys depends on the
selected language.

Parameters:

<Layout> CHINese | DANish | DUTCh | DUTBe | ENGLish | ENGUK |
FINNish | FRENch | FREBe | FRECa | GERMan | ITALian |
JAPanese | KORean | NORWegian | PORTuguese | RUSSian |
SPANish | SWEDish | ENGUS
*RST: ENGLish

Example: KBO:LAY US

Activates American English keyboard layout.

Manual operation: See "Layout (USB Keyboard Settings)" on page 108

7.10 MMEMory Subsystem

The MMEMory subsystem (Mass Memory) contains the commands for managing files
and directories as well as for loading and storing complete instrument settings in files.

The files are stored on the internal flash memory of the instrument or on external USB
memory devices.

The /var/user/ directory can be used to save user-defined data; any subdirectory
structure can be created on /var/user/. Some default subdirectories are predefined,
but can be changed at any time.

The default directory is determined using the command MMEMory : CDIR.

Use the command : sySTem:MMEMory: PATH: USER? to query the path of the direc-
tory for user-defined data.
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files on this directory contain data that must not be changed. Therefore, this directory
should not be accessed, since reconstruction of the system partition will lead to data
loss.

6 The /opt directory is a protected and therefore a not accessible system directory. The

7.10.1 File Naming Conventions

To enable files in different file systems to be used, the following file naming conven-
tions should be observed.

The file name can be of any length and is case-sensitive, meaning it is distinguished
between uppercase and lowercase letters.

The file and the optional file extension are separated by a dot. All letters and numbers
are permitted (numbers are, however, not permitted at the beginning of the file name).
If possible, special characters should not be used. The use of the slashes "\" and "/"
should be avoided since they are used in file paths. A number of names are reserved
for the operating system, e.g. CLOCKS, CON, AUX, COM1...COM4, LPT1...LPT3, NUL
and PRN.

In the R&S SMB all files in which lists and settings are stored are given a characteristic
extension. The extension is separated from the actual file name by a dot (see Chap-
ter 4.7.2.1, "Extensions for User Files", on page 85 for an overview of the file types).

nikn

The two characters ™" and "?" function as "wildcards", meaning they are used for
selecting several files. The "?" character represents exactly one character, while the
character represents all characters up to the end of the file name. "*.*" therefore stands
for all files in a directory.

nikn

When used in conjunction with the commands, the parameter <file name> is speci-
fied as a string parameter with quotation marks. It can contain either the complete path
including the drive, only the path and the file name, or only the file name. The file name
must include the file extension. The same applies for the parameters

<directory name>and <path>.

Depending on how much information is provided, either the values specified in the
parameter or the values specified with the command MMEM: CDIR (default directory)
are used for the path and the drive settings in the commands.

Before the instrument settings can be stored in a file, they have to be stored in an inter-
mediate memory using common command *SAV <number>. The specified number is
subsequently used in the : MMEMory: STORe : STATe on page 311 command. Also,
subsequently to loading a file with instrument settings with command : MMEMory :
LOAD: STATe on page 309, these settings have to be activated with the common com-
mand *RCL <number>.

7.10.2 Extensions for User Files

The following table lists all available file extensions for user files. The currently availa-
ble files on the instrument depend on the installed options.
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Table 7-1: List of the automatically assigned file extensions in the instrument

Function List type Contents File suffix
Instrument State Settings Instrument settings *.savrcltxt
"User Correction" List User-defined level correction values *.uco

Export Data * . txtor *.csv
"List Mode" List User-defined frequency/level value pairs * . lsw

Export Data *.txtor*.csv
"Pulse Train List" User-defined offtime/ontime/repetition values * . pulstrn
SMZ Settings Settings Data (firmware) of a connected SMZ frequency | *.efmfirm

multiplier
NRP Settings Settings NRP Settings *.nrp

7.10.3 Examples

In these examples, the current instrument setting is stored in the file
test.savrcltxt in the directory /var/user/ ..

Storing and Loading Current Settings

1. Store the current setting in an intermediate memory with the number 4. This setting
can be called using command *RCL and the associated number of the memory, for
example *RCL 4.

*SAV 4

2. To store the settings in a file in a specific directory, specify the complete path.
MMEM:STOR:STAT 4,"/var/user/test.savrcltxt"

3. To store the settings in a file in the default drive, set the default drive and specify
only the file name.
MMEM:CDIR '/var/user/'*SAV 4
MMEM:STOR:STAT 4,"test.savrcltxt"

4. Load the file test.savrcltxt in the user directory.
MMEM:LOAD:STAT 4, '/var/user/test.savrcltxt'

5. Activate the instrument setting of the file test.savrcltxt.
*RCL 4

Working with Files and Directories

1. Read out all files in the specified directory.
MMEM:CAT? '/usb/user'
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Response: 127145265,175325184, "test,DIR, 0", "temp, DIR, 0",
"readme.txt,ASC,1324","state.savrcltxt, STAT,5327",
"waveform.wv,BIN, 2342"

the directory /usb/user contains the subdirectories test and temp as well as
the files readme. txt, state.savrcltxt and waveform.wv which have differ-
ent file types.

Tip: To query only the subdirectories of the current or specified directory, perform:
MMEM:DCAT? '/usb/user'

Response: "test', 'temp'

To query only the number of subdirectories in the current or specified directory,
perform:

MMEM:DCAT : LENG? '/usb/user'
Response: 2

2. To query the number of files in the current or specified directory, perform:
MMEM:CAT:LENG? '/usb/user'

Response: 3

3. Create a new subdirectory for mass memory storage in the specified directory.
MMEM:MDIR '/usb/new'

4. Copy the file state to a new file.
MMEM:COPY '/var/user/state.savrcltxt','/usb/new'

5. Rename the file state.
MMEM:MOVE 'state.savrcltxt',6 'state new.savrcltxt'

6. Remove the test directory.
MMEM:RDIR '/usb/test'

7.10.4 Remote Control Commands
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:MMEMory:CATalog? <path>

Returns the content of a particular directory.

Query parameters:
<path>

Return values:
<UsedDiskSpace>

<FreeDiskSpace>

<Filelnfo>

Example:
Usage:

Manual operation:

string

String parameter to specify the directory.

If you leave out the path, the command returns the contents of
the directory selected with : MMEMory:CDIRectory.

The path may be relative or absolute.

Byte size of all files in the directory.
Remaining disk space in bytes.

<NameFileN>,<SuffixFileN>,<SizeFileN>
List of files, separated by commas

<NameFileN>
Name of the file.

<SuffixFileN>
Type of the file. Possible suffixes are: ASCii, BINary, DIRectory

<SizeFileN>
Size of the file in bytes.

See "Working with Files and Directories" on page 304.
Query only

See "Directory, File List and File Name" on page 127

:MMEMory:CATalog:LENGth? <Path>

Returns the number of files in the current or in the specified directory.

Query parameters:
<Path>

Return values:
<FileCount>

Example:

Usage:

string

String parameter to specify the directory. If the directory is omit-
ted, the command queries the content of the current directory,
queried with : MMEMory : CDIRectory command.

integer
Number of files.

See "Working with Files and Directories" on page 304.

Query only

:MMEMory:CDIRectory <Directory>

Changes the default directory for mass memory storage. The directory is used for all
subsequent MMEM commands if no path is specified with them.
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Parameters:

<Directory> <directory_name>
String containing the path to another directory. The path can be
relative or absolute.
To change to a higher directory, use two dots ".." .

Example: See "Working with Files and Directories" on page 304.

Usage: SCPI confirmed

Manual operation: See "Directory, File List and File Name" on page 127

:MMEMory:COPY <SourceFile>[,<DestinationFile>]

Copies an existing file to a new file. Instead of just a file, this command can also be
used to copy a complete directory together with all its files.

Setting parameters:
<SourceFile> string

String containing the path and file name of the source file

<DestinationFile> string
String containing the path and name of the target file. The path
can be relative or absolute.
If <DestinationFile> is not specified, the <SourceFile> is
copied to the current directory, queried with the : MMEMory :
CDIRectory command.
Note: Existing files with the same name in the destination direc-
tory are overwritten without an error message.

Example: See "Working with Files and Directories" on page 304.

Usage: Setting only
SCPI confirmed

Manual operation: See "Copy " on page 131

:MMEMory:DATA <Filename>, <BinaryBlock>
:MMEMory:DATA? <Filename>

The setting command writes the block data <BinaryBlock> to the file identified by
<Filename>.

Set the GPIB-bus terminator to EOT to ensure correct data transfer.

The query command transfers the specified file from the instrument to the GPIB-bus
and then on to the controller. It is important to ensure that the intermediate memory on
the controller is large enough to take the file. The setting for the GPIB-bus terminator is
irrelevant.

Tip: Use this command to read/transfer stored instrument settings or waveforms
directly from/to the instrument.
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Parameters:

<BinaryBlock> #<number><length_entry><data>
#: Hash sign; always comes first in the binary block
<number>: the first digit indicates how many digits the subse-
quent length entry has
<length entry>:indicates the number of subsequent bytes
<data>: binary block data for the specified length.
For files with a size with more than nine digits (gigabytes), the
instrument allows the syntax # (<Length>), where <Length>
is the file size in decimal format.

Parameters for setting and query:
<Filename> string

String parameter to specify the name of the file.

Example: MMEMory:DATA '/var/user/test.txt',#15hallo
Writes the block data to the file test. txt.
The digit 1 indicates a length entry of one digit; the digit 5 indi-
cate a length of the binary data (hallo) in bytes.
MMEMory:DATA? '/var/user/test.txt'
Sends the data of the file test. txt from the instrument to the

controller in the form of a binary block.
Response: #15hallo

Usage: SCPI confirmed

:MMEMory:DCATalog? <path>
Returns the subdirectories of a particular directory.

Query parameters:

<path> String parameter to specify the directory. If the directory is omit-
ted, the command queries the content of the current directory,
queried with :MMEMory : CDIRectory command.

Return values:
<Catalog> <file_entry>

Names of the subdirectories separated by colons. The first two
strings are related to the parent directory.

Example: See "Working with Files and Directories" on page 304.

Usage: Query only

:MMEMory:DCATalog:LENGth? [<Path>]
Returns the number of subdirectories in the current or specified directory.

Query parameters:

<Path> String parameter to specify the directory. If the directory is omit-
ted, the command queries the contents of the current directory,
to be queried with : MMEMory : CDIRectory command.
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Return values:
<DirectoryCount> integer

Number of parent and subdirectories.
Example: See "Working with Files and Directories" on page 304.

Usage: Query only

:MMEMory:DELete <Filename>
Removes a file from the specified directory.

Setting parameters:

<Filename> string
String parameter to specify the name and directory of the file to
be removed.

Example: See "Working with Files and Directories" on page 304.

Usage: Event

SCPI confirmed

Manual operation: See "Cut" on page 131

:MEMory:HFRee?
Returns the used and available memory in Kb.

Return values:
<TotalPhysMemKb> integer

Total physical memory.

<ApplicMemKb> integer
Application memory.

<HeapUsedKb> integer
Used heap memory.

<HeapAuvailableKb> integer
Available heap memory.

Usage: Query only

:MMEMory:LOAD:STATe <SavRcIStateNumb>, <file_name>
Loads the specified file stored under the specified name in an internal memory.

After the file has been loaded, the instrument setting must be activated using an *RCL
command.

Setting parameters:
<SavRclIStateNumb> Determines to the specific <number> to be used with the *RCL
command, e.g. *RCL 4.
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<file_name> String parameter to specify the file name with extension
*.savrcltxt.

Example: See "Storing and Loading Current Settings" on page 304.
Usage: Setting only

Manual operation: See "Recall" on page 129

:MMEMory:MDIRectory <Directory>

Creates a subdirectory for mass memory storage in the specified directory. If no direc-
tory is specified, a subdirectory is created in the default directory. This command can
also be used to create a directory tree.

Setting parameters:
<Directory> string

String parameter to specify the new directory.
Example: See "Working with Files and Directories" on page 304.
Usage: Event

Manual operation: See "Create New Directory" on page 132

:MMEMory:MOVE <SourceFile>, <DestinationFile>

Moves an existing file to a new location or, if no path is specified, renames an existing
file.

Setting parameters:
<SourceFile> string

String parameter to specify the name of the file to be moved.

<DestinationFile> string
String parameters to specify the name of the new file.

Example: See "Working with Files and Directories" on page 304.

Usage: Event
SCPI confirmed

Manual operation: See "Rename " on page 132

:MMEMory:MSIS <Msis>

Defines the drive or network resource (in the case of networks) for instruments with
windows operating system, using msis (MSIS = Mass Storage Identification String).

Note: Instruments with Linux operating system ignore this command, since Linux does
not use drive letter assignment.

Usage: SCPI confirmed



OUTPut Subsystem

:MMEMory:RDIRectory <Directory>

Removes an existing directory from the mass memory storage system. If no directory
is specified, the subdirectory with the specified name is deleted in the default directory.

Setting parameters:
<Directory> string

String parameter to specify the directory to be deleted.
Example: See "Working with Files and Directories" on page 304.

Usage: Event

:MMEMory:STORe:STATe <savrcl_state_nr>, <file_name>
Stores the current instrument setting in the specified file.

The instrument setting must first be stored in an internal memory with the same num-
ber using the common command *sSAv.

Setting parameters:
<savrcl_state _nr> Corresponds to the specific <number> defined with the *sav
command, e.g. *SAV 4.

<file_name> String parameter to specify the file name with extension
*.savrcltxt.

Example: See "Storing and Loading Current Settings" on page 304.

Usage: Event

Manual operation: See "Save" on page 128

7.11 OUTPut Subsystem

The oUTPut system contains the commands which set the properties of the RF output
connector.

The properties of the LF output connector are set in the SOURce:LFOutput Subsystem

system.
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:OUTPut<hw>:AFIXed:RANGe:LOWer?

Queries the minimum level which can be set when the attenuator is fixed, see :
OUTPut<hw>:AMODe.

Return values:
<Lower> float

Increment: 0.01

Example: OUTP:AFIX:RANG:LOW?
queries the minimum level for the FIXed setting.

Example: Response: -50
The minimum level is -50 dBm.

Usage: Query only
Manual operation: See "Fixed Range (PEP) In" on page 149

:OUTPut<hw>:AFIXed:RANGe:UPPer?

Queries the maximum level which can be set when the attenuator is fixed, see :
OUTPut<hw>:AMODe.

Return values:

<Upper> float
Increment: 0.01

Example: OUTP:AFIX:RANG:UPP?
queries the maximum level for the FIXed setting for the RF out-
put.

Example: Response: -27

The maximum level is -27 dBm.
Usage: Query only
Manual operation: See "Fixed Range (PEP) In" on page 149

:OUTPut<hw>:ALC:SEARch:MODE <Mode>

Activates/deactivates the RF output during the power search.

Parameters:
<Mode> NORMal | MINimum

*RST: NORMal
Example: POW:ALC: SEAR:MODE NORM

during the power search, the RF output is active.

Manual operation: See "RF During Power Search - ALC" on page 153
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:OUTPut<hw>:AMODe <AMode>
Selects the mode of the attenuator at the RF output (Attenuator MODe).

Parameters:
<AMode> AUTO | FIXed

AUTO
The attenuator is switched automatically. The level settings are
made in the full range.

FIXed

The level settings are made without switching the attenuator.
When this operating mode is switched on, the attenuator is fixed
in its current position and the resulting variation range is defined.

*RST: AUTO

Example: POW:ALC ON

activates automatic level control for RF output.
OUTP:AMOD FIX

sets the fixed mode with uninterrupted level for RF output.

Manual operation: See "Attenuator Mode" on page 149

:OUTPut<hw>:FILTer:AUTO <Auto>

Activates automatic switching of the low harmonic filter.

Parameters:

<Auto> 0]1|ON|OFF
*RST: 0

Example: OUTP:FILT:AUTO 1

Activates the auto mode.

Manual operation: See "Mode" on page 149

:OUTPut<hw>:FILTer[:LPASs]:STATe <State>

Switches the filter state in manual mode and disables the automatic mode, if activated.

Parameters:

<State> 0]1]OFF|ON
*RST: 0

Example: OUTP:FILT:AUTO O

OUTP:FILT:LPAS:STAT 1

Selects manual mode and activates the low harmonic filter.
OUTP:FILT:STAT?

Queries the current filter activity.

Manual operation: See "State" on page 149
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:OUTPut<hw>:IMPedance?

Queries the impedance of the RF outputs. It enables you to convert the output level
units between V and W. The impedances cannot be changed.

Return values:
<Impedance> G1K | G50 | G10K

*RST: G50
Default unit: Ohm

Example: OUTP: IMP
queries the impedance of RF output.
Response: 50
the impedance is 50 ohms

Usage: Query only

:OUTPut<hw>:PROTection:CLEar

Resets the protective circuit after it has been tripped. The state of the output is again
determined by OUTPut : STATe.

Example: OUTP:PROT:CLE
resets the protective circuit for RF output.

Usage: Event

Manual operation: See "Overload” on page 166

:OUTPut<hw>:PROTection:TRIPped?
Queries the state of the protective circuit.

Return values:

<Tripped> 0|1]|OFF|ON
*RST: 0
Example: OUTP:PROT:TRIP

Queries the state of the protective circuit for RF output A.
Response: 0

The protective circuit has not tripped.
Response: 1
The protective circuit has tripped.

Usage: Query only

Manual operation: See "Overload" on page 166

:OUTPut<hw>[:STATe] <State>
Activates and deactivates the RF output signal (RF ON / RF OFF).
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Parameters:

<State> 0]1|OFF|ON
*RST: 0

Example: OUTP OFF

deactivates the RF output.

Manual operation: See "RF On" on page 135

:OUTPut<hw>[:STATe]:PON <Pon>
Selects the state of the RF output when the instrument is switched on.

Parameters:
<Pon> OFF | UNCHanged
OFF
deactivates the output when the instrument is switched on (RF
OFF).
UNCHanged
restores the initial state of the RF output before the last turn off.

sets the output status as it was when the instrument was
switched off.

*RST: UNCHanged

Example: OUTP:PON OFF
RF output A is deactivated when the instrument is switched on.

Manual operation: See "Power-On State - RF Signal" on page 151

7.12 SENSe, READ and INITiate Subsystems

The SENSe subsystem contains the commands for configuring the power measure-
ments with R&S NRP-Zxx power sensor(s) connected to the generator. The measure-
ment is started and the measurement result retrieved with the READ command. The
description of this commands is included in the following.

Up to four sensors can be connected to the signal generator. They are distinguished by
means of the suffix under SENSe, that means SENSe [1] ... SENSe 4.
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